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Foreword 
 
 
United States Army Corps of Engineers (USACE) policy states that USACE will analyze water 
resources projects, including flood risk management projects, using a risk framework that 
incorporates watershed and systems approaches. USACE's Hydrologic Engineering Center 
(HEC) developed the Watershed Analysis Tool (HEC-WAT) to provide software to the field that 
supports these requirements. 
 
HEC-WAT helps a study team perform the necessary hydrologic, hydraulic, and consequence 
planning analyses by integrating water resources software that is commonly applied by a multi-
disciplinary study team when conducting a water resources study. Many pieces of software 
within the HEC suite of tools are implemented within HEC-WAT, thus allowing a study team to 
perform many of the necessary hydrologic, hydraulic, and planning/ consequence analyses from 
a single interface. The HEC software currently incorporated in HEC-WAT includes HEC-HMS 
(hydrology), HEC-ResSim (reservoir operations), HEC-RAS (hydraulics), and HEC-FIA (flood 
consequences).  
 
The development of the Flood Risk Analysis (FRA) compute option within HEC-WAT software 
allows a watershed or study area to be analyzed in a systems context using risk analysis and 
also supports risk-based analyses and risk-informed decision-making. FRA uses event-based 
Monte Carlo-style uncertainty sampling to evaluate the full range of possible conditions across a 
watershed or within a system, which in turn provides a more complete picture of flood risk in a 
watershed.  
 
The goal of HEC-WAT is to help USACE offices perform all types of water resources studies in 
a coordinated and comprehensive fashion.  HEC-WAT accomplishes this goal through an 
interface that allows the user to: load GIS based layers; establish stream networks and 
schematics; identify locations where models would share information; define the modeling 
software applications and their sequence order; import and edit existing models; develop new 
models; organize and develop alternatives, analysis periods, and simulations; run modeling 
software applications directly; and, view and compare alternative results. 
 
HEC-WAT has been implemented following software guidelines that have been established at 
HEC. The guidelines facilitate a common graphical user interface and look-and-feel for HEC 
software in the PC environment.  Recent HEC software implemented under these guidelines 
include rainfall-runoff analysis (HEC-HMS), river hydraulics (HEC-RAS), reservoir system 
analysis (HEC-ResSim), flood damage analysis (HEC-FDA), flood impact analysis (HEC-FIA), 
statistical analysis (HEC-SSP), and, ecosystem function analysis (HEC-EFM).  HEC software 
implementation is under the guidance of Christopher N. Dunn, Director, Hydrologic Engineering 
Center. 
 
Design and development of the HEC-WAT software has been a team effort.  The initial design 
and concepts of HEC-WAT were done by Messrs. Christopher Dunn, Gary Brunner, Jeff Harris, 
and William Charley.  This group also included John DeGeorge of Resources Management 
Associates (RMA).  Once a draft design document was created, the formal design process 
started and several other individuals joined the team: Michael Deering, Beth Faber, William 
Lehman, Mark Jensen, William Scharffenberg, Joan Klipsch, Matthew Fleming, and Penni 
Baker. The above personnel have also been involved in the development and implementation of 
the FRA compute option. Development and testing of the final release was led by Lea Adams, 
Chief, Water Resource System Division, Hydrologic Engineering Center. 
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Mark Ackerman, Ben Chacon, Ryan Ripken, John DeGeorge, and Shannon Newbold of RMA 
developed the graphical user interface, developed the concept of plug-ins, implemented and 
assisted HEC in the development of the plug-ins, and assisted with debugging and the overall 
design of the program.  
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CHAPTER 1 
 
 

Introduction 
 
1.1 Overview 
 
The U.S. Army Corps of Engineers (USACE) conducts water resources management studies to 
fulfill USACE's Civil Works mission.  These studies begin with the definition of problems, 
issues, and opportunities and continue through the planning process by formulating, evaluating, 
and comparing alternatives. Various analyses are used to determine alternative performance and 
related impacts so that appropriate decisions may be made.  The studies often require 
hydrologic/hydraulic, economic, environmental, and social performance and impact analyses.  In 
most cases, varying sections within a district office or through a Project Delivery Team (PDT), 
perform these analyses independently with the reporting and visualization of modeling results 
using independent models.  For the project study, coordination, file/data sharing, logistics, 
reporting of modeling results, and status reporting are often a problem for the PDT and modeling 
teams as well as project management. 
 
USACE determined that there was a need to streamline and integrate the tools commonly applied 
by the district and division offices to perform water resources analyses so that more efficient, 
transparent, and coordinated modeling and planning can be performed.  The Hydrologic 
Engineering Center (HEC) developed the Watershed Analysis Tool (HEC-WAT) to meet 
USACE requirements for performing water resources studies in a comprehensive, systems based 
approach. Modeling teams benefit because teams will be able to develop models in a closely 
coordinated manner using a shared schematic; track progress of other models; and, automatically 
retrieve results from previous model runs through the shared schematic, thus assuring a more 
efficient and coordinated result.  A graphical user interface (GUI) allows for data and results 
sharing, facilitates the assembly of a common schematic; definition and representation of 
alternatives; model setup; editing and implementation; and, direct data and results visualization.  
The management team will benefit through the use of a tool that employs a common interface to 
track project status through each modeling component and to display results during public and 
project status meetings. 
 
Flood Risk Management 
 
USACE flood risk management (FRM) policy requires that USACE analytical processes include 
methods and tools that employ integrated, comprehensive, systems and life-cycle based 
approaches and risk-based concepts in planning, design, construction, operations and major 
maintenance. These USACE methods need to incorporate systems response of projects when 
considering load distribution and failure possibilities. USACE policy also states that project 
performance needs to consider the system reaction to flood loading and how those loadings are 
distributed across the watershed. A new capability was needed to focus on sustainability and to 
employ adaptive planning and engineering capabilities. This new capability was also needed to 
incorporate new information and knowledge about a project throughout its life to ensure project 
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safety and performance requirements are addressed.  From within USACE there is very little 
guidance and few tools to support these requirements. Also, limitations of the current process 
include difficulty in performing a system-wide risk assessment and incorporating a life-cycle 
approach. 
 
HEC-WAT includes an option that analyzes complex riverine systems while implementing the 
flood risk management and systems requirements.  Life-cycle analysis will be addressed in a 
later version of HEC-WAT.  The compute option, Flood Risk Analysis (FRA), allows a user to 
perform plan formulation or system performance analyses while incorporating risk and 
uncertainty analyses. 

 
The terminology, analysis procedures, and output for the FRA compute option are consistent 
with the following USACE guidance and requirements: 
 
 ● ER 1105-2-100, "Planning Guidance Notebook" (22 Apr 2000), requires systems and life-

cycle approaches  
 
 ● ER 1105-2-101, "Risk Analysis for Flood Damage Reduction Studies" (11 July 2017), 

requires risk analysis for all flood damage reduction studies  
 
 ● EM 1110-2-1619, "Risk-Based Analysis for Flood Damage Reduction Studies" (1 August 

1996), specifies how to conduct risk analysis 
 
 ● ER 1110-2-8159, "Life Cycle Design and Performance" (31 Oct 1997) 
 
 ● ETL 1110-2-573, "Construction Cost Estimating Guide for Civil Works" (30 Sep 2008) 
 
1.2 Purpose 
 
The purpose of the HEC-WAT software is to help USACE study teams perform the necessary 
hydrologic, hydraulic, and consequence planning analyses that are required for water resource 
studies.  The HEC-WAT framework allows a multi-disciplinary PDT to perform water resources 
studies in a comprehensive, systems based approach by building, editing and running models 
commonly applied by multi-disciplinary teams and saving and displaying data and results in a 
coordinated fashion.  The terminology, analysis procedures, and output used by HEC-WAT are 
consistent with the requirements of USACE guidance and policy.  HEC-WAT is designed to 
facilitate: 
 
 ● Entry of the appropriate data into each of the modeling programs is incorporated into the 

HEC-WAT framework. 
 
 ● Trade-off analyses among all study alternatives will eventually be a capability within 

HEC-WAT through the use of consistent schematics, data, and tools.  Results will be 
easier to compare and contrast making the trade-off analysis easier to perform. 

 
 ● The analytical process and enhanced coordination among study team members, while 

producing more consistent results, and displays. 
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 ● The definition of alternatives through schematic representations, model identification and 
sequencing, and tabular formatting. 

 
 ● The assessment of study status by reviewing HEC-WAT outputs and reports. 
 
 ● The review of modeling results at all modeled locations without the direct knowledge of 

how the individual models generate those results.  Those attending meetings can view the 
results system-wide rather than reading the results for a few locations in a hard copy report 
or poster. 

 
1.3 Overview of HEC-WAT 
 
HEC-WAT is software that orchestrates the building, editing, and running of a series of models 
to help perform water resources studies while addressing the requirements prescribed by ER 
1105-2-101.  The software provides flexibility to offices in the performance of water resources 
studies (Figure 1.1). The software can be used to perform small CAP (Continuing Authorities 
Program) studies or large comprehensive studies.  The HEC-WAT interface streamlines and 
integrates the analytical process of water resource studies by using the software tools commonly 
applied by multi-disciplinary teams.  These software tools include hydrologic, hydraulic, 
economic, and social impact assessment models. 
 

 
Figure 1.1  HEC-WAT Study 
 
The HEC-WAT tool allows USACE, partners, and stakeholders to conduct studies in a 
coordinated fashion.  Coordination begins as each model uses the common schematic that is built 
within the HEC-WAT interface.  The common schematic is a "road map" of the study area that 
provides each team with the agreed upon nomenclature for the study area which should be used 
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for each model and alternative.  The individual models can be built and edited inside or outside 
HEC-WAT, or imported from CWMS (Corps Water Management System) or HEC-RTS (Real-
Time Simulation) watersheds.  Model results can be viewed from HEC-WAT by selecting 
elements found on the schematic.  Once the models are located (i.e., importing models, building 
models) within an HEC-WAT study, the models can be run in a user defined sequence.  The 
storage of data is organized by DSS (HEC's Data Storage System) and a simple DSS linking 
device is used to connect the models.  The models, the input data, and the results are all stored in 
the HEC-WAT's directory structure.  Therefore, all data and files used to make decisions are 
easily retrieved.  Alternative analyses can be performed, and output from multiple alternatives 
can be viewed concurrently making alternative analyses and alternative selection more efficient. 
 
1.3.1 Identifying a Study 
 
An issue at the beginning of any project feasibility study is the definition of study extent, the 
without-base year alternative and the array of potential project alternatives.  HEC-WAT helps to 
alleviate these issues by allowing the project study team to jointly define extents and alternatives 
through schematic representations, model identification and sequencing, and tabular formats. 
 
The study team, under the direction of a Project Manager (PM), conducts an initiation meeting to 
introduce the team to the project and study objectives.  The PM will also define the problems and 
identify opportunities within the study area.  A typical study team could be composed of a PM, 
GIS (geographic information system) specialist, hydrologist, hydraulic engineer, geotechnical 
engineer, water manager (reservoir), economist (flood damage and other consequence such as 
life loss), biologist (water quality), and planner. 
 
After locating the watershed boundary and identifying the problems and opportunities of the 
study, the team starts the analytical process by determining what data or models already exist and 
what data and models need to be developed.  Other HEC software performs data management 
functions so that all required data is available in one location (DSS file) before a simulation is 
computed.  HEC-WAT does not perform these data management functions (i.e., extracting, 
copying), therefore, if the study requires the use of observed, historical, or other model data, this 
data needs to be stored in DSS files.  This requirement is based on the way HEC-WAT links 
model alternatives together and simulations are computed. 
 
With a map in hand, the PM leads the study team on choosing the study boundaries, identifying 
gage locations, sub-basin delineations, locations where models can share data (common 
computation points), damage area centers, and location of measures (reservoirs, levees, etc.).  
Once this information has been identified, someone from the study team will be chosen to setup 
the base alternative (Without Project Conditions).  This person should be someone with 
knowledge of the study area. 
 
With the study area defined, the study team needs to identify any models that may already exist, 
what data is available, and what is the time window (analysis period) of the available data for the 
base alternative (Without Project Conditions).  Once the base alternative is set the study team 
identifies names and gathers information for the additional alternatives.  These alternatives could 
include the use of additional flood risk management measures, environmental features, or 
represent future conditions.  The benefit of HEC-WAT is that each of the modeling teams is able  
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to use the identical schematic to perform their modeling with naming and other schematic 
elements (e.g., stream alignment) being consistent across all models.  Each alternative is tied to a 
given schematic.  Therefore, the alternative definitions are fully coordinated making for more 
consistent modeling and modeling results. 
 
1.3.2 Creating a Study 
 
After the PDT has identified the study area, an HEC-WAT study needs to be created (Figure 
1.1).  A study, in HEC-WAT is a combination of data, models, and events required to analyze a 
specific geographic area.  The first step is to define the schematic for the base alternative, and 
then schematics for other defined alternatives. 
 
A schematic is a physical representation of a watershed boundary, stream alignment, and the 
flood risk management and environmental measures to be modeled.  One individual from the 
study team builds the schematic for the base alternative.  The first basic item of an HEC-WAT 
schematic is the stream alignment, which is usually created by importing information from a map 
layer (shapefile) or alternatively constructed within HEC-WAT (Appendix F).  Once a stream 
alignment has been constructed, and using the drawing tools available from within HEC-WAT or 
importing information from a map layer (shapefile), common computation points (Appendix H) 
and existing flood control or restoration measures (Appendix G) can be added to the schematic 
and is available across all models.  To aid in the placement of elements on the schematic, 
background maps of gage locations, reservoir locations, sub-basin delineations, study boundary 
areas, etc. can be added to the study. 
 
By default, HEC-WAT creates the base alternative – Without Project Conditions first.  The 
study team has probably defined other alternatives that can be created, as well (Figure 1.2).  An 
alternative in HEC-WAT is a way to group a schematic with different operations and model 
parameters.  Once an alternative is created, the next step is to create analysis periods.  Analysis 
periods define the time window (events) that could be associated with an alternative.  An event 
 

 
Figure 1.2  Relationship of Alternatives and Schematics 
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is an occurrence of precipitation/snowmelt that leads to some sort of hydrologic response 
normally associated with a specific time period.  The event can be historical or hypothetical or 
represent the upper limit of a precipitation runoff response. 
 
Now that analysis periods and alternatives have been defined (Chapters 9 and 10), existing 
models that have been identified for the study can be brought into the HEC-WAT study either by 
importing (Chapter 8) or copying the files into the HEC-WAT directory structure.  If models are 
to be built, HEC-WAT provides two options.  One is the ability to create the models through 
HEC-WAT by accessing the individual pieces of software directly from within HEC-WAT.  The 
other option is to copy the files created by HEC-WAT to a computer, and then return the files to 
the HEC-WAT study once the models are calibrated and validated.  For example, if the HEC-
RAS (River Analysis System) model for a study needs to be built, within the HEC-WAT 
directory structure, an HEC-RAS folder exists which contains the default HEC-RAS project 
files.  The user can copy these files to another computer, develop the HEC-RAS model, and then 
copy the files back to the HEC-WAT study. 
 
From the individual models, HEC-WAT is interested in the individual model alternatives that 
have been defined.  Each model has their own nomenclature for "alternative": 
 
 ● HEC-HMS – run, simulation 
 ● HEC-RAS – plan 
 ● HEC-ResSim – alternative 
 ● HEC-FIA - alternative 
 
Throughout the rest of this User's Manual, all of the above will be referred to as "model 
alternative".  For example, a RAS plan, from within HEC-WAT, is referred to as "RAS model 
alternative" 
 
Once all the model alternatives have been added to the HEC-WAT study, simulations (Figure 
1.3) can be created (Chapter 11).  A simulation is a combination of an analysis period associated 
with an alternative.  For each of these combinations, model alternatives need to be selected, a 
simulation computed, and results reviewed.  The process is then repeated for the other identified 
alternatives, and after several HEC-WAT simulations, alternative result comparison can be 
reviewed. 
 

 
Figure 1.3  Relationship of Alternatives and Analysis Periods to Simulations 

Simulation
Without Project 

Conditions-AP-Event1

Simulation

Alternative B-AP-
Event1

Analysis 
Period/Event1

Alternative B
(e.g. new reservoir)

Without Project 
Conditions



HEC-WAT User's Manual Chapter 1 - Introduction 

 1-7 

 
1.4 Starting HEC-WAT 
 
When starting HEC-WAT, double-click the HEC-WAT icon on a user's desktop, or 
from the taskbar click Start, point to All Programs, point to HEC, point to HEC-
WAT, and then click HEC-WAT.  The splash dialog box for HEC-WAT opens 
(Figure 1.4). 
 
The splash dialog box (Figure 1.4) appears for a few seconds, and then the main window of 
HEC-WAT appears.  The user is now ready to start using HEC-WAT. 
 

 
Figure 1.4  HEC-WAT Splash Dialog Box 
 
1.5 Organization of Manual 
 
The organization of this manual is shown in Table 1.1.  A description of the HEC-WAT 
framework and interface are provided in Chapters 2 and 3.  Chapters 4 through 14 cover creating 
and computing a basic (deterministic) HEC-WAT study.  Chapters 15 through 21 provide details 
on the HEC-WAT flood risk analysis (FRA) compute option.  Appendix A contains the list of 
references for this manual.  Appendices B through N provide more detailed information on 
specific items within the HEC-WAT framework.  Appendix O is a glossary of terms used in this 
manual. 
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Table 1.1 

Summary of Contents of User's Manual 
 

If the user wants to find out… Refer to… 
HEC-WAT Framework Chapter 2 
HEC-WAT Interface Chapter 3 
How to create and manage studies Chapter 4 
How to work with layers Chapter 5 
Building the base schematic Chapter 6 
Creating a basic HEC-WAT study Chapter 7 
Importing models Chapter 8 
Time Window – Analysis Periods Chapter 9 
Creating and managing alternatives Chapter 10 
Creating and managing simulations Chapter 11 
Model Linking Chapter 12 
Final Basic HEC-WAT Study Setup Chapter 13 
Computes and Alternative Analysis Chapter 14 
Flood Risk Analysis (FRA) Compute Option Overview Chapter 15 
Output Variable Editor Chapter 16 
Fragility Curve Sampler Chapter 17 
Models Skip Rules Editor Chapter 18 
Performance Metrics Chapter 19 
FRA Simulation Setup Chapter 20 
FRA Results Chapter 21 
Tools available from HEC-WAT Appendix B 
How to setup the coordinate system for map layers Appendix C 
Map editors Appendix D 
Using the Color Chooser Appendix E 
Stream Alignment Appendix F 
Measures Appendix G 
Common Computation Points Appendix H 
Impact Areas Appendix I 
How to use HEC-DSSVue Appendix J 
Model Integration Tools Appendix K 
How to edit model data Appendix L 
Plots Appendix M 
Printing and Copying Data Appendix N 
Glossary Appendix O 
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CHAPTER 2 
 

HEC-WAT Framework 
 
A framework is a basic structure underlying a system or concept. In the case of HEC-WAT, the 
framework allows for linkage of stand-alone modeling software, orchestration of modeling 
inputs, and visualization of modeling outputs. The HEC-WAT framework and associated linked 
components allows for the various PDT disciplines to work together in a flexible and transparent 
environment to achieve a common goal. The HEC-WAT overarching framework allows a multi-
disciplinary study team to perform water resources studies in a comprehensive, systems based 
approach. The HEC-WAT framework promotes the building, editing and running of models 
commonly applied by multi-disciplinary teams including the saving and displaying of data and 
results in a coordinated fashion.  Performing a risk analysis in a systems approach is an 
underpinning of the HEC-WAT framework including the Flood Risk Analysis (FRA) compute 
option. The FRA compute option will analyze complex riverine systems while implementing the 
flood risk and uncertainty analysis and systems requirements.  The HEC-WAT software will also 
allow a user to perform plan comparisons or system performance analyses while incorporating 
risk analysis methods. 
 
2.1 Overview 
 
The HEC-WAT software allows USACE to meet its primary mission of managing the nation's 
water resources in a holistic and comprehensive approach. HEC-WAT meets the planning 
perspective for a PDT by allowing the team to perform an alternative analysis in an intuitive and 
collaborative manner.  This ease of use is provided by the HEC-WAT framework which 
improves a study team's ability to facilitate transfer of information, convene as a team, provide 
advice to stakeholders, and work collaboratively. The basic premise of HEC-WAT is to involve 
modelers early in the process, thus encouraging a collaborative team approach to conducting a 
water resources study.  This coordination allows a study team to perform many of the necessary 
hydrologic, hydraulic, consequence, environmental, and planning analyses orchestrated from a 
single interface. 
 
This central framework will allow study team members to: load GIS based layers shapefiles and 
DEMs (digital elevation model); establish stream networks and schematics; identify locations 
(common computation points) where models would share information; define the modeling 
software applications and their compute sequence order; import existing models; and, develop 
new models.  The HEC-WAT framework will also aid in organizing and developing alternatives; 
provide the ability to access and execute modeling software applications directly; and, view and 
compare alternative results. 
 
2.2 Plug-In Concept 
 
HEC-WAT is not replacing existing software but rather the framework allows unique and 
existing software to work together.  The integration of the individual pieces of software within 
the HEC-WAT framework is achieved through the concept of a "plug-in". The plug-in is what 
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allows the individual pieces of software to integrate without requiring special code in HEC-WAT 
to support the individual pieces of software. There are numerous ways to implement plug-ins; 
therefore, the plug-in concept should not preclude a plug-in being developed for software that 
might be included in the HEC-WAT framework in the future. HEC-WAT provides the analysis 
framework but does not know anything about the individual pieces of software used. The 
individual pieces of software provide the technical mechanics within the framework (i.e., editing, 
reporting capability, computational analyses, etc.) and are not intended to contain any HEC-
WAT specific code. Further details about the plug-in concept will be detailed in the HEC-WAT 
Technical Reference Manual (not available for Version 1.0). 
 
2.3 HEC Software Integrated into HEC-WAT 
 
The primary set of initial software to be used during the analytical process in HEC-WAT is 
shown in Figure 2.1. The set of software available is: 
 

• HEC-HMS (Hydrologic Modeling System) 
• HEC-RAS (River Analysis System) 
• HEC-ResSim (Reservoir System Simulation) 
• HEC-FIA (Flood Impact Analysis) 

 

 
Figure 2.1  HEC-WAT Framework - Basic 
 
Other software and tools that are available with the HEC-WAT software include HEC-SSP 
(Statistical Software Package) and HEC-DSSVue (Data Storage System Visual Utility Engine). 
 
2.3.1 Hydrologic - HEC-HMS 
 
HEC-HMS (http://www.hec.usace.army.mil/software/hec-hms/) is a standalone software 
application that is designed to simulate the precipitation-runoff processes of dendritic watershed 
systems. The software is designed to be applicable in a wide range of geographic areas and is a 
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Plug-In

Model Results (simulation.dss)

http://www.hec.usace.army.mil/software/hec-hms/
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generalized hydrologic modeling system capable of representing many different watersheds to 
simulate either a single flood event or a continuous simulation that spans a couple of weeks or 
multiple decades. A model of the watershed is constructed by selected modeling methods for 
different components of the hydrologic cycle defining meteorologic boundary conditions. HEC-
HMS in the HEC-WAT compute sequence is a hydrologic precipitation rainfall-runoff model 
that generally provides simulated flow at multiple locations within a watershed. 
 
2.3.2 Reservoirs - HEC-ResSim 
 
HEC-ResSim (http://www.hec.usace.army.mil/software/hec-ressim/) is a standalone software 
application that is used to model reservoir operations at one or more reservoirs whose rule-based 
operations are defined by a variety of operational goals and constraints.  The software simulates 
reservoir operations for flood management, low flow augmentation and water supply for 
planning studies, detailed reservoir regulation plan investigations, and real-time decision support. 
HEC-ResSim in the HEC-WAT compute sequence is a reservoir simulation model that provides 
regulated flow hydrographs.  Results from both HEC-HMS and HEC-ResSim can be used by the 
hydraulics model. 
 
2.3.3 Hydraulics - HEC-RAS 
 
HEC-RAS (http://www.hec.usace.army.mil/software/hec-ras/) is a standalone software 
application that allows the user to perform one- dimensional steady and unsteady flow and two-
dimensional unsteady flow simulations.  HEC-RAS also includes sediment transport/mobile bed 
computations and water temperature modeling.  HEC-RAS contains four one-dimensional river 
analysis components for: (1) steady flow water surface profile computations; (2) unsteady flow 
simulation; (3) movable boundary sediment transport computations; and (4) water quality 
analysis.  The HEC-RAS Mapper tool that is available from the HEC-RAS interface, calculates 
inundation boundary and water depth maps. HEC-RAS in the HEC-WAT compute sequence is a 
river hydraulic model that computes the river stages, water surface profiles, and levee breach 
information that is used to compute consequences by HEC-FIA. 
 
2.3.4 Consequences - HEC-FIA 
 
HEC-FIA (http://www.hec.usace.army.mil/software/hec-fia/) is a standalone software application 
that evaluates consequences using either continuously observed or simulated stage hydrographs 
(hydrograph-based) or depth grids (GIS-based).  For a specified analysis, the software evaluates 
urban and agricultural flood damage, area inundated, number of structures inundated, and 
consequences.  Consequences include economic and life loss.  HEC-FIA also provides 
information to flood managers and emergency managers for emergency response activities. 
 
2.4 Other Software 
 
The plug-in concept allows study teams to add to the HEC-WAT framework other application 
software that may be required for a study. These additions can be made with minimal changes to 
HEC-WAT.  Examples of additional software applications to HEC-WAT in the past are listed 
below: 
 

http://www.hec.usace.army.mil/software/hec-ressim/
http://www.hec.usace.army.mil/software/hec-ras/
http://www.hec.usace.army.mil/software/hec-fia/
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• URC (Upper Rule Curve) - software used by CENWD for developing upper rule curves 
for storage reservoirs in the Columbia River Basin watershed. 

 
• ECC (Energy Content Curve) - software used by CENWD for developing the guide 

curves (target pool elevations) for storage reservoirs in the Columbia River Basin 
watershed. 

 
• Hydrologic Sampling - when an FRA compute is being performed, the hydrologic 

sampling will generate system-wide flood event samples for a Monte Carlo simulation. 
The data produced by the plug-in can take the form of hydrographs or hyetographs 
spanning the life-cycle of the system, usually fifty years (USACE, CEIWR-HEC). 

 
• Fragility Curve Sampling – when an FRA compute is being performed and the HEC-

RAS model alternative (plan) is setup for levee breaching, sampling of levee failure 
elevations from fragility curves is accomplished through the fragility curve sampling. 
This plug-in defines the probability and elevation of failure at each levee that is part of 
the system. Sampling is conducted and the result is an evaluation of the full range of 
levee failure possibilities for each pre-defined location in the entire system (USACE, 
CEIWR-HEC). 

 
• Performance Metrics - risk for USACE is the measure of the probability and severity of 

undesirable consequences (ER 1105-2-101). From these analyses, the performance of a 
system's reaction to a flood must be reported. Performance and economic metrics 
describe the capability of the system to accommodate a single event (Assurance); the 
full range of events (Annual Exceedance Probability and Long-Term Exceedance 
Probability); and, the average or mean of all annual damage (Expected Annual Damage). 
These metrics assist in communicating risk and the Performance Metrics plug-in 
generates these metrics. Not all FRA studies require performance metrics (USACE, 
CEIWR-HEC). 

 
The following sections detail the additional CEIWR-HEC software that has also been added to 
the HEC-WAT framework. 
 
2.5 Tools 
 
Tools are CEIWR-HEC software applications that are not part of the HEC-WAT compute 
sequence but are used by a PDT team during a water resources study. HEC-DSSVue (HEC Data 
Storage System Visual Utility Engine) is used to view the DSS files where each software 
application stores data. HEC-SSP (Statistical Software Package) might be used for statistically 
analyzing data in a water resources study. 
 
2.5.1 HEC-DSSVue 
 
HEC-DSSVue (http://www.hec.usace.army.mil/software/hec-dssvue/) graphs and tabulates data 
that is stored in a DSS file.  Over sixty mathematical manipulation functions are available for 
operations on datasets within a DSS file, as well as data entry functions, and several utility and 
database maintenance functions.  Data can be displayed from a selection of dataset names or 

http://www.hec.usace.army.mil/software/hec-dssvue/
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from spatially referenced locations with a map background.  Common data stored in a DSS file 
includes time series data, such as hourly or daily flow, stages, precipitation, elevation, and 
storage data; curve data, such as rating tables and frequency curves; gridded data, such as 
NexRAD (Next-Generation Radar) data; and a variety of other data types. 
 
2.5.2 HEC-SSP 
 
HEC-SSP (http://www.hec.usace.army.mil/software/hec-ssp/) allows a user to perform statistical 
analyses of hydrologic data. The flood flow frequency analysis capability is based on Bulletin 
17B, "Guidelines for Determining Flood Flow Frequency" (1982) and Bulletin 17C (England, et. 
al., 2015). The analysis includes a generalized frequency analysis on not only flow data but other 
hydrologic data as well, a volume frequency analysis on high and low flows, a duration analysis, 
a coincident frequency analysis, and a balanced hydrograph analysis. 
 
2.6 How Does It All Work 
 
The HEC-WAT framework allows for the linked application of the software commonly used by 
multi-disciplinary teams in a water resources study. Individual models are built for the study. For 
example, a PDT is conducting a water resources study and is using the following software - 
HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA.  Section 2.6.1 describes the traditional 
approach to conducting a water resources study. Section 2.6.2 describes conducting a water 
resource study using HEC-WAT. 
 
2.6.1 Traditional Approach 
 
A PDT is conducting a water resources study and is using the following software - HEC-HMS, 
HEC-ResSim, HEC-RAS, and HEC-FIA. The HEC-HMS model for the study is built and run, 
which provides data about uncontrolled flows into and downstream of reservoirs.  This 
information is stored to a DSS file. 
 
Next an HEC-ResSim model is built and some of the required input would be results from an 
HEC-HMS model. The modeler will find the appropriate data in a DSS file and will link that 
DSS file to the HEC-ResSim model. The HEC-ResSim model is used to generate regulated 
flow/stages, flow hydrographs, or stage hydrographs which are stored to a DSS file. 
 
The hydraulics model, built using HEC-RAS requires input that has been created by HEC-HMS 
and HEC-ResSim. The modeler will find the appropriate data in a DSS file and will link that 
DSS file to the HEC-RAS model.  During an HEC-RAS compute, river stages, water surface 
profiles, hydrographs (unsteady analysis), and levee breach information, is stored to a DSS file. 
Also, RAS Mapper (a tool in HEC-RAS) calculates inundation boundary and water depth maps. 
 
The last model required for this study is an HEC-FIA model which computes economic and life 
loss consequences. Depending on input requirements, HEC-FIA could require data from all of 
the upstream models. The modeler will need to find the appropriate data (possibly from multiple 
DSS files) and link the HEC-FIA model to the DSS files.  HEC-FIA will evaluate urban and 
agricultural flood damages, area inundated, number of structures inundated, and life loss 
consequences. 

http://www.hec.usace.army.mil/software/hec-ssp/


Chapter 2 – HEC-WAT Framework HEC-WAT User's Manual 

2-6 

With the traditional approach, there is typically insufficient coordination across the PDT as the 
individual models are constructed and simulated. Lack of coordination among the PDT can make 
data management of the study files difficult. Reporting and visualization of modeling results is 
also difficult because it is likely  the individual models would  have different naming 
conventions, could be built to different datum and extents, and may not provide results at 
locations needed by each model. 
 
2.6.2 HEC-WAT Approach 
 
A PDT is conducting a water resources study and is using the following software - HEC-HMS, 
HEC-ResSim, HEC-RAS, and HEC-FIA. An HEC-WAT study has been created with a 
schematic built by the PDT that will be used by most of the models. The models are brought in to 
the HEC-WAT study and all models files are imported or copied into the HEC-WAT data 
management system that is based on the HEC-WAT study name.  
 
Now that all the models have been imported, simulations are created. For each simulation, the 
individual models are selected for a defined alternative. After the simulations are setup, "linking" 
between the models will need to be defined. Linking is the process within the HEC-WAT 
framework that allows the individual models to communicate with each other and how data is 
handed-off from model to model. The majority of linking in HEC-WAT is accomplished through 
DSS mapping and the use of simulation names. Additional linking capabilities include 
inundation boundary maps, water depth maps, and other DSS files. 
 
For example, the HEC-ResSim model requires information from an HEC-HMS model.  From the 
Model Linking Editor (Chapter 12), based on a particular simulation, the modeler will link the 
models. From a table that lists the available locations that were defined by the HEC-ResSim 
model, the modeler will select HEC-HMS as the model that has the information needed.  Then 
the modeler will select the appropriate location/results from the HEC-HMS simulation to pass to  
 
the HEC-ResSim model. Once completed, the linkage will be saved for the HEC-ResSim model. 
All of the software that was included within the HEC-WAT alternative simulation will need to 
be linked. Once all of the linking has been completed the simulation can be run. 
 
The first model is an HEC-HMS model. The model is run and unregulated flows are saved to a 
DSS file (simulation.dss). The unregulated flow from HEC-HMS now becomes inflow to the 
HEC-ResSim model. Because of the linking that was defined earlier in the process, HEC-HMS 
information stored in simulation.dss is used by the HEC-ResSim model during the compute. At 
the same time the HEC-ResSim model is saving peak regulated flows/stages, flow hydrographs 
or stage hydrographs to the simulation.dss file. Once the HEC-ResSim model compute is 
complete, the HEC-RAS model begins running using HEC-HMS and HEC-ResSim information 
from the simulation.dss file. HEC-RAS is saving river stages, water surface profiles, 
hydrographs (unsteady analysis), and levee breach information to the simulation.dss file. HEC-
RAS (through the RAS Mapper tool) is also creating inundation boundary and water depth maps, 
which are saved in the HEC-WAT study data management structure. 
 
After the HEC-RAS model compute is complete the HEC-FIA model compute begins. Based on 
the linking, HEC-FIA will retrieve HEC-ResSim and/or HEC-RAS results from the  
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simulation.dss file and also will use the inundation boundary maps generated by HEC-RAS. 
Once the HEC-FIA model compute is complete the HEC-WAT simulation is complete and 
results can be reviewed from within the HEC-WAT framework.  
 
With the HEC-WAT approach there is flexibility in the performance of water resources studies, 
the PDT is able to perform the study in a coordinated fashion, the data management of study files 
is centrally located within the HEC-WAT directory structure, alternative analyses can be 
performed easily and review of analyses results is from a central location. 
 
2.7 Flood Risk Management 
 
The HEC-WAT framework also includes a flood risk analysis (FRA) compute option (Figure 
2.2), which provides tools that will help a planner address the issues faced during a USACE 
planning study, and specifically the requirement for systems, watershed, and uncertainty 
analyses. The FRA compute builds on the HEC-WAT framework to provide a convenient 
method of implementing a Monte Carlo analysis across multiple models for flood risk 
management. With the initial HEC-WAT framework providing all the initial software that would 
meet the needs of a performing a system-wide analysis, the FRA compute option allows a user to 
perform plan formulation or system performance analyses while incorporating risk and 
uncertainty capabilities.  Chapter 15 provides further details on the flood risk analysis compute 
option. 
 
Note: Not all the models shown in Figure 2.2 are required to run an FRA compute.  An FRA 
compute could be configured with the Hydrologic Sampler and HEC-HMS only in the compute 
sequence.  This shortened compute sequence could be used to simply evaluate how uncertainty 
around meteorologic information might impact flow frequency at locations within a watershed.  
 

 
Figure 2.2  HEC-WAT Framework - Flood Risk Analysis (FRA) Compute Option  
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CHAPTER 3 
 
 

HEC-WAT Interface 
 
 
The HEC-WAT main window (Figure 3.1) displays the framework for HEC-WAT that allows 
users to enter data, review data, create alternatives, run simulations, and view results.  The Title 
Bar (Figure 3.1) displays the HEC-WAT study title.  After a study is opened, the name of the 
study will appear in the Title Bar. 
 

 
Figure 3.1  HEC-WAT Main Window 
 
3.1 Panes 
 
The HEC-WAT main window (Figure 3.1) is laid out in panes that allow the user to view HEC-
WAT study components at the same time or to display different, yet simultaneous, views of 
study components.  The HEC-WAT main window has four main panes.  The panes are: 
 
 Study Pane Provides an overview of items that have been defined for an HEC-WAT 

study (Figure 3.2).  Based on the view (see Section 3.2), the Study Pane can 
display information about alternatives; simulations; analysis periods; models 
that have been defined for the study; what map windows are actively open; 
the available schematics; stream alignments; measures; common computation 
points; and, impact areas. 
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Figure 3.2  Study Pane - Study View 

 
  The Study Pane contains a toolbar of action tools (Figure 3.3), that will 

allow the user to create, edit, display in a map window, delete, and, compute 
an item that has been selected in the Study Tree (Figure 3.2).  For example, 
in Figure 3.2 a simulation has been selected and the available action tools 
(Figure 3.2) are edit, display in map window, delete, and compute the 
simulation. 

 

 
Figure 3.3  Action Toolbar 

 
 Content Pane This pane provides details on selected HEC-WAT components (Figure 3.3) 

in the Study Pane (see Section 3.2).  For example, in Figure 3.4, for a study 
view, an HEC-WAT simulation has been selected – Without Project 
Conditions-RR_Feb_1986.  The Content Pane displays the elements of that 
simulation.  Information includes the alternative; the analysis period; the 
program order; the model alternatives that were run; the time window; the 
directory where the results from the simulation were written; and, the status 
of the simulation.  For a map view, the Content Pane displays the layers 
associated with the selected map windows listed in the Study Pane. 

 

 
Figure 3.4  Content Pane - Study View 
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 Desktop Pane The Desktop Pane (Figure 3.5) is where the different map windows that are 
available from HEC-WAT will display.  For example, in Figure 3.5, the 
Desktop Pane contains a map window of a selected simulation and a map 
window of a selected schematic.  These two map windows provide the user 
with a graphical representation of a simulation and a schematic.   

 

 
Figure 3.5  Desktop Pane 

 
 Message Pane The Message Pane (Figure 3.6) contains messages that the HEC-WAT 

software is providing for informational purposes as a simulation progresses.  
The information in the Message Pane is a record of HEC-WAT software 
activities, records the opening of a study, opening map windows, accessing 
DSS, and many other HEC-WAT activities. 

 

 
Figure 3.6  Message Pane 

 
3.2 Tabs 
 
HEC-WAT tabs provide different views of the available components 
of a study and users can perform certain operations for a study from 
the tabs.  The tabs can change the layout of the menu bar and 
available information in the Study and the Content panes can be changed.  There are three tabs: 
 
 Study The default tab (Figure 3.2) which provides a view of the study components in a 

tree (study tree) in the Study Pane.  Also, from the Study Tree a user can 
create, edit, and delete alternatives, analysis periods, and simulations.  From the 
Content Pane (Figure 3.4) the user can view detailed information about items 
listed in the Study Tree. This view also affects the HEC-WAT menu bar (see 
Section 3.3). 
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 Maps This tab (Figure 3.7) 
provides a view (maps view) 
of the available map 
windows currently active in 
the Desktop Pane (Figure 
3.5).  The maps windows are 
displayed by type in the 
Currently Opened Maps 
pane (Figure 3.7).  In the 
Map Layers Tree (Figure 
3.7) information about the 
layers for a selected map 
window are displayed. From 
the Map Layers Tree, the 
user can turn map layers 
on/off, adjust properties of 
the map layers, and order the 
map layers for viewing in the associated map window.  When the user switches 
to the Maps tab the HEC-WAT menu bar options will change. 

 
 Schematic From this tab (Figure 3.8), 

the user is provided with a 
view (a tree) in the Study 
Pane of the map layers that 
are available in the study, 
schematics that have been 
defined for the study, and 
available components - 
stream alignments, measures 
(levees, reservoirs), common 
computation points, and 
impact areas that have been 
defined for the study.  Also, 
from the study tree, the user 
can create, edit, delete, and 
modify the elements in the 
Schematic View.  In the 
Content Pane portion 
(Figure 3.8) further 
information is provided 
about elements in the 
Schematic View.  When the 
user switches to the 
Schematic View the HEC-
WAT menu bar options will 
change. 

 

Figure 3.7  Maps Tab 

Figure 3.8  Schematic Tab 
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3.3 Menu Bar 
 
The menu bar of HEC-WAT provides the user with many commands to perform various 
activities/functions. 
 
The File menu (Table 3.1) allows the user to perform study management functions such as 
creating, opening, closing, and saving an HEC-WAT study. The File menu also provides 
commands that will allow users to provide information about the study team; select the software 
applications or tools (plug-ins) that are needed for the study; import a CWMS watershed; import 
other HEC software application's model alternatives (HEC-HMS, HEC-ResSim, HEC-RAS, 
HEC-FIA); open recently viewed HEC-WAT studies; and, exit the HEC-WAT software.  The 
File menu is available in all HEC-WAT views. 
 
Table 3.1  HEC-WAT File Menu Commands 

Commands Description 
New Study Creates a new HEC-WAT study; opens the Create New Study dialog box. 
Open Study Open an HEC-WAT study; open the Open Study Browser. 
Close Study Closes the current HEC-WAT study. 
Save Study Saves the current HEC-WAT study. 
Study Details Opens the Study Details dialog box, has four tabs – Map Properties, Contacts, 

Model Info, Simulations, Plugins. Provides general information about the HEC-
WAT study; user can turn on/off map window grids; and, change background color. 
The user can also add information about the study team; list the models and what 
study team member is responsible for a model's development; information about 
simulations; and, disable/enable the plug-ins that are needed for the HEC-WAT study. 

Import Menu items for importing into HEC-WAT:  CWMS Watershed ; FIA; HMS; ResSim; 
RAS 

Recent Studies List the studies (last five) that have been opened. 
Exit Exit the HEC-WAT software. 

 
From the Edit menu (Table 3.2) the HEC-WAT user can create/modify/edit items that are the 
building blocks of an HEC-WAT study. A user can manipulate alternatives and simulations; 
establish the program order for a study; link the individual models of a study; modify the look 
and feel of the common computation point layers (CCPs); provide aliases for the defined stream 
segments in the HEC-WAT study; available FRA editors; and, access editors from application 
software that are part of a study.  The FRA specific editors allow the user to skip models during 
an FRA compute, and select variables to save to the simulation DSS file.  The above description 
is available when in the Study View, the Edit menu in the other views is limited. 
 
Table 3.2  HEC-WAT Edit Menu Commands 

Commands Description 
Alternative and Simulation Manager Opens the Alternative and Simulation Manager dialog box. 
Program Order Opens the Program Order dialog box. 
Model Linking Editor Open the Model Linking Editor. 
Edit Computation Point Layers Opens the Computation Point Layer Editor. 
Stream Reach Alias Editor Opens the Stream Reach Alias Editor. 
FRA Menu items for FRA compute: Model Skip Rules Editor; 

Output Variable Editor 
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HMS From this menu item the user can open the HEC-HMS 
software and also access individual HEC-HMS editors. 

ResSim From this menu item the user can open the HEC-ResSim 
software and also access individual HEC-ResSim editors. 

RAS From this menu item the user can open the HEC-RAS 
software and also access individual HEC-RAS editors. 

FIA From this menu item the user can open the HEC-FIA 
software and also access individual HEC-FIA editors. 

 
The View menu (Table 3.3) is where an HEC-WAT user can setup the HEC-WAT main 
window.  The user can select which toolbars and panes to display and not display; set display 
units for plotting and tabulating (English, SI); create and use layouts of the main window; 
manage layouts; which common computation point layer to display (Default, Fragility Curve); 
and, a report of the common computations point available for the study.  The View menu is 
available in all HEC-WAT views. 
 
Table 3.3  HEC-WAT View Menu Commands 

Commands Description 
Toolbars From this menu item the user can toggles on/off the following 

toolbars that are available in the HEC-WAT framework:  
Standard, WAT Tools, Tools, Maps, Programs 

Study Pane Menu item that toggles on/off the Study Pane in the HEC-WAT 
main window. 

Message Pane Menu item that toggles on/off the Message Pane in the HEC-
WAT main window. 

Status Bar Menu item that toggles on/off the Status Bar in the HEC-WAT 
main window. 

Set Display Units The user can set the display units for the HEC-WAT study - 
English (default) or SI. 

Save Layout Opens the Create Layout dialog box. 
Restore Layout This menu item provides a list of layouts that a user can choose 

from. 
Layout Manager Opens the Layout Manager dialog box. 
Computation Point Layer From this menu item the user can choose which common 

computation point layer is to be displayed - Default or Fragility 
Curve.  The user can also select both layers. 

Computation Point Layer Report Opens the List of Computation Point Layers dialog box. 
 
The Maps menu (Table 3.4), can be used by an HEC-WAT user to setup map layers and map 
windows for an HEC-WAT study.  The user can set spatial properties; zoom the active map 
window out to its full extents; add and remove map layers; open a new map window; adjust the 
active map window's properties; save the contents of the active map window as a graphics file; 
and, synchronize the current open map windows.  The user can also add an Internet map to the 
active map window, and view the map windows in either the watershed coordinate system or the 
coordinate system of the Internet map. Other available commands include the ability to print a 
copy of the active map window in the Desktop Pane (Figure 3.5); import various schematic 
elements (stream alignment, impact areas, reservoirs, levees, computation points) from a 
shapefile; and, export various schematic elements (stream alignment, impacts areas, schematic 
elements) to a shapefile.  The Maps menu is available in all HEC-WAT views. 
 



HEC-WAT User's Manual Chapter 3 – HEC-WAT Interface 

 3-7 

 
Table 3.4  HEC-WAT Maps Menu Commands 

Commands Description 
Default Map Properties Opens the Default Map Properties for dialog box. 
Zoom to All Menu item zooms to the full extents of the current map window. 
Add Map Layers Opens the Select Map to Add Browser. 
Remove Map Layers Opens the Remove Map Layers from Study dialog box. 
New Map Window Opens a map window that displays the map layers selected for the HEC-

WAT study. 
Map Window Properties Opens the Map Window Settings dialog box. 
Save Map Image Opens a Save Browser that allows the user to save the active map 

window as a graphic (*.wmf, *.jpg, *.png). 
Sync Map Windows Menu item syncs the open map windows in the Display Area. 
Add Internet Map Menu item provides a list of available Internet maps that can be 

included as a layer in the HEC-WAT study: 
 Google Street Map Bing Satellite Map 
 Google Satellite Map Open Street Map 
 Google Terrain Map No Internet Map 

Display Map Coordinates Menu item allows the user to toggle on/off the map coordinates for the 
map window.  Can be based either on a selected Internet map or the 
study projection (default). 

Print Map Opens a Print window that allows the user to make a printed copy of 
the active map window. 

Import Menu item that allows the user to import schematic elements from 
shapefiles: Stream Alignment, Computation Points, Reservoirs, Levees, 
Impact Areas 

Export Menu item that allows the user to export define schematic elements to 
shapefiles: Stream Alignment, Impact Areas, Schematic Elements 
(opens the Export Schematic Layers dialog box) 

 
The Compute (Table 3.5) menu is used to compute individual HEC-WAT simulations; compute 
multiple simulations; view a list of simulations for the watershed that have been computed; 
compute the active simulation or compute the individual models of the active simulation; and, 
view the compute log for the active simulation. For an HEC-WAT study with multiple FRA 
simulations there is an item for simulation failures. The Compute menu is only available in the 
Study View. 
 
Table 3.5  HEC-WAT Compute Menu Commands 

Commands Description 
Compute "simulation name" Menu item that computes the active HEC-WAT simulation. 
Compute Manager Opens the Compute Manager dialog box. 
Recent Simulations Menu item that list HEC-WAT simulations that have been computed; 

opens the Run FRA Simulation – "simulation name" dialog box. 
Simulation Failures Opens the Compute Failures for "simulation name" dialog box; 

FRA compute only 
Compute Menu item that allows the user to compute the active simulation or 

compute the individual models of the active simulation. 
View Compute Log Opens the compute log for the active simulation dialog box. 
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An HEC-WAT simulation must be selected for the Results menu to be active.  If a simulation 
has not been selected, from the Results menu, click Select Simulation, the Select Simulations 
Results dialog box will open (Figure 3.9).  From the Simulation list, select the simulation that 
will be active.  Click OK, the Select Simulation Results dialog box will close (Figure 3.9), and 
a simulation Map Window will display in the Desktop Pane.  The user will now be able to 
select results items from the Results menu. 
 

 
Figure 3.9  Select Simulation Results Dialog Box 
 
The Results menu can be different based on the simulation type – deterministic or an FRA 
simulation.  For a deterministic simulation (Table 3.6) the user can view the simulation.dss file 
and view results available from the individual models that were part of the simulation.   
 
Table 3.6  HEC-WAT Results Menu Commands – Deterministic Simulation 

Commands Description 
Simulation DSS File Opens a DSS Viewer dialog box. 
HMS Menu items that lists available HEC-HMS reports. 
ResSim Menu items that lists available HEC-ResSim reports. 
RAS Menu items that lists available HEC-RAS reports. 
FIA Menu items that lists available HEC-FIA reports. 

 
When an FRA simulation (Table 3.7) has been run, the user selects what results will be shown 
based on realization, lifecycle, and event; view the simulation.dss file for the FRA simulation; 
view (Histogram, Scalar, or Frequency) the various model output variables that the user selected 
(Output Variable Editor); results from the hydrologic sampling (if part of the FRA simulation); 
results from the fragility curve sampling (if part of the FRA simulation); results from the 
individual models that are part of the simulation; and, performance metric results (i.e., EAD, 
AEP, LTEP) if part of the FRA simulation. 
 
Table 3.7  HEC-WAT Results Menu Commands – FRA Simulation 

Commands Description 
Select Results (realization, lifecycle, event) Opens the Select Event Results dialog box. 
Simulation DSS File Opens a DSS Viewer dialog box. 
Output Variables User can view the various model output variables that 

were selected; view either by the Histogram Viewer, 
Scalar Viewer, or Frequency Viewer. 

Hydrologic Sampling Available hydrologic sampling results are:  Plot 
Hydrographs, Plot Event Distribution, Plot 
Maximum Flows, Correlation Table, Plot Shape Set 
Frequency, Output Report 

Fragility Curve Available fragility curve sampling results are: Plot, 
Output Report 
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HMS Menu items that lists available HEC-HMS reports. 
ResSim Menu items that lists available HEC-ResSim reports. 
RAS Menu items that lists available HEC-RAS reports. 
FIA Menu items that lists available HEC-FIA reports. 
Performance Metrics Depending on what the user has selected in the 

performance metrics alternatives, available results are: a 
series of EAD plot/reports (Plot EAD, EAD Output 
Report); AEP Histogram; LTEP Histogram; 
Performance Metrics Output Report 

 
The Tools menu (Table 3.8) provides access to DSS data (HEC-DSSVue); access to the 
Statistical Software Package (HEC-SSP); provides options for HEC-WAT (Appendix F); view 
the log for HEC-WAT, view logs for DSS files and the individual models that are part of a 
simulation; monitor memory usage; what graphic elements HEC-WAT knows about from the 
other applications; information on how the different model alternatives are used for the study; 
setup for distributed computing; and, if a simulation is running slowly, setup compute timings to 
locate where slow down is occurring.  The Tools menu is available in all HEC-WAT views. 
 
Table 3.8  HEC-WAT Tools Menu Commands 

Commands Description 
HEC-DSSVue Opens the HEC-DSSVue application. 
HEC-SSP Opens the HEC-SSP application. 
Options Open the Options dialog box. 
Console Output Opens the Console Window which contains the HEC-WAT 

log for the study. 
Logs Opens the DSS.log dialog box and the log files for the 

individual models that are part of simulation. 
Memory Monitor Opens the Memory Monitor window. 
Graphic Elements Opens the Graphic Element Report. 
Model Alternative Usage Opens the Model Alternative Usage dialog box. 
Simulation Compute Engine Manager Opens the Simulation Compute Engine Manager dialog 

box. 
Compute Timings Opens the Compute Timings dialog box. 

 
The Window menu (Table 3.9) is where the HEC-WAT user can control the appearance of the 
map windows in the Desktop Pane (Figure 3.1) of the HEC-WAT main window.  The Window 
menu is available in all HEC-WAT views. 
 
Table 3.9  HEC-WAT Window Menu Commands 

Commands Description 
Tile Menu item that allows the user to organize all of the currently opened map 

windows in either a vertical or horizontal tile. 
Cascade Menu item that allows the user to place one map window on top of the next in a 

cascading fashion. 
Next Window Menu item that brings the next map window in the list of currently opened map 

windows to the top. 
Previous Window Menu item that brings the previous map window that was on top to the top. 
Window Selector Menu item that provides a list of the currently opened map windows. 
Window Menu item that lists the currently opened map windows. 
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The Help menu (Table 3.10) allows the user access to HEC-WAT documentation; install the 
example study; connect to the HEC-WAT web page; connect to the HEC website; and, display 
current version information about HEC-WAT. 
 
Table 3.10  HEC-WAT Help Menu Commands 

Commands Description 
HEC-WAT Quick Start Guide Opens the HEC-WAT Quick Start Guide. 
HEC-WAT User's Manual Opens the HEC-WAT User's Manual. 
Hydrologic Sampling User's Manual Opens the Hydrologic Sampling User's Manual. 
Install Example Study Opens the Select Folder for Installing Example Study 

Browser. 
HEC-WAT Website Goes to the HEC-WAT web page. 
HEC Website Goes to the HEC website. 
About HEC-WAT Opens the About Box for HEC-WAT. 

 
3.4 Toolbar 
 
The toolbar area of the HEC-WAT main window (Figure 3.1) provides quick access to the most 
frequently used options from the HEC-WAT menu bar.  There are six available toolbars from the 
main toolbar: 
 
 Standard There are three tools available from the Standard toolbar (Figure 3.10).  The 

tools allow the HEC-WAT user to open a study, close a study, and save a 
study.  These tools have the same function as items under the File menu (see 
Table 3.1). 

 

 
Figure 3.10  Standard Toolbar 

 
 WAT Tools There are several tools available from the WAT Tools toolbar (Figure 3.11).  

The tools allow the user to set the program order for HEC-WAT; to 
manipulate alternatives, analysis periods, and simulations; link the individual 
model alternatives; set up rules to skip models during an HEC-WAT 
compute; and, select results from the individual models (output variables) 
that will be saved. 

 

 
Figure 3.11  WAT Tools Toolbar 

 
 Tools The tools available from the Tools toolbar (Figure 3.12) are variable 

depending on what plug-ins are loaded.  Two tools that are always available 
are: access DSS data (HEC-DSS) and the Statistical Software Package (HEC-
SSP). 

 

 
Figure 3.12  Tools Toolbar 
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 Maps There are four tools available from the Maps toolbar (Figure 3.13).  The 
tools allow the HEC-WAT user to control the appearance of map windows in 
the Desktop Pane (Figure 3.5) - create a new map window; synchronize 
active map windows; tile; and, cascade.  These tools have the same function 
as items under the Window menu (see Table 3.9). 

 

 
Figure 3.13  Maps Toolbar 

 
 Programs There are usually four tools available from the Programs toolbar (Figure 

3.14) that represent the individual software applications available from  
  HEC-WAT:  HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA.  These 

tools allow the user to directly open the selected software application's user 
interface from within HEC-WAT.  The tools available from the Programs 
toolbar are dependent on which plug-ins are loaded. 

 

 
Figure 3.14  Programs Toolbar 

 
To toggle these toolbars on and off, from the HEC-WAT menu bar, from the View menu, point 
to Toolbars, and select the toolbar the user wishes to toggle on and off. 
 
3.5 Map Windows 
 
Map windows (Figure 3.15) are used to graphically display stream alignments, schematics, 
alternatives, and simulations.  From an alternative map window the user can make adjustments to 
the stream alignment.  A schematic map window allows the user to edit, modify, and delete 
measures, CCPs, impact areas, and make adjustments to the stream alignment.  The simulation 
map window is where the HEC-WAT user can edit individual model parameters and view 
results. 
 
3.5.1 Open a Map Window 
 
There are a couple of ways to open map windows: from the Study Pane (Figure 3.2), double-
click on a stream alignment, schematic, alternative, or simulation; or, from the shortcut menu of 
a stream alignment, schematic, alternative, or simulation. 
 
To open a map window by double-clicking: 
 
 1. From the Study and Schematic tabs the user can double-click on stream alignments, 

schematics, alternatives, or simulations to open map windows in the Desktop Pane. 
 
 2. For example, in Figure 3.16, from the Study tab, double-click on the Without Project 

Conditions-RR_Feb1986 simulation.  A map window will open and display the model 
elements for the simulation Without Project Conditions-RR_Feb1986. 
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Figure 3.15  Map Window 

 

 
Figure 3.16  Display Simulation Map Window from Study Pane 



HEC-WAT User's Manual Chapter 3 – HEC-WAT Interface 

 3-13 

To open a map window from a shortcut menu: 
 
 1. From the Study and Schematic tabs, from the shortcut menus available for stream 

alignments, schematics, alternatives, or simulations the Display in Map Window 
command will open map windows in the Desktop Pane. 

 
 2. For example, in Figure 3.17, from the Schematics tab, right-click on Stream Alignment.  

From the shortcut menu, click Display in Map Window and a map window will open 
displaying the elements for the stream alignment. 

 

 
Figure 3.17  Display Stream Alignment Map Window from Schematic Tab 

 
3.5.2 New Map Window 
 
HEC-WAT provides a mechanism for the user to build a map window.  Instead of double-
clicking on a simulation, alternative or schematic the user can build a new map window. 
 
To create a map window: 
 
 1. From the Maps menu, click New Map Window, in the Desktop Pane a Map Window 

will open (Figure 3.18), with the map layers for the study loaded. 
 
 2. From the Study and Schematic tabs the user can drag-n-drop stream alignments, 

schematics, alternatives, and simulations on to a new map window.  For example, in 
Figure 3.18, from the Schematic tab on the Study Pane, click on the Without Project 
Conditions schematic.  Holding down the left mouse button, drag the schematic to the 
map window.  Release the mouse key, and the schematic for the Without Project 
Conditions is displayed in the new map window, and the map window will now be a 
schematic map window (Figure 3.19). 
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Figure 3.18  New Map Window 

 
 

 
Figure 3.19  New Map Window with Schematic Added 
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 3. To add an alternative to the Map Window, from the Study tab, on the Study Pane, from 

the Alternatives list, select an alternative.  Holding down the left mouse button, drag the 
alternative to the map window.  The elements that make-up the selected alternative will 
now display in the new map window and the map window will now be an alternative map 
window. 

 
 4. The user can save the map window by saving the study.  This means that the next time 

the user opens the study, the map window created will display. 
 
3.5.3 Tools 
 
The Tools appear in a toolbar on the left side of a Map Window (Figure 3.18).  The tools 
change the appearance of the mouse, as well as the functionality of the mouse. 
 
 Pointer/Selector Tool 
 
The Pointer/Selector Tool is available on all HEC-WAT map windows.  For a Simulation Map 
Window (Figure 3.16), with this tool selected the user can right-click on model graphical 
elements from the schematic displayed in the Simulation Map Window and from the shortcut 
menu view results or edit model elements.  When a New Map Window (Figure 3.18), an 
Alternative Map Window, or a Schematic Map Window (Figure 3.19) are selected, with this 
tool selected the user can right-click on the map window and from the shortcut menu edit the 
properties of the map window; zoom to the full extents; duplicate the map window; and, detach 
the map window. 
 
 Zoom Tool 
 
The Zoom Tool is available on all HEC-WAT map windows and allows the user to view data 
closely.  To zoom in, with the Zoom Tool selected, hold the mouse button down and outline the 
area the user wants to enlarge.  To zoom out, click the right mouse button (right-click).  The 
zoom out is done by a factor of two and positions the clicked location at the center of the display 
area. 
 
 
The Pan Tool is available on all HEC-WAT map windows and allows the user to move in map 
windows while zoomed in. 
 
All of the other tools available from a Schematic Map Window (Figure 3.19) are described in 
Chapter 6, Sections 6.3 and 6.4 
 
3.5.4 Zoom with Mouse 
 
In HEC-WAT map windows, if the user has a mouse with a wheel, the user can zoom in and out 
on a map window by manipulating the mouse wheel. 
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3.5.5 Detaching a Map Window from the Desktop Pane 
 
When a map window is opened, the map window is confined to the Desktop Pane of the HEC-
WAT main window.  When several map windows are open, the user can use commands (Section 
3.2) to arrange the map windows, but being able to view several map windows for comparison 
and presentation becomes difficult. 
 
HEC-WAT allows the user to detach a map window from the Desktop Pane, and then the user 
can manipulate the map window outside of the HEC-WAT framework.  This gives the user the 
ability to manipulate the map window as needed for better presentation and communication.  
From a map window (Figure 3.19), in the bottom right corner, there is a Detach Map Window 
tool      , click the Detach Map Window tool, and the tool changes to      , now the user can 
move the map window anywhere in the available display area.  Clicking the Detach Map 
Window tool will return the map window to the Desktop Pane on the HEC-WAT main window. 
 
3.5.6 Synchronous Map Windows 
 
The user can synchronize multiple map windows, which allows a user to review items in one 
map window and then be able to view the same area of the watershed in another map window.  
Open multiple map windows (Figure 3.19), for this example, a Simulation Map Window and a 
Schematic Map Window have been opened.  From the HEC-WAT main window and from the 
Window menu, select Tile, the map windows should appear side-by-side as displayed in Figure 
3.20.  Using the Zoom tool in the Simulation Map Window, zoom-in on an area of the 
watershed.  From the Maps menu, click Sync Map Windows.  Now the two map window are 
synchronized, so any action done by the user in one map window will also happen in the other 
map windows. 
 

 
Figure 3.20  Synchronized Map Windows 
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3.5.7 Properties of a Map Window 
 
The properties of a map window basically are the geographic extents (Chapter 5, Section 5.2.5), 
the zoom factor, the available map layers, the grid, and the background color.  The Map 
Window Settings dialog box (Figure 3.21) provides this information and allows the user to edit 
some of the map window's properties. 
 

 
Figure 3.21  Map Window Settings Dialog Box 
 
To edit and view map window properties: 
 
 1. From the Maps menu, click Map Window Properties, the Map Window Settings 

dialog box will open (Figure 3.21). 
 
 2. From the Current View Extents box, the user can view the extents of the map window 

and the current zoom factor. 
 
 3. The map layers associated with the active map window are listed in the table on the Map 

Window Settings dialog box (Figure 3.21).  The user can remove a map layer from the 
active map window by clicking in the Selected column.  For example, in Figure 3.19, if 
the user does not want to display the map layer associated with the impact areas, click the 
cell in the Selected column associated with RR_ImpactAreas.shp.  Click OK, the Map 
Windows Settings dialog box will close (Figure 3.21), and the map layer will no longer 
display in the active map window. 

 
 4. By clicking Draw Grid (Figure 3.21) the grid that is displayed in the active map window 

is turned off and on. 
 
 5. The default background color for the active map window is white.  By clicking 

Background Color (Figure 3.21); a Background Color Chooser will open (Figure 
3.22).  From the Swatches Tab click on a color, click OK, the Background Color  
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Figure 3.22  Background Color Chooser 

 
  Chooser (Figure 3.22) will close.  See Appendix F for further details on the color 

chooser.  From the Map Windows Setting dialog box (Figure 3.20), click OK.  The 
Map Windows Setting dialog box will close and the background color of the active map 
window will change. 

 
3.5.8 Create a Graphics File of a Map Window 
 
HEC-WAT allows the user to save the active map window to a graphics file for inclusion in 
reports and presentations.  HEC-WAT has three possible formats:  Windows Metafile (*.wmf), 
JPEG (*.jpg, *.jpeg) and Portable Network Graphics (*.png) which is the default. 
 
To create a graphics file of the active map window: 
 
 1. From the Maps menu, click Save Map Image, a Save Browser will open (Figure 3.23). 
 

 
Figure 3.23  Save Browser 
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 2. Browse to a location where the file will be saved, in the File name box type a name.  

From the Files of type list select the graphics file type to create. 
 
 3. Click Save, the Save Browser will close (Figure 3.23), and a file with the appropriate 

extension will be created in the selected location.  The file will contain an image of the 
active map window. 

 
3.5.9 Print a Map Window 
 
From HEC-WAT a user can print the contents of the active map window.  Make sure that the 
correct map window that the user wants to print is active before executing the following steps: 
 
 1. From the Maps menu, click Print Map, a standard system Print dialog box will open 

(Figure 3.24). 
 

 
Figure 3.24  Print Dialog Box 

 
 2. Choose a printer from the Name list (list of system printers), set options for the selected 

printer (click Properties), print to a file, select number of copies, and enter a print range. 
 
 3. Click OK, the Print dialog box will close (Figure 3.24) and output of the map window 

will print on the selected printer.  See Appendix N for further details on printing from the 
HEC-WAT 
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CHAPTER 4 
 

Manage Studies 
 
Data management by HEC-WAT is largely done behind the scenes.  Files are automatically 
created and named by HEC-WAT, and the active software application utilized within the HEC-
WAT framework, to store information.  Simulation information is stored in various DSS files 
(dependent on the type of simulation), while HEC-WAT general information, alternative 
descriptions, and simulation descriptions are all stored in ASCII text files. 
 
4.1 Manage Studies 
 
In HEC-WAT, the set of files associated with a particular 
water resources study is called a study.  HEC-WAT creates a 
directory (folder) with the study name specified, and stores all 
the files associated with the study in that directory.  
 
Commands available from the File menu (Figure 4.1) allow 
the user to create a new study; open an existing study; close 
the current study; save the current study; provide details about 
a study; import models into a study; select a study from the 
most recently opened studies; and, exit HEC-WAT. 
 
4.1.1 Create a New Study 
 
 1. From the HEC-WAT main window, from the File menu, click New Study. The Create 

New Study dialog box (Figure 4.2) will open. 
 

 
Figure 4.2  Create New Study Dialog Box 

Figure 4.1  File Menu Commands 
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 2. In the Study Name box (Figure 4.2), enter a name and in the Description box, enter a 
description of the new study. 

 
 3. In the Directory box (Figure 4.2), either enter the name of the directory where to store 

the HEC-WAT study, or click     , and an Open browser (Figure 4.3) will open.  Navigate 
to the directory where the HEC-WAT study will be stored, click Open.  The Open 
browser (Figure 4.3) will close. On the Create New Study dialog box (Figure 4.2) in the 
Directory box the location will display. 

 

 
Figure 4.3  Open Browser 

 
 4. The Unit System (Figure 4.2) for the study defaults to English (which is correct for the 

RussianRiver study).  The other choice from the list is SI (metric). 
 
 5. Next, the projected coordinate system of the study needs to be set.  A map projection is 

required to view locations from a curved surface on to a flat map.  HEC-WAT will re-
project on-the-fly, but it is a good idea to have all the layers in the same projection. From 
the Create New Study dialog box (Figure 4.2), click Edit (by the Coordinate System 
box), the Map Coordinate Information dialog box will open (Figure 4.4). 

 
 6. If the study has at least one associated map layer that has the correct projected coordinate 

system for the study, that map layer can be used to set the projected coordinate system for 
the study.  From the Map Coordinate Information dialog box (Figure 4.4), click Load 
from file (lower left corner of dialog box); an Open browser (Figure 4.3) will open.  
Browse to where the map layer containing the correct projection is stored. Click Open, 
now the Map Coordinate Information dialog box will contain information about the 
projected coordinate system (Figure 4.4).  Click OK, the Map Coordinate Information 
dialog box will close (Figure 4.4).  Now on the Create New Study dialog box the 
Coordinate System box (Figure 4.2) contains the name of the projected coordinate 
system (i.e., USA_Continguous_Albers_Equal_Area_Conic_ 

  USGS_version) for the study. 
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Figure 4.4  Map Coordinate Information Dialog Box with Study Projection Information 

 
 7. When creating the study the user can add map layers that the PDT has gathered for 

defining the study area.  From the Create New Study dialog box (Figure 4.2), click Add 
Map Layers.  The Select Map to Add browser will open (Figure 4.5). 

 

 
Figure 4.5  Select Map to Add Browser 
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  To copy map layers to the study directory area, from the Select Map to Add browser 
(Figure 4.5), select Create Copy.  Browse to where the map layers are located.  Select 
the map layers for the study.  Click Open, the Select Map to Add browser will close 
(Figure 4.5).  The Create New Study dialog box (Figure 4.6) appears. 

 

 
Figure 4.6  Create New Study Dialog Box - Completed 

 
 8. HEC-WAT creates a default alternative - Without Project Conditions.  If the user wants 

the default alternative to have a different name, several choices are available, including 
Other which allows the user to name the default alternative. 

 
 9. Click OK, the Create New Study dialog box will close (Figure 4.5).  The HEC-WAT 

main window will now have the name of the study (i.e., RussianRiver) on the title bar 
(Figure 4.7).  A Schematic Map Window opens, which contains the map layers that 
were added to the study in Step 7. 

 
 10. An HEC-WAT study has been created. 
 
4.1.2 Open an Existing Study 
 
There are two ways to open existing studies in HEC-WAT.  One way is to open a study by 
selecting it from the list of recently opened studies.  On the File menu (Figure 4.1), point to 
Recent Studies, from the list of the five most recently opened studies, click on the name of the 
study to open, and HEC-WAT will automatically load the selected study.  The second way to 
open an existing study is described below. 
 
To open an existing study: 
 
 1. From the HEC-WAT main window (Figure 4.7), from the File menu, click Open Study, 

an Open Study browser (Figure 4.8) will open. 
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Figure 4.7  HEC-WAT Main Window - Maps Tab 

 

 
Figure 4.8  Open Study Browser 

 
 2. From the Open Study browser (Figure 4.8), browse to the location of an existing HEC-

WAT study.  By default, HEC-WAT is looking for a file with the extension *.sty. 
 
 3. Select the study name, click Open, the Open Study browser will close (Figure 4.8), and 

the selected study will open in the HEC-WAT main window. 
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4.1.3 Close a Study 
 
To close an active study: 
 
 1. From the HEC-WAT main window (Figure 4.7), from the File menu, click Close Study. 
 
 2. HEC-WAT keeps track of changes being made to a study by the major study components 

– alternatives, analysis periods, and simulations.  HEC-WAT will save the study, which 
includes all the files associated with the individual software applications that are part of 
the study (e.g., HEC-RAS, HEC-FIA). 

 
4.1.4 Save a Study 
 
To save a study, from the HEC-WAT main window (Figure 4.7), from the File menu (Figure 
4.1), click Save Study.  HEC-WAT will save the study, which includes all the files associated 
with the individual software applications that are part of the study (e.g., HEC-RAS, HEC-FIA). 
 
4.1.5 Study Details 
 
One of the objectives of HEC-WAT is to provide information regarding the status of the study to 
the manager or any other member of the PDT.  Some of the information needs to be entered by 
the study team.  From the HEC-WAT main window (Figure 4.7), from the File menu (Figure 
4.1), click Study Details, the Study Details dialog box (Figure 4.9) will open.  This dialog box 
has five tabs – Map Properties, Contacts, Model Info, Simulations, and Plugins. 
 

 
Figure 4.9  Study Details Dialog Box – Map Properties Tab 



HEC-WAT User's Manual Chapter 4 – Manage Studies 

 4-7 

The Study Details dialog box (Figure 4.9) displays the name of the study; the study description 
(which the user can edit); location of the study file (*.sty); the selected unit system; the selected 
coordinate system; the user name of the team member that created the study; and, the date and 
time the study was created. 
 
Map Properties 
 
From the Map Properties worksheet, the user can set the synchronizing of map windows; 
choose to have or not have a grid display on map windows (default is to have a grid); and, set the 
background color of map windows (default is white).  The Map Properties worksheet is the 
default tab for the Study Details dialog box (Figure 4.9). 
 
Contacts 
 
The Contacts worksheet is where information regarding the study team is entered (Figure 4.10).  
Information includes the team member's name; the user name of the team member; the team 
member's responsibility on the study team; phone number; office symbol; and, the assignment 
(i.e., specific model, creation of stream alignment, etc.) given to the team member. 
 

 
Figure 4.10  Study Details Dialog Box – Contacts Tab 
 
Model Info 
 
Information from the Model Info worksheet (Figure 4.11) is related to the model alternatives 
that have been defined for a study.  HEC-WAT knows all model alternatives that have been 
identified and to what software applications each alternative belongs.  From the information  
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Figure 4.11  Study Details Dialog Box – Model Info Tab 
 
identified on the Contacts worksheet (Figure 4.10), from the Model Info worksheet a user can 
now identify the team member responsible for an individual model alternative; what team 
member imported the model alternative; the date the model alternative was imported; what team 
member modified the model alternative; the date the model alternative was modified; and, the 
description of the model alternative. 
 
If the model has a description, the Description column will display the description of the model 
alternative.  If there is no description, click in a Description cell, the Edit Description for 
"model alternative" dialog box will open (Figure 4.12).  Enter a description, click OK.  The Edit 
Description for "model alternative" dialog box will close and the entered description will appear 
in the selected Description cell. 
 

 
Figure 4.12  Edit Description for "model alternative" Dialog Box 
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Simulations 
 
From the Simulations worksheet (Figure 4.13) a user can view information regarding 
simulations.  The information on this worksheet is gathered by HEC-WAT based on dates and 
times, and the user name which was entered on the Contacts worksheet (Figure 4.10). 
 

 
Figure 4.13  Study Details Dialog Box – Simulations Tab 
 
Plugins 
 
From the Plugins worksheet (Figure 4.14) the user can define what plug-ins are being used by 
the study.  By enabling or disabling the plug-ins listed, the user will define what plug-ins will be 
used for the active study. 
 

 
Figure 4.14  Study Details Dialog Box – Plugins Tab 
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4.2 Study Directories and Files 
 
Figure 4.15 shows an example of how HEC-WAT organizes the directories and files that it 
creates in the study directory.  In this example, the study directory is /RussianRiver.  As data is 
entered, other files and subdirectories are created.  Table 4.1 describes each directory and file 
that is shown in Figure 4.15. 
 

 
Figure 4.15  Example HEC-WAT Study Directory Structure 
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Table 4.1  Example HEC-WAT Directories and Files 
File or Directory Name Contents 

 Study folder that is created when a user creates a new 
study (Section 4.1.1). 

 

ASCII text file created by HEC-WAT when a study is 
created.  Contains the name and description of the 
study, what user created the study, map coordinate 
information, and references to the stream alignment 
and the schematic data.  The *.bak file is an automatic 
backup file of the *.sty file. 

 ASCII text file created by HEC-ResSim when an HEC- 
WAT study is created.  The file is specifically used by 
the HEC-ResSim model.  Contains the name and 
description of the study, location of stream alignment 
file, and location of any map layers that have been 
added to the study.  The *.bak file is an automatic 
backup file of the *.wksp file. 

 ASCII text file created by HEC-WAT when a study is 
created.  Contains the projection information for an 
HEC-WAT study that was identified in the Map 
Coordinate Information dialog box.  The *.bak file is 
an automatic backup file of the *.projection file. 

 ASCII text file created by HEC-WAT when a study is 
created.  Contains the basic information 
creation/modification of a study.  The *.bak file is an 
automatic backup file of the *.log file. 

 ASCIISerializer text file created by HEC-WAT when a 
study is created.  Contains information for a default 
analysis group.  The *.bak file is an automatic backup 
file of the *.ag file. 

 ASCII text file created by HEC-WAT when a study is 
created.  Contains the name, description, and other 
information that define the stream alignment (stream 
nodes, vertex points, stream element(s), etc.).  The 
*.bak file is an automatic backup file of the *.sty file.  
The stream.prj file (created when importing a stream 
alignment from a shapefile) contains the projection 
information for the stream alignment. 

 ASCII text file created by HEC-WAT when a study is 
created; contains information on the default alternative.  
Contains the name, associated stream alignment, and 
other information.  The *.bak file is an automatic 
backup file of the *.walt file. 

 An XML file created by HEC-WAT when a study is 
created; contains information on the schematic 
associated with an alternative.  The *.bak file is an 
automatic backup file of the *.walt file. 

 An XML file created by HEC-WAT when information 
is entered on the Contacts worksheet from the Study 
Details dialog box.  Contains information on the study 
team that is entered:  team member names, user name 
of team member, software responsibility, phone 
number, office assignment, and, team member 
assignment.  The *.bak file is an automatic backup file 
of the *.xml file. 

  

RussianRiver.sty 

RussianRiver.sty.bak 

RussianRiver 

RussianRiver.wksp 

RussianRiver.wksp.bak 

Default.ag 

Default.ag.bak 

Without_Project_Conditions.walt 

Without_Project_Conditions.walt.bak 

contacts.xml 

contact.xml.bak 

RussianRiver.projection 

RussianRiver.projection.bak 

RussianRiver.log 

RussianRiver.log.bak 

stream.align 

stream.align.bak 

stream.prj 

Without_Project_Conditions.sch 

Without_Project_Conditions.sch.bak 
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File or Directory Name Contents 
 An XML file created by HEC-WAT when information 

is entered on the Model Info worksheet from the 
Study Details dialog box.  Contains information on the 
study team that can be linked to the individual model 
alternatives.  Information includes:  team member 
responsible for model alternative, who imported the 
model alternative, date model alternative was imported, 
team member who modified the model alternative, date 
the model alternative was modified, and the description 
of the model alternative.  The *.bak file is an automatic 
backup file of the *.xml file. 

 Sub-folder created by HEC-WAT when a study is 
created.  This folder contains all HEC-FIA model files. 

 Sub-folder created by HEC-WAT when a study is 
created.  This folder contains all HEC-HMS model 
files. 

 Sub-folder created by HEC-WAT when a study is 
created.  This folder contains the saved layouts for the 
WAT Desktop Pane.  Layouts also contain 
information in regards to the divider locations; what 
has been expanded and selected in the various panes; 
and, other information. 

 Sub-folder created by HEC-WAT when a study is 
created.  Used to store map layers and GIS coverages 
associated with a study. 

 Sub-folder created by HEC-WAT when a study is 
created.  This folder contains all HEC-RAS model 
files. 

 Sub-folder created by HEC-WAT when a study is 
created.  This folder contains all HEC-ResSim model 
files. 

 Sub-folder created by HEC-WAT when a study is 
created.  This folder contains all HEC-SSP model files. 

 Sub-folder created by HEC-WAT when a study is 
created.  This folder contains all CEQUAL-W2 model 
files. 

 Sub-folder created by HEC-WAT when a study is 
created.  This folder contains the default HEC-WAT 
program order; contains the file that has information 
from the Stream Reach Alias Editor; and, any other 
files that might be shared for the study. 

 An XML file created by HEC-WAT when a study is 
created and stored in the shared folder.  Contains 
information on the program order that can be defined 
by HEC-WAT.  Initially, contains the default program 
order:  HEC-HMS, HEC-ResSim, HEC-RAS, and 
HEC-FIA.  The *.bak file is an automatic backup file 
of the *.xml file. 

 An XML file created by HEC-WAT when a study is 
created and stored in the shared folder.  Contains 
information from the Stream Reach Alias Editor.  
The *.bak file is an automatic backup file of the *.sam 
file. 

  

rss 

ras 

modelAltInfo.xml 

modelAltInfo.xml.bak 

watProgramOrder.xml 

watProgramOrder.xml.bak 

StreamAlignAliasMgr.sam 

StreamAlignAliasMgr.sam.bak 

shared 

fia 

maps 

ssp 

w2 

hms 

layouts 
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File or Directory Name Contents 
 Sub-folder created by HEC-WAT when a study is 

created.  This folder contains the information created 
from the Schematic Tab.  Contains database files 
(*.dbf, *.dbt, *.mdx) that contain the data when 
creating measures, impact areas, and common 
computation points. 

 Sub-folder created when an HEC-WAT simulation 
(deterministic or FRA) is computed. 

 Sub-folder created by HEC-WAT when either an 
alternative, analysis period, or simulation is created.  
Contains the sub-folders for alternatives, analysis 
periods, and simulations. 

 Sub-folder of the wat folder that contains the 
information about HEC-WAT alternatives that have 
been created for the study. 

 ASCII text file created by HEC-WAT when an 
alternative is created and stored in the alts folder. 
Contains information on an HEC-WAT alternative.  
Information includes: the name, associated stream 
alignment, and other information.  The *.bak file is an 
automatic backup file of the *.walt file. 

 Sub-folder of the wat folder that contains the 
information about HEC-WAT analysis periods that 
have been created for the study. 

 ASCII text file created by HEC-WAT when an analysis 
period is created and stored in the aps folder. Contains 
information on an HEC-WAT analysis period.  
Information includes: the name, start date and time; 
and the end date and time.  The *.bak file is an 
automatic backup file of the *.wap file. 

 Sub-folder of the wat folder that contains the 
information about HEC-WAT simulations that have 
been created for the study. 

 An XML file created by HEC-WAT when a simulation 
is created and stored in the sims folder. Contains 
information on an HEC-WAT simulation.  Information 
includes: the name; name of the associated analysis 
period; and the names of the selected model 
alternatives.  The *.bak file is an automatic backup file 
of the *.simulation file. 

 
4.3 Automatic Backup Files 
 
As elements are added to the study, such as a stream alignment, map layers, and data; the files 
and directories displayed in Figure 4.15 are created, along with automatic backup files.  For 
example, a RussianRiver.sty file and a RussianRiver.sty.bak file are created when the study is 
created.  If a map layer is added for example, the .bak file would not have any reference to the 
added map layer, the backup file reflects the state previous to the current changes.  So every time 
the study is saved, the *.bak file is updated to the previous state. 
 
Automatic backup files are created for all study files, alternative files, analysis period files, 
simulation files, and results files.  DSS files are not automatically backed up.  Since the .bak file 
reflects the previous state of that file, the user can go back to the previous state by eliminating 

study 

runs 

wat 

alts 

AlternativeA.walt 

AlternativeA.walt.bak 

aps 

RR_1986.wap 

RR_1986_wap.bak 

sims 

Without_Project_Conditions-RR_1986.simulation 

Without_Project_Conditions-RR_1986.simulation.bak 
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the .bak extension.  This would allow the information for that previous state to become the 
current state.  The overall effect would be "undoing" all changes the user made before saving the 
HEC-WAT study. 
 
For example, if for some reason the stream.align file became corrupt, the user could retrieve the 
stream alignment from the stream.align.bak file.  The user would need to close HEC-WAT, 
browse to the correct HEC-WAT study directory, delete the stream.align file, and rename the 
stream.align.bak file to stream.align.  Open HEC-WAT, open the correct HEC-WAT study, and 
the stream alignment will be visible again. 
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CHAPTER 5 
 
 

GIS Layers 
 
 
In the construction of a study, the PDT meets to determine what data or models already exist and 
what data is yet to be collected and what models need to be constructed.  The team must decide 
on the study boundaries, identify gage locations, determine sub-basin delineations, damage area 
centers (impact areas), locations of measures (reservoirs, levees, etc.), and points (locations) 
where models could share data (common computation points). From these discussion the PDT 
must decide on the projected coordinate system for the study area and create layers based on the 
projection.  HEC-WAT will set the projection for the HEC-WAT study based on the projection 
defined by the user. 
 
5.1 Concept of Layers 
 
There are several types of layers available in the HEC-WAT software.  The Stream Alignment 
Layer is specifically for the stream alignment.  Map layers (GIS layers) are used in HEC-WAT 
to visualize a system layout and or a flood inundation map. Map layers identify the projection for 
the HEC-WAT study.  HEC-WAT creates primary layers when a stream alignment, schematic, 
alternatives and a simulation are created.  This chapter covers map and primary layers. 
 
5.2 Map Layers 
 
To help visualize a study area, HEC-WAT has the capability to display maps of study features.  
Sub-basin boundaries, watershed boundary, and stream gage locations, are just a few of the 
digital maps of study features that can be displayed in HEC-WAT. 
 
5.2.1 Map Layer Formats 
 
Digital maps (GIS layers) are referred to as map layers in HEC-WAT.  When a map layer is 
included in a watershed, the software displays the map layer as GIS features, points, lines, and 
polygons.  In Version 1.0, the map layers are used for visual purposes only.  In future versions, 
depending on the type of map layer, the program will interact with map layers as data sources.  
The map layer formats that HEC-WAT can display are listed in Table 5.1. 
 
USGS Digital Line Graph (.dlg) 
 
U.S. Geological Survey (USGS) Digital Line Graphs (DLG) are created from two sources using 
manual and automated digitizing methods.  The two sources are aerial photographs or 
cartographic sources.  DLG files are vector representations of the data.  When HEC-WAT 
interacts with a .dlg file a .dlgbin file is automatically generated for use. 
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Table 5.1  Map Layer Formats Supported by HEC-WAT 

 
Description 

Common Filename 
Extension 

USGS digital line graph .dlg 
AutoCAD® DXF .dxf 
Arc Shapefile .shp 
GeoTIFF .tif 
Raster image .img, .jpg, .gif 
USGS DEM .dem 
ArcInfo® DEM .asc 
SMRMP .smrmp 
Ascii NetTin *.net 
Mr SID *.sid 
Virtual Format *.vrt 
Open Street Maps *.osm 

 
AutoCAD® DXF (.dxf) 
 
A Drawing Interchange File (.dxf) is created by a Computer-Aided Design (CAD) package, 
AutoCAD®.  This format is a tagged data representation of an AutoCad® drawing file.  Tagged 
data is where each data element is preceded by a group code.  A group code is an integer 
indicating the type of data element.  The file created is a vector-based graphic.  The DXF format 
is commonly used for data export from other CAD and GIS programs. 
 
Arc Shapefile (.shp) 
 
Shapefiles are the native data structure for the ArcGIS® program.  Shapefiles store non-
topological geometry and attribute information for the spatial features of a dataset.  Usually there 
are four files associated with a shapefile:  *.dbf, *.shp, *.prj, and *.shx.  The .shp file contains the 
shapes (point, polylines, or polygons) that are displayed in the layer.  Each shape has a record in 
the .dbf file containing descriptive data called "attributes."  The .prj file contains the projection 
information for the shapefile.  The .shx file contains an index that links each shape to its record in 
the .dbf file.  For more information on shapefiles, see the ESRI Shapefile Technical Description 
available here: http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf. 
 
GeoTIFF (.tif) 
 
A metadata standard which allows geo-referencing information to be embedded into a TIF 
(Tagged Image File Format) file. The added metadata could be map projection datums, 
coordinate systems, and any other information that will establish spatial references.  A TIF file 
stores raster graphic images and data within a single file. 
 
 
 

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf
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Raster Image 
 
The raster image formats supported by HEC-WAT are JPEG format (*.jpg) and Graphics 
Interchange Format (*.gif).  To access these file types, an *.img (ASCII text) file must be created 
by the user outside of HEC-WAT.  The file needs to contain the information shown in Figure 
5.1, and this information needs to match the easting and northing parameters stated in the Map 
Default Properties for StudyName dialog box (Section 5.2.5). 
 

 
Figure 5.1  Raster Image File 
 
USGS DEM (.dem) 
 
USGS publishes the file format USGS DEM (as of 2006 USGS no longer directly distributes 
elevation data in the DEM format).  A raster file format, .dem files usually contain terrain 
elevations, but the file format can be used for representing any surface.  The format, published 
by the USGS, allows internal documentation of coordinate system, date of publication, etc.  
These values are referenced horizontally, either to a Universal Transverse Mecator (UTM) 
projection or to a geographic coordinate system. 
 
ArcInfo® DEM (.asc) 
 
An ArcInfo® DEM file is an ASCII file format representation of a grid generated by ArcInfo®.  
The file consists of keywords followed by values defining the number of columns, number of 
rows, lower left corner, cell size, no data value, and each cell value. 
 
SMRMP (.smrmp) 
 
The Segmented Multi-Resolution Multi-Parameter (SMRMP) file was created to incorporate 
gridded data (namely, digital terrain grids, inundation depth grids, and arrival time grids) more 
efficiently in HEC-FIA. When users add terrain and inundation data, the user is prompted to 
convert to SMRMP format. The conversion is not required, but is recommended for higher 
efficiency.  The SMRMP file type is not recommended, and is only being maintained for existing 
HEC-WAT studies which have used the SMRMP format. A conversion tool to export to any 
another file format is not available. 
 

  
Image West=2051443. 
Image North=355443. 
Image East=2054925.6 
Image South=351947.4 
  
   
Image URL = path and filename of raster image 
(i.e., maps/lh_2m.gif) 

These are image boundaries 
that are determined by the user 
and usually figured out by using 
a program like ArcInfo®.  
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ASCII NetTin (.net) 
 
An ASCII NetTin is an ASCII file format used to represent a triangulated irregular network 
(TIN).  TIN data are stored in a simple format that defines the nodes, edges, and triangles 
contained in the TIN.  This format is common for transferring TIN data between software. 
 
LizardTech® MrSID® (.sid) 
 
The MrSID® (multi-resolution seamless image database) is a proprietary geo-referenced image 
file format developed by LizardTech® for use with Geographic Information Systems (GIS). This 
format compresses large raster image files like aerial photographs or satellite imagery for easier 
viewing.  Some MrSID images contain geo-referencing and positioning information and can be 
placed in the watershed. 
 
Virtual Format (.vrt) 
 
The .vrt format is a format driver for GDAL (Geospatial Data Abstraction Library) and allows 
for a virtual GDAL dataset to be composed of other GDAL datasets.  The primary use of this 
format is to group together a series of grids that should be associated together.  This file format 
allows multiple depth grids for the same event to create a mosaic single grid. Relative file paths 
are saved in an XML format, as well as a histogram describing the frequency of cell values 
across all grids within the vrt. 
 
Open Street Maps (.osm) 
 
An XML file created to store user preferences regarding streaming services.  This file is 
generated by HEC-WAT and is stored in the study's maps folder.  This file should not be edited 
by the user. 
 
5.2.2 Add Map Layers 
 
When a map layer is added to a study, HEC-WAT reads the coordinates of points, lines, and 
polygons on the map layer and resets the geographic extents of the study to the smallest rectangle 
that will contain all objects in a map layer.  A map projection uses mathematical models that 
transform spherical coordinates (latitude, longitude) to planar coordinates in a map projection 
(X- and Y-coordinates).  Data is projected onto a flat plane (surface) that can be converted 
without stretching, and features will be referenced by a planar coordinate system.  If a map layer 
is not in the same projection as the study, HEC-WAT can "on-the-fly" re-project the map layer in 
question. 
 
To add map layers: 
 
 1. From the Maps menu, click Add Map Layers, the Select Map to Add browser will 

open (Figure 5.2). 
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Figure 5.2  Select Map to Add Browser 

 
 2. The browser defaults to the study directory, but map layers can be retrieved from 

anywhere on a computer.  From the study directory is a maps directory, which is the 
location where it is recommended that users copy various map layers.  Using the project's 
maps directory ensures the map layers are maintained within the project directory when 
the project is opened on other computers. 

 
 3. To copy the selected map layer to the study directory, click Create Copy on the Select 

Map to Add browser (Figure 5.2). 
 
 4. From the Select Map to Add browser, select the desired map layer format from the Files 

of type list, locate the file of the desired map layer format, select filename, and click 
Open.  The Select Map to Add browser will close (Figure 5.2) and the map layer will 
appear in the active map window.  Also, if the user has chosen to have HEC-WAT copy 
the map layer to the study directory, under the maps folder, the map layer file (s) will 
appear. 

 
 5. From the HEC-WAT main window (Figure 5.3), select the Maps tab, there will now be 

an entry for the added map layers. 
 
5.2.3 Remove Map Layers 
 
To remove map layers: 
 
 1. From the Maps menu, click Remove Map Layers. 
 
 2. The Remove Map Layers from Study dialog box will open (Figure 5.4). 
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Figure 5.3  HEC-WAT Main Window – Maps Tab 

 

 
Figure 5.4  Remove Map Layers from Study Dialog Box 

 
 3. From the Existing box there is list of map layers, select a map layer by clicking on the 

name. 
 
 4. In the Remove box, the name of the selected map layer will appear in the Name box. 
 
 5. Click Remove, a warning message will appear, asking the user if you really want to 

remove the map layer from the study, click Yes. 
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 6. The warning message will close, the Remove Map Layers from Study dialog box 
(Figure 5.4) will close, and the map layer will be eliminated from the active map window. 

 
5.2.4 Shortcut Menu for Map Layers 
 
The shortcut menu (Figure 5.5) for map layers is accessed by right-clicking on any map layer 
that is listed in the Maps tab (Figure 5.3).  This list of map layers refers to the currently active 
map window that is open in the Desktop Pane (Figure 5.3).  The shortcut menu provides several 
ways to manipulate map layers.  This ability to manipulate depends on the type of map layer 
(Figure 5.5), since HEC-WAT does not provide the same capabilities to all recognized map layer 
formats (Table 5.1).  The available commands are: 
 

 
Figure 5.5  Map Layer Shortcut Menu 

 
 Expand – expands the selected map layer's tree; the tree provides information on the 

available elements of a map layer, and details provided are based on what HEC-WAT 
recognizes for the individual map layer format. 

 
 Collapse – collapses the selected map layer's tree; the tree provides information on the 

available elements of a map layer, and details provided are based on what HEC-WAT 
recognizes for the individual map layer format. 

 
 Move to Top – moves the selected map layer to the top of the tree 
 
 Move Up – moves the selected map layer up the tree one position 
 
 Move Down – moves the selected map layer down the tree one position 
 
 Move to Bottom – moves the active map layer to the bottom of the tree 
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 Show Legend – displays the legend for the active map layer in the tree structure. 
 
 Change Label – allows the user to change the label of the map layer in the Maps tab.  This 

does not change the filename of the map layer. 
 
 Properties – displays the properties of the selected map layer.  See Appendix D for further 

details on the available map layer editors. 
 
 Set Scale for Zoom-in – set the zoom-in visualization scale for the selected map layer 
 
 Set Scale for Zoom-out – set the zoom-out visualization scale for the selected map layer 
 
 Remove Scale Factors – disable or clear all scale settings for the selected map layer 
 
 Copy To – allows the user to make a copy of the Internet Map layer. A Save browser will 

open (Figure 5.6), browse to the location on the computer where the map layer is to be 
copied.  Click Save, the Save browser will close and the file (*.osm) that contains the 
Internet Map layer is saved. 

 

 
Figure 5.6  Save Browser 

 
 Attributes Table – if the selected map layer is a shapefile, click Attributes Table, the 

Attributes Table dialog box will open (Figure 5.7).  Each shapefile contains a separate file 
that provides information on the attributes of that shape file.  The Attributes Table dialog 
box provides the user with the attributes of the selected map layer (shapefile). 

 
5.2.5 Geographic Reference for Map Layers 
 
Map projections have been developed because the true image of places on earth would have to be 
a three-dimensional solid (spherical globes).  The sets of mathematical models that transform 
spherical coordinates (latitude, longitude) to planar coordinates are contained within a map  
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Figure 5.7  Attributes Table Dialog Box 

 
projection (X- and Y-coordinates).  Data is projected onto a flat plane (surface) that can be 
converted without stretching, and features will be referenced by a planar coordinate system.  The 
x-coordinate is referred to as "easting" and the y-coordinate is referred to as "northing".  The user 
can select the extent of this grid, the dimensions of the grid's cells, the units of measurement of 
the grid, and even the location of the grid's origin.  Because of this flexibility, a user can specify 
and use virtually any grid coordinates convenient for water resources studies.  To do so: 
 
 1. From the Maps menu, click Default Map Properties, the Map Default Properties for 

StudyName dialog box will open (Figure 5.8).  By default, the Map Extents tab is 
selected. 

 

 
Figure 5.8  Map Default Properties for StudyName Dialog Box 
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 2. The information in the Map Extents tab includes: 
 
 ● Coordinate System.  This box identifies the established coordinate system for a 

study.  To view the coordinate system, click View, and the Map Coordinate 
Information dialog box (Figure 5.9) will open.   

 
 ● Extents – Easting Minimum, Maximum, Northing Minimum, and Maximum.  

These values (Figure 5.8) indicate the location of the left, right, bottom and top 
borders (respectively) of the grid in the map window. 

 
 ● Grow to Map Extents.  When selected, HEC-WAT automatically sets the 

geographic extents to define the smallest rectangle that encompasses all the objects in 
the study. 

 
Figure 5.9  Map Coordinate Information Dialog Box 

 
 ● Set Map Extents to Display.  This will set the limits of the map window.  If the user 

zooms in on an area, and clicks Set Map Extents to Display (Figure 5.8), the Map 
Default Properties for StudyName dialog box (Figure 5.8) extents will change to the 
zoomed area. 

 
Note that the geographic extents of map layers must be selected carefully to ensure that the entire 
study is included.  Further, the extents specified and the coordinate system used must be 
consistent with the projection of the study. 
 
5.2.6 Set Visualization Scales - Map Layer 
 
The easy way to set the visualization scale for map layers is outlined in the following steps: 
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 1. From a map window, the user can zoom-in to the point at which a map layer becomes 
visible. 

 
 2. From the Maps tab, in the Content Pane, right-click on the map layer.  From the 

shortcut menu, click Set Scale for Zoom-in, the visualization scale is set automatically 
for that map layer. 

 
 3. From the map window zoom-out, the selected map layer no longer displays.  Inversely, if 

the user wants the map layer to become visible as the user zooms-out, from the shortcut 
menu click Set Scale for Zoom-out. 

 
 4. Visualization scale settings can be cleared or disabled for a map layer.  From the shortcut 

menu, click Remove Scale Factors, the current visualization scale for that particular map 
layer is cleared. 

 
5.3 Primary Layers 
 
HEC-WAT creates primary layers when a user creates a stream alignment, schematics, 
alternatives, and simulations.  These primary layers appear in the Maps tab.  Depending on 
which type of map window that is open, the user will be able to access different primary layers. 
 
5.3.1 Stream Alignment Layer 
 
The Stream Alignment Layer contains the stream alignment that was imported or digitized and 
is visible on the active map window.  Access for the Stream Alignment Layer is from the Maps 
tab, and is available from all map window types.  This layer has sub-layers for each stream 
alignment element, and can be accessed by expanding the tree for the Stream Alignment Layer 
(Figure 5.10).  To expand the tree, click the plus sign; to collapse the tree, click the minus sign. 
 

 
Figure 5.10  Maps Tab - Stream Alignment Layer 
 
When the tree is expanded, different sub-layers (Figure 5.10) for the stream alignment layer are 
visible.  There are three – Stream Junctions, Streams, and Stream Nodes.  A stream junction 
is where two streams connect, and is represented by a bright green circle on the stream 
alignment.  A stream node is a location (a dark green circle) on a stream that provides stream 
stationing information.  By default, HEC-WAT creates two automatically, and a user can add 
stream nodes to a stream.  A stream in a stream alignment is a multi-segmented line with  
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beginning and ending stream nodes.  If the user does not want to see the stream junctions for the 
entire stream alignment, clear Stream Junctions, and the stream junctions no longer are visible 
in the active map window.  To view the stream junctions, click Stream Junctions.  This 
procedure applies to all of the sub-layers.   
 
Shortcut Menu 
 
The shortcut menu (Figure 5.11) for the Stream Alignment Layer is accessed by right-clicking 
on the stream alignment layer in the Maps tab (Figure 5.10).  The shortcut menu provides 
several ways to manipulate the Stream Alignment Layer.  The available commands are: 
 

 
Figure 5.11  Stream Alignment Layer – Shortcut Menu 
 
 Expand – expands the Stream Alignment Layer's tree; the tree provides information on 

the available elements of the stream alignment. 
 
 Collapse – collapses the Stream Alignment Layer's tree; the tree provides information on 

the available elements of the stream alignment. 
 
 Move to Top – moves the Stream Alignment Layer to the top of the tree 
 
 Move Up – moves the Stream Alignment Layer up the tree one position 
 
 Move Down – moves the Stream Alignment Layer down the tree one position 
 
 Move to Bottom – moves the Stream Alignment Layer to the bottom of the tree 
 
 Properties – opens the Stream Alignment Properties dialog box (Figure 5.12) which 

allows the user to edit properties of the elements that are part of the Stream Alignment 
Layer. 
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Figure 5.12  Stream Alignment Properties Dialog Box 

 
 Import – allows the user to import a stream alignment from a shapefile that has already 

been added to the project. From the Import Stream Alignment dialog box (Figure 5.13), 
the user will select a shapefile (polyline) and then import that shapefile, creating a stream 
alignment. 

 
 Export – allows the user to export the stream alignment to a shapefile. A Save browser 

will open (Figure 5.6), browse to the location on the computer where the shapefile is to be 
copied.  Click Save, the Save browser will close and a shapefile of the stream alignment 
will be saved. 

 
Stream Alignment Properties 
 
For the Stream Alignment Layer, the user can configure the appearance of the streams and their 
labels, configure the appearance of the stream junctions and stream nodes, and set the 
visualization scaling for the Stream Alignment Layer.  To configure these properties, from the 
Maps tab, right-click on Stream Alignment.  From the shortcut menu (Figure 5.11), click 
Properties, and the Stream Alignment Properties dialog box will open (Figure 5.12). 
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Figure 5.13  Import Stream Alignment Dialog Box 

 
Streams 
 
To change the appearance of all streams in the map window: 
 1. The user can set the width of the lines that represent the streams in the stream alignment 

from the Stream Alignment Properties dialog box (Figure 5.12) from the Stream 
Width list (Figure 5.14). 

 

 
Figure 5.14  Stream Alignment Properties - Streams 

 
 2. The color of the lines that represent the streams in the stream alignment can be changed 

from the Stream Color list (Figure 5.14).  The default color is orange, there are several 
colors to choose from, plus the user has the ability to create colors.  From the Stream 
Color list, click Custom, the Choose A Color dialog box (Figure 5.15) will open.  See 
Appendix E for further details on the color chooser. 
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Figure 5.15  Choose A Color Dialog Box 

 
 3. Either changing the width or color of the streams, can be previewed in the example to the 

right of the Edit Properties box (Figure 5.16).  For the changes to appear in the map 
window, click Apply (Figure 5.12), and the map window will update. 

 

 
Figure 5.16  Preview Changes 

 
 4. By default, the labels for the streams appear in the active map window.  If the user does 

not want the labels displayed, clear Show Stream Name (Figure 5.12); click Apply, 
stream labels no longer display in the map window. 

 
 5. To change the font of the stream labels, click Choose Font (Figure 5.12), next to Show 

Stream Name.  A Font Chooser opens (Figure 5.17), select the font type from the Type 
list, and select a size using the Size slider.  Click OK, the Font Chooser closes, from the 
Stream Alignment Properties dialog box (Figure 5.12), click Apply, the stream labels 
display in the font and size chosen. 

 

 
Figure 5.17  Font Chooser 
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Tic marks appear on a stream representing the stream stationing of the stream.  There are two 
types of tic marks – minor and major.  To change the appearance of tic marks in the stream 
alignment: 
 
 1. By default, tic marks display on the stream alignment.  If the user does not want tic marks 

to display, clear Draw Station Tics (Figure 5.18).  Click Apply (Figure 5.12), tic marks 
no longer display in the active map window. 

 

 
Figure 5.18  Stream Alignment Properties - Tic Marks 

 
 2. From the Tic Length list, the user can set the length of the minor tic marks.  To change 

the length of the major tic marks, from the Major Tic Length list (Figure 5.18), select 
the length of the major tic marks.  For the changes to appear in the active map window, 
from the Stream Alignment Properties dialog box (Figure 5.12) click Apply, and the 
map window will update. 

 
 3. By default, the labels for tic marks appear in the active map window.  If the user does not 

want the labels to display, clear Draw Tic Labels (Figure 5.18).  To change the font of 
the tic mark labels, click Choose Font, a Font Chooser opens (Figure 5.17), select the 
font type from the Type list, and select a size using the Size slider.  Click OK, the Font 
Chooser closes, from the Stream Alignment Properties dialog box (Figure 5.12), click 
Apply.  Now all of the tic mark labels will appear in the font and size chosen. 

 
Stream Nodes 
 
To change the appearance of all stream nodes in the map window: 
 
 1. By default stream nodes display, if the user does not want to display stream nodes clear 

Draw Stream Nodes (Figure 5.19), from the Stream Alignment Properties dialog box 
(Figure 5.12) click Apply, the stream nodes no longer display in the active map window. 

 

 
Figure 5.19  Stream Alignment Properties - Stream Nodes 

 
 2. The user can select the color of the stream nodes in the stream alignment from the Node 

Color list (Figure 5.19).  The default color is green, there are several colors to choose 
from, plus the user has the ability to create colors.  From the Node Color list, click 
Custom, the Choose A Color dialog box (Figure 5.15) will open.  Appendix E provides 
further details on the color chooser. 
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 3. The user can select the color of the outline of stream nodes in the stream alignment from 

the Node Outline Color list (Figure 5.19).  The default color is dark green, there are 
several colors to choose from, plus the user has the ability to create colors.  From the 
Node Outline Color list, click Custom, the Choose A Color dialog box (Figure 5.15) 
will open.  Appendix E provides further details on the color chooser. 

 
 4. The user can set the width of the stream nodes in the stream alignment from the Node 

Width list (Figure 5.18). 
 
Stream Junctions 
 
To change the appearance of all stream junctions in the active map window: 
 
 1. By default the stream junctions display, if the user does not want to display the stream 

junctions clear Draw Junctions (Figure 5.20), from the Stream Alignment Properties 
dialog box (Figure 5. 12) click Apply, stream junctions no longer display in the active 
map window. 

 

 
Figure 5.20  Stream Alignment Properties - Stream Junctions 

 
 2. The user can select the color of the stream junctions in the stream alignment from the 

Junction Color list (Figure 5.20).  The default color is darkgreen, there are several 
colors to choose from, plus the user has the ability to create colors.  From the Junction 
Color list, click Custom, the Choose A Color dialog box (see Figure 5.15) will open.  
Appendix E provides further details on the color chooser. 

 
 3. The user can set the width of the stream junctions in the stream alignment from the 

Junction Width list (Figure 5.20). 
 
Scale 
 
Visualization scale can be set for the Stream Alignment Layer: 
 
 1. To set the visualization scale for the stream alignment to a default, from the Stream 

Alignment Properties dialog box (Figure 5.12), from the Scale menu, click Set to 
Defaults.  The visualization scale is set automatically. 

 
 2. To enter a scale factor, from the Scale menu, click New.  The Create New Scale dialog 

box opens (Figure 5.21), in the Scale box, enter values for the scale factor. 
 
 3. Click OK, the Create New Scale dialog box closes (Figure 5.21), and the visualization 

scale is set for the stream alignment. 
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Figure 5.21  Create New Scale Dialog Box 

 
5.3.2 Simulation Layer 
 
When a simulation map window is open, the Simulation Layer for that map window is 
available.  In Figure 5.22, the Simulation Layer is Without Project Conditions-RR_Feb1986, 
which is the active simulation.  When the tree expands, the different sub-layers that represent 
each model in the simulation is displayed.  Therefore, if the user did not want to display the 
impact areas, clear FIA:GridsAndXSecsAlternative (Figure 5.22).  The impact areas will no 
longer be visible in the simulation map window.  To view the impact areas, click 
FIA:GridsAndXSecsAlternative.  This procedure applies to all of the sub-layers of the simulation 
layer. 
 

 
Figure 5.22  Simulation Layer – Shortcut Menu 
 
Shortcut Menu 
 
The shortcut menu (Figure 5.22) for the Simulation Layer is accessed by right-clicking on the 
simulation layer (i.e., Without Project Conditions-RR_Feb1986) in the Maps Tab.  The shortcut 
menu provides several ways to manipulate the Simulation Layer.  The available commands are: 
 
 Expand – expands the Simulation Layer's tree; the tree provides information on the 

available elements of the simulation. 
 
 Collapse – collapses the Simulation Layer's tree; the tree provides information on the 

available elements of the simulation. 
 
 Move to Top – moves the Simulation Layer to the top of the tree 
 
 Move Up – moves the Simulation Layer up the tree one position 
 
 Move Down – moves the Simulation down the tree one position 
 
 Move to Bottom – the Simulation to the bottom of the tree 
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5.3.3 Schematic Layer 
 
When a schematic map window is open, the Schematic Layer for that map window is available.  
In Figure 5.23, the Schematic Layer is Without Project Conditions.  The Schematic Layer 
contains the graphical representations of the measures, common computation points, and impact  
 

 
Figure 5.23  Schematic Layer - Shortcut Menu 
 
areas.  When the tree expands, the different sub-layers that represent each element are displayed.  
Therefore, if the user did not want to the impact areas displayed in the schematic map window, 
clear Impact Areas.  The impact areas will no longer display in the schematic map window.  To 
view the impact areas, click Impact Areas.  This procedure applies to all of the sub-layers of the 
schematic layer. 
 
Shortcut Menu 
 
The shortcut menu (Figure 5.23) for the Schematic Layer is accessed by right-clicking on the 
schematic layer (i.e., Without Project Conditions) in the Maps Tab.  The shortcut menu provides 
several ways to manipulate the Schematic Layer.  The available commands are: 
 
 Expand – expands the Schematic Layer's tree; the tree provides information on the 

available elements of the schematic. 
 
 Collapse – collapses the Schematic Layer's tree; the tree provides information on the 

available elements of the schematic. 
 
 Move to Top – moves the Schematic Layer to the top of the tree 
 
 Move Up – moves the Schematic Layer up the tree one position 
 
 Move Down – moves the Schematic Layer down the tree one position 
 
 Move to Bottom – the Schematic Layer to the bottom of the tree 
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 Properties – opens the Drawing Properties Editor (Figure 5.24) which allows the user to 
edit properties of the elements that are part of the Schematic Layer. 

 
 Export Schematic – opens the Export Schematic Layers dialog box (Figure 5.25) which 

allows the user to export the selected elements for the active Schematic Layer to 
shapefiles. 

 

 
Figure 5.24  Drawing Properties Editor 

 

 
Figure 5.25  Export Schematic Layers Dialog Box 

 
Schematic Properties 
 
For the Schematic Layer, the user can configure the appearance of the measures, common 
computation points, and impact areas.  To configure: 
 
 1. From the Maps tab, right-click on a Schematic Layer.  From the shortcut menu, click 

Properties, the Drawing Properties Editor will open (Figure 5.24).  The Drawing 
Properties Editor has six tabs, which represent the elements available in the study. 
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 2. Depending on the element (i.e., reservoirs, levees, etc.), the user can change the color of 
the element, the size of the element, whether the element is drawn or not, whether the 
label of the element is drawn or not, and what font and size of font the label of the 
element is displayed in. 

 
 3. For example, from the Reservoir tab (Figure 5.24) the user can set the width and colors 

of the different elements that make up a reservoir, whether to draw the reservoir polygon 
(triangle), whether to draw the reservoir label, and set the font for the reservoir label.  
The Triangle Fill Color, Triangle Outline Color, and Draw Reservoir Triangle affect 
the polygon (triangle) of a reservoir.  The Storage Reach Fill Color, Storage Reach 
Outline Color, and Storage Reach Width affect the storage reach of a reservoir.  The 
Dam Fill Color and the Dam Width affect the dam of a reservoir. 

 
 4. By default, the labels for the reservoirs appear in the display area.  If the user does not 

want to display the labels, clear Draw Reservoir Name; click Apply (Figure 5.24), and 
the reservoir labels no longer appear in the display area.  To change the font of the 
reservoir labels, click Font.  A Font Chooser opens (Figure 5.17), select the font type 
from the Type list, and either select a size from the Size slider or enter a size.  Click OK, 
the Font Chooser closes, from the Drawing Properties Editor (Figure 5.24), click 
Apply.  Now all of the reservoir labels will display in the font and size chosen.  The other 
elements in the Drawing Properties Editor have similar properties. 

 
5.4 Layer Visualization Scaling 
 
Layers may be set to become visible or invisible as users zoom-in or zoom-out on the active map 
window.  Generally, this capability allows the user to display finer levels of detail as users zoom-
in on regions in the map window and avoid clutter when displaying the full area.  This might 
include detailed map layers to become visible, and raster or other images to appear that are not as 
distinguishable at a courser zoom level.  
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CHAPTER 6 
 
 

Building the Base Schematic 
 
 
6.1 Concepts 
 
Once a study has been created and background maps have been collected, the next step is the 
development of the common schematic.  A schematic is a physical representation of a stream 
alignment, and the flood damage reduction and environmental measures that will be modeled.  
The schematic also provides a common starting point for construction of compatible model data 
sets.  A common schematic assures the naming convention, measure identification and location 
for the study is consistent throughout the modeling disciplines.  The individual models can be 
edited and those individual model results can be viewed from HEC-WAT by selecting the 
elements found on the common schematic. 
 
The common schematic will provide geo-referencing, stream referencing (stream alignment), 
common physical features (measures), data exchange locations (common computation points) 
and a set of features present for a particular modeling scenario (schematics). 
 
6.2 Elements of a Schematic 
 
The following sections describe in general terms the main elements of a schematic and the tools 
provided by HEC-WAT to create schematics.  Also, further details on each element are provided 
in the appendices of this User's Manual 
 
6.2.1 Stream Alignment 
 
The backbone of any schematic is the stream alignment (Figure 6.1), and is the starting point in 
creating a schematic.  A stream alignment is a one-dimensional river coordinate system, which 
defines the flow network.  Also, from the stream centerline, stationing will be provided relative 
to its global location and specific to the study.  See Section 6.5.1 and Appendix F for further 
details on stream alignments. 
 
6.2.2 Common Computation Points (CCP) 
 
Common computation points (Figure 6.2) are locations where one model transfers model 
results to another model, where results are needed for model development or alternative analysis, 
or where input boundary conditions are to be defined.  The common computation points need to 
be consistent for all models and should be placed on the stream alignment based on knowledge 
of possible study alternatives.  The entire study team should be involved in the definition of the 
common computation points.  For further details on common computation points see Section 
6.5.2 and Appendix H. 
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Figure 6.1  Stream Alignment 
 
 

 
Figure 6.2  Common Computation Points (CCPs) 
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6.2.3 Measures 
 
Measures (Figure 6.3) for HEC-WAT include structural/non-structural measures (flood damage 
reduction), and/or ecosystem measures.  Structural measures are physical modifications 
designed to reduce the frequency of damaging levels of flood inundation, and include dams with 
reservoirs, levees, channelization measures, walls, diversion channels, pumps, bridge 
modifications, and ice-control structures.  Non-structural measures are activities that reduce 
flood damage without significantly altering the nature or extent of flooding (e.g., flood proofing, 
relocation of structures, raising structures).  Ecosystem restoration measures are physical 
modifications or other actions that improve the value and function of an ecosystem (e.g., channel 
restoration, removal of drainage structures or levees).  There are various measures that can be 
defined for HEC-WAT, but this User's Manual will only focus on reservoirs (Section 6.5.3) and 
levees (Appendix G).  Other measures available in HEC-WAT are diversions, channel 
improvements, off-channel storage, and other projects.  Measures are not required for an HEC-
WAT study. 
 

 
Figure 6.3  Measures 
 
6.2.4 Impact Areas 
 
An impact area (Figure 6.4) is any distinct portion of a study that is affected by rising or falling 
stage in a stream, river, lake, or reservoir.  The boundaries of an impact area are defined by a 
closed polygon, and the user can characterize the effects of rising or falling stage by describing 
the property, project, and/or population at risk in the area bounded by the polygon.  Impact areas 
are an optional element, and are only required when a user wants to compute impacts at damage 
area centers in the study area, and an HEC-FIA model is part of the HEC-WAT modeling effort.  
For further details on impact areas see Section 6.5.4 and Appendix I. 



Chapter 6 – Building the Base Schematic HEC-WAT User's Manual 

6-4 

 
Figure 6.4  Impact Areas 
 
6.3 Study Element Tools 
 
There are tools available to view and create the study elements from the schematic map window.  
These tools are as follows: 
 
 Pointer/Selector Tool – use this tool to edit, rename, and delete elements (does not 

include stream alignment elements).  Commands for editing existing study elements are 
available by selecting the Pointer/Selector tool, and right-clicking on a study element. 

 
 Zoom Tool - use this tool to zoom in and out of map windows.  To zoom in, hold the left 

mouse button down and outline the area that will be enlarged.  To zoom out, click the right 
mouse button (right-click).  The zoom out is done by a factor of two and positions the 
clicked location at the center of the map window. 

 
 Pan Tool – use this tool to move the map window while zoomed in. 
 
 Impact Area Tool - use this tool to create, delete, rename, and edit impact areas.  See 

Appendix I for further details on impact areas. 
 
 Computation Point Tool - use this tool to create, delete, rename, and edit common 

computation points.  Common computation points are locations where one model transfers 
data to another model, where results are needed for model development, or where input 
boundary conditions are to be defined.  Appendix H provides further details on common 
computation points. 
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 Stream Alignment Tool - use this tool to create, delete, and edit streams that make up the 

stream alignment (Appendix F). 
 
 Stream Node Tool - use this tool to create, delete, and edit stream nodes and stream 

junctions (Appendix F) on the stream alignment. 
 
6.4 Measure Tools 
 
 Reservoir Tool - use this tool to create, delete, rename, and edit reservoirs.  Appendix G 

provides further details on reservoirs. 
 
 Levee Tool - use this tool to create, delete, rename, and edit levees.  Appendix G provides 

further details on levees. 
 
 Diversion Tool - use this tool to create, delete, rename, and edit diversions.  A diversion 

has to be started on the stream alignment.  To create a diversion, select the Diversion tool, 
hold down the CTRL key, and click on the stream alignment.  Each click creates a vertex 
point along the diversion.  When reaching the end point of the diversion, release the 
CTRL key, and click.  The user will be asked to name the diversion.  After naming the 
diversion, the diversion will appear on the active map window.  Commands available for 
editing an existing diversion are available by selecting the Diversion tool, and right-
clicking on a diversion. 

 
 Channel Modification Tool - use this tool to create, delete, rename, and edit channel 

modifications.  A channel modification has to be created on the stream alignment.  To 
create a channel modification, select the Channel Modification tool, hold down the 
CTRL key, click on the upstream end of the channel modification, release the CTRL key, 
and drag along the stream alignment to the downstream end of the channel modification 
and click.  The user will be asked to name the channel modification.  After naming the 
channel modification, the channel modification will appear on the active map window.  
Commands available for editing an existing channel modification are available by 
selecting the Channel Modification tool, and right-clicking on a channel modification. 

 
 Off-Channel Storage Area Tool - use this tool to create, delete, rename, and edit off-

channel storage areas.  To create an off-channel storage area, select the Off-Channel 
Storage Area tool and hold down the CTRL key while clicking the mouse button.  Each 
click creates a vertex point, which is the boundary of the polygon.  When reaching the end 
point, release the CTRL key and click.  The user will be asked to name the off-channel 
storage area.  After naming the off-channel storage area, the off-channel storage area will 
appear on the active map window.  Commands available for editing an existing off-
channel storage area are available by selecting the Off-Channel Storage Area tool, and 
right-clicking on an off-channel storage area. 

 
 Other Project Tool - use this tool to create, delete, rename, and edit other projects.  This 

tool enables the placement of elements that represent "other" projects, such as pump 
stations.  To create an "other" project, select the Other Project tool and hold down the  



Chapter 6 – Building the Base Schematic HEC-WAT User's Manual 

6-6 

 CTRL key and click.  The user will be asked to name the "other" project.  After naming 
the "other" project, the "other" project will appear on the active map window.  Commands 
available for editing an existing "other" projects are available by selecting the Other 
Project tool, and right-clicking on an "other" project. 

 
6.5 Create the Default Schematic 
 
When a new study is created in HEC-WAT, a default (base) alternative is created with either an 
HEC-WAT default name (Without Project Conditions) or a user-defined name.  After the 
alternative has been created, the default schematic needs to be defined, this will have the same 
name as the default alternative.  The first step in defining the default schematic is to add the 
basic schematic elements to the schematic - stream alignment, common computation points, 
measures (reservoirs, levees), and impact areas. 
 
The steps to define the default schematic are: 
 
 1. Once a study is created, the default schematic map window will open in the Desktop 

Pane (Chapter 3, Section 3.1). 
 
 2. Add a map layer (Chapter 5) that will guide in creating the stream alignment.  The user 

can either digitize the stream alignment by hand or import a stream alignment using a 
stream shapefile layer that has already been added to the HEC-WAT study.  Section 6.5.1 
provides further details on creating a stream alignment. 

 
 3. After the stream alignment has been defined, common computation points should be 

added (Section 6.5.2) to the default schematic.  Common computation points are 
locations where the models associated with the alternative will hand off data to each 
other, the user can view results, or locations where input boundary conditions are defined. 

 
 3. Now measures that describe the default alternative need to be added to the schematic.  

There are several types of optional measures that can be added, this manual will 
concentrate on reservoirs (Section 6.5.3) and levees (Appendix G). 

 
 5. An optional element to add to the default schematic is impact areas.  Impact areas are 

required if computation of impacts at damage area centers in the study area are required, 
and an HEC-FIA model is part of HEC-WAT modeling alternatives.  Section 6.5.4 
provides further details on defining impact areas. 

 
 6. Once the default schematic is complete, be sure to save the schematic data.  The user can 

now create other alternatives and schematics based on the default schematic. 
 
6.5.1 Create a Stream Alignment 
 
The backbone of any schematic is the stream alignment, and is the starting point in creating a 
schematic.  A stream alignment is a one-dimensional river coordinate system, which defines the 
natural downstream flow network.  Also, from the stream centerline, stationing will be provided 
relative to its global location and specific to the study.  The alignment indicates where 
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confluences and bifurcations occur and provides a sense of distance and scale.  Stream 
alignments are composed of a series of streams, stream nodes, and stream junctions. 
 
To import a stream alignment: 
 
 1. From the HEC-WAT main window, click the Maps tab, from the Map Layers tree, 

right-click on Stream Alignment.  From the shortcut menu, click Import.  The Import 
Stream Alignment dialog box will open (Figure 6.5).  The Shapefile Name list defaults 
to the first line shapefile that HEC-WAT can find in the maps directory of a study; which 
for this example (Figure 6.5) happens to be the shapefile that represents the stream 
alignment for the RussianRiver study - RR_StreamAlignment.shp. 

 

 
Figure 6.5  Import Stream Alignment Dialog Box 

 
 2. From the Database Field Name list (Figure 6.5), the user needs to select the field name 

in the attribute file that contains the names of the streams - Name.  Once a field name is 
selected, the table below the Database Field Name list (Figure 6.5) will populate with 
the streams contained in the shapefile.  If there is an issue with any of the stream 
segments the checkbox in the Import column (Figure 6.11) will not be selected.  This 
means the stream segment is not continuous and will not be imported. 
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 3. Click Import, the Import Stream Alignment dialog box will close (Figure 6.5).  Once 
the import of the stream alignment is completed, a message window will appear letting 
the user know that the stream alignment imported successfully.  In the active Map 
Window the stream alignment appears (orange stream segments; green stream nodes and 
stream junctions). 

 
Sometimes the streams in a shapefile are not in the right flow direction.  Instead, of fixing this 
issue outside of HEC-WAT, and if the user is aware of this issue before an import. From the 
Import Stream Alignment dialog box (Figure 6.5), from the table, make sure the under the 
Reverse Direction column, all of the streams are selected where the flow direction is not correct.  
When, the stream alignment is imported, the flow direction will be corrected automatically.  For 
further information on Reverse Direction see Appendix F. 
 
6.5.2 Add Common Computation Points (CCPs) 
 
Common computation points (CCPs) are locations where one model can transfer data to 
another model, where results are needed for model development or alternative analysis, or where 
input boundary conditions are to be defined.  CCPs need to be consistent for all models and 
should be placed on the stream alignment based on the knowledge of possible study alternatives.  
The entire study team should be involved in the definition of the CCPs. 
 
To import CCPs from a shapefile: 
 
 1. From the HEC-WAT main window, from Maps menu, point to Import, click 

Computation Points.  The Import Computation Points dialog box will open (Figure 
6.6).  The Shapefile Name list defaults to the first point shapefile that HEC-WAT can 
find in the maps directory of a study; which happens to be the shapefile that represents 
the CCPs for the Russian River study - RR_CommonComputationPoints.shp. 

 

 
Figure 6.6  Import Computation Points Dialog Box 
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 2. From the Database Field Name list (Figure 6.6), select the field name in the attribute file 
that contains the names of the CCPs - ID_Name.  Once a field name is selected, the table 
below the Database Field Name list (Figure 6.6) will populate with the CCPs contained 
in the shapefile.  If there is an issue with any of the CCPs, the checkbox in the Import 
column will not be selected.   

 
 3. Click Import, the Import Computation Points dialog box will close (Figure 6.6).  Once 

the import of the CCPs is completed, a message window will appear letting you know 
that the CCPs have been imported successfully.  In the active Map Window the CCPs 
appear as black circles. 

 
A user can also add CCPs to the schematic manually by performing the following steps: 
 
 1. From the Schematic Map Window, find the location where a CCP needs to be added, 

press the Computation Point tool     . 
 
 2. Hold down the CTRL key and click on the stream alignment to place the common 

computation point. 
 
 3. The Name New Computation Point dialog box will open (Figure 6.7).  Enter the new 

Name (required) and Description (optional, but recommended).  Click OK, the Name 
New Computation Point dialog box will close. 

 

 
Figure 6.7  Name New Computation Point Dialog Box 

 
 4. The CCP will now appear in the map window as a black circle.  
 
 5. If a CCP is added at a stream junction, a slightly different Name New Computation 

Point dialog box will open (Figure 6.8).  Enter the new Name (required) and Description 
(optional, but recommended). 

 
 6. From the Select the Placement of the Computation Point list (Figure 6.8), determine 

exactly where the CCP will be placed.  Choices are to have the CCP placed on the stream 
junction, along one of the streams that form the stream junction, or none of the above.  
For example, in Figure 6.8, the CCP will be placed on the stream junction. 
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Figure 6.8  Name new Computation Point Dialog Box at a Stream Junction 

 
 7. Click OK, the Name New Computation Point dialog box (Figure 6.8) will close.  The 

CCP will now appear in the display area as a black circle. 
 
6.5.3 Add a Reservoir 
 
A reservoir is the impoundment created behind dams, or behind navigation locks and dams.  For 
HEC-WAT a reservoir also includes the dam built on a stream to store water for uses such as 
flood risk management, hydroelectric power generation, recreation use, and water supply, etc. 
 
To add a reservoir: 
 
 1. From the Schematic Map Window, find the location where a reservoir needs to be 

added, press the Reservoir tool      . 
 
 2. Hold down the CTRL key and click on the stream alignment to place the upstream end of 

the reservoir.  Release the CTRL key; drag the mouse to the downstream end of the 
reservoir and click. 

 
 3. The Name New Reservoir dialog box will open (Figure 6.9).  Enter a Name (Lake 

Mendocino) and Description (optional, but recommended) for the reservoir.  Click OK, 
the Name New Reservoir dialog box will close. 

 
 4. The reservoir will now appear on the schematic as a cyan triangle (reservoir pool), a blue 

line (storage reach), a gray rectangle (dam), and two CCPs that represent the upstream 
and downstream ends of the reservoir. 
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Figure 6.9  Name New Reservoir Dialog Box 

 
 5. The default representation of the reservoir pool is a triangle; the user can edit this triangle 

if a more detailed representation of the pool is desired.  With the Reservoir tool pressed, 
double-click on the reservoir.  The triangle (Figure 6.10) will now be green with a blue 
outline color.  Also, there are three vertex points (blue), and at the apex of the triangle is 
the reservoir label, which is represented by a yellow circle. 

 

 
Figure 6.10  Reservoir Pool 

 
 6. When a reservoir is created there are two CCPs that are created with default names.  It is 

recommended that the names of the two CCPs be changed.  These two CCPs represent 
the inflow and outflow junctions of the reservoir and should be renamed accordingly. 

 
 7. To change the name of a CCP, press the Computation Point tool     , right-click on one 

of the CCPs.  From the shortcut menu, click Rename Computation Point; the Rename 
Computation Point dialog box will open (Figure 6.11).  In the Name box, enter the new 
name, and in the Description box enter a description (optional, but recommended).  For 
example, in Figure 6.11, the inflow junction for Lake Mendocino has been labeled Lake 
Mendocino Inflow Jct, and the outflow junction should be labeled Lake Mendocino 
Outflow Jct. 
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Figure 6.11  Rename Computation Point Dialog Box 

 
 8. Click OK, a Confirm Rename window will open, asking the user to be sure that the 

CCP is to be renamed. Click Yes, the Rename Computation Point dialog box will close 
(Figure 6.11) and the new name for the CCP will appear in the map window. 

 
6.5.4 Add Impact Areas 
 
An impact area is any distinct portion of a study that is affected by rising or falling stage in a 
stream, river, lake, or reservoir.  Impact areas are an optional element, and are only required 
when the user wants to aggregate impacts at damage area centers in the study area 
 
To import impact areas from a shapefile: 
 
 1. From the HEC-WAT main window, from Maps menu, point to Import, click Impact 

Areas.  The Import Impact Areas dialog box will open (Figure 6.12).  The Shapefile 
Name list figures out whether there are any polygon shapefiles available in the maps 
directory (e.g., RR_ImpactAreas.shp). 

 

 
Figure 6.12  Import Impact Areas Dialog Box 
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 2. From the Database Field Name list (Figure 6.12), the user needs to select the field name 

in the attribute file that contains the names of the impact areas - ID_Name (Figure 6.12).  
Once a field name is selected, the table below the Database Field Name list will populate 
with the impact areas contained in the shapefile.  If there is an issue with any of the impact 
areas the checkbox in the Import column will not be selected. 

 
 3. Click Import, the Import Impact Areas dialog box will close (Figure 6.12).  Once the 

import of the impact areas is completed, a message window will appear letting the user 
know that the impact areas have been imported successfully.  In the active Map Window 
the impact areas appear as green polygons. 

 
6.6 Create Additional Schematics 
 
Section 6.5 described the steps for creating the schematic for the default HEC-WAT alternative 
(i.e., Without Project Conditions).  Additional schematics can be created if the HEC-WAT study 
has other alternatives where something might be different, like adding a new project, or 
removing a project from the study area. There are two ways to create a schematic, one is from 
the Schematic Tab, and the other is when an alternative is created. 
 
To create a schematic from the Schematic tab: 
 
 1. From the Schematic tab, on the Study Pane (Figure 6.13), right-click on the 

Schematics, folder, from the shortcut menu click New.  The Create New Schematics 
dialog box will open (Figure 6.14). 

 

 
Figure 6.13  Creating a New Schematic 

 

 
Figure 6.14  Create New Schematics Dialog Box 

 
 2. In the Name box enter the name (required), and in the Description box, enter a 

description (optional, but recommended). 
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 3. Select a stream alignment that the schematic will be built around.  HEC-WAT allows for 
multiple stream alignments in a study.  From the Stream Alignment list (Figure 6.14) 
select a stream alignment. 

 
 4. Click OK, the Create New Schematics dialog box will close (Figure 6.14).  In the Study 

Pane (Figure 6.13), the Schematics folder will now contain the new schematic. 
 
 5. A map window will open in the Desktop Pane representing the schematic.  Now the user 

needs to review the new schematic to see if any adjustment need to be made to the stream 
alignment; add/edit/delete measures; add/edit/delete CCPs; and, add/edit/delete impact 
areas. 

 
 6. If a map window is open in the Desktop Pane, the Select Map dialog box will open 

(Figure 6.15).  The user can choose whether to open the schematic in the current map 
window or in a new map window, click OK.  The Select Map dialog box (Figure 6.15) 
and the Create New Schematics dialog box (Figure 6.14) will both close, and the map 
window for the new schematic will appear in the Desktop pane.  Now the user needs to 
review the new schematic to see if any adjustment need to be made to the stream 
alignment; add/edit/ delete measures; add/edit/delete CCPs; and, add/edit/delete impact 
areas. 

 

 
Figure 6.15  Select Map Dialog Box 

 
To create a schematic when creating an alternative: 
 
 1. From the Study tab, on the Study Pane (Figure 6.16), right-click on the Alternatives 

folder, from the shortcut menu click New.  The Create New Alternatives dialog box will 
open (Figure 6.17). 

 

 
Figure 6.16  Creating a New Alternative 
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 2. Enter the alternative name in the Name box (required), and an optional (recommended) 
description in the Description box (Figure 6.17). 

 

 
Figure 6.17  Create New Alternatives Dialog Box 

 
 3. Each alternative requires a schematic to provide the layout of the study area measures and 

components.  Select a previously defined schematic, or create a schematic for the 
alternative from the Schematic list (see Step 6). 

 
 4. Click OK, the Create New Schematics dialog box will close (Figure 6.12).  If there is 

not a map window open in the Desktop Pane, the Create New Alternatives dialog box 
will close (Figure 6.17) and a map window will open in the Desktop Pane representing 
the alternative. 

 
 5. If a map window is open in the Desktop Pane (Chapter 3, Section 3.1), the Select Map 

dialog box will open (Figure 6.15).  The user can choose whether to open the alternative 
in the current map window or in a new map window, click OK.  The Select Map dialog 
box (Figure 6.15) and the Create New Alternatives dialog box (Figure 6.17) will both 
close, and the map window for the new alternative will appear in the Desktop Pane. 

 
 6. If a new schematic for the alternative needs to be created, from the Schematic list (Figure 

6.17), click <Create New Schematic>.  Click OK, a No schematic was selected warning 
window will open.  The window is asking the user if a schematic needs to be created, 
click Yes.  The Create New Schematics dialog box will open (Figure 6.14).  A name for 
the schematic is automatically generated based on the name of the alternative.  Review 
Steps 4 and 5. 

 
 7. The schematic name will now appear on the Schematic Tab, under the Schematics 

folder (Figure 6.13).  Now the user needs to review the new schematic to see if any 
adjustment need to be made to the stream alignment; add/edit/delete measures; 
add/edit/delete CCPs; and, add/edit/delete impact areas. 

 
6.7 Existing Schematics 
 
After creating a schematic, the user can view the schematic; edit certain properties of a 
schematic; save the active schematic; create a copy of an existing schematic; delete a schematic 
that is not associated with an alternative; and, view an existing schematic's properties.  All of 



Chapter 6 – Building the Base Schematic HEC-WAT User's Manual 

6-16 

these tasks are accomplished through the schematic shortcut menu (Figure 6.18).  To access the 
schematic shortcut menu, from the Schematic tab, right-click on an existing schematic under the 
Schematics folder, and the schematic shortcut menu will appear. 
 

 
Figure 6.18  Schematic Shortcut Menu 
 
6.7.1 View a Schematic 
 
To view a schematic in a map window: 
 
 1. From the schematics shortcut menu (Figure 6.18) click Display in Map Window. 
 
 2. If there is not a map window open in the Desktop Pane (Chapter 3, Section 3.1), the map 

window for the selected schematic will open in the Desktop Pane.  From the map 
window the user needs to review the new schematic to see if any adjustment needs to be 
made to the stream alignment; add/edit/delete measures; add/edit/delete CCPs; and, 
add/edit/delete impact areas. 

 
 3. If a map window is open in the Desktop Pane (Chapter 3, Section 3.1), the Select Map 

dialog box (Figure 6.15) will open.  Now the user needs to review the new schematic to 
see if any adjustment need to be made to the stream alignment; add/edit/delete measures; 
add/edit/delete CCPs; and, add/edit/delete impact areas., Click OK, the Select Map 
dialog box (Figure 6.15) will close, and the map window for the selected schematic will 
appear in the Desktop Pane. 

 
6.7.2 Edit an Existing Schematic 
 
To edit the description, or to add and remove measures from an existing schematic: 
 
 1. From the schematics shortcut menu (Figure 6.18) click Edit.  The Schematic Editor will 

open (Figure 6.19). 
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Figure 6.19  Schematic Editor 

 
 2. In the Description box the user can edit the description of schematic. 
 
 3. From the Measures box the user can add or remove measures from a schematic by 

selecting the measures.  For example (Figure 6.19), if the user decides for this schematic 
not to include the Lake Sonoma, clear Lake Sonoma.  Lake Sonoma will now be 
removed from the schematic. 

 
 4. From the Schematic Editor (Figure 6.19), there is the ability to edit other schematics by 

using the Navigator Button in the upper right-hand corner of the editor.  Clicking       
places the user at the first schematic, while clicking       places the user at the last 
schematic.  Clicking       or       moves the user back (previous) one schematic and 
forward (next) one schematic, respectively.  The center of the navigator button indicates 
the number of schematics and which schematic the user is presently accessing. 

 
 5. Click OK, the Schematic Editor will close (Figure 6.19), and if the map window 

associated with the schematic is open, the measure will no longer display in the map 
window. 

 
6.7.3 Save a Schematic 
 
To save the active schematic, from the schematic shortcut menu (Figure 6.18), click Save.  Any 
changes that have occurred to the selected schematic will be saved by HEC-WAT. 
 
6.7.4 Make a Copy of an Existing Schematic 
 
To make a copy of an existing schematic: 
 
 1. From the schematics shortcut menu (Figure 6.18), click Save As.  The Save Schematic 

As dialog box will open (Figure 6.20). 
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Figure 6.20  Save Schematic As Dialog Box 

 
 2. The information displayed in the dialog box represents the schematic the user has chosen 

to make a copy of. 
 
 3. In the Name box, enter the name (required) of the new schematic, and in the Description 

box, enter a description (optional, but recommended). 
 
 4. Click OK, the Save Schematic As dialog box (Figure 6.20) will close, and in the Study 

Pane; under the Schematics folder the new schematic name will appear. 
 
6.7.5 Delete a Schematic 
 
A schematic can only be deleted as long as it is not associated with an alternative.  For example, 
in Figure 6.18, the Without Project Conditions schematic is associated with an alternative, so the 
Delete from Study command does not display on the schematic shortcut menu.  To delete a 
schematic not associated with an alternative: 
 
 1. From the Schematic tab, on the Study Pane, from the Schematics folder, right-click on 

a schematic that is not associated with an alternative.  From the Schematics shortcut 
menu (Figure 6.18), click Delete from Study. 

 
 2. A Confirm Manager Delete message window will open, asking the user do you really 

want to delete the selected schematic.  Click Yes, the schematic name will no longer 
appear under the Schematics folder on the Study Pane. 

 
6.7.6 Schematic Properties 
 
The properties of a schematic include the name; description; when the schematic was modified; 
who created the schematic; when the schematic was created; and, the file that contains the 
schematic data.  To view the properties of a schematic, from the schematics shortcut menu 
(Figure 6.18), click Properties.  The Properties for SchematicName dialog box will open 
(Figure 6.21). 
 
6.7.7 Export Schematic Layers 
 
The user can export schematic sub-layers: 
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Figure 6.21  Properties for SchematicName Dialog Box 

 
 1. From the Schematic tab, on the Study Pane, from the Schematics folder, right-click on 

a schematic.  From the Schematics shortcut menu (Figure 6.18), click Export 
Schematic. 

 
 2. The Export Schematic Layers dialog box will open (Figure 6.22). 
 
 3. From the Export column (Figure 6.22) select the individual sub-layers that need to be 

exported to a shapefile.  Double-click in the associated cell for a sub-layer, under the 
Export To column (Figure 6.22).  In that cell (Figure 6.22), either enter the name of the 
directory where to store the shapefile, or click     , and an Export browser (Figure 6.23) 
will open. 

 

 
Figure 6.22  Export Schematic Layers Dialog Box 

 
 4. The browser name will be based on the schematic sub-layer that the user has chosen, for 

example in Figure 6.23, the user has selected to export the common computation point 
sub-layer.  Navigate to the directory where the shapefile will be stored, enter a name in 
the File name box (Figure 6.23), click Save.  The Export browser (Figure 6.23) will 
close. 
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Figure 6.23  Export Browser – Common Computation Points 

 
 5. From the Export Schematic Layers dialog box (Figure 6.22), click OK. The Export 

Schematic Layers dialog box will close (Figure 6.22) and the shapefile (all necessary 
files) will be created in the selected location. 
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CHAPTER 7 
 
 

Create a Basic HEC-WAT Study 
 
 
Now that the user has an understanding about the basic building blocks of what an HEC-WAT 
study requires, the following chapter walks the user through the steps of creating a basic HEC-
WAT study. 
 
7.1 Create an HEC-WAT Study 
 
To create a new study: 
 
 1. From the HEC-WAT main window (Figure 7.1), on the File menu, click New Study. The 

Create New Study dialog box (Figure 7.2) will open. 
 

 
Figure 7.1  HEC-WAT Main Window 

 
 2. In the Study Name box (Figure 7.2), enter a name, and in the Description box, enter a 

description for the new study. 
 
 3. In the Directory box (Figure 7.2), either enter the name of the directory where to store 

the HEC-WAT study, or click     , and an Open browser (Figure 7.3) will open.  Navigate 
to the directory where the HEC-WAT study will be stored, click Open.  The Open 
browser (Figure 7.3) will close. On the Create New Study dialog box (Figure 7.2) in the 
Directory box the location will display. 
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Figure 7.2  Create New Study Dialog Box 

 

 
Figure 7.3  Open Browser 

 
 4. The Unit System (Figure 7.2) for the study defaults to English.  The other choice from 

the list is SI (metric). 
 
 5. Next, the projected coordinate system of the study needs to be set. For this example 

study, the study map layers are in the projected coordinate system, and that information 
will be imported from one of the map layers (i.e., shapefile).  
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 6. From the Create New Study dialog box (Figure 7.2), click Edit (by the Coordinate 
System box), the Map Coordinate Information dialog box will open (Figure 7.4).  The 
dialog box opens with a default coordinate system (Google/Bing Web Mercator). 

 

 
Figure 7.4  Map Coordinate Information Dialog Box – Default Coordinate System 

 
 7. From the Map Coordinate Information dialog box (Figure 7.4), click Load from file 

(lower left corner of dialog box); an Open browser (Figure 7.3) will open.  Browse to the 
location of the map layer (i.e., RR_StreamAlignment.prj) that has the correct projection 
for the study area. Click on that map layer, click Open, now the Map Coordinate 
Information dialog box will contain information about the projected coordinate system 
(Figure 7.5).  Click OK, the Map Coordinate Information dialog box will close (Figure 
7.5).  Now on the Create New Study dialog box the Coordinate System box (Figure 
7.2) contains the name of the projected coordinate system (i.e., USA_Continguous_ 

  Albers_Equal_Area_Conic_USGS_version) for the study. 
 

 
Figure 7.5  Map Coordinate Information Dialog Box  
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 8. When creating the study, the user can add map layers that the PDT has gathered for 
defining the watershed area.  From the Create New Study dialog box (Figure 7.2), click 
Add Map Layers.  The Select Map to Add browser will open (Figure 7.6).  To copy the 
map layers to the study directory area, from the Select Map to Add browser (Figure 7.6), 
select Create Copy.  Browse to where the map layers are located, select the appropriate 
map layers, click Open, the Select Map to Add browser will close (Figure 7.6).  The 
Create New Study dialog box (Figure 7.7) appears. 

 

 
Figure 7.6  Select Map to Add Browser 

 

 
Figure 7.7 Create New Study Dialog Box - Completed 

 
 9. HEC-WAT creates a default alternative - Without Project Conditions.  If the user wants 

the default alternative to have a different name, several choices are available, including 
Other which allows the user to name the default alternative.   
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 10. Click OK, the Create New Study dialog box will close (Figure 7.7).  The HEC-WAT 
main window will now have the name of the study on the title bar (Figure 7.8).  A 
Schematic Map Window opens, which contains the map layers that were added to the 
study. 

 

 
Figure 7.8  HEC-WAT Main Window – New Study Created 

 
7.2 Build the Without Project Conditions Schematic 
 
HEC-WAT by default will create a default alternative Without Project Conditions (see Section 
6.1, Step 8).  From the HEC-WAT main widow (Figure 7.8), the Schematic Map Window, will 
contain the initial schematic for the Without Project Conditions.  The next step is to build the 
schematic for the default alternative. 
 
7.2.1 Adjust Map Layers 
 
Once map layers are in an HEC-WAT study, the user can make adjustments to those map layers.  
From the HEC-WAT main window, click the Maps tab (Figure 7.8).  Now the user can see 
which Map Window is currently active and what layers make up that Map Window.  To change 
the color and the fill aspects of a shapefile do the following: 
 
 1. From the Map Layers tree (Figure 7.9), right click on a map layer, which happens to be a 

shapefile.  The shortcut menu that appears is for shapefiles.  This shortcut menu allows 
the user to expand/collapse the selected map layer; move the shapefile to different  
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Figure 7.9  Map Layers Tree - Shortcut Menu 

 
  positions in the tree (Move To Top/Move To Bottom, Move up/Move Down); show the 

legend of the shapefile; change the label of the shapefile; edit the properties of the 
shapefile; set/remove scale factors; copy the map layer to another location; and open the 
attribute table of the shapefile. 

 
 2. From the shapefile shortcut menu (Figure 7.9), click Properties, the Edit Polygon 

Properties dialog box will open (Figure 7.10).  The selected shapefile is a polygon 
shapefile.  To edit the fill of the active map layer, from the Fill tab, change the color or 
turn off the fill.  For the example in Figure 7.10, the fill will be turned off.  Click Display 
Fill, the check mark will clear, meaning that fill is turned off. 

 

 
Figure 7.10  Edit Polygon Properties Dialog Box 
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 3. To change the outline color of the shapefile layer, from the Edit Polygon Properties 
dialog box (Figure 7.10), click the Border tab. From the Color list, select a color 
("darkred").  Click OK, the Edit Polygon Properties dialog box (Figure 7.10) will close 
and the changes will appear in dark red in the Map Window. 

 
 4. To turn off a map layer - click in the checkbox by a map layer, that map layer no longer 

displays in the map window. 
 
 5. To display the map window zoomed in, select the Zoom tool      . Draw a box around the 

map layers that are displayed in the Map Window.  From the Maps menu, click Default 
Map Properties, the Default Map Properties for dialog box will open (Figure 7.11).  
Click Set Map Extents to Display, click OK.  The Default Map Properties for dialog 
box will close. 

 

 
Figure 7.11  Default Map Properties for Dialog Box 

 
This sets the extents for the Map Window so that when the study is opened the next time 
the Map Window will be zoomed in to the tighter area. 

 
7.2.2 Create a Stream Alignment 
 
The backbone of any schematic is the stream alignment, and is the starting point in creating a 
schematic.  A stream alignment is a one-dimensional river coordinate system, which defines the 
natural downstream flow network.  Also, from the stream centerline, stationing will be provided 
relative to its global location and specific to the study.  The alignment indicates where 
confluences and bifurcations occur and provides a sense of distance and scale.  Stream 
alignments are composed of a series of streams, stream nodes, and stream junctions.  The stream 
alignment can be digitized or imported from a map layer.  This section provides the steps for 
importing a stream alignment from a shapefile. 
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To import a stream alignment: 
 
 1. From the Map Layers tree (Figure 7.9), right-click on StreamAlignment. From the 

shortcut menu, click Import.  The Import Stream Alignment dialog box will open 
(Figure 7.12).  The Shapefile Name list defaults to the first line shapefile it can find in 
the maps directory of a study; if that is not the correct shapefile, the user can choose the 
correct shapefile from the Shapefile Name list (Figure 7.12). 

 

 
Figure 7.12  Import Stream Alignment Dialog Box 

 
 2. From the Database Field Name list (Figure 7.12), the user needs to select the field name 

in the attribute file that contains the names of the streams (default is Name).  Once a field 
name is selected, the table below the Database Field Name list (Figure 7.12) will 
populate with the streams contained in the shapefile.  If there is an issue with any of the 
stream segments the checkbox in the Import column (Figure 7.12) will not be selected.  
This means the stream segment is not continuous and will not be imported. 

 
 3. If the flow direction in the shapefile is not correct, click Reverse Direction (Figure 7.12).  

and the system of streams will have the correct flow direction. 
 
 4. Click Import, the Import Stream Alignment dialog box will close (Figure 7.12).  Once 

the import of the stream alignment is completed, a message window will appear letting 
the user know that the stream alignment imported successfully.  In the active Map 
Window the stream alignment appears (orange stream segments; green stream nodes and 
stream junctions). 
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7.2.3 Add the Background Internet Map 
 
Knowing where the watershed is located in reference to known locations can be quite helpful 
when communicating with the PDT and stakeholders.  From the Maps menu (Figure 7.13), point 
to Add Internet Map, from the available list select the internet map that would be a good 
background (Open Street Map) map for the watershed.  The selected internet map will load and 
appear in the active Map Window. 
 

 
Figure 7.13  Maps Menu - Add Internet Map 
 
This layer in the background might help with adding additional streams to the stream alignment; 
locations of reservoirs; levees, other measures; impact areas; and, common computation points 
(CCPs).  Based on the known extents of the study area, the layer provides a view of the 
watershed and surrounding area. 
 
7.2.4 Add Common Computation Points (CCPs) 
 
Common computation points (CCPs) are locations where one model can transfer data to 
another model, where results are needed for model development or alternative analysis, or where 
input boundary conditions are to be defined.  CCPs need to be consistent for all models and 
should be placed on the stream alignment based on knowledge of possible study alternatives.  
The entire study team should be involved in the definition of the CCPs. 
 
To import CCPs from a shapefile: 
 
 1. From Maps menu (Figure 7.13), point to Import, click Computation Points.  The 

Import Computation Points dialog box will open (Figure 7.14).  The Shapefile Name 
list defaults to the first point shapefile it can find in the maps directory of a study; if that 
is not the correct shapefile, the user can choose the correct shapefile from the Shapefile 
Name list. 
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Figure 7.14  Import Computation Points Dialog Box 

 
 2. From the Database Field Name list (Figure 7.14), select the field name in the attribute 

file that contains the names of the CCPs (for the example in Figure 7.14 that name is 
ID_Name).  Once a field name is selected, the table below the Database Field Name list 
(Figure 7.14) will populate with the CCPs contained in the shapefile.  If there is an issue 
with any of the CCPs the checkbox in the Import column will not be selected.   

 
 3. Click Import, the Import Computation Points dialog box will close (Figure 7.14).  

Once the import of the CCPs is completed, a message window will appear letting you 
know that the CCPs have been imported successfully.  In the active Map Window the 
CCPs appear as black circles. 

 
A user can also add CCPs to the schematic manually by performing the following steps: 
 
 1. From the Schematic Map Window, find the location where a CCP needs to be added, 

press the Computation Point tool     . 
 
 2. Hold down the CTRL key and click on the stream alignment to place the common 

computation point. 
 
 3. The Name New Computation Point dialog box will open (Figure 7.15).  Enter the new 

Name (required) and Description (optional, but recommended).  Click OK, the Name 
New Computation Point dialog box will close. 
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Figure 7.15  Name New Computation Point 

 
 4. The CCP will now appear in the map window as a black circle.  
 
 5. If a CCP is added at a stream junction, a slightly different Name New Computation 

Point dialog box will open (Figure 7.16).  Enter the new Name (required) and 
Description (optional, but recommended). 

 

 
Figure 7.16  Name new Computation Point Dialog Box at a Stream Junction 

 
 6. From the Select the Placement of the Computation Point list (Figure 7.16), determine 

exactly where the CCP will be placed.  Choices are to have the CCP placed on the stream 
junction, along one of the streams that form the stream junction, or none of the above.  
For example, in Figure 7.16, the CCP will be placed on the stream junction. 

 
 7. Click OK, the Name New Computation Point dialog box (Figure 7.16) will close.  The 

common computation point will now appear in the display area as a black circle. 
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7.2.5 Add a Reservoir 
 
A reservoir is the impoundment created behind dams, or behind navigation locks and dams.  For 
HEC-WAT a reservoir also includes the dam built on a stream to store water for uses such as 
flood risk management, hydroelectric power generation, recreation use, and water supply, etc. 
 
To add a reservoir: 
 
 1. From the Schematic Map Window, find the location where a reservoir needs to be 

added, press the Reservoir tool      . 
 
 2. Hold down the CTRL key and click on the stream alignment to place the upstream end of 

the reservoir.  Release the CTRL key; drag the mouse to the downstream end of the 
reservoir and click. 

 
 3. The Name New Reservoir dialog box will open (Figure 7.17).  Enter the new Name and 

Description (optional, but recommended).  Click OK, the Name New Reservoir dialog 
box will close. 

 

 
Figure 7.17  Name New Reservoir Dialog Box 

 
 4. The reservoir will now appear on the schematic as a cyan triangle (reservoir pool), a blue 

line (storage reach), a gray rectangle (dam), and two CCPS that represent the upstream 
and downstream ends of the reservoir. 

 
 5. The default representation of the reservoir pool is a triangle; the user can edit this triangle 

if a more detailed representation of the pool is desired.  With the Reservoir Tool pressed, 
double-click on the reservoir.  The triangle (Figure 7.18) will now be green with a blue 
outline color.  Also, there are three vertex points (blue), and at the apex of the triangle is 
the reservoir label, which is represented by a yellow circle. 

 
 6. When a reservoir is created there are two CCPs that are created with default names.  It is 

recommended that the names of the two CCPs be changed.  These two CCPs represent 
the inflow and outflow junctions of the reservoir and should be renamed accordingly. 
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Figure 7.18  Reservoir Pool 

 
 7. To change the name of a common computation point, press the Computation Point tool 
      , right-click on one of the common computation points.  From the shortcut menu, click 

Rename Computation Point; the Rename Computation Point dialog box will open 
(Figure 7.19).  In the Name box, enter the new name, and in the Description box enter a 
description (optional, but recommended).  For example, in Figure 7.19, the inflow 
junction for Lake Mendocino has been labeled Lake Mendocino Inflow Jct, and the 
outflow junction should be labeled Lake Mendocino Outflow Jct. 

 

 
Figure 7.19  Rename Computation Point Dialog Box 

 
 8. Click OK, a Confirm Rename window will open, asking the user to be sure that the 

CCP is to be renamed. Click Yes, the Rename Computation Point dialog box will close 
(Figure 7.19) and the new name for the CCP will appear in the map window. 

 
7.2.6 Add Impact Areas 
 
An impact area is any distinct portion of a study that is affected by rising or falling stage in a 
stream, river, lake, or reservoir.  Impact areas are an optional element, and are only required 
when the user wants to compute impacts at damage area centers in the study area 
 
To import impact areas from a shapefile: 
 
 1. From the Maps menu (Figure 7.13), point to Import, click Impact Areas.  The Import 

Impact Areas dialog box will open (Figure 7.20).  The Shapefile Name list figures out 
whether there are any polygon shapefiles available in the maps directory of a study; if the 
correct shapefile is not selected, the user can choose the correct shapefile from the 
Shapefile Name list. 
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Figure 7.20  Import Impact Areas Dialog Box 
 

 2. From the Database Field Name list (Figure 7.20), the user needs to select the field name 
in the attribute file that contains the names of the impact areas (for the example in Figure 
7.20 that name is ID_Name).  Once a field name is selected, the table below the Database 
Field Name list (Figure 7.20) will populate with the impact areas contained in the 
shapefile.  If there is an issue with any of the impact areas the checkbox in the Import 
column will not be selected. 
 

 3. Click Import, the Import Impact Areas dialog box will close (Figure 7.20).  Once the 
import of the impact areas is completed, a message window will appear letting the user 
know that the impact areas have been imported successfully.  In the active Map Window 
the impact areas appear as green polygons. 

 
A user can also add impact areas to the schematic manually by performing the following steps: 
 
 1. From the Schematic Map Window, find the location where an impact area needs to be 

added, press the Impact Area tool       . 
 
 2. Hold down the CTRL key while clicking the mouse button.  Each click creates a vertex 

point (Figure 7.21), which is the boundary of the polygon.  When reaching the end point, 
release the CTRL key and click. 

 
 3. The Name New Impact Area dialog box will open (Figure 7.22).  Enter a name, and if 

needed, enter a description.  Click OK, the Name New Impact Area dialog box will 
close. 
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Figure 7.21  Draw an Impact Area 

 

 
Figure 7.22  Name New Impact Area Dialog Box 

 
 4. The impact area will now appear in the display area as a green polygon with a name. 
 
Following the steps in this chapter creates the basic schematic elements for an HEC-WAT 
watershed - stream alignment, common computation points, impact areas, and projects 
(reservoirs, levees). Now this basic schematic can be used by the models that are required for the 
watershed.  The user will have choices at this point - to either build the individual models in 
HEC-WAT or build individual models outside of HEC-WAT. 
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CHAPTER 8 
 

Importing Models 
 
Besides building the models directly from the HEC-WAT framework, the PDT can chose to 
import individual models or models from a Corps Water Management Study (CWMS) or an 
HEC-RTS (Real-Time Simulation) watershed.  This chapter will layout the steps for both import 
mechanisms. 
 
8.1 Importing Individual Models 
 
When importing from individual models, it is recommended that the models have been created in 
the individual application software and have been successfully computed.  Calibrated and 
validated models are even better.  Also, it is recommended that all of the models being imported 
into a study have the same projection coordinate system, so that everything displays correctly on 
the schematic.  The first step is to create a basic HEC-WAT study, in Chapter 7, Section 7.1, 
follow those steps to create a new HEC-WAT study  
 
8.1.1 Import an HEC-ResSim Model 
 
If the HEC-WAT study contains an HEC-ResSim model, it is recommended that the user import 
the HEC-ResSim model first.  The HEC-ResSim model usually contains the basic building block 
elements for an HEC-WAT study - a stream alignment, common computation points (CCPs), and 
the reservoirs necessary to model the study area.  HEC-ResSim models are very much tied to the 
stream alignment, any slight changes to the stream alignment can cause an HEC-ResSim model 
to become very unhappy. 
 
 1. From the HEC-WAT main window, from the File menu, point to Import (Figure 8.1), 

and click ResSim, an Import Type window (Figure 8.2) will open. 
 

 
Figure 8.1  HEC-WAT Main Window- File Menu - Import Menu Options 
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Figure 8.2  Import Type Window 

 
 2. There are two import options for the HEC-ResSim import.  If the HEC-WAT study does 

not have any of the basic information (i.e., stream alignment, CCPs, etc.), then the choice 
should be Watershed (this will import everything from the HEC-ResSim model, which 
includes the basic information).  On the other hand, if the HEC-WAT study already has 
the basic information built (i.e., stream alignment, CCPs, etc.), then the user only wants 
to import by Alternative. 

 
 3. For this example, the user will be clicking Watershed.  The Import Type Window will 

close (Figure 8.2), and the Select Watershed File to Import From browser will open 
(Figure 8.3).  Browse to the folder that contains the HEC-ResSim model to be imported.  
Once the correct location has been found, the Files of Type list should display the HEC-
ResSim watershed file (*.wksp).  Click on the "wksp" file, click Open, the Select 
Watershed File to Import From browser will close. 

 

 
Figure 8.3  Select Watershed File to Import From Browser 

 
 4. A ResSim Import window will open (Figure 8.4) showing the progress of the HEC-

ResSim import. 
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Figure 8.4  ResSim Import Window 

 
 5. The HEC-WAT Schematic Editor will open (Figure 8.5), from the Measures area of the 

Schematic Editor, click Select All.  All of the reservoirs listed in the table are now 
selected. Click OK, the Schematic Editor will close (Figure 8.5). 

 

 
Figure 8.5  Schematic Editor 

 
 6. The imported stream alignment, common computation points, reservoirs, and any 

available map layers from the HEC-ResSim model display in the HEC-WAT Schematic 
Map Window (Figure 8.6). For all of the map layers to appear, close the Schematic 
Map Window.  To re-open the Schematic Map Window, from the Study Tree, from an 
Alternative folder (i.e., Without Project Conditions), double-click on a schematic (i.e., 
Schematic:Without Project Conditions), the Schematic Map Window will appear in the 
Desktop Area of the HEC-WAT main window (Figure 8.6).  The importing of an HEC-
ResSim model has completed. 

 
8.1.2 Import an HEC-HMS Model 
 
 1. From the HEC-WAT main window, from the File menu, point to Import (Figure 8.1), 

and click HMS.  The HEC-HMS application will open with the Select Project File 
browser already open (Figure 8.7).   

 



Chapter 8 – Importing Models HEC-WAT User's Manual 

8-4 

 
Figure 8.6  HEC-WAT Schematic Map Window after HEC-ResSim Import 

 

 
Figure 8.7  HEC-HMS Main Window and Select Project File Browser 

 
 2. Browse to the folder that contains the HEC-HMS model to be imported.  Once the right 

location has been found, select the HEC-HMS project file (*.hms). The HEC-HMS 
project filename will appear in the File name box (Figure 8.7), click Select. 

 
 3. When the HEC-WAT study is created an hms subfolder is created.  In that subfolder are 

the default files that are generated when creating an HEC-HMS project.  When the HEC-
HMS import process finds that a project already exists, a warning window will appear 
(Figure 8.8).  From the warning window, click Yes, the warning window will close. 
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Figure 8.8 HEC-HMS Warning Window about HEC-HMS Project 

 
 4. If the HEC-HMS model was created using a previous version of HEC-HMS, a Convert 

HEC-HMS Project window (Figure 8.9) will open.  This window is letting the user 
know that the HEC-HMS model will be converted to a Version 4.2.1 HEC-HMS model. 
Click Convert Project, the Convert HEC-HMS Project window (Figure 8.9) will close, 
and the import of the HEC-HMS model will continue. 

 

 
Figure 8.9  Convert HEC-HMS Project Window 

 
 5. The import process begins (the import this could take a few seconds and depends on the 

number of files being copied to the HEC-WAT project directory and the size of the files). 
The import is finished when the study tree pane in the HEC-HMS main window contains 
a study tree. From the HEC-HMS main window (Figure 8.7), from the File menu, click 
Exit.  The HEC-HMS model import is completed. 

 
8.1.3 Import an HEC-RAS Model 
 
 1. From the HEC-WAT main window, from the File menu, point to Import (Figure 8.1), 

and click RAS.  The Select RAS project to import from browser will open (Figure 
8.10).   

 

 
Figure 8.10  Select RAS project to import from Browser 
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 2. Browse to the folder that contains the HEC-RAS model to be imported.  Once the correct 
location has been found, select the HEC-RAS project file (*.prj). The HEC-RAS project 
filename will appear in the File name box (Figure 8.10), click Open. 

 
 3. The Select RAS project to import from browser will close (Figure 8.10). An Importing 

window (Figure 8.11) will open; when the HEC-RAS model import is complete this 
window will close.  The HEC-RAS model import is completed. 

 

 
Figure 8.11  HEC-RAS Importing Window 

 
The HEC-RAS import does not include copying external files, like terrain files and HEC-DSS files 
containing boundary conditions, to the "ras" folder within the HEC-WAT study directory.  The user will 
need to determine how to manage these files, including whether to make them local to the HEC-WAT 
study directory in order to easily copy the study from one computer to another.  
 
8.1.4 Import an HEC-FIA Model 
 
 1. From the HEC-WAT main window, from the File menu, point to Import (Figure 8.1), 

and click FIA.  The Import Alternatives dialog box will open (Figure 8.12).   
 

 
Figure 8.12  Import Alternatives Dialog Box 

 
 2. Click Select/Add Project, an Open browser will open (Figure 8.13).  Browse to the 

folder that contains the HEC-FIA model to be imported.  Once the correct location has 
been found, select the HEC-FIA project file (*.prj). The HEC-FIA project filename will 
appear in the File name box (Figure 8.13), click Open, the Open browser will close. 

 
 3. From the Import Alternatives dialog box (Figure 8.14), the table will now contain the 

name of the Project (i.e., RussianRiver).  From the Alternative column (Figure 8.14), 
from the list select the HEC-FIA alternative that will be imported (i.e., 
GridsAndXSecsAlternative). 
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Figure 8.13  Open Browser 

 

 
Figure 8.14  HEC-FIA Import Alternative Table 

 
 4. From the Import Alternatives dialog box (Figure 8.12), click Edit Alternative 

Specifications, the Alternative Specification dialog box will open (Figure 8.15).  Copy 
Projection from project should by default be clicked, click OK. 

 

 
Figure 8.15  Alternative Specification Dialog Box 

 
 5. From the Import Alternatives dialog box (Figure 8.12), click Import Alternatives, in 

the Progress column of the table (Figure 8.14) the cell will display the progress of the 
import with a green bar.  When the import is complete an Information window will 
open, click OK. 

 
 6. From the Import Alternatives dialog box (Figure 8.15) click Close.  The HEC-FIA 

model alternative has been imported. 
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8.2 Importing a CWMS/HEC-RTS Watershed 
 
A CWMS (Corps Water Management System) or an HEC-RTS watershed has been built for 
forecasting in the same watershed area that a PDT wants to build an HEC-WAT study.  The 
HEC-WAT software has the capability to import a CWMS/HEC-RTS watershed.  Once the 
import is finished, the study team will need to review the models and make adjustments as 
needed.  The first step is to create a basic HEC-WAT study, in Chapter 7, Section 7.1, follow 
those steps to create a new HEC-WAT study  
 
To import a CWMS/HEC-RTS watershed: 
 
 1. From the HEC-WAT main window (Figure 8.1), from the File menu, point to Import, 

click CWMS Watershed.  The Import CWMS Watershed dialog box will open 
(Figure 8.16). 

 

 
Figure 8.16  Import CWMS Watershed Dialog Box 

 
 2. Now select the CWMS/HEC-RTS watershed, from the CWMS Watershed File box, 

click     , and the Select Workspace File browser (Figure 8.17) will open.  Browse to the 
directory where the CWMS/HEC-RTS watershed is located and select the CWMS/HEC-
RTS watershed file (*.wtrshd).   The watershed filename will appear in the File name 
box (Figure 8.17), click Import, the Select Workspace File browser will close (Figure 
8.17). 

 
 3. A Continue Import? window will open (Figure 8.18).  This window is warning the user 

that the import process will overwrite any existing data in the HEC-WAT study.  Click 
Yes, the Continue Import? window will close (Figure 8.18) 
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Figure 8.17  Select Workspace File Browser 

 

 
Figure 8.18  Continue Import? Window 

 
 4. The Import CWMS Watershed dialog box (Figure 8.19) will now display the name of 

the CWMS/HEC-RTS watershed file in the CWMS Watershed File box (Figure 8.19).  
As the import proceeds, the Import Progress box on the Import CWMS Watershed 
dialog box (Figure 8.10) will display what is happening during the import.  The table on 
the Import CWMS Watershed dialog box (Figure 8.19) will display which 
CWMS/HEC-RTS watershed components have finished, whether the import was 
successful or not, and the number of model alternatives that were imported. 

 
 5. When the HEC-WAT study is created an hms subfolder is created.  In that subfolder are 

the default files that are generated when creating an HEC-HMS project.  When the HEC-
HMS import process finds that a project already exists, a warning window will appear 
(Figure 8.8; this warning window can open behind the HEC-WAT main window).  Click 
Yes, the warning window will close. 

 
 6. If the HEC-HMS model was created using a previous version of HEC-HMS, a Convert 

HEC-HMS Project window (Figure 8.9) will open.  This window is letting the user 
know that the HEC-HMS model will be converted to a Version 4.2.1 HEC-HMS model. 
Click Convert Project, the Convert HEC-HMS Project window (Figure 8.9) will close, 
and the import of the watershed will continue. 
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 7. Once the import process is finished from the Import CWMS Watershed dialog box 

(Figure 8.19) click Close.  The Import CWMS Watershed dialog box (Figure 8.19) will 
close, and the HEC-WAT main window (Figure 8.20) will display the map layers and the 
stream alignment of the imported CWMS/HEC-RTS watershed. 

 

 
Figure 8.19  Importing CWMS Watershed Dialog Box 

 
 8. The CWMS/HEC-RTS watershed has been imported into an HEC-WAT study.  From the 

HEC-WAT main window (Figure 8.20), from the File menu, click Save. 
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Figure 8.20 HEC-WAT Main Window after a CWMS/HEC-RTS Import 
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CHAPTER 9 
 
 
 

Time Window – Analysis Period 
 
 
An analysis period defines the simulation time window that is used by all the model alternatives 
in an HEC-WAT simulation.  An analysis period can span single or multiple historical events or 
can be used to define the lifecycle length within a Flood Risk Analysis (FRA) simulation.  For 
example, an analysis period for a historic event, such as the 1986 flood, should be defined so that 
the start and end time spanned the 1986 event, i.e., the start time captures the precipitation that 
drove the flood event and the end time captures the flood wave and resulting damage.  An 
analysis period for multiple events, or a continuous simulation, would be defined by creating one 
analysis period (start and end times) that captures all the flood events within the continuous 
record. 
 
An analysis period for an FRA simulation is different than when modeling historic events.  The 
analysis period for an FRA simulation is used to set the length of each lifecycle within the FRA 
compute.  Typically, lifecycles are fifty-years in length.  If the FRA compute does not analyze 
damages and lifecycles are not required, then the analysis period can be an arbitrary length; 
however, 100 or 500 year lifecycles are optimal for results management.  
 
Options that modify the analysis period (time window) are available and are described in Section 
9.2.  Once the user has defined an alternative (such as the Without Project Conditions 
alternative), the next step is to create analysis periods.  Analysis periods are required to create 
simulations runs, and an analysis period can only be used once per HEC-WAT alternative. 
 
9.1 Analysis Periods – Study Tree 
 
Analysis periods can be managed from different areas in the HEC-WAT framework (Figure 9.1).  
This sections covers the Study Tree, which is in the Study Pane (Figure 9.1) of the HEC-WAT 
main window.  Analysis periods can also be managed from the Alternative and Simulation 
Manager, which is covered in Section 9.3. 
 
9.1.1 Create an Analysis Period 
 
 1. From the HEC-WAT main window (Figure 9.1), from the Study Tree, right-click on the 

Analysis Periods folder.  From the shortcut menu (Figure 9.2) click New. 
 
 2. The Create New Analysis Periods dialog box will open (Figure 9.3). 
 
 3. In the Name box, enter a name (required) for the analysis period.  Optionally (but 

recommended), the user can enter a description in the Description box. 
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Figure 9.1  HEC-WAT Main Window 

 

 
Figure 9.2  Study Tree- Analysis Periods Folder – Shortcut Menu 

 

 
Figure 9.3  Create New Analysis Period Dialog Box 

 
 4. In the Time Window box (Figure 9.3), the user will enter a start date in the Start Date 

box, and a start time in the Start Time box.  For the end date of the time window the user 
will enter that in the End Date box, and the end time in the End Time box.  The Years 
in Time Window box will automatically update based on the start date/time and end 
date/time specified by the user.  This feedback was added to help users enter standard 
lifecycle lengths for the FRA simulation.  An analysis period of 50.05 years can lead to 
51 flood events within an FRA lifecycle, which may be unwanted.  A Years in Time 
Window of exactly 50 years will result in fifty events within a lifecycle.  
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 5. Click OK.  The Create New Analysis Period dialog box (Figure 9.3) will close.  On the 
Study Tree, under the Analysis Period folder (Figure 9.1), the name of the analysis 
period that was just created is displayed. 

 
9.1.2 Delete Analysis Period(s) 
 
 1. From the HEC-WAT main window (Figure 9.1), from the Study Tree, right-click on the 

Analysis Periods folder.  From the shortcut menu (Figure 9.2) click Delete from Study. 
 
 2. The Delete Analysis Period(s) dialog box will open (Figure 9.4).  This dialog box allows 

the user to delete single or multiple analysis period(s) at one time.  From the Existing 
box select the analysis periods to be deleted.  The name(s) selected will display in the 
Name field of the Delete Object box.  Click Delete, a warning message box will appear, 
checking to see if the user really wants to delete the selected analysis period(s), click Yes. 

 

 
Figure 9.4  Delete Analysis Period(s) Dialog Box 

 
 3. The Delete Analysis Period(s) dialog box will close (Figure 9.4) and the name(s) of the 

selected analysis period(s) are no longer displayed under the Analysis Period folder in 
the Study Tree. 

 
9.1.3 Individual Analysis Periods 
 
When an analysis period has been created, from the Study Tree, under the Analysis Periods 
folder, the analysis periods defined for the HEC-WAT study are displayed. By right-clicking on 
an analysis period, a shortcut menu (Figure 9.5) becomes available.  From the shortcut menu the 
user can perform various functions on individual analysis periods.  These options include editing 
the existing analysis period; save as (which is used to copy an existing analysis period); and, 
deleting the existing analysis period.  
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Figure 9.5  Study Tree - Individual Analysis Period Shortcut Menu 

 
Edit 
 
To edit an analysis period: 
 
 1. From the HEC-WAT main window (Figure 9.1), from the Study Tree, from the Analysis 

Periods folder, right-click on an analysis period.  From the shortcut menu (Figure 9.5), 
click Edit.  The Analysis Period Editor will open (Figure 9.6). 

 

 
Figure 9.6  Analysis Period Editor 

 
 2. The user can edit any of the analysis period data from the editor.  Once the edits are 

complete, click OK.  The Analysis Period Editor will close (Figure 9.6). 
 
Save 
 
When an analysis period has been changed and the Analysis Period Editor has been closed, the 
user can save the analysis period information from the Study Tree. From the Analysis Periods 
folder, right-click on an analysis period.  From the shortcut menu (Figure 9.5) click Save. 
 
Save As 
 
To make a copy of an analysis period: 
 
 1. The user can make a copy of an individual analysis period by using the Save As option. 

From the HEC-WAT main window (Figure 9.1), from the Study Tree, from the Analysis 
Periods folder, right-click on an analysis period.  From the shortcut menu (Figure 9.5), 
click Save As. 
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 2. The Save Analysis Period As dialog box will open (Figure 9.7).  In the Name box, enter 
a name for the new analysis period.  Click OK, the Save Analysis Period As dialog box 
will close (Figure 9.7).  The new analysis period will appear on the Study Tree, under 
the Analysis Periods folder. 

 

 
Figure 9.7  Save Analysis Period As Dialog Box 

 
Delete from Study 
 
To delete an analysis period study: 
 
 1. The user can delete an individual analysis period by using the Delete from Study option. 

From the HEC-WAT main window (Figure 9.1), from the Study Tree, from the Analysis 
Periods folder, right-click on an analysis period.  From the shortcut menu (Figure 9.5), 
click Delete from Study. 

 
 2. A Confirm Manager Delete message window will appear, checking to see if the user 

really wants to delete the selected analysis period.  Click Yes to delete the analysis 
period.  The message window will close and the name of the selected analysis period is 
no longer displayed under the Analysis Period folder in the Study Tree. 

 
Analysis Period Properties 
 
The properties of an analysis period include the name, description, when the analysis period was 
modified, who created the analysis period, when the analysis period was created, and the file that 
contains the analysis period data.  To view the properties of an analysis period, from the 
individual analysis period shortcut menu (Figure 9.5), click Properties.  The Properties for 
AnalysisPeriodName dialog box will open (Figure 9.8). 
 

 
Figure 9.8  Properties for AnalysisPeriodName Dialog Box 
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9.2 Analysis Period - Modifiers 
 
Now that the user has created an analysis period for an HEC-WAT simulation, HEC-WAT 
provides several methods for modifying the analysis period time window within a simulation.  
Modifying the simulation time window is a way to make a simulation run faster or help make 
simulations more stable by adjusting the time window for each model that is part of an HEC-
WAT simulation.  For example, a reservoir model may need to run for the entire time window, 
but a hydraulic model may only need to run for a shorter time around the peak flow in order to 
capture maximum flow and inundation.  
 
There are three options available for modifying the simulation time window: Time Window 
Adjustment (Section 9.2.1), Time Window Modifier (Section 9.2.2), and Time Window 
Interval Generator (Section 9.2.3). The Time Window Adjustment and Time Window 
Modifier options are available in both a deterministic and FRA compute, while the Time 
Window Interval Generator option is only available in a deterministic compute. 
 
9.2.1 Time Window Adjustment 
 
The Time Window Adjustment option (Figure 9.9) provides the user with simple methods to 
adjust the simulation time window for a specific model. The user can independently adjust the 
start and end dates and times of a simulation time window using one of two options: No Change 
and Relative. The time window adjustment modifies the simulation time window based on date 
shifts. The time window adjustment feature is available for both deterministic and FRA compute 
types, and can be used in conjunction with the Time Window Modifier (Section 9.2.2). The 
Time Window Modifier allows users to also alter the simulation time window, but based on 
model alternative results (e.g., adding or subtracting days relative to the date and time of a peak 
flow or stage) instead of date shifts. From the Simulation Editor (Figure 9.9), the user can apply 
time window adjustment options as follows: 
 

 
Figure 9.9  Simulation Editor – Time Window Adjustment 
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 1. From the HEC-WAT main window (Figure 9.1), from the Study Tree, from the 
Alternatives node, from the Simulation folder, right-click on a simulation.  From the 
shortcut menu click Edit Simulation. 

 
 2. The Simulation Editor will open (Figure 9.9).  From the Models table, from the Time 

Window Adjustment column, click Edit.  The Time Window Adjustment Editor 
(Figure 9.10) will open. 

 

 
Figure 9.10  Time Window Adjustment Editor 

 
 3. For the Start and End of the time window, there are two options – No Change and 

Relative.  These options can be selected independently for the Start and End times.  For 
example, the user could select Relative for Start and No Change for End. 

 
 ● No Change (Default) – The start or end of the simulation time window will not be 

adjusted (Figure 9.11). 
 

 
Figure 9.11  Time Window Adjustment Editor – No Change 

 
 ● Relative – The start or end of the simulation time window can be adjusted by 

adding or subtracting days and hours (Figure 9.12). 
 

 
Figure 9.12  Time Window Adjustment Editor – Relative 
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  The start and end times of the Simulation Time Window can be adjusted 
independently (Figure 9.13). Negative values for the number of days and hours 
will move a date backward in time.  For example, a value of minus one day will 
shift the date from May 15 to May 14.  Positive values for the number of days and 
hours will move a date forward in time. For example, a value of plus one day will 
shift the date from May 15 to May 16.   

 

 
Figure 9.13  Time Window Modifier Editor - Relative -Example 

 
Important: The time window can be shortened or lengthened using the Relative 
option.  If the time window is lengthened, however, there is a risk that subsequent 
model alternatives in the compute sequence will not have data for the entire time 
window and may fail to compute. The user should also be aware that it is possible 
to generate overlapping start and end times, through either an incorrect selection of 
dates for the relative Time Window Adjustment option or through a combination 
of a Time Window Modifier alternative (Section 9.2.2) and a Time Window 
Adjustment. A simulation will fail if the start and end times overlap. 

 
 4. An example application of a time window adjustment follows. From the Time Window 

Adjustment Editor the user has selected the Relative option to adjust the time window 
(Figure 9.13).  In the Start box, the user selected Relative from the list, entered the 
number of hours to add to the simulation time window in the Hours box.  In the End 
box, the user selected Relative from the list, entered the number of days and hours to 
adjust the simulation time window in the Days and Hours boxes.  Click OK, the Time 
Window Adjustment Editor (Figure 9.13) closes, and now on the Simulation Editor, 
from the Models box, the Time Window Adjustment cell for the RAS model alternative 
displays the new simulation time window for the RAS model alternative (Figure 9.14).  
When the simulation computes, only HEC-RAS will have a modified simulation time 
window. 
 

 5. Click OK, the Simulation Editor (Figure 9.14) will close. 
 
9.2.2 Time Window Modifier 
 
The Time Window Modifier has greater flexibility than the time window adjustment and can be 
used to modify the simulation time window based on flow, stage, or elevation.  The modification 
can be relative to a threshold, a peak value, or through a script.  If a time window modifier  
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Figure 9.14  Simulation Editor – Example Time Window Adjustment – Relative 
 
alternative is used for the study, make sure the time window modifier plug-in has been enabled 
for the study (Chapter 4, Section 4.1.5).  The user creates a Time Window Modifier 
Alternative (Figure 9.15) and sets up the options.  To use a time window modifier alternative in 
an HEC-WAT simulation, the program order (Chapter 11, Section 11.1) for the simulation must 
include a time window modifier in the compute sequence.   
 

 
Figure 9.15  Create New Time Window Modifier Alternative Dialog Box 
 
One or more time window modifier alternatives can be used in a simulation, and each time 
window modifier alternative must be linked to an output time-series from a model alternative 
that is part of a simulation. For example, a time window modifier alternative could be inserted 
between an HMS model alternative and an RAS model alternative in a simulation to shorten the 
RAS model alternative's runtime. The time window modifier would be linked to a flow time-
series from the HMS model alternative, which runs for the entire analysis period and comes 
before the time window modifier in the simulation. Based on user-specified criteria and HMS 
flow results, the time window modifier would then determine and pass a shortened run time 
window to the RAS model alternative. The time window modifier feature is available for both 
deterministic and FRA compute types, and can be used in conjunction with the time window 
adjustment feature. 
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Create a time window modifier alternative: 
 
 1. From the HEC-WAT main window (Figure 9.1), from the Study Tree, from the Models 

node, right-click on TimeWindowModifier (if TimeWindowModifier does not display, 
the time window modifier plug-in (Chapter 4, Section 4.1.5) has not been enabled for the 
study).  From the shortcut menu click New. 

 
 2. The Create New Time Window Modifier Alternative dialog box will open (Figure 

9.15).  In the Name box, enter a name (required) for the time window modifier 
alternative.  Optionally (but recommended), the user can enter a description in the 
Description box. 

 
 3. Click OK, the Create New Time Window Modifier Alternative dialog box will close 

(Figure 9.15) and the Time Window Modifier Alternative Editor will open (Figure 
9.16). 

 

 
Figure 9.16  Time Window Modifier Alternative Editor 

 
 4. By default, the Time Window Modifier Alternative Editor opens with the Model tab 

selected.  From the Model tab, the user is given choices to adjust the simulation time 
window by either a flow threshold or a time window relative to the peak of a time-series. 
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 The Input Data Parameter box (Figure 9.16) contains three options: Flow, Stage, and 
Elevation. Flow is selected by default when a new time window modifier alternative is 
created, but the user can also select either Stage or Elevation. The parameter type is used 
to filter the list of model results in the Model Linking Editor (Chapter 12) to only those 
specified here in the Time Window Modifier Alternative Editor. 

 
 There are four options for modifying the time window: Threshold Crossing, Minimum 

Time Window, Maximum Time Window and Script. Input information for the first 
three options is organized in separate boxes on the Model tab, and the Script option is a 
tab. The time window modifier checks for input and applies each option in the order that 
the options are displayed, meaning the threshold crossing is checked first, then minimum 
time window, maximum time window and finally script. As each option is applied, the 
time window is modified further. If input data has not been provided for one of the 
options, the time window modifier carries the existing time window forward to the next 
option without modification. The next option in the sequence is then checked for input 
data, and if data is available, the time window is modified accordingly. This process 
continues until all four options have been checked for input data and a final modified 
time window is produced. 

 
 ● The Threshold Crossing option (Figure 9.17) shortens the analysis period time 

window based on user-defined thresholds relative to the peak value of a time-series. 
The user can define both a pre- and post-peak threshold using either absolute values 
or a percentage of the peak value. The user can also choose to define only one 
threshold, either pre- or post-peak. If percentage-based thresholds are desired, the 
user must select Threshold is percentage of value at peak (Figure 9.17). A Search 
Method (Figure 9.17) is also specified, with a default of Out from Peak, which 
searches backwards in time from the peak when a pre-peak threshold is set, and  

 

 
Figure 9.17  Time Window Modifier Alternative Editor – Threshold Crossing 

 
  searches forward in time from the peak when a post-peak threshold is set. The In 

from Edges search method (Figure 9.17) searches forward in time from the start of a 
time-series when a pre-peak threshold is set, and searches backwards in time from 
the end of a time-series when a post-peak threshold is set. In all cases, the time 
window is modified to match the time at which the designated threshold(s) are first 
crossed. If the user-specified threshold(s) are never crossed, the original time 
window is passed forward without modification. 

 
 ● The Minimum Time Window option (Figure 9.18) is applied next, and can be used 

to set a minimum time window based on the peak value from the linked time-series. 
The user can enter Minimum Time Window values in a combination of Days and 
Hours.  This option expands the current time window, based on user inputs. For  
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Figure 9.18  Time Window Modifier Alternative Editor – Minimum Time Window 

 
  example (Figure 9.18), a user may specify a start relative to peak of six days and an 

end relative to peak of four days. If the time window passed to the Minimum Time 
Window option includes six or more days before the peak and four or more days 
after the peak, no adjustment will be made. However, if the initial time window 
includes only three days before the peak and one day after the peak, the time window 
would be expanded to include six days before the peak and four days after the peak 
to match the requirements specified in the Minimum Time Window option.  

 
  Important: Because the Minimum Time Window option can expand a previously 

defined time window, there is a risk that subsequent model alternatives in the 
simulation that come after a time window modifier alternative in an HEC-WAT 
compute sequence will be passed a time window that is larger than the input data of 
those model alternative and the simulation will not complete. The user must 
carefully check the logic defined for this option to ensure that it does not result in a 
modified time window that extends beyond the data limits of the following model 
alternatives in a compute sequence.  

 
 ● The Maximum Time Window option (Figure 9.19) is applied next and works in the 

opposite way of the Minimum Time Window option. It shortens the time window 
based on user-defined values for start and end times relative to the peak. The user 
can enter Maximum Time Window values in a combination of Days and Hours. 
For example, a user may specify a start relative to peak of four days and an end 
relative to peak of two days. If the time window passed to the Maximum Time 
Window option includes four or less days before the peak and two or less days after 
the peak, no adjustment will be made. However, if the initial time window includes 
ten days before the peak and five days after the peak, the time window would be 
shortened to include four days before the peak and two days after the peak to match 
the requirements specified in the Maximum Time Window option.  

 

 
Figure 9.19  Time Window Modifier Alternative Editor – Maximum Time Window 

 
 5. The script option (available from the Script tab) runs last and is described in the 

following section. If the user is not applying the script option and the time window 
modifier setup is complete, click OK, and the Time Window Modifier Alternative 
Editor closes (Figure 9.16). 
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Script Tab 
 
HEC-WAT provides a built-in scripting interface for defining a more complex time window 
modifier. The user can create a Python script that will adjust the simulation time window based 
on parameters and conditions the user selects. An example script is available for download from 
the HEC-WAT webpage. 
 
 1. From the Time Window Modifier Alternative Editor, click the Scripts tab (Figure 

9.20). 
 

 
Figure 9.20  Time Window Modifier Alternative Editor – Script Tab 

 
 2. The name of the script (displays in the Name box, Figure 9.20) is the same as the time 

window modifier alternative. Optionally, the user can enter a description in the 
Description box (Figure 9. 20).  To create a script, click Use Script, the Script File box 
(Figure 9. 20) displays the location of where the file is stored. 
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 3. From the API (Application Programming Interface) Pane (Figure 9. 20), is a list of the 

available APIs that a user can insert into a script.  The user will decide which API needs 
to be included in the script, expand the folder for that API (click the plus sign).  From the 
expanded list, the user will select the appropriate item that needs to be included in the 
script. Once an item is selected, click Insert in Script, and the format for the selected 
item will appear in the Text Editor Pane (Figure 9. 20). 

 
 4. The Text Editor Pane (Figure 9. 20) is a basic editor where the user can create and edit a 

script.  The editor supports the standard Windows® keys for Select All (Ctrl-A), Cut 
(Ctrl-X), Copy (Ctrl-C) and Paste (Ctrl-V) operations. By right-clicking in the Text 
Editor Pane, a shortcut menu is available, that also supports the previously listed 
operations, plus Undo and Redo. Below the Text Editor Pane, by clicking Compile 
Script, the user can check the script for Python code syntax errors. 

 
 5. When editing a script, from the Text Editor Pane (Figure 9. 20), the user will need to 

select the appropriate text in the script where revisions might be made. Then, using the 
API Pane (Figure 9. 20), the user can add items to the script in several ways. One way is 
described in Step 3 by clicking Insert in Script.  The user can also double-click on an 
item in the API Pane, the format for the selected item will be inserted at the current 
cursor position in the text editor.  Another way is by dragging an API item to a position 
in the Text Editor Pane, this also causes the format for the selected item to be inserted 
into the current cursor position in the text editor. 

 
 6. Arguments are placeholders for variables that the user must supply in the script. The user 

needs to replace the placeholders (red parentheses) with an argument of appropriate 
variables/objects that the user has created within the script.  General information about an 
API item can be viewed by hovering over an item in the API Pane, a yellow callout box 
will display (Figure 9.21).  More detailed information can be viewed by selecting an API 
item and then pressing the F1 key, which displays a JavaDoc window (Figure 9.22). 

 

 
Figure 9.21  API Pane – Displaying Information about an API Item 
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Figure 9.22  JavaDoc Window – Displaying More Detailed Information about an API Item 

 
 5. When the script has been completed, click OK, the Time Window Modifier Alternative 

Editor will close (Figure 9.20). 
 
Simulation Editor 
 
Now that a time window modifier alternative has been created, the user will decide on which 
model alternatives to apply the time window modification. Note that multiple time window 
modifier alternatives can be defined within one simulation, and conversely, multiple model 
alternatives can reference the same time window modifier alternative. 
 
 1. From the HEC-WAT main window (Figure 9.1), from the Study Tree, from the 

Alternatives node, from the Simulation folder, right-click on a simulation.  From the 
shortcut menu click Edit Simulation. 

 
 2. The Simulation Editor will open (Figure 9.23), in the table, the Program column 

(Figure 9.23) will contain the names of the software applications.  The software 
applications that display are determined by the selected program order (e.g., FRA_Full 
sequence) from the Program Order list (Figure 9.23). If TimeWindowModifier is not 
listed in the Program column, the selected program order does not include 
TimeWindowModifier (Chapter 11, Section 11.1). The Alternative column will contain 
the time window modifier alternative name (i.e., Minimum Length_FRA) used in the 
compute sequence for the selected simulation.  
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Figure 9.23  Simulation Editor – Simulation with Time Window Modifier Alternative 

 
 3. For a model alternative to use a time window modifier alternative, from the Simulation 

Time Window column (Figure 9.23), from a cell associated with a software application 
(e.g., RAS) that is located below the TimeWindowModifier in the table (Figure 9.23), click 
the cell, a list of available time window modifier alternatives will display, select the name 
for the appropriate time window modifier alternative (i.e., Minimum Length_FRA). 

 
Important: Connecting a model alternative to a time window modifier alternative in the 
Simulation Editor modifies the simulation time window for that model alternative, 
either by shortening or expanding it. As a best practice, subsequent model alternatives in 
the simulation should generally be connected to the same time window modifier 
alternative to ensure that those model alternatives simulation time windows match that of 
prior model alternatives. If the simulation time windows of the subsequent model 
alternatives are not modified, there is a risk that those model alternatives time windows 
will be larger than the previous model alternative.  This could mean that adequate input 
data might be unavailable for those model alternatives and the simulation will not 
complete. 

 
 4. When this example simulation computes, the simulation time window will be modified 

for the model alternatives connected to the time window modifier alternative (i.e., 
Minimum Length_FRA) in the Simulation Editor (Figure 9.23).  

 
 5. Click OK, the Simulation Editor (Figure 9.23) will close. 
 
9.2.3 Time Window Interval Generator 
 
Models can run on a continuous basis in a deterministic simulation. An analysis period can be 
one year or one hundred or more years, based on the boundary condition data available for model 
simulations and the type of analysis.  HEC-FIA is an event based software application, and when  
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HEC-FIA is used within a multi-year deterministic simulation, damage and life loss are only 
computed for the maximum flood event within the analysis period.  If the user is interested in 
average annual damage (damage computed for each year and then averaged) within a 
deterministic compute that spans multiple years, the time window interval generator must be 
used to create annual time windows within an analysis period. The time window interval 
generator feature is only available for the deterministic compute type. The user creates a Time 
Window Interval Generator Alternative (Figure 9.24) and adds the alternative to the user 
created program order for an HEC-WAT simulation.  To use a time window interval generator 
alternative in an HEC-WAT simulation, the program order (Chapter 11, Section 11.1) for the 
simulation must include a time window interval generator in the compute sequence. 
 

 
Figure 9.24  Create New Time Window Interval Generator Alternative Dialog Box 
 
The time window interval generator alternative sets the simulation start time equal to the analysis 
period start time included in the simulation. During the simulation compute, any model 
alternatives listed above the time window interval generator alternative in the compute sequence 
for the simulation will run continuously for the entire analysis period. However, any model 
alternatives listed after the time window interval generator alternative in the compute sequence 
will run independent simulations that are broken up by years. Results are stored for each 
individual year within the analysis period in the results DSS file. The time window modifier 
model alternative (Section 9.3.2) can be used following a time window interval generator 
alternative in a program order to further shorten the time window parameters (e.g., shorten the 
time window to ten days before the peak flow and three days after the peak flow) within each 
year. 
 
For example, the time window interval generator alternative can be used so that the user could 
compute average annual damage within a deterministic simulation that spans fifty-years. The 
program order would consist of the time window interval generator alternative (if Time-Window 
Interval Generator does not display, the time-window interval generator plug-in (Chapter 4, 
Section 4.1.5) has not been enabled for the study), followed by the HEC-RAS and HEC-FIA 
software applications. If a fifty-year analysis period was selected, from 01 Jan 1950 to 31 Dec 
1999, then the time window interval generator alternative would create fifty separate time 
windows within the overall analysis period.  The RAS and FIA model alternatives would run 
independently for each of the fifty years, with results reported in separate event folders for each 
year.  Time window adjustment(s) or time window modifier alternative(s) could be used within 
each year to further shorten the model simulation time windows.  
 
To create a new time window interval generator alternative: 
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 1. From the HEC-WAT main window (Figure 9.1), from the Study Pane, expand the 
Models folder. Right-click on Time-Window Interval Generator (if Time-Window 
Interval Generator does not display, the time-window interval generator plug-in (Chapter 
4, Section 4.1.5) has not been enabled for the study), and from the shortcut menu, click 
New. The Create New Time Window Interval Generator Alternative dialog box will 
open (Figure 9.24). 

 
 2. In the Name box (Figure 9.24), enter a name for the time window interval generator 

alternative. Enter a description (optional, but recommended) in the Description box.  
 
 3. Click OK. The Create New Time Window Interval Generator Alternative dialog box 

will close (Figure 9.24), and the Time-Window Interval Generator Editor will open 
(Figure 9.25). The newly created time window interval generator alternative will be listed 
in the Content Pane of the HEC-WAT main window (Figure 9.1). 

 

 
Figure 9.25  Time-Window Interval Generator Editor 

 
 4. In the Time-Window Interval Generator Editor (Figure 9.25) there is currently only 

one option available for the Start Date, Use Simulation Start Time, which is 
automatically selected. If the analysis period begins on October 1, then the event time 
windows would line up with the standard water year.  If the analysis period begins on 
January 1, then the event windows would line up with the calendar year.  When a time 
window interval generator alternative is included in a simulation, the simulation time 
window passed to subsequent model alternatives in the compute sequence is discretized 
into a series of annual events, with the start date of the first event set equal to the Start 
Date of the analysis period associated with the simulation.  If using a time window 
modifier alternative to further shorten the annual time windows is being considered, place 
the time window modifier alternative after the time window interval generator alternative 
in the compute sequence. 

 
 5. Click OK, the Time-Window Interval Generator Editor (Figure 9.25) will close. A 

time window interval generator alternative has now been created. 
 
Simulation Editor 
 
Now that a time window interval generator alternative has been created, the user will decide on 
which model alternatives to apply the time window interval generator alternative. Note that 
multiple time window interval generator alternatives can be defined within one simulation, and 
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conversely, multiple model alternatives can reference the same time window interval generator 
alternative. 
 
 1. From the HEC-WAT main window (Figure 9.1), from the Study Tree, from the 

Alternatives node, from the Simulation folder, right-click on a simulation.  From the 
shortcut menu click Edit Simulation. 

 
 2. The Simulation Editor will open (Figure 9.26). In the table, the Program column 

(Figure 9.26) will contain the names of the software applications.  The software 
applications that display are determined by the selected program order (e.g., POR_Full 
sequence) from the Program Order list (Figure 9.26). If Time-Window Interval 
Generator is not listed in the Program column, the selected program order does not 
include Time-Window Interval Generator (Chapter 11, Section 11.1). The Alternative 
column will contain the time-window interval generator alternative name (i.e., Annual) 
used in the compute sequence for the selected simulation.  

 

 
Figure 9.26  Simulation Editor – Simulation with Time Window Interval Generator Alternative 

 
 3. When this example (Figure 9.26) simulation computes, once the HMS and ResSim model 

alternatives have run using the defined simulation time window, the time window interval 
generator alternative (i.e., Annual) will create annual time windows (events) within the 
simulation time window.  The time window modifier alternative (i.e., AnnualPeaks 

  _POR) will modify the simulation time window for the model alternatives below the time 
window modifier alternative in the Simulation Editor (Figure 9.26).  

 
  Note:  When using a time window interval generator alternative and a time window 

modifier alternative, the sequence should be the time window interval generator 
alternative first and the time window modifier alternative second (Figure 9.26). 

 
 5. Click OK, the Simulation Editor (Figure 9.26) will close. 
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9.3 Analysis Periods – Alternative and Simulation 
Manager 

 
Analysis periods can also be managed from the Alternative and Simulation Manager, which is 
covered in in the following sections. 
 
9.3.1 Create an Analysis Period 
 
 1. From the HEC-WAT main window (Figure 9.1), from the WAT Tools toolbar, click       . 

The Alternative and Simulation Manager will open (Figure 9.27). 
 

 
Figure 9.27  Alternative and Simulation Manager 

 
 2. From the Alternative and Simulation Manager toolbar, click       ; or from the File 

menu, point to Analysis Periods, click New; or, from the table (Figure 9.27), right-click 
on the Analysis Periods header, from the shortcut menu (Figure 9.2), click New.  The 
Create New Analysis Period dialog box will open (Figure 9.3). 

 
 3. In the Name box (Figure 9.3), enter a name (required) for the analysis period.  Optionally 

(but recommended), the user can enter a description in the Description box (Figure 9.3). 
 
 4. In the Time Window box (Figure 9.3), enter a start date in the Start Date box and a start 

time in the Start Time box.  Enter the end date of the time window in the End Date box, 
and enter the end time in the End Time box. 

 
 5. Click OK.  The Create New Analysis Period dialog box (Figure 9.3) will close.  The 

new analysis period is now displayed on the Study Tree, under the Analysis Period 
folder (Figure 9.1). 

 
9.3.2 Delete Analysis Period(s) 
 
 1. From the Alternative and Simulation Manager (Figure 9.27), from the File menu, point 

to Analysis Periods, click Delete from Study. 
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 2. The Delete Analysis Period(s) dialog box will open (Figure 9.4).  This dialog box allows 
the user to delete one or more analysis periods at one time.  From the Existing box select 
the analysis periods to be deleted. To select more than one, hold down the Shift key 
before selecting the analysis periods. The names selected will display in the Name field 
of the Delete Object box.  Click Delete, a warning message box will appear, checking to 
see if the user really wants to delete the selected analysis periods, click Yes. 

 
 3. The Delete Analysis Period(s) dialog box will close (Figure 9.4) and the selected 

analysis periods are no longer displayed under the Analysis Period folder in the Study 
Tree. 

 
9.3.3 Individual Analysis Periods 
 
When an analysis period has been created, from the Alternative Simulation Manager (Figure 
9.27), from the table, right-click on the header that contains the name of the individual analysis 
period(s). By right-clicking on an analysis period, a shortcut menu (Figure 9.5) becomes 
available.  From the shortcut menu the user can perform various functions on individual analysis 
periods. 
 
Edit 
 
To edit an analysis period: 
 
 1. From the Alternative and Simulation Manager (Figure 9.27), from the table, right-click 

on the header that contains the name of the individual analysis period.  From the shortcut 
menu (Figure 9.5), click Edit.  Alternatively, from the Alternative and Simulation 
Manager (Figure 9.27), from the Edit menu, click Analysis Periods. Either way, the 
Analysis Period Editor will open (Figure 9.6). 

 
 2. The user can edit any of the analysis period data from the editor.  Once the edits are done, 

click OK.  The Analysis Period Editor will close (Figure 9.5). 
 
Save 
 
When an analysis period has been changed and the Analysis Period Editor has been closed, the 
user can save the analysis period information. From the Alternative and Simulation Manager 
(Figure 9.27), from the table, right-click on the header that contains the name of the individual 
analysis period.  From the shortcut menu (Figure 9.5) click Save. 
 
Save As 
 
To make a copy of an analysis period: 
 
 1. From the Alternative and Simulation Manager (Figure 9.27), from the table, right-click 

on the header that contains the name of the individual analysis period.  From the shortcut 
menu (Figure 9.5) click Save As. 
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 2. The Save Analysis Period As dialog box will open (Figure 9.7).  In the Name box, enter 
a name for new analysis period.  Click OK, the Save Analysis Period As dialog box will 
close (Figure 9.8).  The new analysis period will appear on the Study Tree, under the 
Analysis Periods folder. 

 
Delete From Study 
 
To delete an individual analysis period: 
 
 1. From the Alternative and Simulation Manager (Figure 9.27), from the table, right-click 

on the header that contains the name of the individual analysis period.  From the shortcut 
menu (Figure 9.5) click Delete from Study. 

 
 2. A Confirm Manager Delete message window will appear, checking to see if the user 

really wants to delete the selected analysis period, click Yes.  The message window will 
close and the name of the selected analysis period is no longer displayed under the 
Analysis Period folder in the Study Tree. 

 
Analysis Period Properties 
 
The properties of an analysis period include the name, description, when the analysis period was 
modified, who created the analysis period, when it was created, and the file that contains the 
analysis period data.  From the Alternative and Simulation Manager (Figure 9.27), from the 
table, right-click on the header that contains the name of the individual analysis period, from the 
shortcut menu (Figure 9.5), click Properties.  The Properties for AnalysisPeriodName dialog 
box will open (Figure 9.8). 
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CHAPTER 10  
 

Create and Manage Alternatives 
 
10.1 Overview 
 
The start of most studies involves defining the problem, establishing the scope, and formulating 
alternative solutions to be evaluated.  HEC-WAT will help define alternatives through schematic 
representations, model alternative identification, and compute sequencing.  An alternative in 
HEC-WAT is a representation of the physical and operational system, and groups a schematic 
with different measures, operations, and model alternatives.  For example, one alternative could 
be a "current conditions" alternative that represents the current condition in the study area, 
including the current reservoir operational scheme.  Additional alternatives could be some future 
condition, which represents changes to land use, and alternatives representing differing reservoir 
operational schemes or flood damage reduction measures. The alternative framework within 
HEC-WAT facilitates creation of simulations across all defined alternatives (using the same 
analysis period for each), and comparison of model alternative results.  
 
10.2 Default Alternative – Without Project Conditions 
 
When an HEC-WAT study is created (Chapter 4, Section 4.1.1), a default alternative is generated 
(Figure 10.1).  By default, this alternative is given the name Without Project Conditions, the user 
can select several other name choices, or, a user can provide a name for the default alternative.   
 

 
Figure 10.1  Default Alternative Name 
 
Once the study is created, a schematic map window opens in the Desktop Pane (Chapter 3).  
The first action following the creation of the default alternative should be to define the default 
schematic (Chapter 6).  After defining the default schematic, analysis periods and simulations 
can then be created for the default alternative. 
 
10.3 Alternatives - Alternative and Simulation Manager 
 
After the default alternative has been created, the remaining alternatives that have been identified 
by the study team need to be developed.  The Alternative and Simulation Manager (Figure 
10.2) can be used for organizing and developing alternatives.  The Alternative and Simulation  
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Figure 10.2  Alternative and Simulation Manager 
 
Manager (Figure 10.2) provides a convenient way to organize and develop the main components 
for an HEC-WAT study – alternatives, analysis period (time window), and simulations.  The 
Alternative and Simulation Manager has three areas where the user can access commands that 
will allow the user to create, delete, and rename alternatives.  These areas are the Table, 
Toolbar, and Menu Bar.  The Table allows organization of a study's alternatives; a way to track 
the state of datasets needed for each model, create analysis periods, and create simulations. 
 
To access the Alternative and Simulation Manager, from the HEC-WAT main window 
(Figure 10.3), from the WAT Tools toolbar, click      .  Alternatively, from the Edit menu, click 
Alternative and Simulation Manager.  From either method the Alternative and Simulation 
Manager will open (Figure 10.2). 
 
10.3.1 Create an Alternative 
 
To create an alternative: 
 
 1. From the Alternative and Simulation Manager (Figure 10.2), right-click on the 

Alternatives header in the table, from the shortcut menu (Figure 10.4); or from the 
toolbar click      ; or from the File menu, point to Alternatives, click New. 

 
 2. The Create New Alternative dialog box will open (Figure 10.5). In the Name box enter 

the name (required), and in the Description box, enter a description (optional, but 
recommended). 
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Figure 10.3  HEC-WAT Main Window 
 
 

 
Figure 10.4  Alternatives Shortcut Menu 
 
 

 
Figure 10.5  Create New Alternative Dialog Box 
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 3. Each alternative requires a schematic to provide the layout of the study area measures and 
components (Chapter 6).  From the Schematic list, select a previously defined schematic 
(proceed to Step 4), or create a schematic for the alternative (see Step 6). 

 
 4. Click OK, if there is no map window open in the Desktop Pane, the Create New 

Alternative dialog box (Figure 10.5) will close and an alternative map window will open 
in the Desktop Pane. 

 
 5. If a map window is open in the Desktop Pane, the Select Map dialog box will open 

(Figure 10.6).  The user can choose whether to open the alternative map window in the 
current map window or in a new map window, click OK.  The Select Map dialog box 
(Figure 10.6) and the Create New Alternative dialog box (Figure 10.5) will both close, 
and the map window for the new alternative will appear in the Desktop Pane. 

 

 
Figure 10.6  Select Map Dialog Box 

 
 6. If a schematic needs to be created for the alternative, from the Schematic list (Figure 

10.5), click <Create New Schematic>.  Click OK, a warning message appears letting the 
user know that a schematic was not selected, and asks the user to create a new schematic, 
click Yes.  The Create New Schematics dialog box will open (Figure 10.7).  The name 
of the alternative will appear in the Name box for the new schematic.  The user can 
accept this name or enter a name for the schematic in the Name box.  The user can also 
enter a description in the Description box (optional, but recommended).   

 

 
Figure 10.7  Create New Schematics Dialog Box 
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 7. Click OK, if there is no map window open in the Desktop Pane, the Create New 
Schematics dialog box (Figure 10.7) will close and an alternative map window will open 
in the Desktop Pane (Figure 10.8).  The user will need to add measures for the new 
schematic (Chapter 6). 

 

 
Figure 10.8  Alternative Map Window 

 
 8. If a map window is open in the Desktop Pane, the Select Map dialog box will open 

(Figure 10.6).  The user can choose whether to open the alternative map window in the 
current map window or in a new map window, click OK.  The Select Map dialog box 
(Figure 10.6) and the Create New Schematics dialog box (Figure 10.7) will both close, 
and the map window for the new alternative will appear in the Desktop Pane. 

 
 9. The alternative name will now appear in the table on the Alternative and Simulation 

Manager, under the Alternatives column header (Figure 10.9). 
 

 
Figure 10.9  Alternative and Simulation Manager – Additional Alternatives 
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10.3.2 Delete Alternatives 
 
To delete alternatives from a study: 
 
 1. From the Alternative and Simulation Manager (Figure 10.9), right-click on the 

Alternatives header in the table, from the shortcut menu (Figure 10.4); or from the File 
menu, point to Alternatives, click Delete from Study, the Delete Alternative(s) dialog 
box will open (Figure 10.10). 

 

 
Figure 10.10  Delete Alternative(s) Dialog Box 

 
 2. From the Existing list select alternative(s), in the Delete Object box (Figure 10.10) the 

name(s) and descriptions of the selected alternative(s) will appear. 
 
 3. Click Delete, a warning message will appear asking the user if the user really wants to 

delete the selected alternative(s).  Click Yes, the warning message will close, the Delete 
Alternative(s) dialog box will close (Figure 10.10), and the selected alternative(s) will no 
longer appear under the Alternatives column of the Alternative and Simulation 
Manager (Figure 10.9). 

 
10.3.3 Individual Alternatives 
 
The individual alternative shortcut menu (Figure 10.11) is available from the Alternative and 
Simulation Manager (Figure 10.9), by right-clicking on an alternative name in the table.  This 
shortcut menu allows the user to view the selected alternative in a map window, save, make a 
copy, delete from the study, and view the properties of the alternative.  The following sections 
provide further details.  
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Figure 10.11  Alternative and Simulation Manager – Individual Alternative Shortcut Menu 
 
View 
 
To view an alternative in a map window: 
 
 1. From the Alternative and Simulation Manager (Figure 10.9), right-click on an 

alternative in the table.  From the individual alternative shortcut menu (Figure 10.11), 
click Display in Map Window. 

 
 2. If there is not a map window open in the Desktop Pane, the alternative map window for 

the alternative will open in the Desktop Pane.  From the alternative map window the user 
can edit the stream alignment, measures, impact areas, and adjust background maps 
associated with the alternative. 

 
 3. If a map window is open in the Desktop Pane, the Select Map dialog box (Figure 10.6) 

will open.  The user can choose whether to open the alternative map window in the 
current map window or in a new map window, click OK.  The Select Map dialog box 
(Figure 10.6) will close, and the alternative map window for the selected alternative will 
appear in the Desktop Pane. 

 
Save 
 
To save an alternative, from the individual alternative shortcut menu (Figure 10.11), click Save.  
Any changes that have occurred to the selected alternative will be saved by HEC-WAT. 
 
Save As 
 
To make a copy from an existing alternative: 
 
 1. From the individual alternative shortcut menu (Figure 10.11), click Save As.  The Save 

Alternative As dialog box will open (Figure 10.12).  The information displayed in the 
dialog box represents the alternative has been selected for copying. 

 
 2. In the Name box, enter the name (required) of the new alternative, and in the 

Description box, enter a description (optional, but recommended). 
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Figure 10.12  Save Alternative As Dialog Box 

 
 3. The user can also choose to create a copy of the associated schematic (will create a new 

schematic with the new alternative name) or use the associated schematic of the existing 
alternative the user has selected to make a copy of. 

 
 4. The alternative name will now appear in the table on the Alternative and Simulation 

Manager, under the Alternatives column header (Figure 10.9). 
 
Delete from Study 
 
To delete an alternative, right-click on an alternative in the table on the Alternative and 
Simulation Manager (Figure 10.9), from the individual alternative shortcut menu (Figure 
10.11), click Delete From Study.  A Confirm Manager Delete warning message will appear 
asking the user if you really want to delete the selected alternative.  Click Yes, the warning 
message will close.  The alternative will no longer appear on the table in the Alternative and 
Simulation Manager (Figure 10.9). 
 
Alternative Properties 
 
The properties of an alternative include the name, description, when the alternative was 
modified, who created the alternative, when the alternative was created, and the file that contains 
the alternative data.  To view the properties of an alternative: 
 
 1. From the individual alternative shortcut menu (Figure 10.11), click Properties.  The 

Properties for AlternativeName dialog box will open (Figure 10.13). 
 
 2. For HEC-WAT Version 1.0, the properties for viewing are the name and description of 

the selected alternative; the date and time the alternative was last modified (not the date 
and time that individual models making up the simulation were last modified); the 
location of the alternative file; and, the name of the file which contains information about 
the alternative. 
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Figure 10.13  Properties for AlternativeName Dialog Box 

 
10.3.4 Toolbar 
 
From the toolbar of the Alternative and Simulation Manager (Figure 10.9), the user can create 
an alternative.  Click      , the Create New Alternative dialog box will open (Figure 10.5).  The 
steps for creating an alternative are the same as in Creating an Alternative Section 10.3.1.  
 
10.3.5 Menu Bar 
 
From the Menu Bar of the Alternative and Simulation Manager (Figure 10.9), the user can 
create and delete alternatives (Sections 10.3.1 and 10.3.2). 
 
10.3.6 ToolTips 
 
From the Alternative and Simulation Manager (Figure 10.14) the user can review information 
regarding the status of certain elements of the study.  For example, in Figure 10.14, hover the 
mouse over the alternative Without Project Conditions, a small box will appear, this is a tooltip.  
This tooltip provides the name and description of the alternative.  Chapter 4, Section 4.1.5 
provide details on how information is entered that a tooltip displays.  By default tooltips in HEC-
WAT are displayed, if the user does not want tooltips displayed, Appendix B, Section B.2.1 will 
provide further information. 
 
10.4 Alternatives – Study Tree 
 
The user can also create, view, save, save as, delete, and view properties of alternatives from the 
Study Pane (Study Tree).  This section of the chapter describes how to perform these operations 
directly from the Study Tree. 
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Figure 10.14  Alternative and Simulation Manager - Tooltip 
 
10.4.1 Create an Alternative 
 
 1. From the HEC-WAT main window (Figure 10.3), from the Study Tree, right-click on 

the Alternatives folder.  From the shortcut menu click New, the Create New 
Alternative dialog box will open (Figure 10.4). 

 
 2. The steps for creating an alternative are the same as in the Creating an Alternative, 

Section 10.3.1. 
 
10.4.2 Individual Alternatives 
 
When an alternative has been created, from the Study Tree, under the Alternatives folder, the 
alternatives defined for the HEC-WAT study are displayed. By right-clicking on an alternative, a 
shortcut menu (Figure 10.15) becomes available.  From the shortcut menu the user can perform 
various functions on individual alternatives. 
 

 
Figure 10.15  Study Tree – Individual Alternative Shortcut Menu 
 
View 
 
To view an alternative in a map window: 
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 1. From the HEC-WAT main window (Figure 10.3), from the Study Tree, under the 

Alternatives node, right-click an individual alternative. From the individual alternative 
shortcut menu (Figure 10.15), click Display in Map Window. 

 
 2. If there is not a map window open in the Desktop Pane, the alternative map window for 

the alternative will open in the Desktop Pane.  From the alternative map window the user 
can edit the stream alignment, measures, impact areas, and adjust background maps 
associated with the alternative. 

 
 3. If a map window is open in the Desktop Pane, the Select Map dialog box (Figure 10.6) 

will open.  The user can choose whether to open the alternative map window in the 
current map window or in a new map window, click OK.  The Select Map dialog box 
(Figure 10.6) will close, and the alternative map window for the selected alternative will 
appear in the Desktop Pane. 

 
Save 
 
To save an alternative, from the individual alternative shortcut menu (Figure 10.15), click Save.  
Any changes that have occurred to the selected alternative will be saved by HEC-WAT. 
 
Save As 
 
To make a copy from an existing alternative: 
 
 1. From the individual alternative shortcut menu (Figure 10.15), click Save As.  The Save 

Alternative As dialog box will open (Figure 10.12).  The information displayed in the 
dialog box represents the alternative has been selected for copying. 

 
 2. In the Name box, enter the name (required) of the new alternative, and in the 

Description box, enter a description (optional, but recommended). 
 
 3. The user can also choose to create a copy of the associated schematic (will create a new 

schematic with the new alternative name) or use the associated schematic of the 
alternative the user has selected to make a copy of. 

 
 4. The alternative name will now appear on the Study Tree, under the Alternatives folder 

(Figure 10.3). 
 
Delete from Study 
 
To delete an alternative, from the individual alternative shortcut menu (Figure 10.15), click 
Delete From Study.  A Confirm Manager Delete warning message will appear asking the user  
does the user really want to delete the selected alternative.  Click Yes, the warning message will 
close.  The alternative will no longer appear on the Study Tree under the Alternatives folder 
(Figure 10.3). 
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Alternative Properties 
 
The properties of an alternative include the name, description, when the alternative was 
modified, who created the alternative, when the alternative was created, and the file that contains 
the alternative data.  To view the properties of an individual alternative, from the individual 
alternative shortcut menu (Figure 10.15), click Properties.  The Properties for 
AlternativeName dialog box will open (Figure 10.13).  See Section 10.3.3 for further details 
about alternative properties. 
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CHAPTER 11  
 

Create and Manage Simulations 
 
Once model alternatives have been imported, and HEC-WAT alternatives and analysis periods 
have been defined, the user can create an HEC-WAT simulation.  A simulation in HEC-WAT is 
a combination of an analysis period and an alternative.  A program order (sequence of software 
applications) will also need to be established.  This chapter covers creating a program order (if 
necessary), and how to create, edit, and manage simulations. 
 
11.1 Program Order 
 
HEC-WAT provides a flexible set of software applications, computation sequence, and data flow 
for individual simulations.  The user can establish several different program orders for one HEC-
WAT study.  HEC-WAT has a default program order named Default, which consists of HEC-
HMS, HEC-ResSim, HEC-RAS and HEC-FIA. 
 
11.1.1 HEC-WAT Main Window 
 
From the HEC-WAT main window (Figure 11.1), the user can manipulate program orders either 
from the Toolbar, click      , or from the Edit menu, click Program Order.  From either method, 
the Program Order dialog box will open (Figure 11.2). 
 

 
Figure 11.1  HEC-WAT Main Window 
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Figure 11.2  Program Order Dialog Box 
 
11.1.2 Alternative and Simulation Manager 
 
From the Alternative and Simulation Manager (Figure 11.3), the user can define or edit a 
program order either from the Toolbar, by clicking      , or from the Edit menu, by clicking 
Program Order.  From either method, the Program Order dialog box will open (Figure 11.2). 
 

 
Figure 11.3  Alternative and Simulation Manager 
 
11.1.3 Create a Program Order 
 
To create a program order: 
 
 1. By default, the Default program order is displayed in the Program Order dialog box 

(Figure 11.2).  To create a new program order, from the Program Order dialog box, from 
the Program menu, click New.  The New Program Order dialog box will open (Figure 
11.4). 
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Figure 11.4  New Program Order Dialog Box 

 
 2. In the Name box (Figure 11.4) enter a name for the program order.  Optionally (but 

recommended), the user can provide a description in the Description box, and if the 
software application has an icon that represents the software, the user can enter the 
location of the icon file in the Icon box (Figure 11.4).  The user can also browse to the 
location of the icon file by clicking     , an Open browser will open.  Navigate to the 
directory where the icon file is be stored, click Open.  The Open browser will close and 
the location of the icon file will display in the Icon box (Figure 11.4). 

 
 3. To select the software applications that are wanted in the program order, click Select 

Programs, the Selection Editor will open (Figure 11.5).  From the Available list, select 
the software applications that are required for the program order.  Click Add, the name of 
the selected software applications will move to the Selected list (Figure 11.5).  Make sure 
to add the software applications in the order that the software applications will appear 
within the compute sequence.  HEC-WAT will direct the applications to compute in the 
defined order.  

 

 
Figure 11.5  Selection Editor 
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 4. Once all the software applications have been selected, click OK, the Selection Editor will 
close (Figure 11.5).  On the New Program Order dialog box (Figure 11.4) the names of 
the selected software applications will appear.  Click OK, the New Program Order 
dialog box (Figure 11.4) will close. 

 
 5. On the Program Order dialog box (Figure 11.2) the name of the new program order will 

appear in the Name list, and the table will display the software applications selected. 
 
11.1.4 Delete a Program Order 
 
Deleting or editing a program order that is part of a simulation is not recommended.  A new 
program order should be created and then the simulation should be edited to use the new program 
order.  If a program order is deleted or edited that is part of a simulation, the simulation associated 
with that program order should be deleted and then re-created. 
 
 1. From the Program Order dialog box (Figure 11.2), from the Name list, select the 

program order that is to be deleted. 
 
 2. From the Program menu, click Delete.  A Confirm Deletion window will open asking 

the user if the user really wants to delete this program order.  Click Yes, the Confirm 
Deletion window will close and the selected program order is deleted. 

 
11.1.5 Edit a Program Order 
 
Editing or deleting a program order that is part of a simulation is not recommended.  A new 
program order should be created and then the simulation should be edited to use the new program 
order.  If a program order is edited or deleted that is part of a simulation, the simulation associated 
with that program order should be deleted and then re-created. 
 
 1. From the Program Order dialog box (Figure 11.2), from the Edit menu, the user can 

insert a new software application into a program order or remove a software application 
from a program order. 

 
 2. To add a software application to the selected program order, select a row in the table on 

the Program Order dialog box (Figure 11.6).  From the Edit menu, click either Insert 
Before or Insert After, the Select Program dialog box will open (Figure 11.7). 

 
 3. From the Name list select the software application that is to be added to the program 

order, click OK.  The Select Program dialog box will close (Figure 11.7) and the selected 
software application will be added to the program order displayed on the Program Order 
dialog box (Figure 11.6).  Click Apply to save the change. 

 
 4. To remove a software application from the program order, select a row in the table on the 

Program Order dialog box (11.6).  From the Edit menu, click Remove.  A Confirm 
Removal window will open, checking with the user to be sure that the selected software 
application is to be removed, click Yes.  The Confirm Removal window will close, the  
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Figure 11.6  Program Order Dialog Box – Software Application Selected 

 

 
Figure 11.7  Select Program Dialog Box 

 
  selected software application no longer is displayed in the table.  Click Apply (Figure 

11.6) to save the change. 
 
 5. A Confirm Save window will open, letting the user know that making a change to a 

program order that is already being used in an existing simulation will affect that 
simulation, click Yes.  The Confirm Save window closes, and the change is saved to the 
selected program order. 

 
11.2 Simulations – Alternative and Simulation Manager 
 
In HEC-WAT, the Alternative and Simulation Manager (Figure 11. 3) provides a convenient 
way to organize and develop the main components for an HEC-WAT study – alternatives, 
analysis period (time window), and simulations.  From the table on the Alternative and 
Simulation Manager (Figure 11.3) the user can organize a study's alternatives; a way to track the 
state of datasets needed for each model alternative; create analysis periods (time windows; 
Chapter 9); and, create simulations.  Since the focus of this chapter is simulations, the focus of 
this section will only be on the available commands from the table to develop and organize 
simulations. 
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To access the Alternative and Simulation Manager, from the HEC-WAT main window (Figure 
11.1), from the WAT Tools toolbar (Chapter 3, Section 3.2.1), click      ; or, from the Edit menu, 
click Alternative and Simulation Manager.  From either method the Alternative and 
Simulation Manager will open (Figure 11.3). 
 
11.2.1 Create a Simulation - Table 
 
In the table, when an intersection is blank, the user can create a simulation: 
 
 1. From the Alternative and Simulation Manager (Figure 11.8), from the table, right-click 

on the intersection of an alternative and analysis period (blank).  From the shortcut menu 
click Create Simulation.  The Create New Simulation dialog box will open (Figure 
11.9). 

 

 
Figure 11.8  Alternative and Simulation Manager - Table 

 
 2. HEC-WAT has defined a default name for the simulation (e.g., Without Project 

Conditions-RR_Feb1986) in the Name box (Figure 11.9).  The name is a combination of 
the HEC-WAT alternative name and analysis period name, where the intersection was in 
the table (name can be changed).  Also, in the Alternative and Analysis Period lists 
(Figure11.9) the selections have already been made based on the intersection in the table.  
The selected Alternative cannot be changed, but the selected Analysis Period can be 
changed. 

 
 3. The program order is Default. 
 
 4. In the F Part box (Figure 11.9), a DSS F-Part is displayed that was generated by HEC-

WAT based on the alternative and analysis period names.  
 
 5. In the Programs table (Figure 11.9), the software applications that were defined in the 

program order appear in the order the software applications were selected.  Now the user 
must select the appropriate alternative (i.e., plan, run) for each software application. From 
the Alternative column, for example, from the list for HMS (Figure 11.10), select the 
appropriate HEC-HMS run ((RUN)Feb_1986).  Repeat the process for the other software 
applications.  
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Figure 11.9  Create New Simulation Dialog Box 

 

 
Figure 11.10  Selection of Model Alternatives - Create New Simulation Dialog Box 

 
 6. Now that all of the alternatives have been selected, click OK.  The Create New 

Simulation dialog box will close (Figure 11.9).  On the Alternative and Simulation 
Manager (Figure 11.11), the intersection of the alternative and analysis period now 
provides information about the simulation. 

 

 
Figure 11.11  Alternative and Simulation Manager - Completed Simulation 
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 7. Click OK; the Alternative and Simulation Manager will close (Figure 11.11).  From the 
HEC-WAT main window (Figure 11.1), the created simulation appears on the Study 
Tree, under the Simulations folder (Figure 11.12). 

 

 
Figure 11.12  Study Tree with Created Simulation 

 
 8. The Content Pane (Figure 11.13) displays information about the selected simulation. 
 

 
Figure 11.13  Content Pane 

 
 9. Double click on the simulation name (e.g., Without Project Conditions-RR_Feb1986), a 

Select Map dialog box will open. Click New Map Window, click OK. The Select Map 
dialog box will close.  The new map window will contain the schematic elements that 
represent the simulation (Figure 11.1). 

 
11.2.2 Create a Simulation - From another Simulation - Table 
 
In the table, when an intersection is blank, the user can create a simulation from another 
simulation: 
 
 1. From the Alternative and Simulation Manager (Figure 11.8), from the table, right-click 

on the intersection of an alternative and analysis period (blank).  From the shortcut menu 
click Create Simulation From. 

 
 2. The Select Simulation selector will open (Figure 11.14).  From the Existing box, select a 

simulation, the name of the simulation will appear in the Name box.  Click Open, the  
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Figure 11.14  Select Simulation Selector 

 
  Select Simulation selector will close (Figure 11.14) and the Create New Simulation 

dialog box will open (Figure 11.9). 
 
 3. HEC-WAT has defined a default name for the simulation (e.g., Without Project 

Conditions-RR_Jan1986) in the Name box (Figure 11.9).  The name is a combination of 
the HEC-WAT alternative name and analysis period name, where the intersection was in 
the table (name can be changed).  Also, in the Alternative and Analysis Period lists 
(Figure 11.9) the selections have already been made based on the intersection in the table.  
The selected Alternative cannot be changed, but the selected Analysis Period can be 
changed. 

 
 4. The program order is Default. 
 
 5. In the F Part box (Figure 11.9), a DSS F-Part is displayed that was generated by HEC-

WAT based on the alternative and analysis period names. 
 
 6. In the Programs table (Figure 11.9), the software applications that were defined in the 

program order appear in the order the software applications were selected.  The model 
alternative (i.e., plan, run) for each software application that was created for the simulation 
that was being copied from is displayed.  The user can make adjustments if warranted for 
this new simulation. 

 
 7. Now that all of the model alternatives have been selected, click OK.  The Create New 

Simulation dialog box will close (Figure 11.9).  On the Alternative and Simulation 
Manager (Figure 11.11), the intersection of the alternative and analysis period now 
provides information about the simulation. 
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11.2.3 Create a Simulation - Toolbar 
 
From the Alternative and Simulation Manager (Figure 11.11), from the Toolbar, click       , the 
Create New Simulation dialog box will open (Figure 11.15). 
 

 
Figure 11.15  Create New Simulation Dialog Box - Blank 
 
 1. The Create New Simulation dialog box (Figure 11.15) is blank (when created from the 

table most of the information about a simulation is known).  The user must enter a name in 
the Name box.  The user can enter an optional description in the Description box. 

 
 2. From the Alternative list (Figure 11.15) select the HEC-WAT alternative that the user 

wants to analyze. 
 
 3. From the Analysis Period list select the analysis period that represents the time window 

for the analysis. 
 
 4. From the Program Order list, Default has already been selected.  If there is another 

program order that the user wants to use, then from the Program Order list, select the 
appropriate program order.  The user can also create a new program order by clicking New 
(Figure 11.15).  The New Program Order dialog box will open (Figure 11.4); follow the 
instructions in Section 11.1.3 for creating a program order. 

 
 5. Once an analysis period is selected, HEC-WAT builds a default DSS F-Part based on the 

alternative and analysis period selected. 
 
 6. In the Programs table (Figure 11.15), the software applications that were defined in the 

program order appear in the order the software applications were selected.  Now the user 
must select the appropriate model alternative (i.e., plan, run) for each program. From the 
Alternative column, for example, from the list for HMS (Figure 11.10), select the 
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appropriate HEC-HMS run ((RUN)Feb_1986).  Repeat the process for the other software 
applications.  

 
 7. Now that all of the model alternatives have been selected, click OK.  The Create New 

Simulation dialog box will close (Figure 11.15).  On the Alternative and Simulation 
Manager (Figure 11.11), the intersection of the alternative and analysis period now 
provides information about the simulation. 

 
 8. Click OK; the Alternative and Simulation Manager will close (Figure 11.11).  From the 

HEC-WAT main window (Figure 11.1), the created simulation appears on the Study 
Tree, under the Simulations folder (Figure 11.12). 

 
 9. The Content Pane (Figure 11.13) displays information about the selected simulation. 
 
 10. Double click on the simulation name (Without Project Conditions-RR_Feb1986), a Select 

Map dialog box will open. Click New Map Window, click OK. The Select Map dialog 
box will close.  The new map window will contain the schematic elements that represent 
the simulation (Figure 11.1). 

 
11.2.4 Create a Simulation – File Menu 
 
From the Alternative and Simulation Manager (Figure 11.3), from the File menu, point to 
Simulation, click New, the Create New Simulation dialog box will open (Figure 11.15).  The 
instructions for creating a simulation are the same as described in Section 11.2.2. 
 
11.2.5 Delete Simulation(s) 
 
To delete simulation(s) from a study: 
 
 1. From the Alternative and Simulation Manager (Figure 11.3), from the File menu, point 

to Simulation, click Delete from Study, the Delete Simulation(s) dialog box will open 
(Figure 11.16). 

 
 2. From the Existing list select simulation(s), in the Delete box the name(s) and descriptions 

of the selected simulation(s) will appear. 
 
 3. Click Delete, a warning message will appear asking the user if the user really wants to 

delete the selected simulation(s).  Click Yes, the warning message will close and the 
Delete Simulations(s) dialog box will close (Figure 11.16) and the simulation(s) will no 
longer appear under the Simulation column of the table (Figure 11.11). 

 
11.2.6 Individual Simulation Shortcut Menu - Table 
 
The individual simulation shortcut menu (Figure 11.17) is available from the Alternative and 
Simulation Manager (Figure 11.11) by right-clicking on a simulation in the table.  This shortcut 
menu will allow the user to view the selected simulation in a map window; edit the model 
alternatives associated with the selected simulation; remove the simulation map window; edit the 
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Figure 11.16  Delete Simulation(s) Dialog Box 
 

 
Figure 11.17  Individual Simulation Shortcut Menu 
 
active simulation; open the Model Linking Editor (Chapter 12); compute; view the log of the 
compute; view results; save changes to the simulation; delete the simulation from the study; view 
the properties of the simulation; and, browse the run folder associated with the active simulation.  
The following sections provide further details on these capabilities from the individual simulation 
shortcut menu (Figure 11.17).  
 
View a Simulation 
 
To view a simulation in a map window: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click Display in Map 

Window. 
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 2. If there is not a map window open in the Desktop Pane (Chapter 3, Section 3.2.2), the 
simulation map window for the simulation will open in the Desktop Pane.  From the 
simulation map window the user can edit the stream alignment, view model alternative 
results, and edit model alternatives that are associated with a simulation. 

 
 3. If a map window is open in the Desktop Pane (Chapter 3, Section 3.2.2), the Select Map 

dialog box (Figure 11.18) will open.  The user can choose whether to open the simulation 
map window in the current map window or in a new map window, click OK.  The Select 
Map dialog box (Figure 11.18) will close, and the simulation map window for the selected 
simulation will appear in the Desktop Pane. 

 

 
Figure 11.18  Select Map Dialog Box 

 
Edit the Model Alternatives of a Simulation 
 
To edit the model alternatives associated with a simulation: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), point to Edit Model, from 

the sub-menu (Figure 11.19) click on the model alternative that needs to be edited. 
 

 
Figure 11.19  Editing a Model Alternative 
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 2. The user must expand the Alternative and Simulation Manager (Figure 11.8) so that the 
length of the individual simulation shortcut menu fits within the manager. 

 
 3. The program associated with the model alternative that was selected will open.  For 

example, in Figure 11.19, if the model alternative calibrate is selected, the HEC-ResSim 
software will open with the calibrate alternative selected. 

 
 4. The user can now make changes to the selected model alternative, save, and close the 

program associated with the model alternative.  For further details on the individual 
program editors, see Appendix L. 

 
Remove a Simulation from the Active Map Window 
 
To remove a simulation from the active map window: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click Remove from Map 

Window. 
 
 2. The Remove from Map? message box will open asking the user if the user really wants 

to remove the simulation from the active map window, click Yes.  The message box will 
close, and the map window will no longer display the simulation. 

 
Edit a Simulation 
 
To edit a simulation: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click Edit Simulation.  The 

Simulation Editor will open (Figure 11.20). 
 

 
Figure 11.20  Simulation Editor 
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 2. The user can edit the name and the description of the simulation.  The editor also provides 
the user with information on what HEC-WAT alternative and analysis period are 
associated with the simulation.  The editor also provides information on what model 
alternatives are currently being computed for the simulation.  The user can change the 
model alternatives and setup time window adjustments (Chapter 9) for each model 
alternative. 

 
 3. Click OK, the Simulation Editor will close (Figure 11.20) and the information changed 

will be saved. 
 
Model Linking Editor 
 
Opening the Model Linking Editor (Chapter 12): 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click Model Linking 

Editor.  The Model Linking Editor will open (Figure 11.21). 
 

 
Figure 11.21  Model Linking Editor 

 
 2. The Model Linking Editor provides the user with the capability of setting up or changing 

the linking between the model alternatives of the selected simulation.  Further details on 
the Model Linking Editor are provided in Chapter 12. 

 
 3. From the File menu (Figure 11.21), click Close.  The Model Linking Editor will close 

(Figure 11.21) and the information changed will be saved. 
 
Compute a Simulation 
 
To compute a simulation (deterministic): 
 
 1. From the individual simulation shortcut menu (Figure 11.17), point to Compute, from the 

sub-menu (Figure 11.22) the user can compute the entire simulation or compute individual 
models. 
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Figure 11.22  Individual Simulation Shortcut Menu - Compute 

 
 2. The user must expand the Alternative and Simulation Manager (Figure 11.8) so that the 

length of the individual simulation shortcut menu fits within the manager. 
 
 3. To compute the simulation, hold down the CTRL key, click Simulation (Figure 11.22) 
 
 4. The Compute Progress dialog box will open (Figure 11.23) and the compute will begin.  

From this dialog box the user can view which model alternative is computing for the 
simulation and information from each model is displayed in the Compute Progress dialog 
box. 

 

 
Figure 11.23  Compute Progress Dialog Box 

 
 5. When the compute is finished click Close, the Compute Progress dialog box (Figure 

11.23) will close. 
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View the Compute Log of a Simulation 
 
To view the compute log of a simulation: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click View Compute Log.  

The SimulationName.log Editor will open (Figure 11.24). 
 

 
Figure 11.24  SimulationName.log Editor 

 
 2. This editor contains information regarding the compute for the selected simulation.  This 

information is provided by each individual software application that was part of the 
compute. 

 
 3. When the compute is finished click Close, the SimulationName.log Editor (Figure 11.24) 

will close. 
 
Simulation Results 
 
To view results for a simulation (deterministic): 
 
 1. From the individual simulation shortcut menu (Figure 11.17), point to Results, from the 

sub-menu (Figure 11.25) the user can view results from the individual models and review 
the DSS file associated with the simulation. 
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Figure 11.25  Individual Simulation Shortcut Menu – Results 

 
 2. The user must expand the Alternative and Simulation Manager (Figure 11.8) so that the 

length of the individual simulation shortcut menu fits within the manager. 
 
 3. Point to the individual software application that the user wants to display results. For 

example, in Figure 11.25, if the software application HMS is selected, a list of available 
outputs from the HEC-HMS software are listed.  Click Global Summary Table, the 
Global Summary Results dialog box will open (Figure 11.26). 

 

 
Figure 11.26  HEC-HMS Results – Global Summary Results 

 
Save a Simulation 
 
To save a simulation, from the individual simulation shortcut menu (Figure 11. 17), click Save.  
Any changes that have occurred to the selected simulation will be saved by HEC-WAT. 
 



HEC-WAT User's Manual Chapter 11 – Create and Manage Simulations 

 11-19 

Delete a Simulation 
 
To delete a simulation, right-click on a simulation in the table, from the individual simulation 
shortcut menu (Figure 11. 17), click Delete From Study.  A warning message will appear asking 
the user if the user really wants to delete the selected simulation.  Click Yes, the intersection of 
the alternative and analysis period/event that the simulation was associated with will now be 
blank in table in the Alternative and Simulation Manager (Figure 11.11). 
 
Simulation Information 
 
To view information about a simulation: 
 
 1. From the individual simulation shortcut menu (Figure 11. 17), click Properties.  The 

Properties for SimulationName dialog box will open (Figure 11.27). 
 

 
Figure 11.27  Properties for SimulationName Dialog Box 

 
 2. From this dialog box the user can view information about the selected simulation – name 

of simulation; description; date simulation was last modified; who created the simulation; 
date simulation was created; and the location of the simulation file. 

 
 3. Click Close, the Properties for SimulationName dialog box (Figure 11.27) will close. 
 
Browse Run Folder 
 
This command takes the user to the location of the results that are generated by HEC-WAT when 
a simulation is computed.  The user can view the simulation.dss file using HEC-DSSVue from 
this location; and, if the model folders have been saved the user can view results for the individual 
models from HEC-RAS, HEC-ResSim, or HEC-FIA if necessary from this location. 
 
11.3 Simulations – Study Tree 
 
The user can also create simulations; delete individual and multiple simulations; save, view, edit, 
and compute simulations.  This section of the chapter describes how to perform these operations 
directly from the Study Tree. 
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11.3.1 Create a Simulation 
 
If there are no simulations in the study, from the HEC-WAT main window (Figure 11.1), from the 
Study Tree, right-click on the Simulations folder. From the shortcut menu click New, the Create 
New Simulation dialog box will open (Figure 11.15).  The instructions for creating a simulation 
are the same as described in Section 11.2.2. 
 
11.3.2 Delete Simulation(s) 
 
To delete simulation(s) from a study: 
 
 1. From the HEC-WAT main window (Figure 11.1), from the Study Tree, right-click on the 

Simulations folder. From the shortcut menu click Delete from Study, the Delete 
Simulation(s) dialog box will open (Figure 11.16). 

 
 2. From the Existing list select simulation(s), in the Delete box the name(s) and descriptions 

of the selected simulation(s) will appear. 
 
 3. Click Delete, a warning message will appear asking the user if the user really wants to 

delete the selected simulation(s).  Click Yes, the warning message will close and the 
Delete Simulations(s) dialog box will close (Figure 11.16) and the simulation(s) will no 
longer appear under the Simulation folder of the Study Tree. 

 
11.3.3 Individual Simulation Shortcut Menu 
 
The individual simulation shortcut menu (Figure 11.14) is available from the Study Tree (Figure 
11.11), by right-clicking on a simulation under the Simulations folder.  This shortcut menu will 
allow the user to view the selected simulation in a map window; edit the model alternatives 
associated with the selected simulation; remove the simulation map window; edit the active 
simulation; open the Model Linking Editor (Chapter 12); compute; view the log of the compute; 
view results; save changes to the simulation; delete the simulation from the study; view the 
properties of the simulation; and, browse the run folder associated with the active simulation.  The 
following sections provide further details on these capabilities from the individual simulation 
shortcut menu (Figure 11.17).  
 
View a Simulation 
 
To view a simulation in a map window: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click Display in Map 

Window. 
 
 2. If there is not a map window open in the Desktop Pane (Chapter 3, Section 3.2.2), the 

simulation map window for the simulation will open in the Desktop Pane.  From the 
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simulation map window the user can edit the stream alignment, view model alternative 
results, and edit model alternatives that are associated with a simulation. 

 
 3. If a map window is open in the Desktop Pane (Chapter 3, Section 3.2.2), the Select Map 

dialog box (Figure 11.18) will open.  The user can choose whether to open the simulation 
map window in the current map window or in a new map window, click OK.  The Select 
Map dialog box (Figure 11.18) will close, and the simulation map window for the selected 
simulation will appear in the Desktop Pane. 

 
Edit the Model Alternatives of a Simulation 
 
To edit the model alternatives associated with a simulation: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), point to Edit Model, from 

the sub-menu (Figure 11.20) click on the model alternative that needs to be edited. 
 
 2. The user must expand the Alternative and Simulation Manager (Figure 11.8) so that the 

length of the individual simulation shortcut menu fits within the manager. 
 
 3. The program associated with the model alternative that was selected will open.  For 

example, in Figure 11.19, if the model alternative calibrate is selected, the HEC-ResSim 
software will open with the calibrate alternative selected. 

 
 4. The user can now make changes to the selected model alternative, save, and close the 

program associated with the model alternative.  For further details on the individual 
program editors, see Appendix L. 

 
Remove a Simulation from the Active Map Window 
 
To remove a simulation from the active map window: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click Remove from Map 

Window. 
 
 2. The Remove from Map? message box will open asking the user if the user really wants 

to remove the simulation from the active map window, click Yes.  The message box will 
close, and the map window will no longer display the simulation. 

 
Edit a Simulation 
 
To edit a simulation: 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click Edit Simulation.  The 

Simulation Editor will open (Figure 11.20). 
 
 2. The user can edit the name and the description of the simulation.  The editor also provides 

the user with information on what HEC-WAT alternative and analysis period are 
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associated with the simulation.  The editor also provides information on what model 
alternatives are currently being computed for the simulation.  The user can change the 
model alternatives and setup time window adjustments (Chapter 9) for each model 
alternative. 

 
 3. Click OK, the Simulation Editor will close (Figure 11.20) and the information changed 

will be saved. 
 
Model Linking Editor 
 
Opening the Model Linking Editor (Chapter 12): 
 
 1. From the individual simulation shortcut menu (Figure 11.17), click Model Linking 

Editor.  The Model Linking Editor will open (Figure 11.21). 
 
 2. The Model Linking Editor provides the user with the capability of setting up or changing 

the linking between the model alternatives of the selected simulation.  Further details on 
the Model Linking Editor are provided in Chapter 12. 

 
 3. From the File menu (Figure 11.21), click Close.  The Model Linking Editor will close 

(Figure 11.21) and the information changed will be saved. 
 
Compute a Simulation 
 
To compute a simulation (deterministic): 
 
 1. From the individual simulation shortcut menu (Figure 11.17), point to Compute, from the 

sub-menu (Figure 11.22) the user can compute the entire simulation or compute individual 
models. 

 
 2. The user must expand the Alternative and Simulation Manager (Figure 11.8) so that the 

length of the individual simulation shortcut menu fits within the manager. 
 
 3. To compute the simulation, hold down the CTRL key, click Simulation (Figure 11.17) 
 
 4. The Compute Progress dialog box will open (Figure 11.23) and the compute will begin.  

From this dialog box the user can view which model alternative is computing for the 
simulation and information from each model is displayed in the Compute Progress dialog 
box. 

 
 5. When the compute is finished click Close, the Compute Progress dialog box (Figure 

11.23) will close. 
 
View the Compute Log of a Simulation 
 
To view the compute log of a simulation: 
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 1. From the individual simulation shortcut menu (Figure 11.17), click View Compute Log.  

The SimulationName.log Editor will open (Figure 11.24). 
 
 2. This editor contains information regarding the compute for the selected simulation.  This 

information is provided by each individual software application that was part of the 
compute. 

 
 3. When the compute is finished click Close, the SimulationName.log Editor (Figure 11.24) 

will close. 
 
Simulation Results 
 
To view results for a simulation (deterministic): 
 
 1. From the individual simulation shortcut menu (Figure 11.17), point to Results, from the 

sub-menu (Figure 11.25) the user can view results from the individual models and review 
the DSS file associated with the simulation. 

 
 2. The user must expand the Alternative and Simulation Manager (Figure 11.8) so that the 

length of the individual simulation shortcut menu fits within the manager. 
 
 3. Point to the individual software application that the user wants to display results, for 

example, in Figure 11.25, if the software application HMS is selected, a list of available 
outputs from the HEC-HMS software are listed.  Click Global Summary Table, the 
Global Summary Results dialog box will open (Figure 11.26). 

 
Save a Simulation 
 
To save a simulation, from the individual simulation shortcut menu (Figure 11. 17), click Save.  
Any changes that have occurred to the selected simulation will be saved by HEC-WAT. 
 
Delete a Simulation 
 
To delete a simulation, right-click on a simulation in the table, from the individual simulation 
shortcut menu (Figure 11. 17), click Delete From Study.  A warning message will appear asking 
the user if the user really wants to delete the selected simulation.  Click Yes, the intersection of 
the alternative and analysis period/event that the simulation was associated with will now be 
blank in table in the Alternative and Simulation Manager (Figure 11.11). 
 
Simulation Information 
 
To view information about a simulation: 
 
 1. From the individual simulation shortcut menu (Figure 11. 17), click Properties.  The 

Properties for SimulationName dialog box will open (Figure 11.27). 
 



Chapter 11 – Create and Manage Simulations HEC-WAT User's Manual 

11-24 
 

 2. From this dialog box the user can view information about the selected simulation – name 
of simulation; description; date simulation was last modified; who created the simulation; 
date simulation was created; and the location of the simulation file. 

 
 3. Click Close, the Properties for SimulationName dialog box (Figure 11.27) will close. 
 
Browse Run Folder 
 
This command takes the user to the location of the data that is generated by HEC-WAT when a 
simulation is computed.  The user can view the simulation.dss file using HEC-DSSVue from this 
location; and, if the model folders have been saved the user can view results for the individual 
models from HEC-RAS, HEC-ResSim, or HEC-FIA if necessary from this location. 
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CHAPTER 12 
 
 

Model Linking 
 
The next step is to have the model alternatives within a simulation communicate with each other, 
by sharing data.  This is accomplished by linking (DSS mapping, grid files) the model 
alternatives through DSS and using a simulation name.  From HEC-WAT, the Model Linking 
Editor (Figure 12.1) provides an easy way to link model alternatives including observed data, 
and provides a mechanism where the linking will have to be done once per model alternative. 
 

 
Figure 12.1  Model Linking Editor 
 
Model linking is the mechanism that allows the model alternatives involved in an HEC-WAT 
simulation to share data. The available software applications are defined through a program order 
(Chapter 11) that is defined by the user.  This program order defines the software applications 
that will be used and the order in which the software applications will be run in a simulation. 
 
From the Model Linking Editor (Figure 12.1), a model alternative is selected as the Model To 
Link, the current linkage of the selected model alternative displays in the table of the Model 
Linking Editor (Figure 12.1).  From the Input From Model column, the model alternative that 
contains the correct data that needs to be linked is selected.  HEC-WAT facilitates this linking 
from one model alternative to the next in an HEC-WAT simulation, with the linking information 
being saved by the software application (e.g., linkage for an FIA model alternative is saved to an 
HEC-FIA *.fits file) of the selected Model to Link alternative.   
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12.1 Model Linking Editor 
 
To access the Model Linking Editor (Figure 12.1), from the HEC-WAT main window (Figure 
12.2), from the WAT Tools toolbar, click      .  Alternatively, from the HEC-WAT main 
window, from the Edit menu, click Model Linking Editor.  From either method the Model 
Linking Editor will open (Figure 12.1). 
 

 
Figure 12.2  HEC-WAT Main Window 
 
An example basic model linking scenario is described in the following steps. 
 
 1. From the HEC-WAT main window (Figure 12.2), from the WAT Tools toolbar, click     , 

the Model Linking Editor will open (Figure 12.1). 
 
 2. A program order (Chapter 11) of HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA 

has been selected for the study. For these software applications, model alternatives (i.e., 
HEC-HMS (simulations/runs), HEC-ResSim (alternatives), HEC-FIA (alternatives), 
HEC-RAS (plans)) have been imported into the HEC-WAT study.  

 
 3. From the Model Linking Editor (Figure 12.1), the user selects an HEC-WAT simulation 

from the Simulation list (Figure 12.3). 
 

 
Figure 12.3  Model Linking Editor – Simulation List 
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 4. For example, in Figure 12.3, a simulation has already been selected – Without Project 
Conditions-RR_Feb1986.  Since the HEC-WAT study has an active simulation 
(simulation is bold in the Study Tree; a Simulation Map Window is open in the 
Desktop Pane) the Model Linking Editor (Figure 12.1) has already selected that 
simulation. 

 
 5. Once a simulation has been selected, the user now must select a model alternative for 

linking.  From the Model Linking Editor (Figure 12.1) from the Model To Link list 
(Figure 12.4). 

 

 
Figure 12.4  Model Linking Editor – Model To Link List 

 
 6. For example, in Figure 12.4, from the Model to Link list, the user is selecting a RAS 

model alternative – RAS-Base for Real Time forecasting.  
 
 7. The Model Linking Editor table (Figure 12.5) now displays all of the locations from the 

RAS model alternative that will require information (e.g., time-series or levee failure 
elevations) from other model alternatives in the HEC-WAT simulation.  The initial 
linking (Figure 12.5) displayed in the Model Linking Editor (Figure 12.5) will be what 
is defined in the base HEC-RAS model.  For example, Figure 12.5 shows the RAS model 
alternative is linked to DSS files.  

 

 
Figure 12.5  Model Linking Editor - RAS Model Alternative Unlinked 
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 8. For this example (Figure 12.5), the user knows that the RAS model alternative linking 
will be results from the HMS and ResSim model alternatives.  Most of the locations will 
be linked with an HMS model alternative, and a couple of the locations will be linked to a 
ResSim model alternative. 

 
 9. From the table the user can link each location individually (which will be described in 

Step 12); but since most of the locations in the table will be linked to an HMS model 
alternative, for this example the user will link all locations to an HMS model alternative. 
From the Model Linking Editor (Figure 12.5), click Default Model to Link, the Select 
Default Model to Link dialog box will open (Figure 12.6). 

 

 
Figure 12.6  Select Default Model To Link Dialog Box 

 
 10. From the Default Model to Link list (Figure 12.7), there are three choices.  This list is 

based on the program order that was selected for this simulation.  In that program order, 
the HEC-HMS and HEC-ResSim software application were selected to compute before 
the HEC-RAS software application.  The DSS File option allows the user to link 
locations to a DSS file.  For this example, the user will select the HMS model alternative 
HMS-(RUN)Feb_1986.  Click OK, the Select Default Model to Link dialog box will 
close (Figure 12.6). 

 

 
Figure 12.7  Default Model To Link List 

 
 11. A Confirm Input from From Model changing to window (Figure 12.8) will appear 

prompting the user about whether or not to proceed, click Yes. The Confirm Input from 
From Model changing to window closes, and the Model Linking Editor now displays 
the linking for the RAS model alternative (Figure 12.9). 

 

 
Figure 12.8  Confirm Input from Model changing to Window 
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Figure 12.9 Model Linking Editor - RAS Model Alternative to HMS Model Alternative 

 
 12. For this example, there are locations in the RAS model alternative linking that need to be 

linked to a ResSim model alternative.  From the Model Linking Editor table (Figure 
12.10) the user will locate one of the locations (DryCreek DryCreek RS 74716.8 (Sonoma 
Outflow J)).  From the row, from the Input Model column (Figure 12.10), the user will 
select the ResSim model alternative - ResSim-calibrate. 

 

 
Figure 12.10  Model Linking Editor – Individual Locations 

 
 13. Once the linking is finished for the RAS model alternative, from the Model Linking 

Editor (Figure 12.11) click       to save the linking. 
 
This example completes the linking for the RAS model alternative.  From the above steps the 
user should be able to perform the linking for the other model alternatives associated with the 
selected simulation.  HEC-WAT attempts to choose the correct linking based on information 
from the individual model alternatives and locations that have been identified (i.e., element 
names, common computation points).  The user should carefully review all linkages to make sure 
the right choices have been made. 
 
12.2 Dynamic Linking 
 
The example in Section 12.1 addressed modeling linking for one simulation, what happens when 
the HEC-WAT study contains many HEC-WAT simulations?  If the same model alternatives are 
used in other simulations, there could be an issue when a model alternative in one simulation 
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Figure 12.11  Model Linking Editor - Completed RAS Model Alternative Linking 
 
needs to be linked to a different model alternative in another simulation.  One example is where 
RAS model alternative Plan A needs to be linked to HMS model alternative Simulation A in one 
HEC-WAT simulation and then HMS model alternative Simulation B in another HEC-WAT 
simulation.  Dynamic linking can be used in this case to eliminate the need to create a new model 
alternative for each HEC-WAT simulation (in the example above, RAS model alternative Plan A 
would have to be duplicated) where the linking changes, dynamic linking can be used.  Dynamic 
linking is not required, but can save the user time in instances like the above example. 
 
Dynamic linking modifies the DSS pathname F-part such that a single model alternative can be 
applied to several HEC-WAT simulations.  For example, in Figure 12.12, the same RAS model 
alternative Base for Real Time forecasting, is used in both the Without Project 
Conditions_Feb1986 and Without Project Conditions_Jan1995 simulations.  The original linking 
for the Base for Real Time forecasting model alternative was done in the Without Project 
Conditions_Feb1986 simulation.  This simulation is linked to the HMS model alternative, 
(RUN)Feb 1986.  The HEC-WAT simulation Without Project Conditions-RR_Jan1995 uses the 
(RUN)Jan_1995 HMS model alternative. 
 

 
Figure 12.12 Multiple Simulations using the same RAS Model Alternative - Base for Real Time 

forecasting 
 
If dynamic linking was not used for the Without Project Conditions-RR_Jan1995 simulation, the 
RAS model alternative would look for results from the (RUN)Feb_1986 HMS model alternative  
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during the Without Project Conditions-RR_Jan1995 compute.  Dynamic linking allows the Base 
for Real Time forecasting RAS model alternative to be linked to additional HMS model 
alternatives with little additional effort.  Without dynamic linking, a copy of Base for Real Time 
forecasting would have to be created in HEC-RAS for each simulation in the HEC-WAT study 
that used different HMS or ResSim model alternatives. 
 
An example dynamic linking scenario is described in the following steps. 
 
 1. In Section 12.1, the user has set the linking for the RAS model alternative Base for Real 

Time forecasting for the simulation Without Project Conditions_Feb1986.  Now the user 
needs to do the linking for the RAS model alternative in the second HEC-WAT 
simulation Without Project Conditions_Jan1995 

 
 2. From the Model Linking Editor (Figure 12.1), the user selects Without Project 

Conditions_Jan1995 from the Simulation list (Figure 12.3). 
 
 3. From the Model to Link list (Figure 12.3), the user selects Base for Real Time 

forecasting.  
 
 4. The Model Linking Editor (Figure 12.13) now displays all of the locations for the RAS 

model alternative that need to be linked.  As displayed in Figure 12.13, all of the 
locations are displayed in green (except for the two locations that are linked to the 
ResSim model alternative) indicating the model alternative has already been linked in a 
different HEC-WAT simulation. 

 

 
Figure 12.13  Model Linking Editor - RAS Model Alternative Already Linked 

 
 5. To dynamically link, from the toolbar on the Model Linking Editor (Figure 12.13), click 
       , or from the Edit menu, click Dynamic Linkage.  From either method, the Dynamic 

Linkage Editor will open (Figure 12.14). 
 
 6. Since the RAS model alternative Base for Real Time forecasting requires model results 

from multiple HMS model alternatives across multiple HEC-WAT simulations, dynamic 
linking needs to be applied for the RAS model alternative.  The second simulation  
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Figure 12.14  Dynamic Linkage Editor 

 
  Without Project Conditions_Jan1995 requires a different HMS model alternative to be 

used, but not a different ResSim model alternative.  Therefore, dynamic linking is only 
required for the HMS model alternative. 

 
 7. To set dynamic linking for the HMS model alternative, from the table on the Dynamic 

Linkage Editor (Figure 12.14), in the Existing Model column, in the first cell, from the 
list, select HMS.  In the Existing Alternative column, in the first cell, from the list, select 
(RUN)Feb_1986.  In the New Alternative column, in the first cell, from the list select 
HMS-(RUN)Jan_1995 (Figure 12.14). 

 
 8. Click OK, the Dynamic Linkage Editor closes (Figure 12.14) and on the Model 

Linking Editor (Figure 12.15), all of the locations linked to the HMS model alternative 
display in blue.  This means all of those locations are dynamically linked, or linked to 
different model inputs in different HEC-WAT simulations.  The Dynamically Linked 
column (Figure 12.15) will show a check mark for each row that is dynamically linked.  

 

 
Figure 12.15  Dynamic Linkage Editor – Dynamically Linked Locations 
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 9. Once the linking is finished for the RAS model alternative, from the Model Linking 
Editor (Figure 12.15) click      , this will save the linking. 

 
This example illustrates the dynamic linking option for the RAS model alternative in two 
different HEC-WAT simulations.  What did dynamic linking do? By using dynamic linking for 
the second simulation, during a compute of that simulation the dynamically linked DSS 
pathname F-parts will substitute the existing alternative name with the new alternative name 
when creating pathnames for the models to pass results.  How?  When a model alternative is 
linked within an HEC-WAT study, the software application specific files associated with that 
model alternative are changed. The model specific files are saved in the HEC-WAT study 
directory within the corresponding software application folders.  For example, when the RAS 
model alternative (a plan in HEC-RAS) Base for Real Time forecasting was linked to other 
model alternatives in the HEC-WAT compute sequence, the selected information for that 
specific HEC-RAS model was saved to an HEC-RAS file with the extension *.p##.wcfLinks in 
the ras folder of the HEC-WAT study directory.  The other software applications, in the compute 
sequence use different file extensions to save information for each simulation, analysis, or 
alternative within those pieces of software.  The main point is that files in the model specific 
folders are modified anytime an individual model is linked within an HEC-WAT simulation.   
 
Dynamic linking also removes the user from having to create an additional HEC-RAS plan for 
the second HEC-WAT simulation.  Could the user choose to perform the linking this way and 
choose not to use dynamic linking – yes.  But if the study the user is analyzing will require a 
large amount of simulations for analysis, serious thought should be given on which approach to 
use. 
 
Currently, HEC-HMS does not support dynamic linking in HEC-WAT Version 1.0.  HEC-HMS 
is usually the first model in the compute sequence, where dynamic linking is used less often.  For 
HEC-HMS, dynamic linking would be beneficial for linking hydrologic sampling alternatives 
with different precipitation information between hydrologic sampling alternatives.  To work 
around this limitation the user must create duplicate copies of the HEC-HMS simulation (or 
Monte Carlo analysis), and link each one to the appropriate HEC-WAT alternative. 
 
12.3 Select Source Data 
 
Data listed in the Model Linking Editor (Figure 12.1) displays the type of results the location 
needs. In some cases the data type might not be recognized or the type of data is not what the 
user is expecting.  For this reason, the user can specify a data type for a certain location.   
 
 1. Select a row in the Model Linking Editor table (e.g., SantaRosa Cr), click Select 

Source Data (Figure 12.1). If the Input From Model column (Figure 12.1) refers to a 
model alternative, the Select Source Data Location dialog box will open (Figure 12.16).  
If the Input From Model column (Figure 12.1) refers to a DSS file, then HEC-DSSVue 
opens to allow the user to select a DSS file. 

 
 2. To review a list of locations in the Select Source Data Location dialog box, from the 

Location (Figure 12.16) list, the user will select which model alternative's locations to 
review.  The list is the known locations that were part of the original model alternative's  
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Figure 12.16  Select Source Data Location Dialog Box 

 
  standalone model. To show all locations available, the user should select Show All 

Source Locations. 
 
 3. From the Location column (Figure 12.16), select the row that contains the correct 

information (e.g., Santa Rosa Ck Loc).  Click Set Location. The row selected in Step 1 
will now contain the new location information selected from the Select Source Data 
Location dialog box.  The Select Source Data dialog box (Figure 12.16) will remain 
open allowing the user to continue selecting source data for different rows in the Model 
Linking Editor (Figure 12.1). 

 
 4. Click Close, the Select Source Data Location dialog box will close (Figure 12.16). 
 
12.4 Data Locations 
 
Data locations allow the user to view all available data at a particular location for each model 
alternative.  This includes input data and results from model alternatives.  
 
 1. From the Model Linking Editor (Figure 12.1), from the View menu, click Locations.  

The Data Locations dialog box will open (Figure 12.17). 
 
 2. From the Simulation list (Figure 12.17) the user can select a simulation, and then select a 

model alternative from the Model to Link list (Figure 12.17).  Next the user can select 
whether to view input or output locations that are available from the model selected. 

 
 3. If the Model Linking Editor (Figure 12.1) does not have any locations for a particular 

model alternative and the Data Locations dialog box (Figure 12.17) does not have any  
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Figure 12.17  Data Locations Dialog Box 

 
  locations either, then something is not working between HEC-WAT and the selected 

model alternative.  The output location list will give the user an idea of what results 
would be available from the model alternative after a compute. 

 
 4. Click Close, the Data Locations dialog box will close (Figure 12.17). 
 
12.5 Model Linking Report 
 
From the Model Linking Editor (Figure 12.1) the user can print the linking for a simulation or 
model alternative. 
 
 1. From the Model Linking Editor (Figure 12.1), from the File menu, click Print, or from 

the Toolbar click      , a Select Report Type message window will open (Figure 12.18). 
 

 
Figure 12.18  Select Report Type Message Window 
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 2. The user is prompted to print the linkage for either the simulation or the model 

alternative. After making a selection, the Select Report Type message window will 
close, and a print Properties dialog box will open (Figure 12.19).  The user can now 
format the Model Linking Report. When the user is done formatting, click Print. 

 

 
Figure 12.19  Print Properties Dialog Box 

 
 3. A Print dialog box will open (Figure 12.20).  From this dialog the user can choose which 

printer to print to and also setup other printer properties.  Click OK, the Print dialog box 
will close and the Model Linking Report (Figure 12.21) will print. 

 

 
Figure 12.20  Print Dialog Box 
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Figure 12.21  Model Linking Report 
 
12.6 Model Linking Editor – Study Tree 
 
The user can also access the Model Linking Editor (Figure 12.1) from the Study Tree of an 
active HEC-WAT study (Figure 12.22).  From the Study Tree, under the Simulation folder, 
right click on a simulation.  From the shortcut menu, click Model Linking Editor, the Model 
Linking Editor will open (Figure 12.1). 
 

 
Figure 12.22  Study Tree – Model Linking Editor 
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12.7 Modeling Linking Editor – Alternative & Simulation 
Manager 

 
The user can also access the Model Linking Editor (Figure 12.1) from the Alternative and 
Simulation Manager (Figure 12.23).  From the HEC-WAT main window (Figure 12.2), from 
the WAT Tools toolbar, click      , the Alternative and Simulation Manager will open (Figure 
12.23).  From the toolbar, click     ; from the Edit menu, click Model Linking Editor; or from 
the table, right-click on a simulation, from the shortcut menu (Chapter 11, Section 11.2.6), click 
Model Linking Editor.  Either method will open the Model Linking Editor (Figure 12.1). 
 

 
Figure 12.23  Alternative and Simulation Manager 
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CHAPTER 13 
 
 

Final Study Setup - Deterministic 
 
 
The user now has an understanding of the HEC-WAT framework, knows how to create a study 
and has experience using map layers. The user has also created or imported model alternatives, 
created study alternatives and simulations, setup analysis periods, and defined model linking.  
There are a few final setup items that need to occur before a deterministic compute can happen:  
define plug-ins; adjust map layers; and, enter the correct lookback window for an HEC-ResSim 
model (if HEC-ResSim is part of the study). 
 
13.1 Define Plug-Ins for a Study 
 
Plug-ins (Chapter 2) allow HEC-WAT to integrate software applications into its framework 
without requiring special code in HEC-WAT to support the individual software applications.  
Currently there are nineteen plug-ins available (Appendix B provides further details), eight 
specifically for standalone software applications, and eleven specifically for HEC-WAT 
functions.  While all of these plug-ins are available, the user should inform HEC-WAT which 
plug-ins are needed in the Study Details dialog box (Figure 13.1).  Plug-ins can be 
enabled/disabled from the Options dialog box (Appendix B), but this should only be done to 
enable/disable specific plug-ins for specialized studies or when there is an issue with a plug-in. 
 

 
Figure 13.1  Study Details Dialog Box – Plugins Tab – Deterministic 
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To set the specific plug-ins for the active study: 
 
 1. From the HEC-WAT main window (Figure 13.2), from the File menu, click Study 

Details, the Study Details dialog box (Figure 13.1) will open. 
 

 
Figure 13.2 HEC-WAT Main Window 

 
 2. The Study Details dialog box (Figure 13.1) displays the name of the study, the study 

description (which the user can edit), location of the study file (*.sty), the selected unit 
system, the selected coordinate system, the user name of the team member that created 
the study, and the date and time the study was created. 

 
 3. Click the Plugins tab (Figure 13.1), by default, all plug-ins are enabled (Figure 13.3).  

Alternatively, in Figure 13.1, shows the active study in which the only plug-ins enabled 
are FIA, HEC-SSP, HMS, RAS, and ResSim. 

 

 
Figure 13.3  Study Plug-Ins Defaults 
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 3. To disable a plug-in clear the check mark in the Enabled column of the table (Figure 
13.1).  When the user has the right plug-in configuration, click OK.  The Study Details 
dialog box will close (Figure 13.1) and the plug-in configuration for the active study has 
been set. 

 
13.2 Adjust Map Layers 
 
Whether models were built from HEC-WAT or imported, there could be map layers that define 
the study area.  The user may need to adjust the map layers (not required) so that the schematic 
displays information to the study team and others. 
 
 1. From the HEC-WAT main window, click the Maps tab (Figure 13.4).  Now the user can 

see which Map Window is currently active and what layers make up that Map Window.  
The user can now make adjustments (changes to draw properties) to the map layers, from 
the Map Layers tree: 

 

 
Figure 13.4  HEC-WAT Main Window – Maps Tab 

 
 ● Un-check a map layer so that it will no longer display in the active map window.  

For example in Figure 13.4, the Raingages_Albers_ft.shp map layer has been un-
checked. 

 
 ● For map layers, the user can change the display properties of the selected map layer. 

For example, in Figure 13.4, the user could right-click on the RR_ImpactAreas.shp 
map layer, from the shortcut menu, click Properties.  The Edit Polygon Properties 
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Editor will open (Figure 13.5).  From the Fill tab, change the color to "lightgreen", 
click OK.  The impact areas on the active map window will now display in 
"lightgreen". 

 

 
Figure 13.5  Edit Polygon Properties Editor 

 
 ● Move layers to better display certain aspects of the schematic.  For example, in 

Figure 13.4, right-click on Stream Alignment, from the shortcut menu click Move 
To Top.  The Stream Alignment layer is now the top layer in the schematic. 

 
 2. The user can adjust the view of the study area in the active map window.  Using the 

Magnifier tool, zoom the study area in the active map window to the appropriate area 
that the user would like displayed.  From the HEC-WAT main window (Figure 13.4), 
from the Maps menu, click Default Map Properties, the Default Map Properties for 
dialog box will open (Figure 13.6).  Click Set Map Extents to Display, click OK.  The 
Default Map Properties for dialog box will close. 

 

 
Figure 13.6  Default Map Properties for Dialog Box 
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This sets the extents for the Map Window so that when the study is opened the next time 
the Map Window will be zoomed in to the tighter area. 

 
13.3 Lookback Window – HEC-ResSim (only) 
 
The time window for an HEC-ResSim run has two parts, a "lookback period" and a "simulation 
or forecast period".  The lookback period is used by HEC-ResSim to "warm up" a ResSim model 
alternative.  During this period, routing of flows through the river and reservoir network are 
performed but no release decisions are made nor are any mass balance computations evaluated.  
The user should think of the lookback period as the time to establish the state of the river 
network and the starting conditions of the reservoirs.  The simulation period is the portion of the 
time window during which HEC-ResSim simulates reservoir operations, and makes release 
decisions based on the operation logic defined by the user.  Releases are then routed through the 
river network, combining with local inflows along the way. 
 
HEC-WAT and most of the models treat the analysis period as a single, continuous time 
window. For this reason, a setup step is required for each ResSim model alternative in an HEC-
WAT study.  The setup step lets each ResSim model alternative know how much of the analysis 
period to use for the lookback period.   
 
To setup the lookback period: 
 
 1. From the HEC-WAT main window (Figure 13.3), from the Edit menu, point to ResSim, 

click Lookback Window (Figure 13.7), the Lookback Window dialog box (Figure 
13.8) will open. 

 

 
Figure 13.7  Edit Menu – ResSim – Lookback Window 



Chapter 13 - Final Study Setup - Deterministic HEC-WAT User's Manual 

13-6 

 

 
Figure 13.8  Lookback Window Dialog Box 

 
 2. The table on the Lookback Window dialog box (Figure 13.8) displays the ResSim model 

alternatives that are available in the HEC-WAT study.  Each model alternative that is 
being used in an HEC-WAT simulation will need to have a lookback window set.   For 
example, in Figure 13.8, the ResSim model alternative calibrate has a TimeStep of one 
(1) hour and Lookback Steps of 6. 

 
 3. For each Alternative listed, a TimeStep (compute interval) and number of Lookback 

Steps must be specified.  The time step can be selected from the TimeStep column 
(Figure 13.8), in each cell there is a list of available time steps for the user to choose 
from.  The selected time step has to match the time step that was specified for the ResSim 
model alternative as part of the alternative's original Run Control data (which is located 
in the HEC-ResSim Alternative Editor). The number of lookback steps must be entered in 
a cell in the Lookback Steps column (Figure 13.8). At least one lookback time step is 
required for a ResSim model alternative to compute, however more lookback steps may 
be needed, depending on a variety of factors in the ResSim model alternative's operating 
rules.  The HEC-ResSim modeler should be consulted to determine the minimum 
lookback window needed by each ResSim model alternative.  As mentioned, the 
lookback period takes place within the analysis period (time window) that HEC-WAT 
provides to the ResSim model alternative.  No reservoir operations will be simulated 
during the lookback period, which could impact model results.  

 
 4. Click OK, the Lookback Window dialog box (Figure 13.8) will close. 
 
Now that all of the setup has been completed, the user is ready to compute HEC-WAT 
simulations. 
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CHAPTER 14 
 

Compute/Results - Deterministic 
 
Now that simulations have been defined and the linking of model alternatives has been 
completed for the simulations, the user is now ready to compute.  Once again HEC-WAT 
provides the user with several ways to compute simulations.  The user can compute a simulation 
individually, compute multiple simulations, compute individual model alternatives, or compute a 
simulation through a specific model alternative.  For example if the user defined a compute 
sequence of HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA and only wanted to compute a 
simulation through the HEC-RAS model, HEC-WAT could request that the HEC-HMS, HEC-
ResSim and HEC-RAS software applications compute their individual model alternatives (i.e., 
simulation, alternative, plan) for the HEC-WAT simulation alternative.  The following sections 
describe in detail how to compute simulations in HEC-WAT. 
 
14.1 Compute – Single Simulation 
 
14.1.1 Study Tree 
 
Computing a simulation from the Study Tree: 
 
 1. From the HEC-WAT main window (Figure 14.1), from the Study Tree, from the 

Simulations folder, right-click on a simulation (e.g., Without Project Conditions-
RR_Feb1986).  From the shortcut menu (Figure 14.1) point to Compute, hold down the 
CTRL key, click Simulation. 

 

 
Figure 14.1  HEC-WAT Main Window 
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 2. Holding down the Ctrl key forces all models alternatives in the compute sequence to 
compute, and is the recommended way to compute until additional coordination between 
HEC-WAT and software application teams has been completed.  

 
 3. The Compute Progress dialog box will open (Figure 14.2).  When the compute is 

finished, click Close, the Compute Progress dialog box will close (Figure 14.2). 
 

 
Figure 14.2  Compute Progress Dialog Box 

 
14.1.2 Compute Menu 
 
From the HEC-WAT main window (Figure 14.1) from the Compute menu (Figure 14.3), the 
user can compute a single simulation from different commands.  If a simulation is active 
(displayed in a Simulation Map Window in the Desktop Pane), then the first item in the 
Compute menu will be that simulation's name (e.g., Without Project Conditions-RR_Feb1986), 
hold down the CTRL key, click on the simulation, the Compute Progress dialog box will open 
(Figure 14.2) and the compute will start. 
 
Alternately, from the Compute menu (Figure 14.3), point to Recent Simulations, a list of 
recently computed simulations will display. Hold down the CTRL key, click on the simulation 
that is to be computed.  The Compute Progress dialog box will open (Figure 14.2) and the 
compute will start. 
 

 
Figure 14.3  HEC-WAT Main Window – Compute Menu 
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Finally, from the Compute menu (Figure 14.3), point to Compute, hold down the CTRL key, 
click Simulation, the Compute Progress dialog box will open (Figure 14.2), and the Compute 
Progress dialog box will open (Figure 14.2) and the compute will start.  This will compute the 
active simulation (displayed in a Simulation Map Window in the Desktop Pane). 
 
14.2 Compute – Multiple Simulations 
 
To compute multiple simulations (non-FRA simulations): 
 
 1. From the Compute menu (Figure 14.3), click Compute Manager, the Compute 

Manager dialog box will open (Figure 14.4). 
 

 
Figure 14.4  Compute Manager Dialog Box 

 
 2. From the tree, simulations are organized by HEC-WAT alternatives (i.e., Without Project 

Conditions), with sub-nodes being the simulations (i.e., Without Project Conditions-
RRFeb1986) that have been defined for an HEC-WAT alternative. 

 
 3. By default, the known simulations are all selected for computing. To un-select 

simulations, click the checkbox next to a simulation, the check mark will disappear and 
the simulation will not be computed.  To easily de-select all simulations, click Deselect 
All (Figure 14.4); to select all simulations, click Select All (Figure 14.4). 

 
 4. Force Recompute (Figure 14.4) forces all models in the compute sequence to re-

compute, and is the recommended way to re-compute until additional coordination 
between HEC-WAT and application teams has been completed. 

 
 5. For each simulation that is computed, a Compute Progress dialog box will open (Figure 

14.2).  When computing several simulations at once, many Compute Progress dialog 
boxes will be visible.  The user can turn off the appearance of the Compute Progress 
dialog boxes by clicking Close Progress Windows (Figure 14.4).  
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 6. Once the simulations have been selected in the Computer Manager dialog box (Figure 
14.4), click Compute, a Compute Progress dialog box (Figure 14.2) will open for each 
simulation as that simulation starts to compute. 

 
 7. When done computing simulations, click Close (Figure 14.4), the Compute Manager 

dialog box will close (Figure 14.4). 
 
14.3 Compute – Individual Model Alternatives 
 
Individual model alternatives (i.e., simulations, plans, alternatives) can be computed from within 
an HEC-WAT compute sequence.  For example, within a compute sequence that includes HEC-
HMS, HEC-ResSim, HEC-RAS and then HEC-FIA, the user can choose to run just the HMS 
model alternative within the compute sequence, or run only the HMS and ResSim model 
alternatives.  The user can also choose to run the entire compute sequence.  
 
The user can compute individual model alternatives from the HEC-WAT framework from 
several different places.  From the HEC-WAT main window (Figure 14.1), from the Study Tree, 
from the Simulations folder, right-click on a simulation (e.g., Without Project Conditions-
RR_Feb1986).  From the shortcut menu (Figure 14.1) point to Compute, from the sub-menu the 
user can choose which available model alternative to compute.  The Compute Progress dialog 
box will open (Figure 14.2) and the compute will start. 
 
From the HEC-WAT main window (Figure 14.1), from the Compute menu (Figure 14.3), point 
to Compute, from the sub-menu the user can choose which available model alternative to 
compute.  The Compute Progress dialog box will open (Figure 14.2) and the compute will start. 
 
From the HEC-WAT main window (Figure 14.1), the user needs to select a simulation from the 
Study Tree, under the Simulation folder.  The Content Pane (Figure 14.5) contains information 
about the selected simulation, including what model alternatives are part of the simulation.  From 
a model alternative, right-click, from the shortcut menu click Compute.  The Compute 
Progress dialog box will open (Figure 14.2) and the compute will start. 
 

 
Figure 14.5  Content Pane – Individual Model Alternatives Shortcut Menu 
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14.4 Compute through a Specific Model Alternative 
 
The user can compute a simulation through an individual model alternative from the Study Tree, 
from the Simulations folder, right-click on a simulation (e.g., Without Project Conditions-
RR_Feb1986).  From the shortcut menu (Figure 14.1) point to Compute, from the sub-menu, 
click on the model alternative where the compute will stop.  The Compute Progress dialog box 
will open (Figure 14.2) and the compute will start.  The user can perform the same function from 
the Compute menu (Figure 14.3).  If previous model alternatives have been computed and not 
changed, those model alternatives will be skipped. 
 
14.5 Compute Log 
 
To view a simulation compute log: 
 
 1. From the HEC-WAT main window (Figure 14.1), from the Study Tree, from the 

Simulations folder, right-click on a simulation, from the shortcut menu (Figure 14.6), 
click View Compute Log. Also, from the Compute Menu (Figure 14.3), click View 
Compute Log – this command is only available when there is an active simulation 
(displayed in a Simulation Map Window in the Desktop Pane).  Both methods open the 
View Compute Log Editor (Figure 14.7). 

 

 
Figure 14.6  Individual Simulation Shortcut Menu – View Compute Log 

 
 2. The compute log opens in an editor that allows the user to edit, search, print, and format 

the log.  The search function lets the user search for specific items to troubleshoot or 
review details regarding one of the software applications in the compute sequence. 

 
 3. From the File menu, click Close, the Compute Log Editor will close (Figure 14.7). 
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Figure 14.7  Compute Log Editor 

 
14.6 Results Menu 
 
From the HEC-WAT Results menu, the user can access results from the different software 
applications in a compute sequence.  From the HEC-WAT main window (Figure 4.1), from the 
Results menu (Figure 14.8), the user will point to a software application from which the user 
wants to view results. 
 

 
Figure 14.8 HEC-WAT Main Window – Results Menu - HMS 
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For example, in Figure 14.8, the user points to HMS, clicks Global Summary Table, the 
Global Summary Results for that particular HMS model alternative will display (Figure 14.9).  
The summary table is a native summary table that is generated by HEC-HMS; however, the 
summary table is accessed through HEC-WAT.  
 

 
Figure 14.9  HMS - Global Summary Report 
 
For HEC-RAS, from the Results menu, point to RAS, the sub-menu (Figure 14.10) provides a 
list of available HEC-RAS results from which the user can select.  For example, from the RAS 
results menu, click Plot XYZ 3-D, the X-Y-Z Perspective Plot dialog box will open (Figure 
14.11).  The plot is a native result that is generated by HEC-RAS; however, the plot is accessed 
through HEC-WAT. 
 

 
Figure 14.10 HEC-WAT Main Window – Results Menu - RAS 
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Figure 14.11  RAS - X-Y-Z Perspective Plot 
 
14.7 Content Pane 
 
Once a simulation has been computed, the user can review the same reports that are available 
from the Results menu from the Content Pane. From the Content Pane, right-click on one of 
the available model alternatives, from the shortcut menu (Figure 14.12), point to Results, click 
on the results that are available. 
 

 
Figure 14.12  Content Pane - Shortcut Menu – Results - ResSim 
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For example, in Figure 14.12, from the Content Pane, right-click on the ResSim calibrate model 
alternative, point to Results.  The sub-menu provides a list of available HEC-ResSim results 
from which the user can select.  For example, point to Results, click Flow Summary, the Flow 
Summary Report dialog box will open (Figure 14.13). The report is a native result that is 
generated by HEC-ResSim; however, the report is accessed through HEC-WAT. 
 

 
Figure 14.13  ResSim - Flow Summary Report 
 
Another example, from the Content Pane, right-click on the FIA GridsAndXSecsAlternative 
model alternative, point to Results.  The sub-menu (Figure 14.14) provides a list of available 
HEC-FIA results from which the user can select.  For example, point to Results, click 
Individual Structure Damage Report, the Individual Structure Damage Report dialog box 
will open (Figure 14.15).  The report is a native result that is generated by HEC-FIA; however, 
the report is accessed through HEC-WAT. 
 

 
Figure 14.14  Content Pane - Shortcut Menu – Results - FIA 
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Figure 14.15  FIA - Individual Structure Damage Report 
 
14.8 Schematic 
 
Results from the schematic are available by right-clicking on schematic elements and from the 
shortcut menu select result items (zooming in on an area is a good idea).  From the map window 
click the Pointer Tool     , right-click on a schematic element, a shortcut menu will appear 
(Figure 14.16).  For example, in Figure 14.16, from the shortcut menu, besides providing 
information about a junction, HEC-WAT also provides information on schematic elements that 
are around the junction, like impact areas, routing reaches, and cross sections. 
 

 
Figure 14.16  HEC-WAT Schematic Shortcut Menu – Impact Area 
 
In the example (Figure 14.16), the user right-clicks on a junction from the schematic, from the 
shortcut menu (Figure 14.16), point to Impact Area, click Aggregated Consequence Report, 
the HEC-FIA Aggregated Consequence Report will open (Figure 14.17). Click the Life Loss 
tab to get a Life Loss Report by impact areas. The report is a native result that is generated by 
HEC-FIA; however, the report is accessed through HEC-WAT. 
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Figure 14.17  FIA - Aggregated Consequence Report - Life Loss Report 
 
From the same location in Figure 14.16, from the shortcut menu point to Reach.  The sub-menu 
(Figure 14.18) lists all the available results from the models in the compute sequence that include 
routing reaches in their analysis (hydrologic, hydraulic).  In Figure 14.18, each software 
application that has results is represented by the icon for each software application. For example, 
if the user wants to view the computed profile for a particular HEC-RAS hydraulic routing reach, 
click Profile Plot (Figure 14.18), the HEC-RAS Profile Plot (Figure 14.19) is displayed. The 
plot is a native result that is generated by HEC-RAS; however, the plot is accessed through 
HEC-WAT. 
 
Another example, from the same location (Figure 14.16), from the shortcut menu (Figure 14.18) 
point to Reach. To view the computed hydrograph at that location along an HEC-HMS 
hydrologic routing reach, click Graph, and the Graph for Reach (Figure 14.20) is displayed.  
The plot is a native result that is generated by HEC-HMS; however, the plot is accessed through 
HEC-WAT. 
 

 
Figure 14.18  HEC-WAT Schematic Shortcut Menu - Reach 
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Figure 14.19  RAS - Profile Plot 
 

 
Figure 14.20  HMS - Graph of HEC-HMS Routing Reach 
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CHAPTER 15 
 

Flood Risk Analysis (FRA) Compute 
Option 
 
USACE flood risk management (FRM) policy requires that USACE analytical processes include 
methods and tools that employ integrated, comprehensive, systems and life-cycle based 
approaches and risk-based concepts in planning, design, construction, operations and major 
maintenance. These USACE methods need to incorporate systems response of projects when 
considering load distribution and failure possibilities. USACE policy also states that project 
performance needs to consider the system reaction to flood loading and how those loadings are 
distributed across the watershed.  
 
HEC-WAT includes an option that will analyze complex riverine systems while implementing 
the flood risk management and systems requirements. Currently, life-cycle analysis in HEC-
WAT is a period of analysis with no changes to measures (i.e., levees, reservoirs) being 
accounted for over that period of analysis. For levees, that period of analysis is fifty years, and 
for reservoirs/dams that period is 100 years. Ture life-cycle analysis is the tracking of how things 
(i.e., failure, re-build, maintenance) could change during the period of analysis for measures (i.e., 
levees, reservoirs), which HEC-WAT will address in a later version. The compute option, Flood 
Risk Analysis (FRA), allows a user to perform plan formulation or system performance analyses 
while incorporating risk analysis.  FRA includes several plug-ins that provide sampling 
methodologies for hydrology and fragility curves (Figure 15.1). Also, a majority of the initial set 
of HEC software applications will include parameter sampling.  
 

 
Figure 15.1  HEC-WAT Framework - Flood Risk Analysis (FRA) Compute Option  
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15.1 Overview 
 
The FRA compute option in HEC-WAT allows users to perform risk analysis using a Monte 
Carlo simulation approach.  The Monte Carlo simulation provides a method for incorporating a 
probabilistic description of inputs (i.e., boundary conditions, initial conditions, model 
parameters) into an analysis while making use of detailed deterministic models.  During a Monte 
Carlo simulation, the single-valued inputs (deterministic models) are replaced with randomly 
sampled values as defined by probability distributions.  In turn, the sampled model information is 
repeated over and over to span the possible range of model inputs to quantify uncertainty in 
model results.  During an FRA simulation input values are sampled, algorithmic decisions are 
performed, results are summarized, and convergence is reached (for Version 1.0, automatic 
convergence is not a feature, the user must define the total number of events). 
 
The FRA compute option allows the model alternatives to evaluate a full range of flood 
scenarios based on reasonable probabilistic assumptions.  The randomly sampled input values, 
the models involved in the simulation sequence, and the hydrologic loading are all executed 
iteratively according to the Monte Carlo analysis.  At the beginning of each iteration, HEC-WAT 
generates random numbers which are used by each model alternative in the simulation, with the 
software application independently deciding if and how to use those random numbers. 
 
An FRA compute requires a large amount of computation resources and a large amount of 
storage for results.  HEC-WAT provides model skip flags (Chapter 18) that are developed based 
on user criteria that aid in the budgeting of simulation times.  This is a very high-level overview 
of the FRA compute option, for further details on the Monte Carlo simulation, the HEC-WAT 
Technical Reference Guide will provide details (will not be available with Version 1.0 release). 
 
This chapter provides an overview of the items that the user will need to create for an FRA 
simulation for a study area.  This includes plug-ins; sampling of hydrologic data; possible 
sampling of levee fragility curves; analysis periods (time windows); alternatives; simulations; 
computations; and results.  Chapters following this section will provide more details on certain 
items in an FRA study. 
 
15.2 Random Numbers 
 
When an FRA compute starts, HEC-WAT generates pseudo-random numbers.  Pseudo random 
numbers allow for repeatability of the random sampling when an HEC-WAT alternative is re-
computed or between multiple HEC-WAT alternatives. This means that the random values used 
to sample input variables are pseudo-random, which allows the same random value to be 
reproduced identically in a subsequent compute. Repeatability is important to support 
comparison of study alternatives or in case a simulation is stopped for some reason.  Also, when 
an event is deemed interesting after the compute is complete, a user can re-run that particular 
event, saving detailed information for further analysis. 
 
The pseudo-random numbers are generated by a random number generator, which uniquely 
determines the pseudo-random numbers that are created.  Random numbers are generated for 
each software application (and plug-ins) listed in the program order of a simulation.  Three sets 
of pseudo-random numbers are created, one set varies by realization (knowledge uncertainty), 



HEC-WAT User's Manual Chapter 15 – FRA Compute Option 

 15-3 

another set varies by life cycle, and the third set varies by event (natural variability).  Any 
software application (and plug-in) must be able to accept these pseudo-random numbers, but not 
necessarily do anything with the pseudo-random numbers.  In Version 1.0, most of the current 
software applications and plug-ins will receive all of the pseudo-random numbers, but only use 
one of the pseudo-random numbers. Some of the software applications not doing anything with 
the pseudo-random number information.  The fragility curve sampler and HEC-ResSim use two 
of the pseudo-random numbers. 
 
Further details on the pseudo-random numbers and how this information is being used in the 
FRA compute and by the other software applications and plug-ins, are provided in the HEC-
WAT Technical Reference Guide. 
 
15.3 Realizations, Life Cycles, and Events 
 
The Monte Carlo simulation in the FRA compute is implemented as a two-level nested process 
so that the uncertainty about the probability distributions can be captured, along with the nature 
of the uncertainty.  Two kinds of uncertainty are distinguished in an FRA compute: 
 
 ● Knowledge uncertainty (epistemic uncertainty) random variables are not known exactly 

and exist when it is not possible to make an accurate estimate of an input value. A few 
examples are flood likelihood, hydraulic coefficients, and channel capacities. 

 
 ● Natural variability (aleatoric uncertainty) random variables vary spatially or event-to-

event and exist when the outcome of a natural process is random, or the natural process is 
so complex it seems random when viewed in isolation.  A few examples are flood 
magnitude and forecasts. 

 
The FRA compute incorporates the two kinds of uncertainty separately, and all software 
applications (plug-ins) must distinguish between knowledge and natural variability random 
numbers.  Iterations in the inner loop, events, randomly sample from natural variability 
uncertainties.  When enough events (50, 100, 500, etc.) have been sampled to create frequency 
curves and compute probabilistic metrics, a realization is created.  The outer loop randomly 
samples the knowledge uncertainty to define uncertainty parameters that are held for all the 
events in a realization. 
 
Life-cycle analysis has been included at a very basic level, further changes to the life-cycle 
analysis procedures (including cost analysis) will be included in a later version of HEC-WAT. 
Further details on knowledge and natural variability uncertainty, realizations, life cycles, and 
events, are provided in the HEC-WAT Technical Reference Guide (not available for Version 1.0 
release). 
 
15.4 FRA Plug-Ins 
 
The following sections provide information on the plug-ins in HEC-WAT that might be needed 
for an FRA compute.  This covers plug-ins that provide hydrologic data sampling, fragility curve 
sampling, and performance metric results. 
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15.4.1 Hydrologic Sampling 
 
The first step of the FRA compute is the sampling of the hydrology to create perhaps thousands 
of events in a hydrologic sequence.  The hydrologic sampling will generate hydrologic 
information such as flow or precipitation frequency curves, cross correlations between curves, 
and hydrograph or hyetograph shapes, or instead, historical and synthetic event hydrographs.  
This hydrologic data will be sampled to generate as many realizations of the life-cycle 
hydrologic sequence as necessary, with each generated sequence provided to the other software 
applications available in the program sequence.  For further details on the hydrologic sampling 
available in HEC-WAT, refer to the Hydrologic Sampler User's Manual. 
 
15.4.2 Fragility Curve Sampler 
 
The sampling of levee failure elevations from fragility curves is accomplished through the 
Fragility Curve Sampler. This plug-in defines the probability and elevation of failure at each 
levee that is part of the system. Sampling is conducted and the result is an evaluation of the full 
range of levee failure possibilities for each pre-defined location in the entire system.  The 
fragility curve sampler is only needed for studies that model levee failures.  For further details on 
the fragility curve sampling available in HEC-WAT, refer to Chapter 17 of this User's Manual. 
 
15.4.3 Performance Metrics 
 
USACE guidance and policy requires that risk and uncertainty analyses be performed for 
USACE planning studies. Risk for USACE is the measure of the probability and severity of 
undesirable consequences (ER 1105-2-101). From these analyses, the performance of a system's 
reaction to a flood must be commented. These metrics (Chapter 19) describe the capability of the 
system to accommodate a single event (Assurance) and the full range of events (Annual 
Exceedance Probability and Long-Term Exceedance Probability). These metrics assist in 
communicating risk and are defined in the following sections.  Not all FRA studies require the 
metrics from the Performance Metrics plug-in. Therefore, this plug-in should only be included in 
the compute sequence when necessary.  
 
Expected Annual Damage (EAD) 
 
Expected Annual Damage (EAD) is the average or mean of all possible values of damage 
determined on an annual basis by a Monte Carlo (a numerical integration approach) analysis of 
various variables that contribute to EAD along with those variable's associated uncertainties.  An 
HEC-FIA model is required in the FRA compute for EAD to be computed.  
 
Annual Exceedance Probability (AEP) 
 
Annual Exceedance Probability (AEP) is the probability that a specific capacity or target stage at 
a location of interest will be exceeded in a given year, based on the full range of possible flows. 
For levees (if applicable), AEP is the chance of failure or exceedance in any given year.  AEP is 
calculated at every grid cell and structure, and reflects the probability of ground stage being 
equaled or exceeded. 
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Assurance 
 
Assurance (also known as Conditional Non-Exceedance Probability, CNP) is the probability that 
a specific target (e.g., the top of a levee) will not be exceeded, given the occurrence of a specific 
flood event. 
 
Long Term Exceedance Probability (LTEP) 
 
Long Term Exceedance Probability (LTEP) is the probability that one or more flood events will 
occur within a specified time period or the likelihood that the target stage will be exceeded in a 
specified time period.  The calculations are made directly by using the binomial distribution (EM 
1110-2-1415). 
 
15.4.4 Life-Cycle Cost Analysis (LCCA) 
 
The FRA compute capability within the HEC-WAT framework is a computational option that a 
user can choose to perform plan formulation, system performance analyses or asset management 
studies using a life-cycle approach.  Expected annual damage is computed based on a 50-year 
life-cycle in part to capture changes to the system through the project life. Net benefits (damage 
reduced less costs), will be an output from the FRA compute. Therefore, the FRA compute will 
include the initial and life-cycle costs through that 50 year project life. Life cycle costs include 
the initial project investment, costs for operation, maintenance, repair, rehabilitation, and 
replacement. Estimates for future rehabilitation or replacement will include the costs of all 
related work. For example, it may be necessary to construct temporary facilities to ensure 
continued project function during replacement. For comparison purposes, evaluation of life cycle 
costs should include a calculation of the present worth, based on constant dollar analysis, and 
using appropriate discount rates for future costs. This life-cycle capability will allow for 
investment decisions on risk management system components and for scenario testing of 
management options.  Life cycle analysis including cost is not available in HEC-WAT Version 
1.0. 
 
15.4.5 Benefit Calculation Tool 
 
This tool will calculate the benefit (damage reduced) and net benefit (damage reduced minus 
cost) if cost information is available. HEC-WAT computes the benefits (damage reduced) for 
each alternative. Damage reduced is the damage prevented because a project or projects 
(measures), or structural and/or non-structural, are part of an alternative analyses. Frist, HEC-
WAT computes EAD for the Without Project Alternative and uses that EAD as a baseline to 
compare against all with-project alternatives. The Benefit Calculation Tool subtracts the with-
project alternative's EAD from the Without Project Alternative EAD to obtain the damage 
reduced for that particular with-project alternative.  The tool then computes Net Benefit for each 
with-project alternative by subtracting the EAC (Expected Annual Cost) for that particular with-
project alternative from the damage reduced for that particular with-project alternative. If the Net 
Benefit is greater than zero that means the damage reduced from that with-project alternative 
exceed costs and therefore is an economically viable project; i.e., net benefits of the with-project 
alternative exceed the costs of that with-project alternative. To generate the Benefit to Cost ratio, 
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the Benefit Calculation Tool simply takes the benefits for the with-project alternative and divides 
by the costs.  This tool will not be available in HEC-WAT Version 1.0. 
 
15.5 An FRA Study 
 
Now that the user has created a study (Chapter 7); has imported (Chapter 8) or created the 
appropriate model alternatives (including a hydrologic sampling alternative); created a program 
order (Chapter 11); created HEC-WAT alternative(s) (Chapter 10); created analysis period(s) 
(Chapter 9); and, if HEC-ResSim is included in the compute sequence, created an HEC-ResSim 
lookback window (Chapter 13, Section 13.3) – the user needs to decide if the study needs to 
include flood risk analysis. Chapters 16 through 21 provide details on selecting results for an 
FRA compute to view; setup fragility curve sampling if necessary; how to skip models in an 
FRA compute; setup the calculation of performance metrics if needed; and, outline the necessary 
steps for a user to create FRA simulations that will a1low the user to perform a plan formulation 
of system performance analyses that incorporates risk and uncertainty. 
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CHAPTER 16 
 
 

Output Variable Editor 
 
 
The Output Variable Editor (Figure 16.1) provides an interface for selecting results from an 
HEC-WAT flood risk analysis (FRA) compute.  Currently, only the maximum values from 
selected model alternative results and sampled parameters from some of the model alternatives 
are saved through output variables.  There are multiple options for saving files and model 
alternative results from an FRA compute.  All time-series information is saved in DSS files 
organized by life cycles.  In many cases, saving and maintaining many thousands of time-series 
data records is not possible due to storage limitations.  However, the maximum value from each 
time series is useful. For example, the peak flow or stage value from a hydrograph time-series 
can be used to compute a flow/stage frequency curve or these values can be plotted to quickly 
show if a flow or stage threshold was exceeded.  Saving the sampled parameters or initial 
conditions is useful when evaluating the conditions that led to certain results (i.e., when a high 
reservoir stage is a result of sampling a high starting pool condition).  
 

 
Figure 16.1  Output Variable Editor 
 
The Output Variable Editor has options for selecting an HEC-WAT simulation (only FRA 
simulations). First, select a model that is part of the selected HEC-WAT simulation program 
order and then select an available model alternative (a compute sequence can contain multiple 
instances of the same model) from the selected HEC-WAT simulation.  Once those selections 
have been made, the user can select various variables (maximum values only), and, if wanted, 
create frequency curves. 
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The user must choose at least one output variable from the model alternatives in the compute 
sequence, or notify the FRA simulation to compute without an output variable.  For a 
"production" simulation where results are required, the user should choose all appropriate output 
variables before running the simulation.  Recommended and it is considered good practices for 
the user to choose at least one output variable.  In most cases, the desired type of results from an 
FRA simulation will include the maximum (or minimum) value from a time-series record.  For 
example, the maximum stage from a reservoir time-series could be extracted to build a reservoir 
stage frequency curve.  Saving time-series information from many thousands of events, at many 
locations, for many model alternatives could overwhelm the available storage on a computer.  
However, maximum values (scalars) do not require much disk space.  From the Output 
Variable Editor (Figure 16.1), a user can select any available output variables from the model 
alternatives that are part of a selected FRA simulation and get summary information (e.g., 
maximum flows, maximum stage, etc.) for each event in the FRA compute. 
 
 1. From the HEC-WAT main window (Figure 16.2), from the WAT Tools toolbar, click 
       . 
 

 
Figure 16.2  HEC-WAT Main Window 

 
 2. The Output Variable Editor will open (Figure 16.1).  From the editor, the user can 

select variables from the model alternatives that are part of a selected FRA simulation.  
Currently, the maximum value for each of the output variables selected will be saved to 
the simulation.dss file and if the user wants to generate a frequency curve for a selected 
output variable, the user must select Frequency from the Output Variable Editor 
(Figure 16.1). 
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 3. From the Simulation list, select an FRA simulation (only FRA simulations will be 
available). Next, from the Model list select the appropriate software application; and, 
then from the Alternative list select the appropriate model alternative. 

 
 4. Next, click Select Variables to Save, the Select model name and model alternative name 

Variables selector will open (Figure 16.3). 
 

 
Figure 16.3  Select model name and model alternative name Variables Selector 

 
 5. A list of the selected model alternative's available output variables is listed in the 

Available Variables list (e.g., Hydrologic Sampling, RR_Precipitation).  To select an 
output variable, highlight the variable, and then click Add.  The selected variable is 
moved to the Selected Variables list.  Click OK, the Select model name and model 
alternative name Variables selector (Figure 16.3) closes and the selected output variables 
appear on the Output Variable Editor (Figure 16.1). 

 
 6. From the File menu, click Save. Close the Output Variable Editor (Figure 16.1) 
 
16.1 Scalar Values 
 
The selected maximum value from each selected time-series is saved to the simulation.dss file.  
The selected output variables can be referred to as scalar values (Figure 16.4) since only the 
maximum magnitude is saved from the selected time-series records.  The output variables are 
organized by realization in the simulation.dss file.  Each realization is a collection member, and 
within a realization record, the individual life cycle results are saved in separate columns of a 
multi-column paired data record.  The x-parameter is the event number, and the y-parameter is  
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Figure 16.4  Maximum Scalars Saved to simulation.dss File 
 
the maximum value.  As shown in Figure 16.5, the results for Realization 1 are broken into two 
life cycles, Lifecycle 1 and 2, and each life cycle is a separate column in the paired data record.  
For the example HEC-WAT study being used (Figure 16.5), only two life cycles in a realization 
were specified which was due to the configuration of the analysis period and the FRA 
simulation. Other HEC-WAT studies may have a different number of life cycles per realization.  
Also, notice in Figure 16.5, that there are not scalars for every single event as some events were 
skipped because model skip flags was being applied (Chapter 18). 
 

 
Figure 16.5  Tabulated View of Maximum Scalars Saved to simulation.dss File 
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16.2 Frequency Curves 
 
For each scalar value selected, a frequency curve can be created.  From the Output Variable 
Editor (Figure 16.1), in the Frequency column (Figure 16.1), the user can select, for each scalar 
value, that a frequency curve be computed from results in each realization, and the combined 
frequency curve (computed by combining results from all realizations) will be computed 
(generated) along with the 5 and 95 percent confidence limits for the combined curve by HEC-
WAT. The checkbox in the Frequency column (Figure 16.1) must be checked, so that when the 
selected FRA simulation computes, results will be added to the simulation DSS file.  Figure 16.6 
provides an example of DSS pathnames with frequency curve results for each realization in 
addition to the combined curve and confidence limits.  The frequency curves are computed based 
on the total number of events that were simulated including events that were skipped using 
model skip flags.  The scalars (maximum values) are ranked from largest to smallest and the 
exceedance probability is computed based on the rank divided by the total number of events 
(plus one) in the realization.   
 

 
Figure 16.6  Frequency Curves in the simulation.dss File 
 
If frequency curves were not created for certain output variables after an FRA simulation has 
computed, the user can compute frequency curves.  After selecting output variables to create 
frequency curves, from the File menu (Figure 16.1), click Save and Compute Selected 
Frequencies. HEC-WAT will then compute frequency curves for the selected output variables.  
This option will only work when an FRA simulation has been previously computed. 
 
16.3 Results 
 
Results from the output variables can be accessed from the HEC-WAT main window (Figure 
16.2). From the Results menu (Figure 16.7), point to Output Variables.  Three options are 
available to visualize output variables - Histogram Viewer, Scalar Viewer, and Frequency 
Viewer.   
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Figure 16.7  HEC-WAT Main Window – Results Menu – Output Variables 
 
16.3.1 Histogram Viewer 
 
The Histogram Viewer (Figure 16.8) provides histogram plots of the user selected output 
variable from the Variable list (Figure 16.8) and then the realization (Realization list) and life 
cycle number (Lifecycle list).  The Lifecycle list does include an option to view all life cycles 
within a realization.  The Histogram Viewer (Figure 16.8) provides the user with a quick way to 
visualize the range of values (x-axis) for the selected model results and the relative probability 
(y-axis).  For example, in Figure 16.8, the user has chosen the output variable to plot a histogram 
for Realization 6 and all of its life cycles. 
 

 
Figure 16.8  Histogram Viewer 
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16.3.2 Variable Viewer 
 
The Variable Viewer (Figure 16.9) provides scalar plots of the user selected output variable 
from the Variable list (Figure 16.9) and the realization (Realization list) and life cycle number 
(Lifecycle list).  The Lifecycle list does include an option to view all life cycles within a 
realization.  The Output Variable Viewer (Figure 16.9) displays the output value (y-axis) for 
each event (x-axis) in the selected life cycle or from all life cycles in the selected realization.  
The Output Variable Viewer can be used to quickly identify outliers in the model results that 
might require additional investigation.  For example, in Figure 16.9, the user has chosen the 
output variable to plot a histogram for Realization 6, and all its life cycles. 
 

 
Figure 16.9  Output Variable Viewer 
 
16.3.3 Frequency Viewer 
 
The Frequency Viewer (Figure 16.10) provides frequency plots of the user selected output 
variable from the Variable list (Figure 16.10) and the realization (Realization list).  The 
Realization list does include an option to view all realizations.  For example, Figure 16.10, 
displays a frequency curve for All Realizations.  A separate frequency curve is plotted with 
results from each realization plus the combined frequency curve and the 5 and 95 percent 
confidence limits for the combined curve.  Only those output variables with Frequency selected 
in the Output Variable Editor (Figure 16.1) will have frequency curve results to visualize. 
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Figure 16.10  Frequency Viewer 
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CHAPTER 17 
 
 

Fragility Curve Sampling 
 
 
A fragility curve defines a structure's (i.e., levee) probability of failure over a range of elevation 
values at a specific location along the structure (i.e., levee).  To capture the likelihood of 
structural (i.e., levee) failure at specified locations, the fragility curve sampling in HEC-WAT 
occurs in a systems context with failure elevations at multiple locations being sampled either by 
realization or by event.  The elevation of failure that is sampled is then used by the hydraulics 
software (i.e., HEC-RAS) to evaluate breaching.  When sampling by realization, the failure 
elevation is sampled once per realization and held constant for every event in the realization. For 
sampling by event, a different failure elevation is generated for each event in a realization.  In 
Version 1.0 of HEC-WAT, the fragility curves should be representative of all potential failure 
modes (i.e., under seepage, through seepage, erosion), and there is no uncertainty around the 
fragility curve. 
 
The User's Manual describes the use of fragility curves in levee evaluations, but fragility curves 
can also be defined and used within HEC-WAT for structures situated perpendicular to a water 
course (i.e. dam). In this case, the Inline Structure Breach Data Editor in HEC-RAS is used in 
place of the Levee (Lateral Structure) Breach Data Editor (Section 17.1) to define the 
fragility curve characteristics for inline structures. 
 
17.1 Overview 
 
To capture the likelihood of levee failure at specified levee locations, levee failure elevations 
will be sampled from the input fragility curves at each project location for each event or 
realization.  HEC-WAT randomly selects a value between zero and one for either each event or 
each realization (user's choice), from the user-defined fragility curve(s) in the Fragility Curve 
Editor (Figure 17.1).  The corresponding levee breach elevation is then passed to the RAS 
model alternative.  HEC-RAS uses that elevation as the trigger failure elevation, which is defined 
in the HEC-RAS Levee (Lateral Structure) Breach Data Editor (Figure 17.2; for further 
details refer to the HEC-RAS User's Manual).  If the HEC-RAS computed water surface 
elevation meets or exceeds the elevation sampled from the fragility curve, the levee is assumed 
to breach and the breach progresses according to the defined values within the HEC-RAS model. 
 
Fragility is also an element of the project life cycle process.  Commonly, without maintenance, 
structures (i.e., levees) deteriorate over time.  This can be reflected within a fragility curve by 
increasing the likelihood of failure at a given water surface elevation (or a lower elevation for a 
given probability).  Scheduled maintenance can be reflected within a fragility curve by 
decreasing the likelihood of failure at a given elevation or raising the elevation for a given 
probability.  A levee failure and subsequent repair would also have an effect on the fragility 
curves.  Figure 17.3 displays an example 50-year life cycle, and the hypothetical change in levee 
fragility with time as well as failure and repair.  Also, the randomly sampled failure elevation  
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Figure 17.1  Fragility Curve Editor 
 

 
Figure 17.2  HEC-RAS – Levee (Lateral Structure) Breach Data Editor 
 
at that location (from random value 0.29) used for one realization of the Monte Carlo simulations 
is displayed in Figure 17.3.  This sampled failure elevation would decrease as the fragility curve 
showed weakening over time and would further decrease after a failure, but would increase after 
subsequent repair. To capture these changing conditions, the user must enter a different fragility 
curve and perform a separate analysis for each condition within HEC-WAT.   
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Figure 17.3  Levee Fragility Curves at Different Points during a Fifty-Year Life Cycle 
 
17.2 HEC-WAT Fragility Curve Sampling Prerequisites 
 
There are several prerequisites to creating fragility curves within HEC-WAT: 
 
 1. To perform fragility curve sampling in an HEC-WAT study, the fragility curve plug-in 

should be enabled. By default, the fragility curve plug-in should be enabled in HEC-
WAT. To verify that the plug-in is enabled, from the HEC-WAT main window (Figure 
17.4), from the Tools menu, click Options.  The Options dialog box will open (Figure 
17.5), click the Plug-ins tab.  A display of the enabled/disabled plug-ins available in 
HEC-WAT is displayed, check FragilityCurvePlugin and make sure it is enabled. 

 

 
Figure 17.4  HEC-WAT Main Window 
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Figure 17.5  Options Dialog Box – Plug-Ins Tab 

 
 2. To enable fragility curve sampling for an HEC-WAT study, from the HEC-WAT main 

window (Figure 17.4), from the File menu, click Study Details, the Study Details dialog 
box (Figure 17.6) will open (for further information on the Study Details dialog box, see 
Chapter 4, Section 4.1.5). 

 

 
Figure 17.6  Study Details Dialog Box – Plugins Tab 

 
 3. Click the Plugins tab (Figure 17.6), by default, all plug-ins are enabled (Figure 17.6).  

For example, in Figure 17.6, the plug-ins enabled include FIA, Fragility Curve, 
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Hydrologic Sampling, Performance Metrics, RAS, Simulation Compute Engine Manager, 
and TimeWindowModifier.  To ensure that the fragility curve sampler is available, a 
check mark should be displayed in the Enabled column of the table (Figure 17.6).  When 
the appropriate plug-in configuration is selected, click OK.  The Study Details dialog 
box will close (Figure 17.6) and the plug-in configuration for the active study will be set. 

 
 4. The HEC-WAT study must include a RAS model alternative (plan) with at least one 

lateral or inline structure and defined breach information.  
 
 5. Fragility curves are associated with alternatives within HEC-WAT, and each fragility 

curve requires a fragility curve common computation point (CCP) defined within an 
HEC-WAT alternative.  

 
In Version 1.0, the user can import levee breach locations from HEC-RAS (Section 17.4), or the 
user can define each levee and/or breach location (CCPs) in the HEC-WAT schematic.  The 
CCPs must correspond to breach location(s) defined in the HEC-RAS model. For further details 
on adding levees and CCPs to an HEC-WAT study, see Chapter 6. 
 
17.3 HEC-RAS Breach Configuration Considerations 
 
For fragility curve sampling to work in HEC-WAT, the RAS model alternative (plan) must be 
setup for levee breaching. 
 
 1. To ensure the RAS model alternative (plan) for the current HEC-WAT simulation is 

setup correctly, from the HEC-WAT main window (Figure 17.4), from the Toolbar, click 
       .  The HEC-RAS main window will open (Figure 17.7). 
 

 
Figure 17.7  HEC-RAS Main Window 

 
 2. From the HEC-RAS Toolbar click     , or from the Run menu, click Unsteady Flow 

Analysis.  The HEC-RAS Unsteady Flow Analysis dialog box will open (Figure 17.8). 
 
 3. From the HEC-RAS Unsteady Flow Analysis dialog box (Figure 17.8), from the 

Options menu, click Levee (Lateral Structure) Breach, the Levee (Lateral Structure) 
Breach Data Editor will open (Figure 17.2).  Note: Fragility curves may also be 
associated with inline structures (i.e., dams).  This data can be entered on the Dam 
(Inline Structure) Breach Data Editor.  The following example will only provide 
descriptions for the definition of levee breach information.  However, the data 
requirements are similar for inline structures. 
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Figure 17.8  HEC-RAS – Unsteady Flow Analysis Dialog Box 

 
 5. From the HEC-RAS Levee (Lateral Structure) Breach Data Editor (Figure 17.2), the 

user will need to select breach options (Figure 17.9) for the defined lateral structure at a 
location.  The user will need to select Breach This Structure, select a breach method 
from the Breach Method list (default – User Entered Data), select a failure mode from 
the Failure Mode list, and select WS Elev from the Trigger Failure at list as the trigger 
failure option. 

 

 
Figure 17.9  HEC-RAS – Levee Breach Options 
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 6. From the Failure Mode list (Figure 17.9), HEC-RAS currently has two different 
breaching methods - piping and overtopping. The user must specify only one of these 
modes, even if the fragility curve combines the probability of failure due to both modes.  
If the levee is going to overtop and fail then select the Overtopping failure mode.  If the 
breach is expected to initiate from a piping failure mode and progress upwards and 
downwards until a complete breach has occurred, the Piping failure mode should be 
selected. 

 
 7. The user must define a trigger failure, from the Trigger Failure at list (Figure 17.9).  For 

HEC-WAT 1.0, the user should select WS Elev.  The WS Elev+Duration and Set Time 
options should not be selected for an FRA compute. However, if the user does select the 
WS Elev+Duration or the Set Time option and an FRA compute has been selected, then 
the trigger failure at option is automatically switched to the WS Elev.  The trigger failure 
elevation is used by HEC-RAS to begin initiation of the lateral structure breach.  The 
breach is initiated when the computed water surface elevation exceeds the trigger 
elevation and is not dependent on the selected failure mode. 

 
 8. When the user is finished configuring breach information for the study area in the RAS 

model alternative.  From the Unsteady Flow Analysis dialog box (Figure 17.8), from the 
File menu, click Save Plan to save changes.  From the File menu, click Exit, the 
Unsteady Flow Analysis dialog box will close (Figure 17.8).  From the HEC-RAS main 
window (Figure 17.7), from the File menu, click Exit, the HEC-RAS main window will 
close (Figure 17.7). 

 
 9. If the RAS model alternative in the HEC-WAT FRA simulation has all of the above set, 

then the user can go on to defining fragility curve alternatives and input data in HEC-
WAT. 

 
17.4 Import HEC-RAS Breach Locations 
 
When an HEC-WAT simulation contains a RAS model alternative (plan) that includes structure 
breach data, the user can import HEC-RAS breach locations as fragility CCPs. From the HEC-
WAT main window (Figure 17.4), from the Edit menu, point to RAS, click Import Breach 
Locations.  The Import Levee Breach Locations dialog box will open (Figure 17.10). 
 

 
Figure 17.10  Import Breach Locations Dialog Box 
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 1. From the RAS Plan list (Figure 17.10) select the RAS plan (model alternative) that 

contains the breach locations which should be imported. 
 
 2. The table (Figure 17.10) lists all of the defined breach locations (all lateral structures with 

breaching turned on) in the selected RAS plan (model alternative).  From the table, the 
user can select individual breach locations from the Import column (Figure 17.10) by 
clicking the check box.  The user can also change the stream station of the breach 
location from the Stream Station (Figure 17.10) column and change the name of the 
CCP from the CCP Name column (Figure 17.10). 

 
 3. The user can select all known breach locations (Select All) or clear the selections in the 

table (Select None).  If fragility curve CCPs already exist, the user can replace by 
selecting Replace Existing CCPs (Figure 17.10). 

 
 4. Click OK, the Import Levee Breach Locations dialog box will close (Figure 17.10).  

The HEC-RAS breach locations will be imported as fragility CCPs in the HEC-WAT 
study.  Please note that the import process only adds a geographic data layer based on the 
geographic coordinates of the breach locations.  There is no data linking (i.e., fragility 
curve input) when importing fragility curve CCPs. 

 
 5. Optionally, the user can associate the fragility CCPS with levees or other structures that 

may have been created for the HEC-WAT study. However, this is not a requirement. 
 
17.5 Creating Fragility Curves Alternatives 
 
Now that the user has verified that the fragility curve plug-in is enabled and that the RAS model 
alternative (plan) associated with the FRA simulation is setup for levee breaching, a fragility 
curve alternative needs to be created.  For each fragility curve alternative, the user will need to 
define fragility curves at each breach location. 
 
 1. From the HEC-WAT main window (Figure 17.4), from the Study Tree, from the Models 

node, right click on Fragility Curve, from the shortcut menu click New.  The Create 
New Fragility Curve Alternative dialog box will open (Figure 17.11).  Another way to 
create a fragility curve alternative is from the Edit menu, point to Fragility Curve, click 
New. 

 

 
Figure 17.11  Create New Fragility Curve Alternative Dialog Box 
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 2. In the Name box (Figure 17.11), the user must enter a unique name for the fragility curve 
alternative.  The user can also add a description in the Description box.  Click OK, the 
Create New Fragility Curve Alternative dialog box will close (Figure 17.11) and the 
Fragility Curve Editor will open (Figure 17.1). 

 
 3. The Fragility Curve Editor will display the name of the fragility curve alternative and a 

description, if entered.  Click OK, the Fragility Curve Editor will close (Figure 17.1). 
The name of the fragility curve alternative will appear in the Content Pane of the HEC-
WAT main window (Figure 17.12). 

 

 
Figure 17.12  Content Pane – Fragility Curve Alternative Shortcut Menu 

 
17.6 Fragility Curve Editor 
 
Now that fragility curve alternatives have been created, the user needs to define the fragility 
curves and to associate each curve with a failure location on a levee (structure).  From the 
Fragility Curve Editor (Figure 17.1): 
 
 1. The user can select from the Randomize every list (Figure 17.13) to have the failure 

elevations sampled by every event in a realization or sampled once in a realization.  The 
default is to randomize the failure elevations by event. 

 

 
Figure 17.13  Fragility Curve – Initial Setup 

 
 2. From the Levee list (Figure 17.13), the user can filter the list of fragility CCPs.  The list 

will either contain the names of levees that have been included in the HEC-WAT 
schematic (created in HEC-WAT for visual purposes only and not provided by the RAS 
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model alternative) or the <Not Selected> option.  If the user selects the <Not Selected> 
option, then all of the fragility curve CCPs will be available from the Failure Location 
list (Figure 17.13). 

 
 3. Elevation-probability information, which is used to define a fragility curve (Figure 

17.14), can then be entered.  The elevations should correspond to the levee structure 
elevations in the RAS model alternative (plan). 

 

 
Figure 17.14  Defining a Fragility Curve 

 
 4. A fragility curve (within HEC-WAT) is defined as a cumulative 

distribution function (CDF) where the probability of failure must 
start at zero (0.0) and span to a probability of one (1.0).  Both 
elevation and probability of failure must be monotonically 
increasing. 

 
 5. By right-clicking on the table that defines fragility curves, a 

shortcut menu will display (which is shown in the figure to the 
right).  From this shortcut menu, the user can cut/copy/paste 
items; clear selected cells; select all cells; delete rows; print the 
table; and export the table. 

 
 6. The user can fill cells that have been selected, from the shortcut 

menu click Fill, the Table Fill Options dialog box (Figure 
17.15).  The user has several options to choose from: 

 
 ● Linear Fill - when selecting the cells, for Linear Fill 

(Figure 17.18), the first and last rows must have data. Click 
OK, the Table Fill Options dialog box will close and the 
table will be filled with linearly interpolated data. 

 
 ● Repeat Fill - when selecting the cells, for Repeat Fill (Figure 17.15), the user must 

select a row that contains the data that will be repeated in the other selected rows. 
Click OK, the Table Fill Options dialog box will close and the table will be filled 
with repeated data. 

 
 ● Add Constant - when selecting the cells, for Add Constant (Figure 17.15), the user 

must select rows that contain data that the user wishes to increase by a constant value.  
The user will enter a value in the box next to Add Constant.  Click OK, the Table 
Fill Options dialog box will close and the rows selected in table will be filled with 
data that has been increased by the constant value entered by the user. 
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Figure 17.15  Table Fill Options Dialog Box 

 
 ● Multiple Factor - when selecting the cells, for Multiple Factor (Figure 17.15), the 

user must select rows that contain data that the user wishes to increase by a multiplier.  
The user will enter the multiplier in the box next to Multiple Factor.  Click OK, the 
Table Fill Options dialog box will close and the rows selected in table will be filled 
with data that has been increased by the multiplier entered by the user. 

 
 7. When the user chooses to Sum Selected Cells or Sum Entire Column from the shortcut 

menu, a Sum window will open (Figure 17.16) providing the user with the desired 
information. 

 

 
Figure 17.16 Sum Window 

 
 8. Once the user has entered all of the information for the fragility curve, click OK, the 

Fragility Curve Editor (Figure 17.1) will close. 
 
17.7 Individual Fragility Curve Alternatives 
 
The individual fragility curve alternative shortcut menu (Figure 17.12) will allows the user to 
edit, save, create a copy of an existing fragility curve alternative, rename, and delete. 
 
17.7.1 Edit 
 
 1. From the HEC-WAT main window (Figure 17.4), from the Content Pane (Figure 17.12), 

right-click on a fragility curve alternative, from the shortcut menu click Edit.  The 
Fragility Curve Editor will open (Figure 17.1).  

 
 2. From the Fragility Curve Editor, the user can edit an existing fragility curve alternative.  

When editing is finished, click OK, the Fragility Curve Editor will close (Figure 17.1). 
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17.7.2 Save 
 
From the HEC-WAT main window (Figure 17.4), from the Content Pane (Figure 17.12), right-
click on a fragility curve alternative, from the shortcut menu click Save.  The fragility curve data 
is saved. 
 
17.7.3 Save As 
 
 1. From the HEC-WAT main window (Figure 17.4), from the Content Pane (Figure 17.12), 

right-click on a fragility curve alternative, from the shortcut menu click Save As.  The 
Save Fragility Curve As dialog box will open (Figure 17.17). 

 

 
Figure 17.17  Save Fragility Curve As Dialog Box 

 
 2. The name of the fragility curve alternative which is being copied is displayed in the Old 

Name box (Figure 17.17).  The user must enter a new unique name in the Name box, and 
can provide a description in the Description box (Figure 17.17). 

 
 3. Click OK, the Save Fragility Curve As dialog box will close (Figure 17.17). The name 

of the new fragility curve alternative will appear in the Content Pane (Figure 17.14) of 
the HEC-WAT main window (Figure 17.4). 

 
17.7.4 Rename 
 
 1. From the HEC-WAT main window (Figure 17.4), from the Content Pane (Figure 17.12), 

right-click on a fragility curve alternative, from the shortcut menu click Rename.  The 
Rename Fragility Curve dialog box will open (Figure 17.18). 

 

 
Figure 17.18  Rename Fragility Curve Dialog Box 

 
 2. The name of the fragility curve alternative that the user is renaming is displayed in the 

Name box.  The user must enter a new unique name in the Name box (Figure 17.18), and 
can provide a description in the Description box (Figure 17.18). 
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 3. Click OK, the Rename Fragility Curve dialog box will close (Figure 17.18). The re-

named fragility curve alternative will appear in the Content Pane (Figure 17.12) of the 
HEC-WAT main window (Figure 17.4). 

 
17.7.5 Delete 
 
 1. From the HEC-WAT main window (Figure 17.4), from the Content Pane (Figure 17.12), 

right-click on a fragility curve alternative, from the shortcut menu click Delete.  A 
Confirm Delete window box will open (Figure 17.19). 

 

 
Figure 17.19  Confirm Delete Window 

 
 2. Click Yes, the selected fragility curve alternative will no longer be displayed in the 

Content Pane (Figure 17.12) of the HEC-WAT main window (Figure 17.4). 
 
17.8 Multiple Fragility Curve Alternatives 
 
Multiple fragility curve alternatives can be created that evaluate different scenarios of levee 
fragility, like weak or strong levee alternatives.  The user defined elevation-probability 
information is saved per fragility curve alternative.  The same fragility curve CCPs can be used 
in multiple fragility curve alternatives with different elevation-probability information.  The user 
can edit and view the multiple fragility curve alternatives in the Fragility Curve Model Editor 
(Figure 17.1) using the Navigator Tool (Figure 17.20) or manipulate the fragility curve 
alternatives from the Content Pane (Figure 17.12) using the shortcut menu (Figure 17.12). 
 

 
Figure 17.20  Navigator Tool 
 
 1. From the Fragility Curve Editor (Figure 17.1), using the Navigator Tool (Figure 

17.20), the user can move through the defined fragility curve alternatives. 
 
 2. The      symbol places the user at the top (first) of the fragility curve alternative list, while 

the      symbol places the user at the bottom (last) of the fragility curve alternative list. 
The      (previous) symbol and the      (next) symbol moves the user back one and forward 
one in the fragility curve alternative list, respectively. The center of the navigation button 
indicates the number of fragility curve alternatives in the list and which fragility curve 
alternative the user is presently accessing.  
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 3. For example, the user could edit the first fragility curve alternative, click Apply (which 
saves any edits), click     . Now the user can view or edit the next fragility curve 
alternative in the list. 
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CHAPTER 18 
 

Model Skip Rules Editor 
 
The Model Skip Rules Editor is available as part of the flood risk analysis (FRA) compute of 
HEC-WAT. The purpose of the Model Skip Rules Editor is to allow the user to define logical 
expressions (i.e., if-then statements) of conditions when model computations will be skipped, or 
not performed, within an FRA compute. This allows the user to eliminate unnecessary 
computations and reduce run-times for an FRA compute.  Note the user needs to understand 
what it might mean to skip a model alternative within an FRA compute. Some model alternatives 
should never be skipped within the compute sequence. For a performance metrics alternative 
(Chapter 19) it should not be skipped, because some of the computations being performed by the 
performance metrics alternative cannot be skipped.  
 
To access the Model Skip Rules Editor, from the HEC-WAT main window (Figure 18.1), from 
the toolbar click     , or from the Edit menu, point to FRA, click Model Skip Rules Editor.  
Either way the Model Skip Rules Editor (Figure 18.2) will open. 
 

 
Figure 18.1  HEC-WAT Main Window 
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Figure 18.2  Model Skip Rules Editor 
 
18.1 Create a Skip Rule 
 
To create a skip rule for a simulation and a model alternative that is part of that simulation's 
program order: 
 
 1. From the Model Skip Rules Editor (Figure 18.2), from the Simulation list (Figure 18.2) 

select a simulation.  From the Description box, the user can enter an optional description.   
 
 2. From the Model Alternative list (Figure 18.2), select a model alternative that is part of 

the selected simulation.  The skip rule that is being created will be applied prior to the 
selected model alternative.  This is important, the skip rule is not automatically applied to 
the selected model alternative.  The selected model alternative is required to place the 
skip rule within the compute sequence. 

 
 3. Only models at and below the selected model alternative are available to be skipped, and 

standard practice is to select the model alternative that corresponds to the model that will 
be skipped first. 

 
 4. The Build Logical Expression table (Figure 18.2) is where a logical expression is 

defined that provides information to the simulation about when and which model 
computation will be skipped during an FRA compute. A logical expression is tied to the 
selected model alternative, which means that only one logical expression can be defined 
per model alternative. The default values presented in the table are the IF and END 
conditions, and the user defines desired conditions and rules.  Further information about 
building a logical expression is detailed in Section 18.2. 
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 5. From the Edit Logical Expression box (Figure 18.2), the user can select which type of 
logical expression needs to be built from the Logical Expression list (Figure 18.2).  The 
Logical Expression list has two options - Comparison and Model was Skipped. The 
Comparison option allows the user to compare one expression to another to determine 
whether a computation should be skipped. When the first model alternative in the list is 
selected, only the Comparison option is available. The Model was Skipped option 
allows the user to include the following condition within the logical expression: a model 
alternative located earlier in the compute sequence has been skipped.  Further 
information about editing a logical expression is detailed in Section 18.3. 

 
18.2 Building Logical Expressions 
 
The basic format of a logical expression follows: IF [Expression A] compared to [Expression B] 
is true, SKIP [Selected Models]. The user can add more complex logic using ELSEIF, ELSE, 
AND and OR logic actions, and can add parentheses around a selection or a COMMENT to the 
logical expression to support understanding of the decision logic. Each expression must be 
defined to return a scalar value, and two expressions are evaluated to determine whether the 
specified comparison of scalar values results in a true or false condition. If the comparison 
results in a false condition, no action is taken. If the comparison results in a true condition, the 
model alternatives selected by the user are skipped in the compute sequence. 
 
To build the first part of each skip rule (IF [Expression A] compared to [Expression B]), the user 
starts by selecting the IF row in the Build Logical Expression table (Figure 18.2). This enables 
the Edit Logical Expression box (Figure 18.2) of the Model Skip Rules Editor.  
 

1. From the Logical Expression list (Figure 18.2), select Comparison or Model was 
Skipped.  The Comparison function is used to compare the scalar values created by the 
two expressions to determine whether the comparison results in a true or false condition. 
The Model was Skipped function is used to evaluate whether a previous model 
alternative was skipped due to a skip rule. This option is most beneficial when the user 
wants to base skipping of a model alternative on another model alternative that does not 
immediately precede the model alternative of interest (i.e., is several levels higher in the 
Program Order). 

 
2. If the logical expression choice is Model was Skipped (Figure 18.3), the user only has to 

select the model alternative that will be skipped from the Model list (Figure 18.3).  Only 
model alternatives in the compute sequence before the selected model alternative are 
available in the list.  Click Save, in the Build Logical Expression table, row one, Rule 
column (Figure 18.2), the model alternative selected will display. 

 

 
Figure 18.3  Model Skip Rules Editor – Edit Logical Expression – Model was Skipped 

 
3. If the logical expression choice is Comparison, in the Expression A box (Figure 18.2), 

start creating the Expression A part of the logical expression.  To the right of the 
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Expression A box, click Edit, the Edit Logical Expression dialog box will open (Figure 
18.4).  From this editor the user will build the Expression A part of the logical expression.  
Further information about editing a logical expression is detailed in Section 18.3.  When 
finished click Save (Figure 18.4), click OK, the Edit Logical Expression dialog box will 
close (Figure 18.4).  In the Expression A box of the Model Skip Rules Editor (Figure 
18.2), the created expression will display.  Expression A in the Build Logical Expression 
table can be updated by selecting Apply in the Model Skip Rules Editor. 

 

 
Figure 18.4  Edit Logical Expression Dialog Box 

 
4. If the logical expression choice was Comparison, in the Expression B box (Figure 18.2), 

start creating the Expression B part of the logical expression.  To the right of the 
Expression B box, click Edit, the Edit Logical Expression dialog box will open (Figure 
18.4).  From this editor the user will build the Expression B part of the logical expression.  
Further information about editing a logical expression is detailed in Section 18.3.  When 
finished click Save (Figure 18.4), click OK, the Edit Logical Expression dialog box will 
close (Figure 18.4).  In the Expression B box of the Model Skip Rules Editor (Figure 
18.2), the created expression will display.  Expression B in the Build Logical Expression 
table can be updated by selecting Apply in the Model Skip Rules Editor. 

 
18.3 Edit Logical Expression Dialog Box 
 
From the Edit Logical Expression dialog box (Figure 18.4) the user will build Expression A and 
Expression B for the logical expression that is being created for a model alternative.  Initially 
there are three commands available to the user to start creating an expression for Comparison - 
Operator, Table Lookup, and Scalar (Figure 18.5).  As an expression is built, the other 
commands become available – Time Series, Time Window, and Delete.  When building a 
logical expression, note that the contents of a selected row affect where a command is placed.  
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Figure 18.5  Edit Logical Expression Dialog Box – Initial Commands 
 
Specifically, if a selected row contains **Not Set**, the command will be placed on that row, 
and if a selected row contains anything other than **Not Set**, the command will be placed one 
row above the selected row.  The following sections provide details on each of the individual 
commands. 
 
18.3.1 Operator 
 
The Operator command is used to select the maximum (MAX), average (AVG) or minimum 
(MIN) value of a designated dataset for the logical expression comparison. When the user selects 
Operator, a row is added to the logical expression table with the default value of MAX(). The 
user can change this default operator from the Operator list (Figure 18.6).  Be sure the row with 
MAX is highlighted so the Operator list will display on the Edit Logical Expression dialog 
box (Figure 18.4).  
 

 
Figure 18.6  Edit Logical Expression Dialog Box – Operator List 
 
Once the desired operator is specified, the user then selects the row inside the operator 
parentheses labeled *Not Set* to define the source of information used for comparison. Three 
commands for source data are available: Time Series (Section 18.3.4), Time Window (Section 
18.3.5), and Table Lookup (Section 18.3.2).  
 
18.3.2 Table Lookup 
 
Table Lookup allows the user to define a set of related data (e.g., a hydraulic rating curve), and 
is used to look up a dependent variable based on an independent variable. Two actions are 
needed to configure the Table Lookup option: define the contents of the lookup table and define 
a logical expression that specifies the independent variable.  
 
The first Table Lookup action is to define the contents of the lookup table.  When Table 
Lookup is selected (Figure 18.7), a row is added to the logical expression table with the 
LOOKUP@ expression and the interface is updated to present the user with two options for 
entering tabulated data from the Table Type list (Figure 18.7) - User Table and DSS Table. For 
either option, the user can optionally enter a name in the Table Name box (Figure 18.7). 
 

● The User Table option (Figure 18.7) allows for the manual entry of X and Y values, with 
X as the independent variable and Y as the dependent variable. The number of rows in 
the table can be expanded by right-clicking inside the table for a shortcut menu of table 
editing options. 
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Figure 18.7  Edit Logical Expression Dialog Box – Table Lookup – User Table 

 
● The DSS Table option (Figure 18.8) allows the user to select a DSS file (click Select, the 

Select Time Series dialog box will open) for the reference table in the same manner as 
described in the Time Series section (Section 18.3.4). 

 

 
Figure 18.8  Edit Logical Expression Dialog Box – Table Lookup – DSS Table 

 
The second Table Lookup action is to define a logical expression that specifies the independent 
variable (Figure 18.9), click Operator. The MAX operator is added to the expression building 
table (Figure 18.9). For example, in Figure 18.9, the Table Lookup command is using the 
maximum value from the time series (click Time Series) referenced in the MAX command as the 
independent variable.  From the Time Series Expression list (Figure 18.9), select Time Series 
from Model.  From the Select Time Series box (Figure 18.9), select the model alternative that 
contains the time series that the user is looking for.  In the Time Series list box (Figure 18.9), is 
a list of available time series data for the selected model alternative.  Click Apply, the row in the 
expression building table (Figure 18.9) that contains the independent variable will now display 
the time series information for the independent variable. 
 
18.3.3 Scalar 
 
The Scalar command allows the user to specify a constant value (default).  From the Scalar 
Expression list (Figure 18.10) select Constant, in the Constant box (Figure 18.10), enter the 
value (default is zero).  
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Figure 18.9  Edit Logical Expression Dialog Box – Table Lookup – Time Series 
 

 
Figure 18.10  Edit Logical Expression Dialog Box – Scalar 
 
18.3.4 Time Series 
 
The Time Series option allows the user to reference a time series of data in a logical expression. 
Note that a Time Series can only be added to the expression inside an Operator (Section 
18.3.1). From the table on the Edit Logical Expression dialog box (Figure 18.4), make sure the 
row with *Not Set*has been selected, click Time Series (Figure 18.11), the interface will 
change. From the Time Series Expression list (Figure 18.11), there are two options - DSS from 
File (Figure 18.11) or Time Series from Model.  
 
For the DSS from File option (Figure 18.11), the user can select a DSS file and pathname, click 
Select (Figure 18.11).  The Select Time Series dialog box will open (Figure 18.12), navigate to 
the DSS file location, from the table select the appropriate pathname, click Select (Figure 18.11).  
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Figure 18.11  Edit Logical Expression Dialog Box – Time Series – DSS from File 
 

 
Figure 18.12  Select Time Series Dialog Box 
 
The Select Time Series dialog box will close (Figure 18.12), and the selected information will 
display on the Edit Logical Expression dialog box (Figure 18.11) in the File box and the Path 
box.  The logical expression can be updated to display the Time Series by clicking Save or 
Apply on the Edit Logical Expression Editor (Figure 18.9). 
 
The Time Series from Model option (Figure 18.13) allows the user to select time series data 
from model alternatives that are part of the FRA simulation. From the Select Time Series box 
(Figure 18.12), from the Model list (Figure 18.13), select the appropriate model alternative. The 
Time Series list (Figure 18.13) displays the time series data available from the selected model 
alternative. Select a single time series to include in the logical expression, click Apply, the 
selected time series will be added to the expression. 
 
18.3.5 Time Window 
 
The Time Window can only be added to the expression inside an Operator (Section 18.3.1) and 
allows the user to apply an Operator to a portion or subset of a time-series. For example, the 
user can find the maximum flow between two dates of interest, as specified by the time  
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Figure 18.13  Edit Logical Expression Dialog Box – Time Series – Time Series from Model 
 
window. From the table on the Edit Logical Expression dialog box (Figure 18.4), make sure the 
row with *Not Set*has been selected, click Time Window (Figure 18.14), the interface will 
change. A row is added to the logical expression table on the Edit Logical Expression dialog 
box (Figure 18.14), with the TIMEWINDOW expression.  
 

 
Figure 18.14  Edit Logical Expression Dialog Box – Time Window 
 
For the Start and End of the time window (Figure 18.14) there are three options - DSS Record, 
Model's Compute Window, and Specified.  These options can be selected independently for the 
start and end dates and times. For example, the user could select DSS Record for Start and 
Specified for End (Figure 18.14).  
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In addition to specifying a source for both the start and end of a time window, the user must also 
specify a time series for application of the Operator. For example, a MAX Operator could be 
applied to a stage time series from HEC-RAS or a flow time series from the Hydrologic Sampler 
to find the maximum stage or flow, respectively, within a given time window. The time series is 
specified by selecting the row immediately below the TIMEWINDOW row in the logical 
expression, which activates the Time Series command (Figure 18.5). Refer to Section 18.3.4 for 
details on how to select a time series from a DSS file. 
 
The DSS Record option (Figure 18.13) bases the start or end date and time on a user-specified 
DSS record. In this case, the DSS record selected to provide the time series data for the 
Operator is also used to set the time window start or end time.  
 
The Model's Compute Window bases the start or end date and time on the compute window of 
the selected model alternative. The selected model alternative is identified on the Edit Logical 
Expression dialog box (Figure 18.3), along with the name of the FRA simulation. If a Time 
Window Modifier (Chapter 9) has been applied to the selected model alternative, the Model's 
Compute Window option will reference the modified time window associated with that model 
alternative.  
 
The Specified option (Figure 18.15) allows the user to enter a specific date and time for either 
the Start or End time. For both the Start and End boxes (Figure 18.15) there are Date and 
Time boxes (Figure 18.14). The date should be entered in DDMMM format (e.g., 10Jan) or 
selected from a calendar, from the right of the Date box (Figure 18.15) click     , a calendar 
window will open from which the user can select a date (although year is displayed in the 
calendar, it is not used in the Date box or computations). The time should be entered in 24-hour 
format (e.g., 1630). 
 

 
Figure 18.15  Edit Logical Expression Dialog Box – Time Window - Specified 
 
18.3.6  Delete 
 
The Delete option can be used to delete one or more highlighted rows from the expression. 
 
18.4 Model Skip Rules Editor - Comparison Operator 
 
The Comparison Operator defines how Expression A will be compared to Expression B.  From 
the Model Skip Rules Editor (Figure 18.2), from the Edit Logical Expression box, the 
Comparison Operator list (Figure 18.16) contains the following operators: 
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== (equal to) 
!= (not equal to) 
<= (less than or equal to) 
>= (greater than or equal to) 
< (less than) 
> (greater than) 

 

 
Figure 18.16  Edit Logical Expression Dialog Box – Comparison Operator List 
 
18.5 Model Skip Rules Editor - Available Actions 
 
The user has the option to add other conditions to the skip rule beyond the simple IF statement. 
If the user selects a row in the middle of the skip rule (i.e., not the first or the last row), all four 
commands in the Available Actions box (Figure 18.17) are enabled -  Else If, Else, And, and 
Or. When the user selects one of these options, a new row with the selected command is added 
to the Build Logical Expression table (Figure 8.2) above the highlighted row. If the user selects 
the END row, only the Else If and Else commands are enabled. In this case, a new row with the 
selected command is added to the Build Logical Expression table (Figure 8.2) above the END 
row. The commands function is detailed in the following sections. 
 

 
Figure 18.17  Model Skip Rules Editor – Available Actions - End 
 
18.5.1 Default - If 
 
This condition specifies the first rule that is tested for true or false. This is included in the Build 
Logical Expression table by default. If this rule is true, the evaluation moves to the Skip rule. If 
the If rule is false, the evaluation moves to the first Else If rule (Section 18.5.2). If all rules are 
false, the evaluation moves to the Else rule if the user has chosen to specify a default action. 
Otherwise the evaluation stops and no models are skipped. 
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18.5.2 Else If 
 
This condition allows the user to evaluate additional rules for true or false beyond the initial If 
rule. If the evaluation is false for the initial If rule (Section 18.5.1), the evaluation moves to the 
first Else If rule (Figure 18.17) to test for true or false. If an Else If rule is true, the evaluation 
moves to the Skip rule. If an Else If rule is false, the evaluation moves to the next Else If rule. If 
all rules are false, the evaluation moves to the Else rule if the user has chosen to specify a default 
action. Otherwise the evaluation stops and no models are skipped. The user can include as many 
Else Ifs, or alternate rules, as desired. 
 
18.5.3 Else 
 
This condition specifies the default action when none of the If or Else If rules are evaluated as 
true. The Else rule (Figure 18.17) is optional, and only one Else rule is allowed in a logical 
expression. 
 
18.5.4 And 
 
The And condition (Figure 18.17) can be used to ensure that multiple rules are evaluated as true 
before models are skipped. If any part of an And rule set is evaluated as false, the logical 
expression evaluation stops and no models are skipped. 
 
18.5.5 Or 
 
The Or condition (Figure 18.17) allows evaluation of additional expressions if previous 
expressions are evaluated as false. If any part of an Or rule is evaluated as true, the logical 
expression evaluation moves to directly to the Skip rule. 
 
18.5.6 Selection 
 
This option lets the user specify the order of operation using parentheses, where operations 
inside parentheses are completed first. 
 
18.5.7 Select List of Models to Skip 
 
The user should specify which models to skip in the FRA compute if the skip rule is met. This is 
done by selecting the row in the Build Logical Expression table that contains END. In the 
Available Actions box (Figure 8.17), several options become available.  
 
To skip models in the selected FRA simulation, click Select List of Models to Skip (Figure 
18.17), the Select Models to Skip box (Figure 18.18) contains a list of model alternatives that 
could be skipped.   The list is based on the selected model alternative and the listed models 
follow the selected model alternative in the program order. The user should select the model of 
interest to skip, as well as all other models that follow in the compute sequence because they will 
not have input data to run. 
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Figure 18.18  Model Skip Rules Editor – Select Models to Skip Box 
 
18.5.8 Comment 
 
This command allows the user to enter documentation within a logical expression. Comments 
(Figure 18-17) do not affect the evaluation of the logical expression. 
 
18.5.9 Delete 
 
Multiple conditions can be added to the Model Skip Rules Editor, and one or more rows can be 
deleted by highlighting them and selecting the Delete button. 
 
18.6 Default - End Condition 
 
The END condition signifies the end of the defined logical expression or skip rule. 
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CHAPTER 19 
 
 

Performance and Economic Metrics 
 
 
USACE requires that for USACE planning studies, risk and uncertainty analyses be performed in 
a systems context.  From these analyses, the performance of the system's reaction to an event 
needs to be stated.  The performance and economic metrics that can be computed in Version 1.0 
of HEC-WAT meet these USACE requirements.  The user will need to determine if the study 
being conducted needs to report performance and economic metrics.  If the study requires the 
reporting of performance and economic metrics, then the user will need to build a Performance 
Metrics Alternative for the FRA compute.  The HEC-WAT Technical Reference Guide (not 
available for Version 1.0 release) will provide the user with further details on the computation of 
performance and economic metrics in HEC-WAT. 
 
19.1 Available Performance and Economic Metrics 
 
The performance and economic metrics available in Version 1.0 of HEC-WAT are described in 
the following sections. 
 
19.1.1 Expected Annual Damage (EAD) 
 
Expected Annual Damage (EAD) is an economic metric that is the average or mean of all annual 
damage determined from a Monte Carlo (a numerical integration approach) analysis of variables 
that contribute to EAD, along with those variables' associated uncertainties. HEC-WAT can 
compute both EAD and the uncertainty about EAD, as shown in Figure 19.1. An HEC-FIA 
model is required in the FRA compute for EAD to be computed. 
 
HEC-WAT results for EAD provide the user with a general idea of how the EAD estimates are 
probabilistically distributed and easily characterize some global aspects of the distribution (skew, 
data gaps, etc.).  During an FRA simulation, the consequence model alternative (FIA) can 
produce damage for each simulated flood event.  HEC-WAT can then collect these damage 
results and calculate an average value per life cycle for each simulation which is analogous to an 
EAD estimate.  All of these EAD estimates can then be assigned an equal probability. Finally, 
HEC-WAT can create a probability density function of EAD with uncertainty. 
 
19.1.2 Annual Exceedance Probability (AEP) 
 
Annual Exceedance Probability (AEP) is the probability that a specific target stage at a location 
of interest will be exceeded in a given year, based on the full range of possible flows. Within the 
HEC-WAT Performance Metrics tool the user can select a common computation point (CCP) 
location and, for each location the user can specify a target stage. This means that the target stage 
is per location, and the locations must be CCPs. For each selected CCP, the user will be able to  
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Figure 19.1  EAD with Uncertainty Plot – PDF (probability distribution function) 
 
select an input DSS time series record from any model alternative.  An example, is an AEP of 
stage at a CCP, is generated by an RAS model alternative. It should be noted that stage 
information from HEC-RAS storage areas is not currently available for AEP evaluation. AEP is 
used in the calculation of Assurance and Long Term Exceedance Probability (LTEP). 
 
19.1.3 Assurance 
 
The performance metric Assurance (also known as Conditional Non-Exceedance Probability, 
CNP), is the probability that a specific target (e.g., the top of a levee) will not be exceeded, given 
the occurrence of a specific flood event. This is illustrated in Figure 19.2, which shows that a 
stage of 53 feet is not exceeded for 90 percent of the stages modeled for the 1 percent ACE 
(Annual Chance Exceedance). To compute Assurance, create a performance metrics alternative 
and define an AEP location (Section 19.1.4). When AEP is calculated, assurance will also be 
automatically calculated for six exceedance probabilities: 10%, 4%, 2%, 1%, 0.5% and 0.2%. 
 
19.1.4 Long Term Exceedance Probability (LTEP) 
 
Long Term Exceedance Probability (LTEP) is a performance metric that is the probability that 
one or more flood events will occur within a specified time period or the likelihood that the 
target stage will be exceeded in a specified time period.  LTEP results are currently available for 
three time periods in HEC-WAT: 10-, 30- and 50-years. The calculations use the binomial 
distribution and the computed AEP (EM 1110-2-1415). 
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Figure 19.2  Assurance 
 
19.2 Performance Metrics Alternative 
 
For HEC-WAT to compute performance and economic metrics the user will need to create and 
setup certain parameters in a performance metrics alternative.  This section provides information 
on creating, editing, saving, creating copies, renaming, and deleting performance metrics 
alternatives. 
 
19.2.1 Create 
 
To create a performance metrics alternative: 
 
 1. From the HEC-WAT main window (Figure 19.3), from the Study Tree, from the Models 

folder, right-click on Performance Metrics.  From the shortcut menu (Figure 19.4), click 
New, or from the HEC-WAT main window (Figure 19.3), from the Edit menu, point to 
Performance Metrics, click New.  Using either approach, the Create New 
Performance Metrics Alternative dialog box will open (Figure 19.5). 

 

 
Figure 19.3  HEC-WAT Main Window 
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Figure 19.4  Study Tree – Performance Metrics – Shortcut Menu 

 

 
Figure 19.5  Create New Performance Metrics Alternative Dialog Box 

 
 2. In the Name box (Figure 19.5), enter a name for the performance metrics alternative.  A 

description for the alternative can be entered in the Description box (Figure 19.5). 
 
 3. Click OK, the Create New Performance Metrics Alternative dialog box (Figure 19.5) 

will close.  The Performance Metrics Editor will open (Figure 19.6) and the name of 
the performance metrics alternative will display in the Content Pane (Figure 19.4) of the 
HEC-WAT main window. 

 

 
Figure 19.6  Performance Metrics Editor 
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 4. By default the Performance Metrics Editor (Figure 19.6) defaults to computing EAD 

with uncertainty.  If the user wishes not to compute EAD with uncertainty, click 
Compute EAD with Uncertainty (check-mark will disappear). 

 
 5. To create a name for linking the models to the active performance metrics alternative 

(i.e., PM_St. Paul), click Add (Figure 19.6).  A default name will display (EAD 1, EAD 
2, etc.) in the Linkage Name Table (Figure 19.6).  The user can change this default 
name by selecting a row in the table and changing the name.  A name can be deleted by 
selecting a row, clicking Remove (Figure 19.6) and the selected name is deleted.  

 
 6. From the Annual Exceedance Probability tab (Figure 19.7) of the Performance 

Metrics Editor, the user can setup the computation of AEP.  By default, the computation 
of AEP is set. If the user does not wish to calculate AEP, click Compute AEP (check-
mark will disappear).  It should be noted that AEP is used in the calculation of the other 
performance metrics (e.g., Assurance, LTEP). Therefore, ensure that AEP is being 
computed when also computing Assurance and/or LTEP. 

 

 
Figure 19.7  Performance Metrics Editor – Annual Exceedance Probability Tab 

 
 7. To display AEP and LTEP in a histogram, the number of bars (bins) is required.  By 

default the number of bars (bins) in the histograms is set to twenty (20).  The user can 
change the number of bars (bins) in the Number of AEP Histogram Bars and the 
Number of LTEP Histogram Bars boxes (Figure 19.7). 

 
 8. Next the user needs to select the location(s) where AEP is to be computed in the study.  

These locations can only be CCPs that have already been defined for the study area.  
From the Performance Metric Editor (Figure 19.7), click Select Locations, the 
Selection Editor (Figure 19.8) will open.  From the Available Locations box, select the 
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location(s) where AEP is to be computed.  Click Add, the selected location(s) will now 
appear in the Selected Locations box (Figure 19.8). Click OK, the Selection Editor will 
close (Figure 19.8) and the names of the selected location(s) will appear on the 
Performance Metrics Editor (Figure 19.7) in the table. 

 

 
Figure 19.8  Selection Editor 

 
 9. For the specified location(s), the user will need to enter a target stage, from the table 

(Figure 19.7), under the Target Stage column. 
 
 10. Now that information has be defined for the performance metric alternative, click OK, 

the Performance Metrics Editor (Figure 19.7) will close. 
 
19.2.2 Edit 
 
 1. From the HEC-WAT main window (Figure 19.3), from the Content Pane (Figure 19.9), 

right-click on a performance metrics alternative, from the shortcut menu click Edit.  The 
Performance Metrics Editor will open (Figure 19.6).  

 
 2. From the Performance Metrics Editor, the user can edit an existing performance 

metrics alternative.  When editing is finished, click OK, the Performance Metrics 
Editor will close (Figure 19.6). 

 
19.2.3 Save 
 
From the HEC-WAT main window (Figure 19.3), from the Content Pane (Figure 19.9), right-
click on a performance metrics alternative, from the shortcut menu click Save.  The performance 
metrics alternative data is saved. 
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Figure 19.9  Individual Performance Metrics Alternative - Content Pane- Shortcut Menu 

 
19.2.4 Save As 
 
 1. From the HEC-WAT main window (Figure 19.3), from the Content Pane (Figure 19.9), 

right-click on a performance metrics alternative, from the shortcut menu, click Save As.  
The Save Performance Metrics As dialog box will open (Figure 19.10). 

 

 
Figure 19.10  Save Performance Metrics As Dialog Box 

 
 2. The name of the performance metrics alternative which is being copied is displayed in the 

Old Name box (Figure 19.10).  The user will enter a new unique name in the Name box. 
An optional can be provided description in the Description box (Figure 19.10). 

 
 3. Click OK, the Save Performance Metrics As dialog box will close (Figure 19.10), and 

the name of the new performance metrics alternative will appear in the Content Pane 
(Figure 19.9) of the HEC-WAT main window (Figure 19.3). 

 
19.2.5 Rename 
 
 1. From the HEC-WAT main window (Figure 19.3), from the Content Pane (Figure 19.9), 

right-click on a performance metrics alternative, from the shortcut menu click Rename.  
The Rename Performance Metrics dialog box will open (Figure 19.11). 

 
 2. The name of the performance metrics alternative which is being renamed is displayed in 

the Name box.  The user must enter a new unique name in the Name box (Figure 19.11). 
An optional description can be provided in the Description box (Figure 19.11). 
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Figure 19.11  Rename Performance Metrics Dialog Box 

 
 3. Click OK, the Rename Performance Metrics dialog box will close (Figure 19.11), and 

the re-named performance metrics alternative will appear in the Content Pane (Figure 
19.9) of the HEC-WAT main window (Figure 19.3). 

 
19.2.6 Delete 
 
 1. From the HEC-WAT main window (Figure 19.3), from the Content Pane (Figure 19.9), 

right-click on a performance metrics alternative, from the shortcut menu click Delete.  A 
Confirm Delete window box will open (Figure 19.12). 

 

 
Figure 19.12  Confirm Delete Window 

 
 2. Click Yes, the selected performance metrics alternative will no longer be displayed in the 

Content Pane (Figure 19.9) of the HEC-WAT main window (Figure 19.3). 
 
19.3 Model Skip Rules Editor 
 
The Model Skip Rules Editor (Chapter 18) is available as part of the flood risk analysis (FRA) 
compute of HEC-WAT. The purpose of the Model Skip Rules Editor is to allow the user to 
define logical expressions (i.e.., if-then statements) of conditions when model computations will 
be skipped, or not performed, within an FRA compute. A performance metrics alternative should 
never be skipped, because some of the computed results may not be correct if the performance 
metrics alternative is skipped. 
 
19.4 Model Linking 
 
Model linking (Chapter 12) is the process within the HEC-WAT framework that allows the 
individual models to communicate with each other and how data is handed-off from model 
alternative to model alternative.  For a performance metrics alternative, the EAD metric should 
be linked to an FIA model alternative and the AEP metric should be linked to stage at an HEC-
RAS cross-section. 
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19.5 Results 
 
Performance metrics results are available from a series of plots and reports that will be discussed 
in the following sections.  Chapter 21 will provide further details on where in the HEC-WAT 
interface these results can be obtained.  The simulation.dss file (e.g., Without_Project_ 
Conditions-TimeWindow.dss) contains performance metrics results (EAD, AEP) that the user can 
access with HEC-DSSVue (Figure 19.13) and create specific plots and reports. 
 

 
Figure 19.13  HEC-DSSVue – simulation.dss File 
 
HEC-WAT results for a performance metrics alternative are available for the active HEC-WAT 
FRA simulation from the HEC-WAT main window (Figure 19.3). From the Results menu 
(Figure 19.14), point to Performance Metrics, from the sub-menu are the available performance 
metrics results from HEC-WAT. 
 

 
Figure 19.14  Results Menu – Performance Metrics 
 
19.5.1 Select Event Results 
 
To provide meaningful results, the user can setup how to organize those results.  From the HEC-
WAT main window (Figure 19.3), from the Results menu (Figure 19.14), click Select Results. 



Chapter 19 – Performance & Economic Metrics HEC-WAT User's Manual 

19-10 

The Select Event Results dialog box will open (Figure 19.15).  The user can select a realization, 
lifecycle, and/or event, for which performance metrics results will be displayed. 
 

 
Figure 19.15  Select Event Results Dialog Box 
 
19.5.2 Plot EAD 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 19.3), 
from the Results menu (Figure 19.14), point to Performance Metrics, from the sub-menu click 
Plot EAD.  The EAD with Uncertainty Plot dialog box will open (19.16), displaying (by 
default) the cumulative distribution function (CDF) of the EAD with Uncertainty Plot.  For 
EAD, this plot is for all realizations. For example, in Figure 19.16, ten realizations of 500 events 
each (total of 5,000 events).  An example of the probability density function (PDF) is provided in 
Figure 19.1.  The CDF displayed in Figure 19.16 records the EAD from each realization, ranked 
from smallest to largest, plotted by the position of the record in the ranked list as an exceedance 
probability. Within any realization, the damage from all events are accumulated and divided by 
the total number of events simulated within a realization. This produces an estimate of EAD at 
the realization level. Each realization estimate of EAD will differ slightly from other realization 
estimates, based on the sampled frequency curve and sampled uncertainty in each model in the 
compute sequence. The average of all realization estimates of EAD is presented in the Total 
Mean EAD box (Figure 19.16), and the variance in the realization level EAD values represents 
the uncertainty around the average.  Equivalently, the PDF plot presented in Figure 19.1 also 
describes the distribution of the realization estimates of EAD. 
 
19.5.3 EAD Output Report 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 19.3), 
from the Results menu (Figure 19.14), point to Performance Metrics, from the sub-menu click 
EAD Output Report.  A text editor will open (Figure 19.17), which contains the EAD Output 
Report.  This report provides information about the years in a realization (i.e., 500); the number 
of realizations (i.e., 10); the mean EAD (i.e., $48,618,722.38); a table summarizing confidence 
about the mean EAD; numbers of bins (bars) (i.e., 20) for the EAD histogram; and, a table that 
represents the EAD histogram.  This report is generated in after the completion of an FRA 
compute. 
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Figure 19.16  EAD with Uncertainty Plot Dialog Box – Plot CDF 
 
 

 
Figure 19.17  EAD Output Report 
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19.5.4 AEP Histogram 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 19.3), 
from the Results menu (Figure 19.14), point to Performance Metrics, from the sub-menu click 
AEP Histogram.  An AEP Histograms dialog box will open (Figure 19.18), providing a plot of 
the calculated AEP in a histogram.  The histogram provides a graphical representation of 
numerical data and allows the user to discover and display the underlying frequency distribution 
(shape) of the numerical data.  This plot is representative of all realizations (e.g., 5,000 events), 
and for the first watershed location (i.e., PFMW3) in the Location list (Figure 19.18). 
 

 
Figure 19.18  AEP Histogram 
 
19.5.5 LTEP Histogram 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 19.3), 
from the Results menu (Figure 19.14), point to Performance Metrics, from the sub-menu click 
LTEP Histogram.  An LTEP Histograms dialog box will open (Figure 19.19), providing a plot 
of the calculated LTEP values in a histogram.  The histogram provides a graphical representation 
of numerical data and allows the user to discover and display the underlying frequency 
distribution (shape) of numerical data.  This plot is representative of all realizations (e.g., 5,000 
events), and for the first watershed location (i.e., PFMW3) in the Location list (Figure 19.19). 
 



HEC-WAT User's Manual Chapter 19 – Performance & Economic Metrics 

 19-13 

 

 
Figure 19.19  LTEP Histogram 
 
19.5.6 Performance Metrics Output Report 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 19.3), 
from the Results menu (Figure 19.14), point to Performance Metrics, from the sub-menu click 
Performance Metrics Output Report.  A text editor will open (Figure 19.20), which contains 
the Performance Metrics Report.  This report provides information about the years in a 
realization (i.e., 500); the number of realizations (i.e., 10); the mean AEP (i.e., 34.57) for a 
specific watershed location (i.e., PFMW3); a table that is the summary of Assurance; a table of 
the AEP histogram; a table of the mean LTEP; and, a table that represents the LTEP histogram.  
This report is generated in after the completion of an FRA compute. 
 



Chapter 19 – Performance & Economic Metrics HEC-WAT User's Manual 

19-14 

 
Figure 19.20  Performance Metrics Output Report 
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CHAPTER 20 
 

Final Study Setup – Flood Risk Analysis 
 
Now the user has an understanding about the HEC-WAT framework with an FRA study in mind 
- how to create a study; an introduction to map layers; model alternatives have either been 
created or imported into the study; analysis periods (time windows); alternative and simulations 
have been created; and, model linking has been defined.  There are a few more setup items for an 
FRA compute that need to occur:  which plug-ins are associated with an FRA study; 
manipulating map layers associated with the study; entering the correct lookback window for an 
HEC-ResSim model (if part of the study); creating specific FRA model alternatives; time 
window modifiers; model linking the FRA model alternatives; creating an FRA simulation; and 
selecting specific output for an FRA simulation. 
 
20.1 Define Plug-Ins for an FRA Study 
 
Plug-ins (Chapter 2) allow HEC-WAT to integrate software applications into its framework 
without requiring special code in HEC-WAT to support the individual software applications.  
Currently there are nineteen plug-ins that have been created (Appendix B provides further 
details), eight of those specifically for standalone software applications, and eleven plug-ins 
specifically created for HEC-WAT functions.  While all of these plug-ins are available, the user 
must inform HEC-WAT which plug-ins are needed for a given study from the Study Details 
dialog box (Figure 20.1).  Plug-ins can be enabled/disabled from the Options dialog box 
(Appendix B), but this should only be done to enable/disable specific plug-ins for specialized 
studies or when there is an issue with a plug-in. 
 

 
Figure 20.1  Study Details Dialog Box – Plugins Tab – FRA 
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To set the specific plug-ins for an FRA study: 
 
 1. From the HEC-WAT main window (Figure 20.2), from the File menu, click Study 

Details, the Study Details dialog box (Figure 20.1) will open. 
 

 
Figure 20.2 HEC-WAT Main Window 

 
 2. The Study Details dialog box (Figure 20.1) displays the name of the study, the study 

description (which the user can edit), location of the study file (*.sty), the selected unit 
system, the selected coordinate system, the user name of the team member that created 
the study, and the date and time the study was created. 

 
 3. Click the Plugins tab (Figure 20.1), by default, all plug-ins are enabled; for an FRA study 

the user should choose the software applications that will be used in an FRA study.  For 
example, in Figure 20.1, for the active FRA study the plug-ins enabled are FIA, Fragility 
Curve, Hydrologic Sampling, Performance Metrics, RAS, Simulation Compute Engine 
Manager, and TimeWindowModifier. 

 
 4. For an FRA study, the only required plug-in is the Hydrologic Sampling plug-in, for all 

other plug-ins and software applications the user can select based on the analyses 
required of the FRA study area. 

 
 5. To disable a plug-in clear the check mark in the Enabled column of the table (Figure 

20.1).  When the user has the right plug-in configuration, click OK.  The Study Details 
dialog box will close (Figure 20.1) and the plug-in configuration for the FRA study has 
been set. 
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20.2 Adjust Map Layers 
 
Whether models were built from within the HEC-WAT study or imported, there could be map 
layers that define the study area.  The user may need to adjust the map layers so that the 
schematic displays information to the study team and others. 
 
 1. From the HEC-WAT main window, click the Maps tab (Figure 20.3).  Now the user can 

see which Map Window is currently active and what layers make up that Map Window.  
The user can now make adjustments (changes to draw properties) to the map layers, from 
the Map Layers tree: 

 

 
Figure 20.3  HEC-WAT Main Window – Maps Tab 

 
 ● Un-check a map layer so that it will no longer display in the active map window.  

For example in Figure 20.3, the stpaul_10ft.smrmp map layer has been un-checked. 
 
 ● For map layers, the user can change the display properties of the selected map layer 

For example, in Figure 20.3, the user could right-click on the Fail_Middle_Design_ 
  HA.shp map layer, from the shortcut menu, click Properties.  The Edit Polygon 

Properties Editor will open (Figure 20.4).  From the Fill tab, change the color to 
"lightblue", click OK.  The impact areas on the active map window will now display 
in "lightblue". 

 
 ● Move layers to better display certain aspects of the schematic.  For example, in 

Figure 20.3, right-click on Stream Alignment, from the shortcut menu click Move 
To Top.  The Stream Alignment layer is now the top layer in the schematic. 
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Figure 20.4  Edit Polygon Properties Editor 

 
 2. The user can adjust the view of the study area in the active map window.  Using the 

Magnifier tool, zoom the study area in the active map window to the appropriate area 
that the user would like displayed.  From the HEC-WAT main window (Figure 20.3), 
from the Maps menu, click Default Map Properties, the Default Map Properties for 
dialog box will open (Figure 20.5).  Click Set Map Extents to Display, click OK.  The 
Default Map Properties for dialog box will close. 

 

 
Figure 20.5  Default Map Properties for Dialog Box 
 
This sets the extents for the Map Window so that when the study is opened the next time 
the Map Window will be zoomed in to the tighter area. 
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20.3 Lookback Window – HEC-ResSim (only) 
 
The time window for an HEC-ResSim run has two parts, a "lookback period" and a "simulation 
or forecast period".  The lookback period is used by HEC-ResSim to "warm up" a ResSim model 
alternative.  During this period, routing of flows through the river and reservoir network are 
performed but no release decisions are made nor are any mass balance computations evaluated.  
The user should think of the lookback period as the time to establish the state of the river 
network and the starting conditions of the reservoirs.  The simulation period is the portion of the 
time window during which HEC-ResSim simulates reservoir operations, and makes release 
decisions based on the operation logic defined by the user.  Releases are then routed through the 
river network, combining with local inflows along the way.   
 
HEC-WAT and most of the models treat the analysis period as a single, continuous time 
window. Because HEC-ResSim splits the analysis period into two parts, an additional setup step 
is required for each active HEC-ResSim alternative in an HEC-WAT study.  The setup step lets 
each ResSim model alternative know how much of the analysis period to use for the lookback 
period.   
 
To set-up the lookback period: 
 
 1. From the HEC-WAT main window (Figure 20.2), from the Edit menu, point to ResSim, 

click Lookback Window (Figure 20.6), the Lookback Window dialog box (Figure 
20.7) will open. 

 

 
Figure 20.6  Edit Menu – ResSim – Lookback Window 

 
 2. The table on the Lookback Window dialog box (Figure 20.7) displays the ResSim model 

alternatives that are available in the HEC-WAT study.  Each model alternative that is 
being used in an HEC-WAT simulation will need to have a lookback window set.   For 
example, in Figure 20.7, the ResSim model alternative calibrate has a TimeStep of 1 
hour and Lookback Steps of 6. 
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Figure 20.7  Lookback Window Dialog Box 

 
 3. For each Alternative listed, a TimeStep (compute interval) and number of Lookback 

Steps must be specified.  The time step can be selected from the TimeStep column 
(Figure 20.7), in each cell there is a list of available time steps for the user to choose 
from.  The selected time step has to match the time step that was specified for the ResSim 
model alternative as part of the alternative's original Run Control data (which is located 
in the HEC-ResSim Alternative Editor). The number of lookback steps must be entered in 
a cell in the Lookback Steps column (Figure 20.7). At least one lookback time step is 
required for a ResSim model alternative to compute, however more lookback steps may 
be needed, depending on a variety of factors in the ResSim model alternative's operating 
rules.  The HEC-ResSim modeler should be consulted to determine the minimum 
lookback window needed by each alternative.  As mentioned, the lookback period takes 
place within the analysis period (time window) that HEC-WAT provides to the ResSim 
model alternative.  No reservoir operations will be simulated during the lookback period, 
which could impact model results.  

 
 4. Click OK, the Lookback Window dialog box (Figure 20.7) will close. 
 
20.4 FRA Specific Model Alternatives 
 
The HEC-WAT framework has several FRA specific model alternatives – hydrologic sampling, 
fragility curve sampling, performance and economic metrics, model skip flags, time window 
modifiers, and selecting specific output for an FRA simulation.  This section will provide an 
overview of these model alternatives (Chapters 16 through 19). 
 
20.4.1 Hydrologic Sampling 
 
The first step in an FRA compute is the sampling of the meteorology or hydrology of the study 
area to create perhaps thousands of events in meteorologic/hydrologic sequences.  The 
hydrologic information is needed as time series of flow or precipitation to be routed through the 
system being studied.  Both precipitation and flow sampling are supported within HEC-WAT, 
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although not within the same alternative. Precipitation would be sampled if an HEC-HMS model 
alternative is included in the compute sequence and is used to transform precipitation to runoff, 
which is then passed to other model alternatives in the compute sequence.  Flow would be 
sampled when the decision was made to bypass a precipitation-runoff model and go directly to 
reservoir or river hydraulics modeling.   
 
Hydrologic sampling (Figure 20.8) generates the hydrologic sequences, precipitation 
hyetographs or flow hydrographs, required for the simulation of the hydrology, reservoir 
operation, and hydraulics.  The hydrologic information, such as flow or precipitation frequency 
curves, cross correlations between curves, and hydrograph or hyetograph shapes is defined 
within the Hydrologic Sampling Editor.  For details on further details on hydrologic sampling 
in HEC-WAT, review the Hydrologic Sampler User's Manual. 
 

 
Figure 20.8  Hydrologic Sampling Editor 
 
20.4.2 Fragility Curve Sampling 
 
A fragility curve defines a structure's (i.e., levee) probability of failure over a range of elevation 
values at a specific location along the structure (i.e., levee).  To capture the likelihood of 
structural (i.e., levee) failure at specified locations, the fragility curve sampling in HEC-WAT  
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occurs in a systems context with failure elevations at multiple locations being sampled either by 
realization or by event.  The elevation of failure that is sampled is then used by the hydraulics 
software (i.e., HEC-RAS) to evaluate breaching.  When sampling by realization, the failure 
elevation is sampled once per realization and held constant for every event in the realization. For 
sampling by event, a different failure elevation is generated for each event in a realization.  For 
further details on how to enter data for fragility curve sampling, see Chapter 17 of this User's 
Manual.  The HEC-WAT Technical Reference Guide (which will not be available with the initial 
release of Version 1.0) will provide the user with further details on fragility curve sampling in 
HEC-WAT.  Fragility curve sampling is not required for an FRA compute, the user needs to 
determine if fragility curve sampling is needed for a flood risk management study. 
 
20.4.3 Performance Metrics Alternative 
 
As described in Chapter 19, there are several economic and performance metrics that can be 
computed that measure the performance of a system's reaction to an event.  Currently, in Version 
1.0 of HEC-WAT the user can (not required) request the computation of economic and 
performance metrics through a Performance Metrics Alternative.  The creation and entering of 
data for a Performance Metrics Alternative is described in Chapter 19.  The HEC-WAT 
Technical Reference Guide will provide the user with further details on the computation of 
economic and performance metrics in HEC-WAT (which will not be available with the initial 
release of Version 1.0).  Economic and performance metrics are not required for an FRA 
compute, the user needs to determine if reporting of economic and performance metrics are 
needed for a flood risk management study. 
 
20.5 Model Skip Flags 
 
An FRA compute requires a large amount of computation resources and a large amount of 
storage for results.  HEC-WAT provides a way to aid in the budgeting of computation resources 
and simulation times based on user entered criteria.  The Model Skip Rules Editor (Chapter 18) 
allows the user to define logical expressions (i.e.., if-then statements) of conditions when model 
alternative computations will be skipped, or not performed, within an FRA compute sequence. 
This allows the user to eliminate unnecessary computations and reduce run-times for an FRA 
compute.  Detailed information on the Model Skip Rules Editor and its available options is in 
Chapter 18. 
 
20.6 Time Window Modifiers 
 
An analysis period (time window) for an FRA simulation is different than when modeling 
historic events.  The analysis period for an FRA simulation is used to set the length of each life 
cycle within the FRA compute.  Typically, life cycles are fifty-years in length.  If the FRA 
simulation does not requires damage being analyzed and life cycles are not required, then the 
analysis period can be an arbitrary length; however, 100 or 500 year life cycles are optimal for 
results management.  The HEC-WAT framework provides several methods for modifying the 
analysis period time window within a simulation.  Modifying (time window modifiers are not 
required for an FRA simulation) the simulation time window is a way to make a simulation run 
faster or help make simulations more stable by adjusting the time window for each model that is 
part of an HEC-WAT simulation. 
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The Time Window Adjustment option (Chapter 9, Section 9.2.1) provides the user with simple 
methods to adjust the simulation time window for a specific model. The user can independently 
adjust the start and end dates and times of a simulation time window.  The Time Window 
Modifier (Chapter 9, Section 9.2.2) allows users to also alter the simulation time window, but 
based on model alternative results (e.g., adding or subtracting days relative to the date and time 
of a peak flow or stage) instead of date shifts. 
 
20.7 Create an HEC-WAT FRA Simulation 
 
Now that all of the building blocks have been configured, the user can create an HEC-WAT FRA 
simulation.  To create an HEC-WAT FRA simulation: 
 
 1. From the HEC-WAT main window (Figure 20.3), from the WAT Tools toolbar, click 
       . 
 
 2. The Alternative and Simulation Manager will open (Figure 20.9).  From this manager 

the user can create/modify alternatives, analysis periods, simulations, program order, link 
model alternatives, and compute FRA simulations. 

 

 
Figure 20.9  Alternative and Simulation Manager  

 
 3. To create a simulation, from the Alternative and Simulation Manager (Figure 20.9) 

table, right-click on the intersection of an alternative and analysis period.  An Analysis 
Period must be available in order for a simulation to be created.  An analysis period can 
only be used once per HEC-WAT alternative.  From the shortcut menu click Create 
Simulation.  The Create New Simulation dialog box will open (Figure 15.6). 

 
 4. HEC-WAT has defined a default name for the simulation (e.g., Without Project 

Conditions-TimeWindow) in the Name box (Figure 20.10).  The name is a combination 
of the HEC-WAT alternative name and analysis period name. The simulation name can 
be changed.  Also, in the Alternative and Analysis Period lists (Figure 20.10) the 
selections have already been made based on the intersection in the table.  The selected 
Alternative (Figure 20.10) cannot be changed, but the selected Analysis Period can be 
changed if there is an available analysis period to select. 
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Figure 20.10  Create New Simulation Dialog Box 

 
 5. In the F Part box (Figure 20.10), a default DSS F-Part is displayed that was generated by 

HEC-WAT based on the alternative and analysis period (this is informational and cannot 
be changed).  

 
 6. To create an FRA simulation, select Run FRA (Figure 20.11).  The options for setting up 

an FRA simulation are now available. 
 

 
Figure 20.11 Create New Simulation Dialog Box – FRA Setup 

 
 ● Number of realizations to perform the flood risk management analysis - enter 

the maximum number of realizations (e.g., 100) that are needed to perform the 
FRA analysis.  

 
 ● Years per realization - default is 500; number can be increased.  
 

Note: The number of events and the analysis period length are used to define the number 
of life cycles within a realization.  For example, an analysis period that is 50 years long 
will result in 10 life cycles if the years per realization is set to 500.  The years per  
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realization should be set to an even multiplier of the analysis period length.  The user can 
enter 1,000 years per realization and then 100 realizations.  In this example, 100 separate 
realizations of 1,000 years will be simulated, providing 100 flow and stage frequency 
curves that extend to 1/1,000 ACE (by sorting and ranking the flows/stages then dividing 
the rank by the total number of years in a realization, 1,000). In general, the number of 
events per realization should be two to three times the frequency storm event desired. For 
example, if the 1/100 pool elevation is desired, the number of sampled events for each 
realization should be a minimum of 250.  

 
 7. From the Hydrologic Event Alternative list (Figure 20.11) select the appropriate 

Hydrologic Sampling Alternative (e.g., HS – St. Paul Levee 30years). 
 
 8. A program order needs to be selected.  From the Program Order list (Figure 20.10) 

select the appropriate (i.e., FRM) program order for the simulation. 
 
 9. In the Programs table (Figure 20.12), the software applications that were defined in the 

program order appear in the order that was set in the program order.  Now the user must 
select the appropriate model alternative (i.e., plan, simulation run, alternative) for each 
software application. From the Alternative column (Figure 20.12), from the list for 
Fragility Curve (Figure 20.12), select the appropriate fragility curve alternative (e.g., FC 
– St. Paul Levee).  Repeat the process for the other software applications.  

 

Figure 20.12  Create New Simulation Dialog Box - Selection of Model Alternatives 
 
 10. Now that all of the model alternatives have been selected, click OK.  The Create New 

Simulation dialog box will close (Figure 20.11).  On the Alternative and Simulation 
Manager (Figure 20.13) dialog box, the intersection of the alternative and analysis 
period now provides information about the simulation. 

 
 11. Click OK; the Alternative and Simulation Manager dialog box will close (Figure 

20.13).  From the HEC-WAT main window (Figure 20.3), the created simulation appears 
on the Study Tree, under the Simulations folder (Figure 20.14). 

 
 12. Click on the simulation in the Study Tree (Figure 20.14), the Content Pane (Figure 

20.15) displays information about the selected simulation. 
 
 13. Double-click on the simulation name (e.g., Without Project Conditions-TimeWindow), a 

Select Map dialog box will open. Click New Map Window, click OK. The Select Map 
dialog box will close.  The new map window will contain the schematic elements that 
represent the simulation (Figure 20.16). 
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Figure 20.13  Alternative and Simulation Manager - Completed Simulation 

 
 

 
Figure 20.14  Study Tree with Created Simulation 

 
 

 
Figure 20.15  Content Pane 

 



HEC-WAT User's Manual Chapter 20 – Final Study Setup – Flood Risk Analysis 

 20-13 

 
Figure 20.16  Map Window - Schematic of Current HEC-WAT Simulation - FRA 
 
20.8 Manipulating FRA Simulations 
 
FRA simulations can be manipulated from shortcut menus that are available from the Study 
Tree (Chapter 11, Section 11.3.3), and the Alternative and Simulation Manager (Chapter 11, 
Section 11.2.6).  These shortcut menus will allow the user to view the selected simulation in a 
map window; edit the model alternatives associated with the selected simulation; remove the 
simulation map window; edit the active simulation; open the Model Linking Editor (Chapter 
12); compute; view the log of the compute; view results; save changes to the simulation; delete 
the simulation from the study; view the properties of the simulation; and, browse the run folder 
associated with the active simulation.  Chapter 11 provides further details on these capabilities 
from the individual simulation shortcut menu. 
 
20.9 Model Linking 
 
Now that FRA simulation(s) are setup, "linking" between the models will need to be defined. 
Linking is the process within the HEC-WAT framework that allows the individual models to 
communicate with each other and how data is handed-off from model alternative to model 
alternative. The majority of linking in HEC-WAT is accomplished through DSS mapping and the 
use of simulation names. Additional linking capabilities include inundation boundary maps, 
water depth maps, and other DSS files.  For example, the ResSim model alternative might 
require information from an HMS model alternative.  Chapter 12 provides information on using 
the Model Linking Editor and details other available linking options. 
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The hydrologic sampling and fragility curve sampling alternatives do not require linking to other 
model alternatives.  An example of modeling linking for the Time Window Modifier alternative 
is displayed in Figure 20.17.  This Time Window Modifier alternative (TimeWindowModifier-
ForRAS) shortens the time window for the RAS model alternative based on sampled upstream 
boundary conditions that are provided by the hydrologic sampling alternative (Hydrologic 
Sampling-HS – St. Paul Levee 30years). 
 

 
Figure 20.17  Model Linking Editor – Time Window Modifier Alternative 
 
For the Performance Metrics alternative, in the example displayed in Figure 20.18, there are 
two locations that are being linked, one location is being linked to an FIA model alternative 
(FIA_ALT_Grids) for the computation of EAD.  The second location (fragility curve location) is 
linked to a RAS model alternative (RAS-Fail Middle) for the computation of AEP and/or LTEP. 
 

 
Figure 20.18  Model Linking Editor – Performance Metrics Alternative 
 
20.10 Output Variables 
 
The Output Variable Editor (Figure 20.19) provides an interface for selecting output from an 
HEC-WAT FRA simulation.  Currently, only the maximum values from selected model outputs  
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Figure 20.19  Output Variable Editor 
 
and the sampled model parameters from some of the model applications are saved through output 
variables.  As previously mentioned, there are multiple options for saving files and model results 
for an FRA simulation.  All time-series information is saved in what is referred to as the lifecycle 
DSS files.  In many cases, saving and maintaining many thousands of time-series data records is 
not possible due to storage limitations.  However, the maximum value from each time-series is 
useful, and not storage-intensive to save.  For example, the peak flow or stage value from a 
hydrograph time-series can be used to compute a flow/stage frequency curve or these values can 
be plotted to quickly show if a flow or stage threshold was exceeded.  Saving the sampled 
parameters or initial conditions is useful when evaluating the conditions that led to certain results 
(i.e., a high reservoir stage is a result of sampling a high starting pool condition).  Results from 
many, but not all, variables from the individual applications can be saved through the Output 
Variable Editor (Chapter 16), and are written to a DSS file at the simulation level. 
 
The Output Variable Editor (Figure 20.19), has options for selecting an HEC-WAT FRA 
simulation, for selecting the model that is part of the selected FRA simulations, and then the 
model alternative (a compute sequence can contain multiple instances of the same model).  Once 
a simulation, model, and model alternative are selected, click Select Variables to Save, from the 
selector that opens (Chapter 18), the user will select variables that will be saved.  The user must 
select at least one output variable from the models in the compute sequence or tell the FRA 
simulation to compute without an output variable being chosen before computing an FRA 
simulation.  For a "production" simulation where output is required, the user should choose all 
appropriate output variables before running the simulation. 
 
Now that all of the setup has been completed, the user is ready to compute HEC-WAT flood risk 
analysis simulations. 
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CHAPTER 21 
 

Compute/Results – Flood Risk Analysis 
 
Now that an FRA simulation has been defined – which means model alternatives have been 
imported for an HEC-WAT study (Chapter 8); analysis periods (time window) have been defined 
(Chapter 9); a hydrologic sampling alternative has been defined (Hydrologic Sampler User's 
Manual); creation of fragility curve sampling (Chapter 17) and performance metrics alternatives 
(Chapter 19) are optional; time window modifiers (Chapter 9) have been defined if necessary; 
linking of model alternatives has been completed (Chapter 12); model skip flags (Chapter 18) 
have been defined if necessary; and, output variables have been selected (Chapter 16), the user is 
ready to compute an FRA simulation. 
 
21.1 Compute – FRA Simulation 
 
21.1.1 Study Tree 
 
Computing an FRA simulation from the Study Tree: 
 
 1. From the HEC-WAT main window (Figure 21.1), from the Study Tree, from the 

Simulations folder, right-click on a simulation (e.g., Without Project Conditions-
TimeWindow). From the shortcut menu (Figure 21.1) point to Compute, click 
Simulation. 

 

 
Figure 21.1  HEC-WAT Main Window – FRA Compute 



Chapter 21 – Computes/Results – Flood Risk Analysis HEC-WAT User's Manual 

21-2 

 2. The Run FRA Simulation dialog box will open (Figure 21.2).  In the Name box is the 
name of the simulation that will be computed (e.g., Without Project Conditions-
TimeWindow).  The number of realizations (10) that will be computed is provided in the 
Max. Number of Realizations box.  Other options are: 

 

 
Figure 21.2  Run FRA Simulation Dialog Box 

 
 ● Start at Lifecycle 1 - default starting point of an FRA compute (Figure 21.2).  
 
 ● Run specified - by selecting this option (Figure 21.2) the user can choose whether 

to run a specific life cycle or realization, or a range of life cycles or realizations.  
For example, the user can enter 2-5, 22 to run Lifecycles 2 through 5 and then 
Lifecycle 22. 

 
 ● Save Lifecycle DSS Files - when the user selects this option (Figure 21.2) all 

FRA results written to the life cycle DSS files are saved.  All HEC software 
applications - HEC-HMS, HEC-RAS, HEC-ResSim, and HEC-FIA write time-
series results to the life cycle DSS files during an FRA compute.  The output 
variables selected by the user are used by HEC-WAT to extract maximum values 
from the user selected time-series records.  If the user does not want the time-
series results to be saved, the user should not select Save Lifecycle DSS Files. 

 
  Note: It is a good practice to turn on the Save Lifecycle DSS Files (Figure 21.2) 

option when initially setting up an FRA simulation and evaluating results.  Once 
the user is comfortable that results are reasonable, then the life cycle DSS option 
can be turned off.  Also, the individual software applications have options for 
limiting the amount of data written to the life cycle DSS files.  The user could 
ensure that only necessary information was saved to the life cycle DSS files and 
then choose to keep these files.  
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 ● Save Model Folders – model alternative files by event are not saved by default; if 
the user wishes to save all information for each event, Save Model Folders 
(Figure 21.2) must be selected.  This information aids in the debugging of any 
issues that might occur when attempting to run an FRA compute.  As mentioned 
for the Save Lifecycle DSS Files option, this option can be turned off after the 
user verifies model alternative results are reasonable.  

 
 ● Stop Simulation Compute on Error - selecting this option (Figure 21.2) will 

cause the FRA compute to stop when any kind of error is detected during the 
simulation (compute).  This is a good option to turn on when initially making sure 
the FRA simulation can run. However, when performing final production 
simulations, it might be preferred to let the simulation run even though issues 
might have stopped an individual event from completing.  For example, when a 
RAS model alternative goes unstable due to initial conditions, the error is 
detected, and the simulation continues to the next model alternative in the 
compute sequence.  It is likely that the next model alternative will fail as well 
since adequate boundary conditions were not computed by the previous model 
alternative.  Eventually, the simulations will get through all the model alternatives 
within the compute sequence and then start the next event.  The output log will 
document any errors that prevented the successful completion of all model 
alternatives within the compute sequence for an event. 

 
 ● Output Variables Optional – by default an FRA compute requires that at least 

one output variable be selected; if Output Variables Optional (Figure 21.2) is 
selected then output variables are not required for the FRA compute.  Care should 
be taken when considering the selection of this option.  If no output variables are 
selected, then there will be no maximum values in the simulation DSS file.  

 
 ● Restart WAT After Model Errors – if Stop Simulation Compute on Error has 

not been selected, the Restart WAT After Model Errors option (Figure 21.2) 
becomes available.  If this option is selected, the user can set the consecutive 
number of errors that will make HEC-WAT restart and the maximum number of 
restarts.  This option is a way to restart HEC-WAT and all software applications 
computing within an FRA simulation.  When HEC-WAT is restarted, the FRA 
simulation will restart after the last successful life cycle.  

 
 ● Restart Plugins - this option allows the user to decide which software 

applications to restart during an FRA compute.  Restart Plugins (Figure 21.2) 
should be enacted if the user notices the compute runtimes slowing down for each 
model alternative in the compute sequence as the simulation progresses.  The 
software applications are restarted at the end of each life cycle, which frees up 
any virtual memory the software applications might be hanging onto while 
compute the events within a life cycle.  

 
 3. Click Next, the Run FRA Simulation Information dialog box (Figure 21.3) will open.  

This dialog box provides summary information about the FRA simulation that is about to 
be computed.  Information includes the time window, when the simulation will be 
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stopped, whether results will be saved, life cycles that will be run, model sequence 
information, time window modifiers; and output variable time windows. 

 

 
Figure 21.3  Run FRA Simulation Information Dialog Box 

 
 4. Click Compute, the Compute Progress dialog box will open (Figure 21.4).  When the 

compute is finished, click Close, the Compute Progress dialog box will close. 
 

 
Figure 21.4  Compute Progress Dialog Box - FRA Compute 
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21.1.2 Compute Menu 
 
From the HEC-WAT main window (Figure 21.1) from the Compute menu (Figure 21.5), the 
user can compute an FRA simulation from different commands.  If an FRA simulation is active 
(displayed in a Simulation Map Window in the Desktop Pane), then the first item in the 
Compute menu will be that FRA simulation's name (e.g., Without Project Conditions-
TimeWindow), hold down the CTRL key, click the FRA simulation, the Compute Progress 
dialog box will open (Figure 21.4) and the compute will start. 
 

 
Figure 21.5  HEC-WAT Main Window – Compute Menu 
 
From the Compute menu (Figure 21.5), point to Recent Simulations, a list of recently 
computed simulations will display, hold down the CTRL key, click on an FRA simulation that is 
to be computed.  The Compute Progress dialog box will open (Figure 21.4) and the compute 
will start. 
 
From the Compute menu (Figure 21.5), point to Compute, hold down the CTRL key, click 
Simulation, the Compute Progress dialog box will open (Figure 21.4) and the compute will 
start.  This will compute the active simulation (displayed in a Simulation Map Window in the 
Desktop Pane). 
 
21.2 Compute Manager 
 
The Compute Manager (Figure 21.6) is not available for FRA simulations, the main purpose of 
the Compute Manager is to setup running multiple simulations in deterministic mode.  FRA 
simulations are compute intensive; one simulation could run for several hours/days; and, a great 
deal of results are generated (consuming disk space).  For example, in Figure 21.6, since 
simulations are organized by HEC-WAT alternatives (i.e., Without Project Conditions), the only 
simulation displaying in the Compute Manager is the alternative that is not an FRA compute. 
 
21.3 Compute Log 
 
To view an FRA simulation compute log: 
 
 1. From the HEC-WAT main window (Figure 21.1), from the Compute Menu (Figure 

21.5), click View Compute Log – this command is only available when there is an active 
simulation (displayed in a Simulation Map Window in the Desktop Pane), the View 
Compute Log Editor (Figure 21.7). 
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Figure 21.6  Compute Manager Dialog Box 

 

 
Figure 21.7  Compute Log Editor 

 
 2. The compute log opens in an editor that allows the user to edit, search, print, and format 

the log.  The search function lets the user search for specific items to troubleshoot what is 
going on with the compute or review a detail about one of the software applications. 

 
 3. From the File menu, click Close, the Compute Log Editor will close (Figure 21.7). 
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21.4 Distributed Compute 
 
The FRA compute option relies on a Monte Carlo computational algorithm that requires 
potentially many thousands of simulations (realizations) of the individual model alternatives 
included in the program sequence defined for an FRA simulation.  To accommodate this need, 
the HEC-WAT framework includes a distributed compute option.  This distributed compute 
option allows the HEC-WAT software to distribute FRA computes across several compute 
nodes.  The compute node is the basic component of the distributed compute.  This option is 
available in Version 1.0 of HEC-WAT, if there is interest in using please contact the Hydrologic 
Engineering Center. 
 
21.5 Results Menu 
 
From the HEC-WAT Results menu, the user can access results from the different software 
applications and results from the FRA specific plug-ins that have been defined in an FRA 
simulation.  From the HEC-WAT main window (Figure 21.1), from the Results menu (Figure 
21.8), the user will point to a software application or a specific FRA plug-in from which the user 
wants to view results. 
 

 
Figure 21.8  HEC-WAT Main Window - Results Menu - FRA 
 
21.5.1 Select Event Results 
 
If the Save Model Folders option (Section 21.1.1) has been selected then results are available, 
and in an FRA compute that means all time series results from model alternatives that ran during 
the simulation. To provide meaningful results, the user can choose which individual event results 
to view.  From the HEC-WAT main window (Figure 21.1.), from the Results menu (Figure 
21.8), click Select Results, the Select Event Results dialog box will open (Figure 21.9).  The 
user can select by realization, life cycle, and event; with that selection define any of the FRA 
specific results will default to the selection. 
 
21.5.2 Simulation DSS File 
 
In an FRA compute, results from the model alternatives are stored in the DSS file that is stored 
in each life cycle folder (lifecycle.dss) of a realization.  Scalar results (maximum values from the 
time-series records), generated by the FRA specific model alternatives are stored in the  
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Figure 21.9  Select Event Results Dialog Box 
 
simulation.dss file (e.g., random numbers; output variables, frequency curves, etc.).  For Version 
1.0 not all of the FRA generated results are available from the HEC-WAT framework. From the 
HEC-WAT main window (Figure 2.1), from the Results menu (Figure 21.8), click Simulation 
DSS File, a HEC-DSSVue window will open (Figure 21.10), with the DSS file of the active 
simulation displayed.  Using the HEC-DSSVue interface, the user can view and create results, 
Appendix K provides further details on using the HEC-DSSVue software. Before opening the 
simulation DSS file, from the Results menu (Figure 21.8), a user should access model results 
stored in the simulation DSS file from the Output Variables menu item (Section 21.5.3). 
 

 
Figure 21.10  simulation.dss File 
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21.5.3 Output Variables 
 
Output variables in Version 1.0 are only the maximum values from user selected model 
alternative results and sampled parameters from some of the model alternatives.  The maximum 
value from each-time series is useful, for example, the peak flow or stage value from a 
hydrograph time-series can be used to compute a flow/stage frequency curve or these values can 
be plotted to quickly show if a flow or stage threshold was exceeded.  Saving the sampled 
parameters or initial conditions is useful when evaluating the conditions that led to certain results 
(a high reservoir stage is a result of sampling a high starting pool condition).  Chapter 16 
provides further details on output variables. 
 
There are three options for visualizing scalar results (output variables) – Histogram Viewer, 
Variable Viewer, and Frequency Viewer.  From the HEC-WAT main window (Figure 21.1), 
from the Results menu (Figure 21.8), point to Output Variables, click Frequency Viewer, the 
Frequency Viewer will open (Figure 21.11). 
 

 
Figure 21.11  Frequency Viewer - Default 
 
The Frequency Viewer by default displays the first defined output variable in the Variable list 
(Figure 21.12), and the first realization in the Realization list (Figure 21.11).  For example, to 
view the three-day average maximum flow frequency curves for all realizations for a particular 
location, from the Variable list (Figure 21.12), click Upstream Boundary Conditions – AVG 3 
DAY Max Flow  (results generated by the hydrologic sampling).  From the Realization list 
(Figure 21.11), click All Realizations.  The Frequency Viewer (Figure 21.13) will now display 
the frequency curves at the selected location for all realizations in the simulation. 
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Figure 21.12  Frequency Viewer – Variable List 
 

 
Figure 21.13  Frequency Viewer – Selected Location and All Realizations 
 
From the Edit and View menus of all the output variable viewers, the user can adjust items in the 
plot.  Also, by right-clicking in the viewer in various locations, the user can change the legend, 
change both axes, change the title, and more.  From the File menu, the user can Print, save the 
display plot as a graphics file (Save As), Tabulate, create/apply a template, and save the 
specifications of the plot.  For further information on manipulating the viewers, refer to 
Appendix M of this User's Manual, and HEC-DSSVue User's Manual. 
 
By using the Navigator Tool (Figure 21.14) the user can click through the output variables that 
have been defined, instead of making a selection from the Variable list (Figure 21.12). 
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Figure 21.14  Navigator Tool 
 
 1. From the Frequency Viewer (Figure 17.1), using the Navigator Tool (Figure 21.14), the 

user can move through the defined output variables. 
 
 2. The      symbol places the user at the top (first) of the output variable list, while the      

symbol places the user at the bottom (last) of the output variable list. The      (previous) 
symbol and the      (next) symbol moves the user back one and forward one in the output 
variable list, respectively. The center of the navigation button indicates the number of 
output variables in the list and which output variable the user is presently accessing.  

 
21.5.4 Hydrologic Sampling Results 
 
The sampling of hydrology can possibly generate thousands of events in a hydrologic sequence.  
Results will be hydrologic information such as flow or precipitation frequency curves, cross 
correlations between curves, and hydrograph or hyetograph shapes.  From the Results menu 
(Figure 21.15), point to Hydrologic Sampling, from the sub-menu there are various plots and 
reports that provide a view of some of the hydrology information.  For further details on the 
hydrologic sampling options available in HEC-WAT, refer to the Hydrologic Sampling User's 
Manual.  Note: the hydrologic sampling results are only available if the user chooses to save all 
model files during the FRA compute.  For many simulations, it is not practical so save all model 
files as disk storage is not adequate.  Output variables (Chapter 16) can be defined for most of 
the hydrologic sampling results.  
 

 
Figure 21.15  FRA Results Menu – Hydrologic Sampling 
 
All six results options described below are available for the Flow Sampling – Correlated 
Frequency Curves method, while only two of the items are available for the Flow Sampling – 
Bootstrapping Historical/Synthetic Basin-wide Events method (Plot Hydrograph and Output 
Report). No results are currently available through the interface for the Precipitation Sampling 
method, but these can be viewed through the DSS results file.  For further details on the 
hydrologic sampling options available in HEC-WAT, refer to the Hydrologic Sampler User's 
Manual. 
 
Plot Hydrograph 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 21.1), 
from the Results menu (Figure 21.15), point to Hydrologic Sampling, from the sub-menu click 
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Plot Hydrograph, the Hydrographs dialog box will open (Figure 21.16).  The initial 
hydrograph displayed is based on the selections (realization, life cycle, and event) made in the 
Select Event Results dialog box (Figure 21.9).  The user can view other hydrographs by 
selecting items in the lists (Figure 21.15) – Realization, Lifecycle, Event, and Location.  
 

 
Figure 21.16  Hydrographs Dialog Box 
 
Using the Zoom Tool,       (Figure 21.16) the user can zoom in on areas of interest in the plot.  
The user can modify the plot by right-clicking on areas in the plot, from the shortcut menus 
various items could be modified -  the axes title, the title of the plot, the viewport, axis tics, the 
curve, and many other things.  For further information on manipulating the plots, refer to 
Appendix M of this User's Manual, and HEC-DSSVue User's Manual. 
 
Plot Event Distribution 
 
The Plot Event Distribution option plots a histogram of the event dates of all sampled floods 
generated by the hydrologic sampling within an FRA compute. Each sampled date is used to 
place the peak of the flood event hydrograph in time, on a month and day. For the active FRA 
simulation, from the HEC-WAT main window (Figure 21.1), from the Results menu (Figure 
21.15), point to Hydrologic Sampling, from the sub-menu click Plot Event Distrib., the Flood 
Season dialog box will open (Figure 21.17).  This plot is for all life cycles (i.e., 100) and the 
number events (i.e., 5,000 events). The plot contains both the user defined and sampled dates. 
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Figure 21.17  Flood Season Dialog Box 
 
Using the Zoom Tool,       (Figure 21.17) the user can zoom in on areas of interest in the plot.  
The user can modify the plot by right-clicking on areas in the plot, from the shortcut menus 
various items could be modified -  the axes title, the title of the plot, the viewport, axis tics, the 
curve, and many other things.  For further information on manipulating the plots, refer to 
Appendix M of this User's Manual, and HEC-DSSVue User's Manual. 
 
Plot Maximum Flows 
 
The Plot Maximum Flow option creates a frequency plot of the sampled maximum flow of all 
flood events at each primary location generated by the hydrologic sampling within an FRA 
compute. A peak flow magnitude is generated for every event at each primary location based on 
correlated sampling from all locations' user-defined frequency curves. The results of this 
sampling are compared to the user-defined curve on a frequency plot. For the active FRA 
simulation from the HEC-WAT main window (Figure 21.1), from the Results menu (Figure 
21.15), point to Hydrologic Sampling, from the sub-menu click Plot Maximum Flows, the 
Primary Maximum Flow Frequency dialog box will open (Figure 21.18).  This plot is for all 
life cycles (i.e., 100), number of events (5,000 events), and a flow location.  From the Flow 
Location list (Figure 21.18), the user can select different locations that have been defined. 
 
Using the Zoom Tool,       (Figure 21.18) the user can zoom in on areas of interest in the plot.  
The user can modify the plot by right-clicking on areas in the plot, from the shortcut menus 
various items could be modified - the axes title, the title of the plot, the viewport, axis tics, the 
curve, and many other things.  For further information on manipulating the plots, refer to 
Appendix M of this User's Manual, and HEC-DSSVue User's Manual. 
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Figure 21.18  Primary Maximum Flow Frequency Dialog Box 
 
Correlation Table 
 
The Correlation Table contains the computed correlation coefficient for every pair of primary 
location maximum flows. Maximum flows for each event are generated by correlated random 
sampling from the frequency curves at every location, maintaining cross-correlations entered by 
the user.  For the active FRA simulation from the HEC-WAT main window (Figure 21.1), from 
the Results menu (Figure 21.15), point to Hydrologic Sampling, from the sub-menu click 
Correlation Table, the Cross Correlations dialog box will open (Figure 21.19).  This plot is for 
all lifecycles (i.e., 100) and number of events (5,000 events). 
 

 
Figure 21.19  Cross Correlations Dialog Box 
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Plot Shape Set Frequency 
 
The Plot Shape Set Frequency option plots a histogram of the event dates of all sampled floods 
generated by the hydrologic sampling within an FRA compute. Each sampled date is used to 
place the peak of the flood event hydrograph in time, on a month and day. For the active FRA 
simulation from the HEC-WAT main window (Figure 21.1), from the Results menu (Figure 
21.15), point to Hydrologic Sampling, from the sub-menu click Plot Shape Set Freq., the 
Shape Set Frequency dialog box will open (Figure 21.20).  This plot is for all life cycles (i.e., 
100) and number of events (5,000 events). 
 

 
Figure 21.20  Shape Set Frequency Dialog Box 
 
Using the Zoom Tool,       (Figure 21.20) the user can zoom in on areas of interest in the plot.  
The user can modify the plot by right-clicking on areas in the plot, from the shortcut menus 
various items could be modified -  the axes title, the title of the plot, the viewport, axis tics, the 
curve, and many other things.  For further information on manipulating the plots, refer to 
Appendix M of this User's Manual, and HEC-DSSVue User's Manual. 
 
Output Report 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 21.1), 
from the Results menu (Figure 21.15), point to Hydrologic Sampling, from the sub-menu click 
Output Report, a text editor will open (Figure 21.21).  This editor contains the hydrologic 
sampling results file (i.e., Without_Project_Conditions-TimeWindow.hsr), which provides the 
user with information about the hydrologic sampling compute.   
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Figure 21.21  Output Report Editor – Hydrologic Sampling 
 
The editor allows the user to edit, search, print, and format the log.  The search function lets the 
user search for specific items to troubleshoot what is going on with the hydrologic sampling 
compute.  Refer to the Hydrologic Sampling User's Manual for further details. 
 
21.5.5 Fragility Curve Results 
 
The sampling of levee failure trigger elevations from fragility curves is accomplished through 
the Fragility Curve Sampler with the results being an evaluation of the full range of levee 
failure possibilities for each pre-defined location in the entire system.  For further details on the 
fragility curve sampling available in HEC-WAT, refer to Chapter 17 of this User's Manual.  
Note: results from the Fragility Curve menu item (Figure 21.8) will only be available if the user 
chooses to save all model files.  Output variables (Chapter 16) can also be used to save the 
sampled failure elevation. 
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Plot – FC (Fragility Curve) 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 21.1), 
from the Results menu (Figure 21.15), point to Fragility Curve, from the sub-menu click Plot - 
FC, the Fragility Curve Plot dialog box will open (Figure 21.22).  This plot displays the 
samples (i.e., 50) for a defined failure location (i.e., PFMW3) in addition to the original user 
defined curve.  From the Failure Location list (Figure 21.22), the user can select different 
failure locations that have been defined. 
 

 
Figure 21.22  Fragility Curve Plot Dialog Box 
 
Using the Zoom Tool,       (Figure 21.22) the user can zoom in on areas of interest in the plot.  
The user can modify the plot by right-clicking on areas in the plot, from the shortcut menus 
various items could be modified -  the axes title, the title of the plot, the viewport, axis tics, the 
curve, and many other things.  For further information on manipulating the plots, refer to 
Appendix M of this User's Manual, and HEC-DSSVue User's Manual. 
 
Output Report 
 
For the active HEC-WAT FRA simulation from the HEC-WAT main window (Figure 21.1), 
from the Results menu (Figure 21.15), point to Fragility Curve, from the sub-menu click 
Output Report, a text editor will open (Figure 21.23).  This editor contains the fragility curve 
sampling results file (i.e., FC_-_St._Paul_levee.fcr), which includes the sampled failure trigger 
elevations for each location.   
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Figure 21.23  Output Report Editor – Fragility Curve Sampling 
 
The editor allows the user to edit, search, print, and format the log.  The search function lets the 
user search for specific items to troubleshoot what is going on with the fragility curve sampling 
compute.  Refer to the HEC-WAT Technical Reference Manual for further details (will not be 
available when HEC-WAT Version 1.0 is released). 
 
21.5.6 Performance Metrics Results 
 
USACE guidance and policy requires that risk and uncertainty analyses be performed for 
USACE planning studies. Risk for USACE is the measure of the probability and severity of 
undesirable consequences (ER 1105-2-101). The performance metrics provided by HEC-WAT 
measure a system's reaction to a flood which must be included in a USACE planning study. 
Performance metrics is discussed in Chapter 19, and performance metrics results are presented in 
Section 19.5. 
 
21.6 Content Pane 
 
Once a simulation has been computed, the user can review the same FRA results that are 
available from the Results menu from the Content Pane. From the Content Pane, right-click on 
one of the available model alternatives, from the shortcut menu (Figure 21.24), point to Results, 
click on the results that are available. 
 

 
Figure 21.24  Content Pane - Shortcut Menu – Results – Hydrologic Sampling 
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For example, in Figure 21.24, from the Content Pane, right-click on the hydrologic sampling  
St. Paul Levee 30years alternative, point to Results.  The submenu provides a list of available 
hydrologic sampling results from which the user can select.  For example, point to Results, click 
Plot Hydrograph, the Hydrographs dialog box will open (Figure 21.16).  Section 21.5.4 
provides details on the available hydrological sampling results. 
 
21.7 Schematic 
 
FRA results from the schematic are available by right-clicking on schematic elements (i.e., 
failure locations, common computation points) and from the shortcut menu select result items 
(zooming in on an area is a good idea).  Results are available for both the model alternatives and 
the FRA results.  From the map window click the Pointer Tool     , right-click on a schematic 
element, a shortcut menu will appear (Figure 21.25).  For example, right-click on a failure 
location, the shortcut menu (Figure 21.25), besides providing information about the failure 
location, also provides information on schematic elements that are around the junction, like 
impact areas, routing reaches, and cross sections. 
 

 
Figure 21.25  Schematic Shortcut Menu – Failure Location 
 
In the example (Figure 21.25), the user right-clicks on a failure location from the schematic, 
from the shortcut menu (Figure 21.25), point to Failure Location, click Plot - FC, the Fragility 
Curve Plot will open (Figure 21.22).  Section 21.5.5 provides details on the available fragility 
curve sampling results. 
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Appendix B 
 
 

Tools 
 
 
The HEC-WAT has several types of tools available for the user: a software application to 
manipulate DSS data (Appendix J); a software tool to perform statistical analysis on data; setting 
options for HEC-WAT; viewing the HEC-WAT log; viewing the logs of the software 
applications defined for an HEC-WAT study; check on HEC-WAT memory usage; the available 
graphic elements from each model alternative defined for an HEC-WAT study; model alternative 
usage within an HEC-WAT study; checking the setup for distributed computing; and, debugging 
compute times of an HEC-WAT simulation. 
 
B.1 HEC-SSP 
 
The Statistical Software Package, HEC-SSP, is used to perform statistical analyses of hydrologic 
data (Figure B.1).  The current version of HEC-SSP can perform flood flow frequency analysis 
based on Bulletin 17B (Interagency Advisory Committee on Water Data, 1982) and Bulletin 17C 
(England, et al., 2015). The software can also perform a generalized frequency analysis on flow 
data and other hydrologic data as well; perform a volume frequency analysis on high and low 
flows; duration analysis; coincident frequency analysis; and, a balanced hydrograph analysis.  
From HEC-WAT a frequency analysis would be performed at stream gages to create frequency 
curves that could be used by other software in the HEC-WAT study's program order.  See the 
HEC-SSP User's Manual (CPD-86) for further details. 
 
To perform a frequency analysis: 
 
 1. From the HEC-WAT main window (Figure B.2), from the WAT Tools toolbar, click     , 

or from the HEC-WAT main window (Figure B.2), from the Tools menu, click HEC-
SSP.  Either way, the HEC-SSP main window will open (Figure B.1). 

 
 2. To create a new HEC-SSP study, from the HEC-SSP main window (Figure B.1), from 

the Study Tree, right-click on Bulletin 17, or from the Analysis menu, point on New, 
click Bulletin 17 Flow Frequency.  The Bulletin Editor will open (Figure B.1). 

 
 3. Enter a name for the frequency analysis, select a flow dataset; select a name for the 

output DSS file; and, enter a name for the report file. 
 
 4. The General tab (Figure B.1) is where the user will set the general settings for a 

frequency analysis.  This includes: generalized skew, expected probability curve 
(frequency curve), plotting positions, and confidence limits. 

 
 5. The Options tab (Figure B.1) is for optional data like low outlier threshold, historic 

period data, and user-specified frequency outliers. 
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Figure B.1  HEC-SSP Main Window 

 

 
Figure B.2  HEC-WAT Main Window 
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 6 The last tab is the Tabular Results tab (Figure B.1), which is populated after the user 
clicks Compute.  This tab contains the computed flow frequency curve, the expected 
probability adjusted curve, general statistics about the data, and information on the 
events.  Also, the user can view data graphically and in a report form from this tab. 

 
 7. The EMA Data tab (Figure B.1) is for a Bulletin 17C analysis only. 
 
 8. HEC-SSP data is stored to a DSS file and can be retrieved by software applications in an 

HEC-WAT study. 
 
B.2 HEC-WAT Options Dialog Box 
 
HEC-WAT allows a user to configure several options for the HEC-WAT framework: 
create/modify HEC-WAT system properties; view threads being used by HEC-WAT; available 
software application plug-ins; set the color scheme for the HEC-WAT compute messages; set 
DSS debug levels and information on the library being used by DSS; define directories where 
HEC-WAT studies can be stored; use plug-ins for the active HEC-WAT study; enable tracking 
of the compute timings for DSS files; and, debug information for both HEC-HMS and HEC-
RAS. 
 
B.2.1 General Tab 
 
From this worksheet, the user can set the last study to be loaded during the startup of HEC-
WAT; display a dialog box that allows the user to open or create a study; save the study 
automatically when exiting HEC-WAT; restore the default layout; synchronize the Study Tree 
to the active Map Window; set an interval (minutes) for automatically saving a study; display 
tooltips; set default scheme for cascading windows; and, specify the number of HEC-WAT 
studies to display in the Recent Studies item under the File menu. 
 
Load Last Study at Startup 
 
To set the automatic reload of the last study: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
 
 2. If the user wants to have the last study automatically loaded the next time HEC-WAT is 

started, click Load Last Study at startup. Click OK, the Options dialog box (Figure 
B.3) will close. 

 
Show Startup Screen 
 
Ability to open or create a study when HEC-WAT loads: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
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Figure B.3  Options Dialog Box 

 
 2. If the user wants to open or create a study when the HEC-WAT software loads, select 

Show Startup Screen (Figure B.3).  When HEC-WAT loads the next time, the Getting 
Started dialog box (B.4) will open.  This allows the user a convenient way to open or 
create a study.  Note: for this option to work properly, the Load Last Study at startup 
option cannot be selected (Figure B.3). 

 

 
Figure B.4  Getting Started Dialog Box 

 
 3. Click OK, the Options dialog box will close (Figure B.3).  The next time HEC-WAT is 

loaded, the Getting Started dialog box will display (Figure B.4).  This allows the user a 
convenient way to open or create a study. 

 
Automatically Save Study on Exit 
 
To automatically save an HEC-WAT study on exit: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
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 2. By default, an HEC-WAT study is saved automatically when exiting HEC-WAT.  If the 
user does not want to save a study automatically, click Automatically Save Study on 
Exit (Figure B.3), the checkmark will no longer display. 

 
 3. When exiting HEC-WAT, the Save File dialog box will open (Figure B.5), a list of items 

that need to be saved will be displayed.  Ensure that all selected items are to be saved, 
click OK, the Save File dialog box will close (Figure B.5) and the HEC-WAT main 
window (Figure B.2) will close. 

 

 
Figure B.5  Save File Dialog Box 

 
Restore Layout 
 
Displaying the layout of a study: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
 
 2. By default, as an HEC-WAT study is saved, information about the current "layout" 

(display in the Desktop Pane) is automatically saved when exiting HEC-WAT.  When 
the study is opened the next time, the layout will be the same. 

 
Sync Study Tree to Map Window 
 
Synchronize the study tree with the active Map Window in the Desktop Pane: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
 
 2. By default, the study tree of the current study is synchronized with the active Map 

Window currently displayed in the Desktop Pane of the HEC-WAT main window 
(Figure B.2).  If the user does not want the study tree to be synchronized with the active 
Map Window, de-select Sync Study Tree to Map Window (Figure B.3). 
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Study Save Interval 
 
Setting how often the current study will be saved: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
 
 2. By default, the study that is currently opened in HEC-WAT is not automatically saved.  If 

the user wishes to set the interval (in minutes) for automatically saving a study, from the 
General Tab (Figure B.3), enter a time in minutes for the automatic saving in the Study 
Save Interval box. 

 
Show Tooltips 
 
Controlling tooltips in HEC-WAT: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
 
 2. By default, all tooltips are displayed.  If the user no longer wants to have tooltips display, 

click Show Tooltips (Figure B.3), this clears the setting.  Tooltips will no longer display 
in the HEC-WAT interface. 

 
Cascade Internal Windows 
 
Controlling map windows: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
 
 2. By default, the capability to cascade map windows in the Desktop Pane of the HEC-

WAT main window (Figure B.2) is set.  If the user does not want map windows to 
cascade, click Cascade Internal Windows (Figure B.3), this clears the setting.  Map 
windows will no longer cascade. 

 
Recent Studies Menu Count 
 
Setting the number of studies available from the Recent Studies menu item: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open, click the General tab (Figure B.3). 
 
 2. By default, the number of recent HEC-WAT studies for display is set to five.  The user 

can change this number by entering a new number in the Recent Studies Menu Count 
(Figure B.3).  Once this number had been changed, the number of recent HEC-WAT 
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studies that display from the HEC-WAT main window (Figure B.2), from the File menu, 
point to Recent Studies, will be different. 

 
B.2.2 System Properties Tab 
 
The System Properties tab (Figure B.6) allows the user to view system properties. If the user 
has the correct user access, the user can edit some or all of the system properties.  It is 
recommended that the user only use this information for debugging purposes and viewing.  
Editing must be done with extreme caution as any changes made can directly affect the WAT 
functionality. 
 

 
Figure B.6  Options Dialog Box – System Properties Tab 
 
To view system properties: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the System Properties tab (Figure 
B.6). 

 
 2. The Server Properties Worksheet provides the user with information regarding HEC-

WAT system properties that have been set. 
 
Add a System Property 
 
If a user has the correct user access level, then that user can add a system property, click New, a 
warning window will open (Figure B.7).  This warning window lets the user know that any 
changes made will not be retained once HEC-WAT is exited.  Click OK, the warning window 
will close (Figure B.7) and the New Property dialog box (Figure B.8) will open. 
 

 
Figure B.7  Changes Not Saved Window 
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Figure B.8  New Property Dialog Box 
 
In the Property box (Figure B.8), enter the name of the new system property.  For the 
parameters of the new system property, enter the parameters in the Property Value box.  Click 
OK, the New Property dialog box (Figure B.8) closes, and the new system property will appear 
on the System Properties worksheet (Figure B.6). 
 
Edit a System Property 
 
If a user has the correct user access level, then that user can edit a system property.  Select a 
system property from the available list, click Edit, a warning window will open (Figure B.7).  
This warning window lets the user know that any changes made will not be retained once HEC-
WAT is exited.  Click OK, the warning window wills close (Figure B.7) and the Edit Property 
Value dialog box (Figure B.9) will open. 
 

 
Figure B.9  Edit Property Value Dialog Box 
 
In the Property and Property Value boxes (Figure B.9), from the selection made, the user can 
edit the items.  Click OK, the Edit Property Value dialog box will close (Figure B.9), and the 
changed system property will appear on the System Properties worksheet (Figure B.6). 
 
Delete a System Property 
 
If a user has the correct user access level, then that user can delete a system property.  Select a 
system property from the available list, click Delete, a Confirm Property Delete message 
window (Figure B.10) will open.  If user wishes to delete the selected system property, click Yes.  
The Confirm Property Delete message window will close and the selected system property will 
be removed from the System Properties worksheet (Figure B.6). 
 

 
Figure B.10  Confirm Property Delete Message Window 
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B.2.3 Threads Tab 
 
A thread is a single sequential flow of control within software.  Within Java the user has the 
ability to have multiple threads in a piece of software all running at the same time and 
performing different tasks.  HEC-WAT is a multi-threaded software application, to view HEC-
WAT threads: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the Threads tab (Figure B.11). 
 

 
Figure B.11  Options Dialog Box – Threads Tab 

 
 2. The Threads Worksheet displays information regarding the threads that are actively 

being used by HEC-WAT.  To provide an up-to-date list of the active threads, click 
Refresh. 

 
B.2.4 Plug-ins Tab 
 
From the Plug-ins tab (Figure B.12), is a table of the plug-ins that are enabled by default for 
HEC-WAT Version 1.0.  Disabling plug-ins using this tab will disable those plug-ins for all 
studies.  Disabling plug-ins for specific studies should be done from the Study Details dialog 
box (Chapter 4, Section 4.1.5), which is the recommended place to disable plugins. 
 

 
Figure B.12  Options Dialog Box – Plug-ins Tab 
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B.2.5 Compute Colors Tab 
 
Setup color scheme for the Compute Progress dialog box: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the Compute Colors tab (Figure 
B.13). 

 

 
Figure B.13  Options Dialog Box – Compute Colors Tab 

 
 2. By default, during an HEC-WAT simulation the Compute Progress dialog box displays 

information about the compute.  In Figure B.13, is the default color scheme for Normal 
Messages, Warning Messages, and Error Messages. 

 
 3. For example, in Figure B.13, if the user wishes to change the color of the warning 

messages in the Compute Progress dialog box, from the Warning Messages list (Figure 
B.13), the user can choose from several default colors that are available (i.e., dark blue). 

 
 4. Click Apply, when an HEC-WAT simulation is computing the warning messages in the 

Compute Progress dialog box will now display in the user selected color. 
 
B.2.6 Debug Tab 
 
To set the debug level for DSS: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the Debug tab (Figure B.14). 
 

 
Figure B.14  Options Dialog Box – Debug Tab 

 
 2. The default DSS Debug Level (Figure B.14) is three (3); the user can enter a value from 

1 to 15.  If a user is contemplating changing this number please contact the Hydrologic 
Engineering Center, increasing this number can generate very large log files.  This 
determines how much DSS debug information is written to the HEC-WAT log file, the 
debug information will assists users in debugging DSS and HEC-DSSVue issues.  Click 
Apply, to set the new debug level. 



HEC-WAT User's Manual Appendix B - Tools 

 B-11 

B.2.7 WAT Plug-ins Tab 
 
This worksheet (Figure B.15) provides information on the plug-ins that are currently being used 
in the HEC-WAT for the four basic software applications in the default program order, plus the 
plug-in for the HEC-SSP software application (Section B.1, page B.1).  The information includes 
the plug-in name; the version of the software application the plug-in represents; the name of the 
HEC-WAT study; whether the plug-in is written is in client/server mode or not; status of the 
server side of a plug-in; and, a log file associated with the plug-in.  The log file is very important 
when debugging issues related to the individual software applications in HEC-WAT.  The only 
software application that does not have a log file for Version 1.0 is HEC-HMS.  The following 
steps use HEC-RAS as an example, but can be followed for any of the software application plug-
ins. 
 

 
Figure B.15  Options Dialog Box – WAT Plug-ins Tab 
 
To access the RAS log file: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the WAT Plug-ins tab (Figure 
B.15). 

 
 2. To view the log file for RAS, on the table, in the RAS row, click View (Figure B.15).  

The rasserver5901.log will open (Figure B.16). 
 
 3. Review the rasserver5901.log for any information that can help debug any issues with 

the HEC-RAS software application.  From the File menu, click Close, the 
rasserver5901.log will close (Figure B.12). 

 
B.2.8 DSS Timing Log Tab 
 
Another debugging tool is to track the compute timings in DSS files.  To enable this capability: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the DSS Timing Log tab (Figure 
B.17). 
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Figure B.16  rasserver5901.log 

 
 2. Click Enable Compute Timings to DSS File (Figure B.17), this will enable the tracking 

of compute timings in DSS files.  The tracking information will be written to the DSS log 
file (Section B.4).  Click Apply, to set the tracking of compute timings in DSS files. 

 

 
Figure B.17  Options Dialog Box – DSS Timing Log Tab 

 
B.2.9 ECC Tab 
 
The ECC (Energy Content Curve) software is used specifically for the Columbia River Treaty 
study that the Hydrologic Engineering Center (HEC) assisted the USACE Northwest Division 
and Districts with. 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the ECC tab (Figure B.18). 
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 2. For the ECC software to run in HEC-WAT, the user must provide the location of the 

ECC executable (ECC Exe box, Figure B.18); the location of the ECC pre-processor 
(Preprocessor Exe box); and, the location of the ECC post-processor (Postprocessor 
Exe box). 

 

 
Figure B.18  Options Dialog Box – ECC Tab 

 
 3. Click Apply, now the ECC software will execute in the HEC-WAT framework. 
 
B.2.10 HMS Tab 
 
Another debugging tool is available by turning on debugging for the HMS software application.  
To enable this capability: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the HMS tab (Figure B.19). 
 
 2. Click Debug (Figure B.19), this will debug XML (eXtensible Markup Language) calls in 

the HMS software application.  Click Apply, to set the HMS debug option. 
 

 
Figure B.19  Options Dialog Box – HMS Tab 

 
B.2.11 RAS Plugin Tab 
 
Another debugging option is to turn on debugging of XML calls and display the HEC-RAS 
Computations dialog box (Figure B.20) for the RAS software application.  To enable this 
capability: 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Options. 

The Options dialog box will open (Figure B.3), click the RAS Plugin tab (Figure B.21). 
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Figure B.20  HEC-RAS Computations Dialog Box 

 

 
Figure B.21  Options Dialog Box – RAS Plugin Tab 

 
 2. Click Debug XML calls to RAS (Figure B.21), this will debug XML calls in the HEC-

RAS software application, plus the HEC-RAS Computations dialog box (Figure B.20) 
will display during the selected simulation's compute.  The tracking information will be 
written to the RAS log file (Section B.2.7).  Click Apply, to set the RAS debug option. 

 
B.3 Console Output 
 
To review the progress of HEC-WAT, on the Tools menu, click Console Output, the Console 
Window will open (Figure B.22).   
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Figure B.22  Console Window 
 
From this editor (Figure B.22) a user can view the progress of HEC-WAT; the editor helps in 
debugging issues with HEC-WAT; search for certain items; format the text displayed in the 
editor; and, print the contents of the editor (Figure B.22).  From the File menu, click Close, the 
Console Window will close (Figure B.22). 
 
B.4 Logs 
 
Log files for three of the HEC basic software applications and the log file for DSS are available 
from the HEC-WAT framework. 
 
B.4.1 HEC-DSS Log 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, point to Logs, 

click HEC-DSS Log, the HEC-WAT_DSS.log Editor will open (Figure B.23). 
 
 2. The editor allows the user to edit, search, print, and format the log.  The search function 

lets the user search for specific items to troubleshoot issues with DSS files.   
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Figure B.23  HEC-WAT_DSS.log Editor 

 
B.4.2 ResSim 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, point to Logs, 

click ResSim, the ressimserver.log Editor will open (Figure B.24). 
 

 
Figure B.24  ressimserver.log Editor 

 
 2. The editor allows the user to edit, search, print, and format the log.  The search function 

lets the user search for specific items to troubleshoot issues with the ResSim compute. 
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B.4.3 RAS 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, point to Logs, 

click RAS, the rasserver5901.log Editor will open (Figure B.25). 
 

 
Figure B.25  rasserver5901.log Editor 

 
 2. The editor allows the user to edit, search, print, and format the log.  The search function 

lets the user search for specific items to troubleshoot issues with the RAS compute. 
 
B.4.4 FIA 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, point to Logs, 

click FIA, the HEC-FIA.log Editor will open (Figure B.26). 
 

 
Figure B.26  HEC-FIA.log Editor 
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 2. The editor allows the user to edit, search, print, and format the log.  The search function 
lets the user search for specific items to troubleshoot issues with the FIA compute. 

 
B.5 HEC-WAT Memory Usage 
 
To review the memory being used by HEC-WAT, on the Tools menu, click Memory Monitor, 
the Memory Monitor dialog box will open (Figure B.27).  From this dialog box the user can 
view the memory usage of HEC-WAT.  Click          to close the Memory Monitor dialog box. 
 

 
Figure B.27  Memory Monitor Dialog Box 
 
B.6 Graphic Elements 
 
On an HEC-WAT schematic the graphic elements that represent the individual model 
alternatives of a study are displayed. To view a list of these graphics elements:  
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Graphic 

Elements, the Graphic Element Report dialog box will open (Figure B.28). 
 

 
Figure B.28  Graphic Element Report Dialog Box 
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 2. From the Simulation list (Figure B.28) select a simulation (i.e., Without Project 
Conditions-RR_Feb1986).  From the Model list (Figure B.28), select a model alternative 
(i.e., ResSim-calibrate).  The table will display the known graphic elements for the 
selected model alternative.  This report can be used when debugging issues on the 
schematic of the selected simulation. 

 
 3. If the report is lengthy, the user can search the listed graphic elements by using a filter.  

Click      , a Filter dialog box will open (Figure B.29).  By defining filters, the user can 
scan the list of graphic elements.  Click OK, the Filter dialog box will close, and the 
table on the Graphic Element Report dialog box (Figure B.28) will reflect the results of 
the defined filter.  To clear the filter, click      . 

 

 
Figure B.29  Filter Dialog Box 

 
B.7 Model Alternative Usage 
 
For a very large HEC-WAT study, there could possibly be a large number of model alternatives 
that are being used by HEC-WAT simulations.  Being able to view where these models 
alternative are being used from the HEC-WAT study tree can be overwhelming to process.  The 
HEC-WAT framework provides a way to view this usage by model alternative. 
 
 1. From the HEC-WAT main window (Figure B.2), from the Tools menu, click Model 

Alternative Usage, the Model Alternative Usage dialog box will open (Figure B.30). 
 

 
Figure B.30  Model Alternative Usage Dialog Box 
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 2. From the Plugin list (Figure B.31) select the associated software application with a 
model alternative (i.e., RAS).  From the Model Alternative list (Figure B.30), select a 
model alternative (i.e., Base for Real Time forecasting).  The table will display a list of all 
the simulations in an HEC-WAT study that contain the selected model alternative. 

 

 
Figure B.31  Model Alternative Usage Dialog Box – Model Alternative List 

 
B.8 Simulation Compute Engine Manager 
 
The FRA compute option relies on a Monte Carlo computational algorithm that requires 
potentially many thousands of simulations (realizations) of the individual model alternatives that 
are included in the program sequence defined for an FRA simulation.  To accommodate this 
need, the HEC-WAT framework includes a distributed compute option.  This distributed 
compute option allows the HEC-WAT software to distribute FRA computes across several 
compute nodes.  The distributed compute option is available in Version 1.0 of HEC-WAT, if 
there is interest in using distributed FRA computes, please contact the Hydrologic Engineering 
Center. 
 
There is a certain amount of setup required for distributed computing, one step is the creation of 
compute nodes where simulations will be performed.  The "master" node needs to be able to find 
the defined compute nodes on a network.  From the HEC-WAT main window (Figure B.2), from 
the Tools menu, click Simulation Compute Engine Manager, the Simulation Compute 
Engine Manager will open (Figure B.30).  HEC-WAT will automatically search the network to 
find the computed nodes, when done searching a number will appear in the Nodes Present box 
(Figure B.32) 
 

 
Figure B.32  Simulation Compute Engine Manager 
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B.9 Compute Timings 
 
This debugging tool allows the user to review the compute time of HEC-WAT simulations by 
the models alternatives that are being computed.  The DSS Timing Log option (Section B.2.8) 
must be enabled, and a simulation needs to be computed with the timings option turned on. 
 
From the HEC-WAT main window (Figure B.2), from the Tools menu, click Compute 
Timings, the Simulation Compute Engine Manager will open (Figure B.33).  From the 
Simulation list (Figure B.33), select a simulation that has been computed.  If the simulation has 
not been computed, a No Timings window (Figure B.34) will display letting the user know that 
there are no compute timings saved for the selected simulation. 
 

 
Figure B.33  Compute Timings Dialog Box 
 

 
Figure B.34  No Timings Window 
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The Record list (Figure B.33) is used when the simulation is an FRA compute, the user can 
review timings by Lifecycle.  From the Location list (Figure B.35), the user can select what 
compute timings to review.  For example, in Figure B.32, the default is Event Compute Time, 
this provides the timings for the entries simulation.  Those timings are displayed in the table in 
the upper right of the Compute Timings dialog box (Figure B.32). 
 

 
Figure B.35  Compute Timings Dialog Box – Location List 
 
The example simulation (i.e., Without Project Condition-RR_Feb1986) selected in Figure B.32 is 
a deterministic simulation.  The only compute timings of interest would be the overall compute 
time of the simulation (Event Compute Time) and the times for the model alternatives that are 
part of the simulation.  Therefore, if the user wishes to see the compute timing for the HMS 
model alternative, from the Location list (Figure B.35), the user would select 
HMS:(RUN)Feb_1986.  The table (Figure B.36), will change for the Minimum, Maximum, 
and Average timings. 
 

 
Figure B.36  Compute Timings Dialog Box – Table 
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Appendix C 
 

Setting Up the Coordinate System 
 
Map projections have been developed because the true image of places on earth would have to be 
a three-dimensional solid (spherical globes).  Sets of mathematical models transform spherical 
coordinates (latitude, longitude) to planar coordinates in a map projection (X- and Y-
coordinates).  Data is then projected onto a flat plane (surface), where that data can be converted 
without stretching, and features will be referenced by a planar coordinate system.  The x-
coordinate is referred to as "easting" and the y-coordinate is referred to as "northing".  The user 
can select the extent of this grid, the dimensions of the cells of the grid, the units of measurement 
of the grid, and even the location of the origin of the grid.  Because of this flexibility, a user can 
specify and use virtually any grid coordinates convenient for water resources studies.   
 
When creating a study, users are encouraged to set the coordinate system by selecting a map 
layer that is in the correct projection.  Once that is done, the coordinate system cannot be 
changed.  If the study does not have any available map layers in the correct coordinate system, 
the user at the time of creating a study can select a coordinate system and provide the 
information of that coordinate system.  This appendix focuses on how to setup and edit different 
coordinate systems. 
 
C.1 Geographic Referencing 
 
To maintain a geographic reference in a study and when a projection is established, a coordinate 
system is created for each HEC-WAT study which establishes the grid size: 
 
 1. From the Maps menu, click Default Map Properties, the Map Default Properties for 

StudyName dialog box will open (Figure C.1).  By default, the Map Extents tab is 
selected. 

 

 
Figure C.1  Map Default Properties for StudyName Dialog Box 
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 2. The information in the Map Extents tab includes: 
 
 ● Coordinate System.  This box identifies the established coordinate system for a 

study.  To view the coordinate system, click View, and the Map Coordinate 
Information dialog box (Figure C.2) will open.   

 

 
Figure C.2  Map Coordinate Information Dialog Box 

 
 ● Extents – Easting Minimum, Maximum, Northing Minimum, and Maximum.  

These values (Figure C.1) indicate the location of the left, right, bottom and top 
borders (respectively) of the grid in the map window. 

 
 ● Grow to Map Extents.  When selected, HEC-WAT automatically sets the 

geographic extents to define the smallest rectangle that encompasses all the objects in 
the study. 

 
 ● Set Map Extents to Display.  This will set the limits of the map window.  If the user 

zooms in on an area, and clicks Set Map Extents to Display (Figure C.1), the Map 
Default Properties for StudyName dialog box (Figure C.1) extents will change to the 
zoomed area. 

 
Note that the geographic extents of map layers must be selected carefully to ensure that the entire 
study is included.  Further, the extents specified and the coordinate system used must be 
consistent with the projection of the study. 
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C.2 Coordinate System Types 
 
A coordinate system is a method of representing points in a space of given dimensions by 
coordinates. There are several different types of coordinate systems; including geographic 
coordinate systems, which are based on latitude and longitude coordinates, and projected 
coordinate systems, which represent the projection of a geographic coordinate system on a plane 
and use linear measures (like feet or meters) for coordinates. The following list of coordinate 
systems is available in HEC-WAT. 
 

● Google/Bing Web Mercator 
● Geographic 
● Universal Transverse Mercator 
● State Plane Coordinates 
● Albers Equal-Area Conic 
● Lambert Conformal Conic 
● Transverse Mercator 
● Albers Equal-Area Conic (SHG) 
● Polar Stereographic (HRAP) 

 
C.2.1 Google/Bing Web Mercator 
 
Google/Bing Web Mercator (i.e., Web Mercator, Google Web Mercator, WGS 84 Web 
Mercator, etc.) is a variation of the Mercator projection and is the standard for web mapping 
applications.  This system uses the same formulas as the standard Mercator systems, but uses the 
spherical formulas at all scales.  Geographical coordinates are required to be in the WGS 84 
ellipsoidal datum.  Google/Bing Web Mercator does not quite conform due to the use of the 
ellipsoidal datum against a spherical projection. United States Department of the Defense does 
not encourage the use of this map projection in official capacity. 
 
C.2.2 Geographic Coordinate System 
 
For the geographic coordinate system, the user can specify units and a spheroid type.  To set 
parameters for the Geographic Coordinate System: 
 
 1. Create a new study (Chapter 4, Section 4.1.1), from the Create New Study dialog box 

(Figure C.3), click Edit (by the Coordinate System box), the Map Coordinate 
Information dialog box will open (Figure C.2). 

 
 2. From the System list, select Geographic, the Map Coordinate Information dialog box 

(Figure C.4) will now display the data needed to setup a Geographic coordinate system 
for the study. 

 
 3. From the Units list (Figure C.4), select the units for the Geographic coordinate system.  

Available units are Radians, Seconds of Arc, and Degrees of Arc. 
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Figure C.3  Create New Study Dialog Box 

 

 
Figure C.4  Geographic Coordinate System 

 
 4. From the Spheroid list, select a spheroid type for the Geographic coordinate system. 
 
 5. Click OK, the Map Coordinate Information dialog box (Figure C.4) will close, and the 

user will be returned to the Create New Study dialog box (Figure C.3).  In the 
Coordinate System box, Geographic will be displayed. 

 
C.2.3 Universal Transverse Mercator Coordinate System 
 
The Universal Transverse Mercator (UTM) coordinate system is a projection coordinate system.  
UTM is used to define horizontal positions throughout the world by dividing the surface of the 
Earth into six-degree zones, with a central meridian in the center of each zone. 
 
To set parameters for the Universal Transverse Mercator Coordinate System: 
 
 



HEC-WAT User's Manual Appendix C – Setting Up the Coordinate System 

 C-5 

 1. Create a new study (Chapter 4, Section 4.1.1), from the Create New Study dialog box 
(Figure C.3), click Edit (by the Coordinate System box), the Map Coordinate 
Information dialog box will open (Figure C.2). 

 
 2. From the System list, select Universal Transverse Mercator, the Map Coordinate 

Information dialog box (Figure C.5) will now display the data needed to setup a 
Universal Transverse Mercator coordinate system for the study. 

 

 
Figure C.5  Universal Transverse Mercator Coordinate System 

 
 3. From the Units list (Figure C.5), select the units for the Universal Transverse Mercator 

coordinate system. 
 
 4. From the Spheroid list (Figure C.5), select a spheroid type for the Universal Transverse 

Mercator coordinate system. 
 
 5. In the UTM Zone box (Figure C.5), enter the UTM zone number. 
 
 6. Click OK, the Map Coordinate Information dialog box (Figure C.5) will close, and the 

user will be returned to the Create New Study dialog box (Figure C.3).  In the 
Coordinate System box, Universal Transverse Mercator will be displayed. 

 
C.2.4 State Plane Coordinate System 
 
The State Plane Coordinate System (SPCS) was established in the 1930's and now covers all fifty 
states.  Zones were established for each state using either the Lambert Conformal or Traverse 
Mercator projections.  Units are generally in feet (NAD27) or meters (NAD83). 
 
To set parameters for the State Plane Coordinate System: 
 
 1. Create a new study (Chapter 4, Section 4.1.1), from the Create New Study dialog box 

(Figure C.3), click Edit (by the Coordinate System box), the Map Coordinate 
Information dialog box will open (Figure C.2). 
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 2. From the System list, select State Plane Coordinates, the Map Coordinate 
Information dialog box (Figure C.6) will now display the data needed to setup a State 
Plane coordinate system for the study. 

 

 
Figure C.6  State Plane Coordinate System 

 
 3. In the Zone box (Figure C.6), enter the zone for the state (FIPS codes). 
 
 4. Click OK, the Map Coordinate Information dialog box (Figure C.6) will close, and the 

user will be returned to the Create New Study dialog box (Figure C.3).  In the 
Coordinate System box, State Plane Coordinates will be displayed. 

 
C.2.5 Albers Equal-Area Conic Coordinate System 
 
The Albers Equal-Area Conic projection was established for mapping large countries like the 
United States.  The projection is an equivalent projection, where areas are proportional and 
directions are true in limited areas. 
 
To set parameters for the Albers Equal-Area Conic Coordinate System: 
 
 1. Create a new study (Chapter 4, Section 4.1.1), from the Create New Study dialog box 

(Figure C.3), click Edit (by the Coordinate System box), the Map Coordinate 
Information dialog box will open (Figure C.2). 

 
 2. From the System list, select Albers Equal-Area Conic, the Map Coordinate 

Information dialog box (Figure C.7) will now display the data needed to setup an Albers 
Equal-Area Conic coordinate system for the study. 

 
 3. From the Units list (Figure C.7), select the units for the Albers Equal-Area Conic 

coordinate system. 
 
 4. From the Spheroid list (Figure C.7), select a spheroid type for the Albers Equal-Area 

Conic coordinate system. 
 
 5. The remaining items (Figure C.7) to be entered are the angular parameters that are 

required to fine-tune the projection.  When specifying latitudes the user will enter N or S, 
and for longitudes, enter E or W.  Use the SPACEBAR to toggle between the entries. 
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Figure C.7  Albers Equal-Area Conic Coordinate System 

 
 6. Click OK, the Map Coordinate Information dialog box (Figure C.7) will close, and the 

user will be returned to the Create New Study dialog box (Figure C.3).  In the 
Coordinate System box, Albers Equal-Area Conic will be displayed. 

 
C.2.6 Lambert Conformal Conic Coordinate System 
 
The Lambert Conformal Conic projection is used extensively for mapping areas of the world 
with predominantly east-west orientation.  Similar to the Albers Equal-Conic projection, 
however the projection is not done in an equal-area. 
 
To set parameters for the Lambert Conformal Conic Coordinate System: 
 
 1. Create a new study (Chapter 4, Section 4.1.1), from the Create New Study dialog box 

(Figure C.3), click Edit (by the Coordinate System box), the Map Coordinate 
Information dialog box will open (Figure C.2). 

 
 2. From the System list, select Lambert Conformal Conic, the Map Coordinate 

Information dialog box (Figure C.8) will now display the data needed to setup a 
Lambert Conformal Conic coordinate system for the study. 

 
 3. From the Units list, select the units for the Lambert Conformal Conic coordinate system. 
 
 4. From the Spheroid list (Figure C.8), select a spheroid type for the Lambert Conformal 

Conic coordinate system. 
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Figure C.8  Lambert Conformal Conic Coordinate System 

 
 5. When specifying latitudes the user will enter N or S, and for longitudes, enter E or W.  

Use the SPACEBAR to toggle between the entries. 
 
 6. Click OK, the Map Coordinate Information dialog box (Figure C.7) will close, and the 

user will be returned to the Create New Study dialog box (Figure C.3).  In the 
Coordinate System box, Lambert Conformal Conic will be displayed. 

 
C.2.7 Transverse Mercator Coordinate System 
 
The Transverse Mercator projection is when a sphere is projected onto a cylinder tangent to a 
central meridian.  This projection is similar to the Lambert Conformal Conic projection, but used 
to portray large areas in a north-south orientation.  Many national grid systems are based on the 
Transverse Mercator projection. 
 
To set parameters for the Transverse Mercator Coordinate System: 
 
 1. Create a new study (Chapter 4, Section 4.1.1), from the Create New Study dialog box 

(Figure C.3), click Edit (by the Coordinate System box), the Map Coordinate 
Information dialog box will open (Figure C.2). 

 
 2. From the System list, select Transverse Mercator, the Map Coordinate Information 

dialog box (Figure C.9) will now display the data needed to setup a Transverse Mercator 
coordinate system for the study. 

 
 3. From the Units list (Figure C.9), select the units for the Transverse Mercator coordinate 

system. 
 
 4. From the Spheroid list (Figure C.9), select a spheroid type for the Transverse Mercator 

coordinate system. 



HEC-WAT User's Manual Appendix C – Setting Up the Coordinate System 

 C-9 

 
Figure C.9  Transverse Mercator Coordinate System 
 

 5. Enter a scaling factor for central meridian, in the Scale factor at central meridian box 
(Figure C.9). 

 
 6. When specifying latitudes the user will enter N or S, and for longitudes, enter E or W.  

Use the SPACEBAR to toggle between the entries. 
 
 7. Click OK, the Map Coordinate Information dialog box (Figure C.9) will close, and the 

user will be returned to the Create New Study dialog box (Figure C.3).  In the 
Coordinate System box, Transverse Mercator will be displayed. 

 
C.2.8 Albers Equal-Area Conic (SHG) Coordinate System 
 
The Standard Hydrologic Grid, or SHG version of the Albers Equal-Area Conic coordinate 
system.  The parameters are set to match USACE map coordinates for SHG, so do not change 
any parameter settings. 
 
To view the parameters for the Albers Equal-Area Conic (SHG) Coordinate System: 
 
 1. Create a new study (Chapter 4, Section 4.1.1), from the Create New Study dialog box 

(Figure C.3), click Edit (by the Coordinate System box), the Map Coordinate 
Information dialog box will open (Figure C.2). 

 
 2. From the System list, select Albers Equal-Area Conic (SHG), the Map Coordinate 

Information dialog box (Figure C.10) will now display the data needed to setup an 
Albers Equal-Area Conic (SHG) coordinate system for the study. 
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 3. From the Units list (Figure C.10), select the units for the Albers Equal-Area Conic (SHG) 
coordinate system. 

 

 
Figure C.10  Albers Equal-Area Conic (SHG) Coordinate System 

 
 4. From the Spheroid list (Figure C.10), select a spheroid type for the Albers Equal-Area 

Conic (SHG) coordinate system. 
 
 5. The remaining parameters are informational and are not editable. 
 
 6. Click OK, the Map Coordinate Information dialog box (Figure C.9) will close, and the 

user will be returned to the Create New Study dialog box (Figure C.3).  In the 
Coordinate System box, Albers Equal-Area Conic (SHG) will be displayed. 

 
C.2.9 Polar Stereographic (HRAP) Coordinate System 
 
The Hydrologic Rainfall Analysis Project (HRAP) grid was designed by the National Weather 
Service (NWS) for use with NEXRAD radar precipitation data.  The Polar Stereographic 
(HRAP) is used for navigation in polar regions.  The parameters are set to match NWS map 
coordinates used for radar grids, so do not change any parameter settings. 
 
To view the parameters for the Polar Stereographic (HRAP) Coordinate System: 
 
 1. Create a new study (Chapter 4, Section 4.1.1), from the Create New Study dialog box 

(Figure C.3), click Edit (by the Coordinate System box), the Map Coordinate 
Information dialog box will open (Figure C.2). 
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 2. From the System list, select Polar Stereographic (HRAP), the Map Coordinate 
Information dialog box (Figure C.11) will now display the data needed to setup a Polar 
Stereographic (HRAP) coordinate system for the study. 

 

 
Figure C.11  Polar Stereographic (HRAP) Coordinate System 

 
 4. From the Units list, select the units for the Polar Stereographic (HRAP) coordinate 

system. 
 
 5. From the Spheroid list (Figure C.11), select a spheroid type for the Polar Stereographic 

(HRAP) coordinate system. 
 
 6. From the Axis box the user can edit the axes information for either the Semi-major or 

the Semi-minor axes. 
 
 7. The remaining parameters are informational and are not editable. 
 
 8. Click OK, the Map Coordinate Information dialog box (Figure C.11) will close, and 

the user will be returned to the Create New Study dialog box (Figure C.3).  In the 
Coordinate System box, Polar Stereographic (HRAP) will be displayed. 

 
C.3 Well Known Text 
 
Well Known Text (WKT) is an Open Geospatial Consortium (OGC) standard that provides a 
textual description of a geographic coordinate reference system.  Allows the user the flexibility 
to copy a coordinate reference description that is not included in HEC-WAT.  Descriptions of 
WKT can be found on the Internet. 
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Appendix D 
 
 
 

Using Map Editors 
 
 
There are seven map layers supported by HEC-WAT. The different map layers are described in 
Chapter 5, Section 5.2.1 of this user's manual.  In HEC-WAT the user can configure several 
options for each type of map layer, except for AutoCAD® DXF files; additional customization is 
under development for future versions of the software. 
 
The user can access the map layer editors, from the Maps Tab (Chapter 3, Section 3.2), which 
provides a view of the active map window in the Desktop Pane (Chapter 3, Section 3.1).  From 
the Content Pane (Figure D.1), either double-click on a map layer name, or right-click, and 
from the shortcut menu click Properties.  An editor specific to the type of map layer selected 
will open. 
 

 
Figure D.1  Maps Tab – Content Pane 
 
D.1 Shapefiles (.shp) 
 
Shapefiles store non-topological geometry and attribute information for the spatial features of a 
data set.  There are three kinds of shapefiles: line, polygon, and point. The following sections 
discuss examples of line and polygon shapefiles. 
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D.1.1 Line 
 
To edit a line shapefile: 
 
 1. With an active map window displayed in the Desktop Pane, from the Maps Tab, from 

the Content Pane (Figure D.1), right-click on a shapefile that the user knows is a line 
shapefile.  From the shortcut menu click Properties or double-click on the shapefile 
filename.  For example, in Figure D.1, from the Map Layers tree, the user right-clicked 
on RR_StreamAlignment.shp which is a line shapefile. 

 
 2. The Edit Line Properties dialog box (Figure D.2) will open. 
 

 
Figure D.2  Edit Line Properties Dialog Box 

 
 3. By default the Style Tab is selected.  Also, by default, all the shapes (lines) in a line Arc 

Shapefile are set to one color, style, and weight.  From the Draw Features using list 
(Figure D.2), this default is One Style.  The user can change the color of the shapes from 
the Color list; change the style of shapes from the Style list; and, change the weight of 
the shapes from the Weight list (Figure D.2). 

 
 4. A shapefile has three files associated with it, which contain shape information, attributes, 

and an index that links a shape to its attributes.  If the user wishes to change the 
individual shapes (lines) contained in a shapefile by attribute, from the Draw Features 
using list, select Attribute Values.  The Edit Lines Properties dialog box now displays 
(Figure D.3) the items the user can edit for individual shapes by attribute. 

 
 5. To select the attribute the user wishes to change, the user must have some knowledge of 

the Arc Shapefile and its attributes.  For example, in Figure D.3, for the 
RR_StreamAlignment.shp file, from the Field for values list (Figure D.3), the attribute 
Name has been selected.  This provides the user with the shapes by stream name, which 
are displayed in the table below the Color box (Figure D.3). 
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Figure D.3  Edit Line Properties Dialog Box – Attribute Values 

 
 6. For the selected attribute the user can change the style of the shapes from the Style list 

(Figure D.3), and change the weight of the shapes from the Weight list. 
 
 7. From the Color box (Figure D.3), the user can set a range of colors for all the shapes 

displayed in the table below the Color box (Figure D.3). 
 
 8. To change the colors of the individual shapes, from the table, in the Color column, 

double-click on a color square.  The Select Color dialog box (Figure D.4) will open. 
 
 9. The properties of the Select Color dialog box are similar to the Color Chooser 

(Appendix E).  From the color palette, select a color, click OK.  The Select Color dialog 
box (Figure D.4) will close. 

 
 10. From the Edit Line Properties dialog box (Figure D.3), click Apply, the shape 

associated with the color square that was selected, will now display the new color in the 
active Map Window on the Desktop Pane. 
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Figure D.4  Select Color Dialog Box 

 
 11. Associated with each shape (line) is a label, to edit the label properties, from the Edit 

Line Properties dialog box (Figure D.3) select the Labels tab (Figure D.5). 
 
 12. By default, the label for the shapes is turned off (<None>), if the user wishes to display 

the label, from the Label features using list (Figure D.5) select the attribute that contains 
the information that is to be displayed. 

 

 
Figure D.5  Edit Line Properties Dialog Box – Labels Tab 
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 13. For labels, the user can select what font to use; styles like bold or italics; select the size 
and position; and, rotate the labels. 

 
 14. From the Edit Line Properties dialog box (Figure D.5), click Apply, the labels for the 

shapes (lines) will now display in the active Map Window on the Desktop Pane. 
 
 15. Once the user is finished with making changes, click OK, the Edit Line Properties 

dialog box (Figure D.5) will close. 
 
 16. If the user wishes to save any changes made to the selected shapefile, from the File menu, 

click Save Study.  Changes are saved to a file with the extension .gdr.  For this example, 
the selected shapefile name was RR_StreamAlignment.shp, if changes were made and 
saved, a file RR_StreamAlignment.gdr will be created. 

 
D.1.2 Polygon 
 
To edit a polygon shapefile: 
 
 1. With an active map window displayed in the Desktop Pane, from the Maps Tab, from 

the Content Pane (Figure D.1), right-click on ac shapefile that the user knows is a 
polygon shapefile.  From the shortcut menu click Properties or double-click on the 
shapefile filename.  For example, in Figure D.1, the user would right-click on 
RussianSubbasins.shp which is a polygon shapefile. 

 
 2. The Edit Polygon Properties dialog box (Figure D.6) will open. 
 

 
Figure D.6  Edit Polygon Properties Dialog Box 

 
 3. By default the Fill Tab is selected.  Also, by default, all the shapes (polygons) in a 

polygon shapefile are set to one color, style, and weight.  From the Draw Features using 
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list, this default is One Fill, with Display Fill (Figure D.6) set.  The user can turn on and 
off the filling of the shapes (polygons) by selecting and un-selecting Display Fill; change 
the color of the shapes from the Color list (Figure D.6); change the style of shapes from 
the Style list; and, change the transparency of the shapes from the Transparency slider 
(Figure D.6). 

 
 4. A shapefile has three files associated with it, which contain shape information, attributes, 

and an index that links a shape to its attributes.  If the user wishes to change the 
individual shapes (polygons) contained in an Arc Shapefile by attribute, from the Draw 
Features using list, select Attribute Values.  The Edit Polygon Properties dialog box 
now displays (Figure D.7) the items user can edit for individual shapes by attribute. 

 

 
Figure D.7  Edit Polygon Properties Dialog Box – Attribute Values 

 
 5. To select the attribute you wish to change, the user must have some knowledge of the 

shapefile and its attributes.  For example, in Figure D.7, for the RussianSubbasins.shp 
file, the attribute Name has been selected from the Field for values list.  This provides 
the user with the shapes by subbasin name, which are displayed in the table below the 
Color box (Figure D.7). 

 
 6. For the selected attribute the user can change the style of the shapes from the Style list 

(Figure D.7), and change the weight of the shapes from the Weight list (Figure D.7). 
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 7. From the Color box, the user can set a range of colors for all the shapes displayed in the 
table (Figure D.7) below the Color box. 

 
 8. To change the colors of the individual shapes, from the table, in the Color column, 

double-click on the color square.  The Select Color dialog box (Figure D.4) will open. 
 
 9. The properties of the Select Color dialog box are similar to the Color Chooser 

(Appendix E).  From the color palette, select a color, click OK.  The Select Color dialog 
box will close (Figure D.4). 

 
 10. From the Edit Line Properties dialog box (Figure D.7), click Apply, the shape 

associated with the color square selected, will now display the new color in the active 
Map Window on the Desktop Pane. 

 
 11. Associated with each shape (polygon) is a border, to edit border properties, from the Edit 

Polygon Properties dialog box (Figure D.7) select the Border Tab (Figure D.8). 
 

 
Figure D.8  Edit Polygon Properties Dialog Box – Border Tab 

 
 12. By default, the border for the shapes is turned on. If the user does not want the border to 

display, click Display Border (Figure D.8).  The user can change the color of the shapes 
from the Color list; change the style of shapes from the Style list (Figure D.8); and, 
change the weight of the shapes from the Weight list (Figure D.8). 

 
 13. Associated with each shape (polygon) is a label. To edit the label properties, from the 

Edit Polygon Properties dialog box (Figure D.7) select the Labels Tab (Figure D.9). 
 
 14. By default, the labels for the shapes is turned off (<None>), if the user wishes to display 

the labels from the Label features using list (Figure D.9) select the attribute that 
contains the information that will be displayed. 

 
 15. For labels, the user can select what font to use; styles like bold or italics; select the size 

and position; and, rotate the labels. 
 
 16. From the Edit Polygon Properties dialog box (Figure D.9), click Apply, the labels for 

the shapes (lines) will now display in the active Map Window on the Desktop Pane. 
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Figure D.9  Edit Polygon Properties Dialog Box – Labels Tab 

 
 17. Once the user is finished with making changes, click OK, the Edit Polygon Properties 

dialog box (Figure D.9) will close. 
 
 18. If the user wishes to save any changes made to the selected shapefile, from the File menu, 

click Save Study.  Changes are saved to a file with the extension .gdr.  For example, in 
Figure D.1, the shapefile name is RussianSubbasins.shp, if changes have been made and 
saved, a file RussianSubbasins.gdr will be created. 

 
D.2 USGS Digital Line Graph (.dlg) 
 
This layer type is a vector representation of the data.  When HEC-WAT interacts with a dlg file 
it automatically creates a dlgbin file for use. 
 
To edit a USGS Digital Line Graph file: 
 
 1. From the Maps tab, from the Content Pane, right-click on a USGS Digital Line Graph 

file.  From the shortcut menu, click Properties, or double-click on the USGS Digital 
Line Graph filename. 

 
 2. The USGS Digital Line Graph Editor (Figure D.10) will open. 
 
 3. Across the top of the dialog box, is displayed the location and name of the USGS Digital 

Line Graph file. 
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Figure D.10  USGS Digital Line Graph Editor 
 

 4. To change the color of the lines of the dlg file, click the color box.  The Color Chooser 
dialog box will open (Figure D.11). 

 

 
Figure D.11  Color Chooser 

 
 5. The properties of the Color Chooser are discussed in detail in Appendix E.  From the 

color palette, select a color, click OK.  The Color Chooser will close (Figure D.11) and 
the selected color will now appear in the color box. 

 
 6. Click Apply, the color change will appear on the Map Window in the Desktop Pane. 
 
 7. The user can control the appearance of nodes, lines, and areas by selecting and clearing 

Draw Nodes, Draw Lines, and Draw Areas, respectively. 
 
 8. The user can also control the saturation and brightness level of the selected color by 

entering values in the Saturation or Brightness boxes.  Values entered for saturation or 
brightness must be between zero (0) and one (1). 
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 9. Once the user is finished with changes, click OK, the USGS Digital Line Graph Editor 
(Figure D.10) will close. 

 
 10. If the user wishes to save any changes made to the selected USGS digital line graph, from 

the File menu, click Save Study, changes are saved to the study file (*.sty). 
 
D.3 Elevation Options Dialog Box 
 
For the other map layer formats – USGS DEM, ASCII NetTin, SMRMP, and ArcInfo® DEM; 
they all have the same editor, the Elevation Options dialog box. 
 
To edit a SMRMP file: 
 
 1. From the Maps tab, from the Content Pane, right-click on a SMRMP file.  From the 

shortcut menu, click Properties, or double-click on the SMRMP name. 
 
 2. The Elevation Options dialog box (Figure D.12) will open with the Properties Tab 

selected by default. 
 

 
Figure D.12  Elevation Options Dialog Box 
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 3. Across the top of the Elevation Options dialog box (Figure D.12), is displayed the name 

of the SMRMP file.  For example, in Figure D.12, the name is stpaul_10ft.smrmp. 
 
 4. From the list box, there are available color contour schemes – Aspect Shading, 

Grayscale, Linear, Precipitation, Red-Green-Blue, Terrain (default), and Water 
Depth. 

 
 5. The Draw Edges check box (Figure D.12) is specifically for ASCII NetTin files.  If 

Draw Edges is selected, the edges of the triangles that make up an ASCII NetTin file 
will be drawn. 

 
 6. The user can set the contour tic interval, by entering a value in the Tic Interval box 

(Figure D.12).  HEC-WAT sets the maximum and minimum limits of the contours 
automatically.  The user can set maximum and minimum limits, from the Contour 
Limits box (Figure D.12), clear System Specified Min/Max Values. The Maximum and 
Minimum boxes are now available for the user to enter values. 

 
 7. The user can control the brightness (amount of white), saturation (amount of black), and 

transparency (level of opacity or alpha) for the colors.  Also, the user can adjust the 
values by using the Brightness, Saturation, and Transparency slider bars or boxes 
(Figure D.12). 

 
 8. By default the Aspect Shading option (Figure D.12) is on, aspect shading is where the 

user can make the map layer appear in relief by placing an imaginary light source above 
the map and shading the contours.  The user can adjust the angle of the light source by 
using the Angle slider bar or the box (Figure D.12).  If the user does not want aspect 
shading, clear Aspect Shading. 

 
 9. Clipping provides a way to highlight an area based on color choices and values.  For 

maximum clipping, the user would fill the contour with the clip color from the maximum 
value of the map to the value entered for Maximum Clipping (Figure D.12).  An 
example of where the user might use maximum clipping would be smog levels, cloud 
cover, or snow level at a particular elevation.  By default, maximum clipping is turned 
off, to turn this option on, click Maximum Clipping (Figure D.12).  The user can either 
enter a maximum clipping value by using the slider bar or entering a value in the box 
(Figure D.12).  The user can change the color by clicking the Color box (Figure D.12), a 
Color Chooser will open (Figure D.11). 

 
 10. Minimum clipping will fill the contour with the clip color from the minimum value of the 

map to the value entered for Minimum Clipping.  An example of where the user might 
use minimum clipping would be to see where a water level would be if it flooded to a 
particular elevation.  By default, minimum clipping is turned off. To turn this option on, 
click Minimum Clipping (Figure D.12).  The user can either enter a minimum clipping 
value by using the slider bar or entering a value in the box (Figure D.12).  The user can 
change the color by clicking the Color box (Figure D.12), a Color Chooser will open 
(Figure D.11). 
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 11. Scaling for the SMRMP file can be set from the Scale Tab on the Elevation Options 
dialog box (Figure D.13). 

 

 
Figure D.13  Elevation Options Dialog Box – Scale Tab 

 
 12. If the user wishes to save any changes made to the selected SMRMP, from the File menu, 

click Save Study, changes are saved to the study file (*.sty). 
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Appendix E 
 
 

Using the Color Chooser 
 
The Color Chooser (Figure E.1) affords great flexibility when the user needs to select default 
colors for map layers, labels, and background colors for the watershed display.  The Color 
Chooser has three tabs: Swatches, HSB, and RGB, offering three methods for choosing a color.  
For each method, the preview area allows the user to see the choices made before applying 
changes. 
 

 
Figure E.1  Color Chooser 
 
E.1 Swatches Worksheet 
 
The Swatches worksheet provides a palette of pre-defined colors.  From the palette, select a 
color.  Once a color has been selected, the Recent box displays that color, as also does the 
Preview box.  Click OK, the Color Chooser will close.  Depending on where the Color 
Chooser was accessed, the user will need to click either Apply or OK for the color change to 
appear in the map window. 
 
For example, for a USGS Digital Line Graph, the user would have accessed the Color Chooser 
from the USGS Digital Line Graph Editor (Appendix D, Section D.2).  Once a color has been 
selected from the Color Chooser (Figure E.1) and closed, then the user needs to click OK or 
Apply from the USGS Digital Line Graph Editor for the color change to appear in the map 
window. 
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E.2 HSB Worksheet 
 
HSB is the Hue, Saturation, and Brightness color model, which allows the user to set the hue, 
saturation, and brightness of the colors.  From the Color Chooser, select the HSB tab; the HSB 
Worksheet (Figure E.2) becomes available. 
 

 
Figure E.2  Color Chooser – HSB Worksheet 
 
There are several ways to adjust the hue, saturation, and brightness of the colors.  The slider bar 
in conjunction with the H, S, and B options will change the color, if red is selected with the Hue 
option selected, then when the user switches to the Saturation and Brightness options, the slider 
bar will be changing the saturation and brightness of the selected color (i.e., red).  Another way 
to affect the colors is in the Hues, Saturation, and Brightness boxes the user can directly enter a 
value for hue, saturation, and brightness.  The following rules apply when entering values for 
each option: 
 
 Hue Box: Hue is measured in a circle from zero (0) to 359 degrees. 
 0 = red, 60 = yellow, 120 = green, 180 = cyan 
 240 = blue, 300 = magenta 
 
 Saturation Box: Saturation is the amount of black, measured from zero (0) to one hundred 

(100) percent. 
 
 Brightness Box: Brightness is the amount of white, measured from zero (0) to one hundred 

(100) percent. 
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A finally a way to set a color on the HSB worksheet is from the color palette by clicking and 
draging the little white circle (Figure E.2).  This will automatically change the hue, saturation, 
and brightness values, along with the red, green and blue color values.  The red, green, and blue 
values in the Red, Green, and Blue boxes (Figure E.2) are not editable and are informational 
only. 
 
Click OK, the Color Chooser will close.  Depending on where the Color Chooser was 
accessed, the user will need to click either Apply or OK for the color change to appear in the 
map window. 
 
E.3 RGBA Worksheet 
 
RGBA is the Red, Green, Blue, and Alpha color model, which allows the user to set the red, 
green, blue, and alpha values.  Alpha is normally used as an opacity channel, with zero percent 
being fully transparent (invisible) and 100 percent being fully opaque.  From the Color Chooser, 
select the RGBA tab; the RGBA Worksheet (Figure E.3) becomes available. 
 

 
Figure E.3  Color Chooser – RGBA Worksheet 
 
There are two ways to adjust the red, green, blue, and alpha values.  The slider bar available for 
each item changes the value, the color being produced is displayed in the Preview box (Figure 
E.3).  Another way to affect colors is in the Red, Green, Blue, Alpha boxes the user can directly 
enter a value.  Click OK, the Color Chooser will close.  Depending on where the Color 
Chooser was accessed, the user will need to click either Apply or OK for the color change to 
appear in the map window. 
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Appendix F  
 
 
 

Stream Alignment 
 
 
Stream alignments represent the stream system in the study.  The alignment indicates where 
confluences and bifurcations occur and provides a sense of distance and scale.  Stream 
alignments are composed of a series of streams, stream nodes, and stream junctions (Figure F.1).  
A stream typically begins or ends at a confluence, bifurcation, or at the boundary of the river 
system.  A stream is composed of vertex points, with the beginning and ending vertex points 
being stream nodes. 
 

 
Figure F.1  Stream Alignment Parts 
 
 

 
Stream Nodes 

Stream Alignment Streams 

Stream Junctions 
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Streams are drawn as multi-segmented lines.  Each stream must have at least two stream nodes, 
defining the beginning and end of the stream.  Streams, stream nodes, and stream junctions, are 
illustrated in Figure F.2. 
 

 
Figure F.2  Relationships of Streams in a Stream Alignment 
 
HEC-WAT creates and labels stream stations (or river stations) along each stream.  The station at 
the downstream end of a stream is Station 0 (zero), and the stationing increases upstream along 
the stream according to the linear distance between vertices on the stream in the study coordinate 
system.  The user can override the default stationing by editing the station values of the stream 
nodes at the upstream and downstream ends of the stream, as well as by adding additional nodes 
along the stream.  Stream stationing is based on the geographic extents that are defined when a 
stream is drawn.  If the geo-extents are based on a map layer, the units for the stream stationing 
are the same as the map layer (i.e., feet, meters).  In Version 1.0 of HEC-WAT, where there is no 
unit indicator, there will be a way for the user to view the units in future versions. 
 
F.1 Creating the Default Stream Alignment 
 
If the stream alignment is going to be based on a map layer, the map layer should already have 
been included in the study.  The details on how to include a map layer are given in Chapter 5.  
The map layer should contain water features, such as stream channels and reservoirs.  Use this 
map layer as a guide while creating the stream alignment.  By doing this, the units of the labels 
on the stream alignment will be the same as the units of the water feature layer (i.e., if the water 
feature layer is projected in state plane coordinates (feet), then the labels on the stream alignment 
will be in feet). 



HEC-WAT User's Manual Appendix F – Stream Alignment 

 F-3 

The user can either import a stream alignment from a shapefile or digitize a stream alignment by 
hand.  The following are the steps for importing a stream alignment, details on digitizing a 
stream alignment are provided later in this appendix. 
 
To import a stream alignment: 
 
 1. From the HEC-WAT main window (Figure F.3), from the Maps Tab, from the Map 

Layers tree, right-click on Stream Alignment (Figure F.4).  From the shortcut menu, click 
Import. 

 

 
Figure F.3  HEC-WAT Main Menu – Maps Tab 

 

 
Figure F.4  Map Layers Tree - Shortcut Menu 
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 2. The Import Stream Alignment dialog box will open (Figure F.5).  The Shapefile Name 
list defaults to the first line shapefile it can find in the maps directory; which in this 
example happens to be the shapefile that represents the stream alignment for the 
RussianRiver study - RR_StreamAlignment.shp. 

 

 
Figure F.5  Import Stream Alignment Dialog Box 

 
 3. If the map layer that represents the stream alignment is not stored in the maps directory of 

the HEC-WAT study, click       , a Choose Shapefile Browser will open (Figure F.6).  
Browse to the location where the shapefile that represents the stream alignment is stored 
on the computer.  Click on the filename (e.g., RR_StreamAlignment.shp), the filename 
will appear in the File name box of the browser (Figure F.6).  Click Open, the Choose 
Shapefile Browser will close (Figure F.6). 

 

 
Figure F.6  Choose Shapefile Dialog Box 

 
 4. The name of the selected shapefile will appear in the Shapefile Name box on the Import 

Stream Alignment dialog box (Figure F.7). 
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Figure F.7  Import Stream Alignment Dialog Box – Shapefile Name 

 
 5. From the Database Field Name list (Figure F.8), the user needs to select the field name 

in the attribute file that contains the names of the streams - Name.  Once a field name is 
selected, the table below will populate with the streams contained in the shapefile.  If 
there is an issue with any of the stream segments the checkbox in the Import column 
(Figure F.8) will not be selected.  This means the stream segment is not continuous and 
will not be imported. 

 

 
Figure F.8  Import Stream Alignment Dialog Box – Example Shapefile 
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 6. Gap Tolerance (Figure F.8) is used when stream segments are not continuous and the 
user wants HEC-WAT to connect the segments via the gap tolerance.  The gap tolerance 
units are based on the selected shapefile units (i.e., shapefile units is feet, the gap 
tolerance will be in feet).  To set the gap tolerance, select Gap Tolerance and enter a 
value in the box.  Recommended that users enter one (1) for the unit of tolerance to 
connect.  The value entered can also be fractional so for units that are in large units of 
distance.  For example, a gap toleration of .001 might be used for a shapefile file that has 
units in miles. 

 
 7. Click Reverse Direction (Figure F.8). The flow direction in the RR_StreamAlignment. 
  shp shapefile is not correct.  So instead of fixing the issues with ArcMap® (ESRI GIS 

software), the user can perform the Reserve Direction procedure on the system of 
streams to correct flow direction. 

 
 8. Click Import, the Import Stream Alignment dialog box will close (Figure F.8).  Once 

the import of the stream alignment is completed, a message window will appear letting 
the user know that the stream alignment imported successfully.  In the active Map 
Window the stream alignment appears (orange stream segments; green stream nodes and 
stream junctions). 

 
F.2 Existing Stream Alignments 
 
After creating a stream alignment, the user can view the stream alignment; remove the stream 
alignment from an active map window; save the stream alignment; create a copy of an existing 
stream alignment; rename an existing stream alignment; delete an existing stream alignment; 
view an existing stream alignment's properties; reverse direction of all streams that make up a 
stream alignment; import a stream alignment from an existing HEC-WAT stream alignment 
(stream.align); import a stream alignment from a shapefile (Figure F.8); export an HEC-WAT 
stream alignment to a shapefile; and, view a list of all streams contained in a stream alignment.  
All of these tasks are accomplished through the stream alignment shortcut menu (Figure F.9).  
The stream alignment shortcut menu is available from the HEC-WAT main window (Figure 
F.3), click Schematic Tab, on the Study Pane, under the Components folder, under the Stream 
Alignments folder, and then right-click on an existing stream alignment. 
 

 
Figure F.9  Stream Alignment Shortcut Menu 
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F.2.1 View a Stream Alignment 
 
To view a stream alignment in a map window: 
 
 1. Right click on an existing stream alignment, from the stream alignment shortcut menu 

(Figure F.9) click Display in Map Window. 
 
 2. If there is not a map window open in the Desktop Pane, the map window for the selected 

stream alignment will open in the Desktop Pane (Chapter 3, Section 3.1).  From the map 
window the user can edit the streams, stream nodes, and stream junctions that make-up 
the stream alignment. 

 
 3. If a map window is open in the Desktop Pane, the Select Location message box will 

open letting the user know that the stream alignment is already displayed in the active 
map window.  If the user wishes to open a separate map window for the stream 
alignment, click Yes.  The message box will close, and a map window will open with the 
selected stream alignment displayed. 

 
F.2.2 Remove a Stream Alignment from the Active Map 

Window 
 
To remove a stream alignment in a map window: 
 
 1. Right click on an existing stream alignment, from the stream alignment shortcut menu 

(Figure F.9) click Remove from Map Window. 
 
 2. The Remove from Map? message box will open letting asking the user do you wish to 

remove the stream alignment from the active map window, click Yes.  The message box 
will close, and the map window will no longer display the stream alignment. 

 
F.2.3 Save a Stream Alignment 
 
To save the active stream alignment, from the stream alignment shortcut menu (Figure F.9), click 
Save.  Any changes that have occurred to the selected stream alignment will be saved by HEC-
WAT. 
 
F.2.4 Make a Copy of a Stream Alignment 
 
To create a copy of a stream alignment: 
 
 1. Right click on an existing stream alignment, from the stream alignment shortcut menu 

(Figure F.9) click Save As. 
 
 2. The Save Stream Alignment As dialog box will open (Figure F.10).  The name of the 

stream alignment that is being copied is displayed in the Old Name box (Figure F.10). 
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Figure F.10  Save Stream Alignment As Dialog Box 

 
 3. The user should enter a new name in the Name box (required) and provide a new 

description in the Description box (optional). 
 
 4. Click OK, the Save Stream Alignment As dialog box will close (Figure F.10).  The new 

stream alignment is displayed on the Schematic Tab (Figure F.9), in the Study Pane, 
under the Stream Alignments folder. 

 
F.2.5 Rename a Stream Alignment 
 
To rename a stream alignment: 
 
 1. Right click on an existing stream alignment, from the stream alignment shortcut menu 

(Figure F.9) click Rename. 
 
 2. The Rename Stream Alignment dialog box will open (Figure F.11).  The name of the 

existing stream alignment is displayed in the Name box (Figure F.11). 
 

 
Figure F.11  Rename Stream Alignment Dialog Box 

 
 3. The user should enter a new name in the Name box (required) and provide a new 

description in the Description box (optional). 
 
 4. Click OK, a Confirm Rename message window will open asking the user are sure that 

you really want to rename the stream alignment (renaming a stream alignment in a study 
that already has alternatives created could cause issues).  Click Yes, the Rename Stream 
Alignment dialog box will close (Figure F.11).  The new stream alignment is displayed 
on the Schematic Tab (Figure F.9), in the Study Pane, under the Stream Alignments 
folder. 
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F.2.6 Delete a Stream Alignment from the Study 
 
To delete a stream alignment from the study: 
 
 1. Right click on an existing stream alignment, from the stream alignment shortcut menu 

(Figure F.9) click Delete from Study. 
 
 2. A Confirm Manager Delete message window will open asking the user for confirmation 

to delete the stream alignment (deleting a stream alignment in a study that already has 
alternatives created could cause issues).  Click Yes, the Confirm Manager Delete 
message window will close.  The selected stream alignment is no longer displayed on the 
Schematic Tab (Figure F.9), in the Study Pane, under the Stream Alignments folder. 

 
F.2.7 Stream Alignment Properties 
 
The properties of a stream alignment include the name, description, when the stream alignment 
was last modified, who created the stream alignment, when the stream alignment was created, 
the file that contains the stream alignment data; and the spatial layout of the stream alignment.  
To view the properties of a stream alignment, from the stream alignment shortcut menu (Figure 
F.9), click Properties.  The Properties for Stream Alignment dialog box will open (Figure 
F.12). 
 

 
Figure F.12  Properties for Stream Alignment Dialog Box 
 
F.2.8 Reverse Direction of All Streams in a Stream  

Alignment 
 
When importing a stream alignment from ArcView® as shapefiles or when digitizing a stream 
alignment, individual streams segments can be in the wrong direction (downstream to upstream).  
The user can reverse the direction of all the streams if the streams are in the wrong direction. 
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From the stream alignment shortcut menu (Figure F.9), click Reverse Direction All.  The 
Confirm Reverse Direction warning message box will appear. The user will be warned that 
reversing the streams direction will reverse the default stationing for all the streams in the stream 
alignment.  Click Yes, the warning message box will close, and all streams associated with the 
stream alignment will have reversed direction. 
 
F.2.9 Import from an HEC-WAT Stream Alignment 
 
 1. Right click on an existing stream alignment, from the stream alignment shortcut menu 

(Figure F.9) click Import from Existing. 
 
 2. A Confirm Import message window will open letting the user know that this command 

will replace the contents of the HEC-WAT stream.align file.  Click yes, an Open 
Browser will appear (Figure F.13).  Browse to an HEC-WAT study, click on the 
stream.align file (which appears in the File name box). 

 

 
Figure F.13 Open Browser 

 
 3. Click Open, the Open Browser will close (Figure F.13) and the stream alignment from 

the selected HEC-WAT study is displayed. 
 
F.2.10 Export an Existing Stream Alignment 
 
If adjustment have been made to the stream alignment or the stream alignment was digitized, the 
stream alignment can be saved as a shapefile.  To export a stream alignment the user must have a 
stream alignment in the map window. 
 
To export a stream alignment: 
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 1. Right click on an existing stream alignment, from the stream alignment shortcut menu 
(Figure F.9) click Export. 

 
 2. A Save browser will open (Figure F.14).  Enter a name in the File name box.  Click OK, 

the Save browser will close, and a shapefile of the displayed stream alignment will be 
saved in the selected location. 

 

 
Figure F.14 Save Browser 

 
F.3 Edit a Stream Alignment 
 
From a map window (Figure F.15) a user can edit the individual components of a stream 
alignment – streams, stream nodes, and stream junctions.  The following sections describes the 
editing capabilities provided for each stream component. 
 

 
Figure F.15 Map Window – Stream Alignment 
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F.3.1 Streams 
 
After establishing a stream alignment, the user can rename and edit the description of individual 
streams, delete individual streams, reverse the direction of a stream, disconnect a stream at both 
the upstream or downstream end, and view the stream stationing and coordinates of the stream 
nodes on a stream.  All of these tasks are accomplished through the stream shortcut menu (Figure 
F.16).  To access the stream shortcut menu, the Stream Alignment Tool       must be selected, 
and from the map window (Figure F.15), right-click on a stream. 
 

 
Figure F.16 Stream Shortcut Menu 
 
Edit a Stream 
 
The user can edit a stream's description and view the stream's stationing and coordinates of the 
upstream and downstream stream nodes, plus any stream nodes in between the two. 
 
To edit the description of a stream: 
 
 1. Press the Stream Alignment Tool from the toolbar on the map window (Figure F.15), 

right-click on the stream element to edit, click Edit Stream Element from the stream 
shortcut menu (Figure F.16), the Stream Editor will open (Figure F.17). 

 

 
Figure F.17 Stream Editor 
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 2. The user can either enter a new description (recommended) or edit the description of the 
stream in the Description box. 

 
 3. The table provides the user with the stream stationing and coordinates of the stream 

nodes that are on the selected stream and is informational only. 
 
 4. Click OK, the Stream Editor will close (Figure F.17). 
 
Rename a Stream 
 
To rename a stream: 
 
 1. Press the Stream Alignment Tool from the toolbar on the map window (Figure F.15), 

right-click on the stream to rename, and click Rename Stream Element from the stream 
shortcut menu (Figure F.16). 

 
 2. The Rename Stream dialog box opens (Figure F.18).  Enter the new name in the Name 

box (required) and description in the Description box (optional, but recommended). 
 

 
Figure F.18  Rename Stream Dialog Box 

 
 3. Click OK and the Rename Stream dialog box will close (Figure F.18).  The new name 

of the stream will be shown on the map window. 
 
Delete a Stream 
 
To delete a stream: 
 
 1. Press the Stream Alignment Tool from the toolbar on the map window (Figure F.15), 

right-click on the stream to delete and click Delete Stream Element from the stream 
shortcut menu (Figure F.16). 

 
 2. A Confirm Delete warning message will open asking the user whether you really want to 

delete the selected stream.  Click Yes, the warning message will close and the stream will 
be deleted from the map window. 

 
Disconnect a Stream 
 
If the user wants to disconnect a stream from another stream, HEC-WAT will allow the user to 
do so at either the upstream or downstream end of the stream. 
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To disconnect a stream from another stream: 
 
 1. Press the Stream Alignment Tool from the toolbar on the map window (Figure F.15), 

right-click on the stream to disconnect and either click Disconnect Upstream or 
Disconnect Downstream from the stream shortcut menu (Figure F.16). 

 
 2. The stream will now be disconnected from the stream at the location chosen.  On the map 

window, the upstream or downstream point will physically move away from the 
connecting stream and a stream node will remain on the connecting stream. 

 
Reverse Direction of a Stream 
 
If a stream in the drawn in the wrong direction (downstream to upstream), HEC-WAT provides a 
way to reverse the direction of a stream, instead of having to delete and redraw the stream. 
 
To reverse direction of a stream: 
 
 1. Press the Stream Alignment Tool from the toolbar on the map window (Figure F.15), 

right-click on the stream you want to reverse and click Reverse Direction from the 
stream shortcut menu (Figure F.16). 

 
 2. A Confirm Reverse Direction warning message will appear asking if the user really 

wants to reverse the direction of the stream.  Click Yes, the warning message will close 
and the stream's direction will be reversed. 

 
Graphically Edit a Stream 
 
After establishing a stream alignment, the user can graphically edit the individual streams of the 
stream alignment.  By using the Stream Alignment Tool      , the CTRL key, and the SHIFT 
key, the user can edit individual streams by adding, moving, and deleting vertex points.  The edit 
is performed graphically on the schematic in the active map window. 
 
Add Vertices to a Stream 
 
To add vertex points to an existing stream: 
 
 1. Press the Stream Alignment Tool from the toolbar on the map window (Figure F.15), 

double-click on a stream that needs additional vertices, and the stream will turn red, with 
blue points that represent vertices. 

 
 2. Place the pointer on the selected stream where a new vertex point needs to be added.  Hold 

down the CTRL key and click.  A blue point will now appear on the selected stream, 
which represents a new vertex point. 
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Move the Vertices of a Stream 
 
To move vertex points on an existing stream: 
 
 1. Press the Stream Alignment Tool from the toolbar on the map window (Figure F.15); 

double-click on the stream where a vertex point needs to be moved.  The selected stream 
will turn red, and the individual vertex points will be blue points. 

 
 2. Click on the vertex point that needs to be moved move and then drag the vertex point to a 

new location; the vertex point has been moved. 
 
Delete Vertices from a Stream 
 
To delete vertex points from an existing stream: 
 
 1. Press the Stream Alignment Tool from the toolbar on the map window (Figure F.15); 

double-click on the stream where a vertex point needs to be deleted.  The selected stream 
will turn red, and the individual vertex points will be blue points. 

 
 2. Hold down the SHIFT+CTRL keys and click on the vertex point to be deleted.  The blue 

vertex point will disappear from the stream. 
 
F.3.2 Stream Nodes 
 
After establishing the stream alignment, the user can edit and delete the individual stream nodes 
of a stream alignment.  Both of these tasks are accomplished through the stream node shortcut 
menu (Figure F.19).  To access the stream node shortcut menu, the Stream Node tool       must 
be selected, and from the map window right-click on a stream node. 
 

 
Figure F.19  Stream Node Shortcut Menu 
 
Establish Stream Stationing 
 
HEC-WAT creates a beginning and ending stream node for each stream.  Stream nodes are also 
created where streams meet (stream junctions).  Stream nodes are used to establish stationing for 
a stream.  To establish stream stationing for a stream, the user can edit the stream nodes.   
 
To edit a stream node: 
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 1. Press the Stream Node Tool from the toolbar on the map window (Figure F.15), right-
click on the stream node to edit.  From the stream node shortcut menu (Figure F.19), 
click Edit Node; the Stream Node Editor will open (Figure F.20). 

 

 
Figure F.20  Stream Node Editor 

 
 2. The default stream station has the downstream node at zero (0) and the upstream node is 

based on the coordinate system from the imported stream alignment.  To change the 
stream stationing, clear Use Default Stationing.  The Station box can now be edited. 

 
 3. Click OK, the Stream Node Editor will close (Figure F.20).  Based on what is entered, 

HEC-WAT will automatically adjust the stream stationing for the stream associated with 
the stream node.  This includes the upstream and downstream nodes. 

 
Delete a Stream Node 
 
To delete a stream node, press the Stream Node Tool from the toolbar, right-click on the stream 
node that needs to be deleted.  From the stream node shortcut menu (Figure F.19) click Delete 
Node.  A Confirm Delete warning message will open to request for user confirmation prior to 
node deletion.  Click Yes, the warning message will close and the stream node will be deleted 
from the stream alignment.  The beginning and ending stream nodes of a stream element cannot 
be deleted. 
 
Graphically Edit a Stream Node 
 
After establishing a stream alignment, the user can graphically edit the individual stream nodes 
of the stream alignment.  By using the Stream Node Tool, and the CTRL key, the user can add 
and move stream nodes.  This edit is performed graphically on the schematic in the active map 
window. 
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Add a Stream Node 
 
Two stream nodes are created automatically at the beginning and ending stream nodes of a 
stream.  The user can add stream nodes to a stream by pressing the Stream Node Tool from the 
toolbar.  Using the Stream Node Tool      , place the pointer on the stream where a stream node 
needs to be added.  Hold down the CTRL key and click.  A circle will now appear on the stream 
that indicates the new stream node. 
 
Move a Stream Node 
 
To move a stream node, press the Stream Node Tool from the toolbar; double-click on the 
stream node that needs to be moved.  The stream node becomes a yellow circle with a black 
outline and four small black dots (Figure F.21).  Click and drag the stream node along the stream 
to its new position.  The beginning and ending stream nodes of a stream cannot be moved. 
 

 
Figure F.21  Move a Stream Node 
 
F.3.3 Stream Junctions 
 
When two streams intersect, a stream junction is created.  A stream junction is multiple stream 
nodes at one location and is represented by a dark green circle with a light green halo around the 
circle.  The user can establish stream stationing at a stream junction.  This task is accomplished 
through the stream junction shortcut menu (Figure F.22).  To access the stream junction shortcut 
menu, the Stream Node       tool must be selected, and from the map window right-click on a 
stream junction. 
 

 
Figure F.22  Stream Junction Shortcut Menu 
 
Edit a Stream Junction 
 
To edit a stream junction: 
 
 1. Press the Stream Node Tool from the toolbar on the map window (Figure F.15), right-

click on the stream junction that you want to edit.  From the stream junction shortcut 
menu (Figure F.22), click Edit Stream Junction.  The Stream Junction Editor will 
open (Figure F.23). 
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Figure F.23  Stream Junction Editor 

 
 2. The editor displays information about the stream nodes associated with the stream 

junction.  To change the stream stationing for a stream node, clear the checkbox for a 
stream node from the Use Default Stationing column of the table.  The cell in the 
Station column becomes active.  Based on the station is entered, HEC-WAT will 
automatically adjust the stream stationing for the stream associated with the stream node. 

 
 3. Click OK, the Stream Junction Editor will close (Figure F.23). 
 
Graphically Edit a Stream Junction 
 
After establishing a stream alignment, the user can graphically edit the individual stream 
junctions of the stream alignment.  By using the Stream Node Tool, the user can move a stream 
junction.  This edit is performed graphically on the schematic in the active map window. 
 
Move a Stream Junction 
 
To move a stream junction press the Stream Node Tool      from the toolbar; double-click on the 
stream junction that needs to be moved.  The stream node becomes a green circle with a black 
outline and four small black dots (Figure F.24).  Click and drag the stream junction along the 
stream element to its new position. 
 

 
Figure F.24  Move a Stream Junction 
 
F.4 Change Stream Alignment Properties 
 
Stream alignment properties that can be changed include: color of streams, stream nodes, and 
stream junctions; the width of streams, stream nodes, and stream junctions; font for the stream 
name; tic mark properties; and visualization scaling for the stream alignment. 
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To change stream alignment properties: 
 
 1. From the HEC-WAT main window (Figure F.15), from the Maps Tab, right-click on 

Stream Alignment in the tree.  From the shortcut menu, click Properties. 
 
 2. The Stream Alignment Properties dialog box will open (Figure F.25). 
 

 
Figure F.25  Stream Alignment Properties Dialog Box 

 
 3. To change the color of the stream alignment, select a color from the Stream Color list.  

The example to the right of the Edit Properties box (Figure F.25) will preview the 
selected color. 

 
 4. Click OK, the Stream Alignment Properties dialog box (Figure F.25) will close and the 

color change will appear in the map window. 
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F.5 Digitize a Stream Alignment 
 
To digitize the default stream alignment for a new study: 
 
 1. When a new study is created (Chapter 4, Section 4.1.1), the default stream alignment is 

created (Stream Alignment) and a schematic map window is automatically opened in the 
Desktop Pane (Chapter 3, Section 3.1). 

 
 2. The default stream alignment is blank, to begin building the default stream alignment; 

find a location on the map window where a stream should start.  Streams should be 
created from upstream to downstream.  Hold down the CTRL key, while clicking the 
mouse button.  Each click creates a vertex point (Figure F.26), on the stream.  The first 
vertex point is the upstream or beginning stream node of a stream. 

 

 
Figure F.26  Creating a Stream 

 
 3. For the most downstream or last vertex point, release the CTRL key, and then click the 

mouse button.  This creates the ending stream node of the stream.  A single stream has 
been created. 

 
 4. The Create New Stream dialog box will open (Figure F.27).  The user can either accept 

the default name or enter a new name (required) in the Name box.  If needed, the user 
can enter an optional description (recommended) in the Description box.  Click OK, the 
Create New Stream dialog box will close. 
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Figure F.27  Create New Stream Dialog Box 

 
 5. Repeat steps 2 through 4 to add more streams to the stream alignment. 
 
 6. To connect a stream to an existing stream, place the first or last click of the new stream 

on the existing stream where the two streams to join.  After naming the new stream, a 
Connect Stream Reaches message box will appear asking the user do you want to 
connect the new stream to the existing stream.  Click Yes if the two streams need to be 
connected.  Otherwise, click No and the new stream will not be connected to the existing 
stream. 

 
 7. Once the user has completed the stream alignment, save your work. 
 
The Zoom Tool (Section 6.3) can be used to help define the stream alignment.  Use it to magnify 
the stream network, which makes defining the vertices along a stream easier. 
 
F.6 Save Stream Alignment Data 
 
To save stream alignment input, from the Stream Alignment shortcut menu (Figure F.9), click 
Save, the stream alignment has been saved.  Another way to save data is from the File menu, 
click Save Study.  Both commands will save all of the stream alignment input to the appropriate 
files created and used by HEC-WAT for the stream alignment. 
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Appendix G 
 
 

Measures 
 
Measures for HEC-WAT include structural/non-structural measures (flood damage reduction), 
and/or ecosystem measures.  Structural measures are physical modifications designed to reduce 
the frequency of damaging levels of flood inundation, and include dams with reservoirs, levees, 
channelization measures, walls, diversion channels, pumps, bridge modifications, and ice-control 
structures.  Non-structural measures are activities that reduce flood damage without 
significantly altering the nature or extent of flooding (e.g., flood proofing, relocation of 
structures, raising structures).  Ecosystem restoration measures are physical modifications or 
other actions that improve the value and function of an ecosystem (e.g., channel restoration, 
removal of drainage structures or levees).  There are various measures that can be defined for 
HEC-WAT, but this User's Manual will only focus on reservoirs and levees.  Other measures 
available in HEC-WAT are diversions, channel improvements, off-channel storage, and other 
projects. 
 
Measures are components of an existing or proposed physical system and provide a starting point 
for implementation in a particular model.  All models should incorporate the presence of 
measures in the system, although the measures maybe represented very differently from model to 
model. 
 
G.1 Reservoirs 
 
A reservoir is the impoundment created behind dams, or behind navigation locks and dams.  For 
HEC-WAT a reservoir also includes the dam built on a stream to store water for uses such as 
flood damage reduction, hydroelectric power generation, recreation use, and water supply, etc. 
 
G.1.1 Create a Reservoir 
 
To create reservoirs, the study must have a valid stream alignment (Appendix F), once the stream 
alignment has been created, the following steps are how a user would add reservoirs to the study: 
 
 1. From the HEC-WAT main window (Figure G.1), from the Study Pane, from the Study 

Tree, under the Simulations folder, double click on the schematic that requires the 
addition of reservoirs (e.g., Schematic:WithoutProjectCondtions).  A Schematic Map 
Window will open in the Desktop Pane that displays a stream alignment. 

 
 2. To assist the user in the location of the reservoir(s), a map layer that displays reservoir 

locations for the study area should be added to the study (Chapter 5). 
 
 3. From the map window toolbar, press the Zoom Tool      , zoom into an area on the map 

window where a reservoir is located. On the map window toolbar, press the Reservoir 
Tool      . 
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Figure G.1  HEC-WAT Main Window 

 
 4. Hold down the CTRL key and click on the stream alignment to place the upstream end of 

the reservoir.  Release the CTRL key; drag the mouse to the downstream end of the 
reservoir and click. 

 
 5. The Name New Reservoir dialog box will open (Figure G.2).  Enter the new Name 

(required) and Description (optional, but recommended).  Click OK, the Name New 
Reservoir dialog box will close. 

 

 
Figure G.2  Name New Reservoir Dialog Box 
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 6. The reservoir will now appear on the schematic as a cyan triangle (reservoir pool), a blue 
line (storage reach), a gray rectangle (dam), and two common computation points that 
represent the upstream and downstream ends of the reservoir, as shown in Figure G.3. 

 

 
Figure G.3  A Reservoir Added to the Map Window 

 
 7. The default representation of the reservoir pool is a triangle; the user can edit this triangle 

if a more detailed representation of the pool is desired.  With the Reservoir Tool pressed, 
double-click on the reservoir.  The triangle (Figure G.4) will now be green with a blue 
outline color.  Also, there are three vertex points (blue), and at the apex of the triangle is 
the reservoir label, which is represented by a yellow circle. 

 

 
Figure G.4  Reservoir Pool 

 
 8. By clicking and dragging the yellow circle the user can move the reservoir label to an 

appropriate location. Similar to the stream alignment, the user can add, move, and delete 
vertex points to the reservoir pool.  Figure G.5 illustrates how the reservoir pool shown in 
Figure G.6 has been edited to give a more detailed representation of the reservoir pool. 
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Figure G.5  Detailed Representation of a Reservoir Pool 

 
 9. When a reservoir is created there are two common computation points that are created 

with default names.  It is recommended that the names of the two common computation 
points be changed.  These two common computation points represent the inflow and 
outflow junctions of the reservoir and should be renamed accordingly. 

 
 10. To change the name of a common computation point, press the Computation Point Tool 
      , right-click on one of the common computation points.  From the shortcut menu, click 

Rename Computation Point; the Rename Computation Point dialog box will open 
(Figure G.6).  In the Name box, enter the new name, and in the Description box enter a 
description (optional, but recommended).  For example, in Figure G.6, the inflow 
junction for Lake Mendocino has been labeled Lake Mendocino Inflow Jct. 

 

 
Figure G.6  Rename Computation Point Dialog Box 

 
G.1.2 Existing Reservoirs 
 
After adding a reservoir to the schematic, the user can edit the reservoir; rename an individual 
reservoir; remove a reservoir from the active schematic, delete individual reservoirs from the 
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study; and, create configuration notes for individual reservoirs.  All of these tasks are 
accomplished through the reservoir shortcut menu (Figure G.7).  To access the reservoir shortcut 
menu, from a schematic, and with the Reservoir Tool (on the map toolbar, press the Reservoir 
Tool      ) selected, right-click on a reservoir. 
 

 
Figure G.7  Reservoir Shortcut Menu 
 
Edit a Reservoir 
 
The user can edit the properties of a reservoir.  Properties that can be changed are the 
description, whether the reservoir is an existing project, whether the reservoir is a Corps project, 
and the year the reservoir came on-line. 
 
To edit reservoir properties: 
 
 1. Right-click on the reservoir whose properties need to be changed, and click Edit 

Reservoir from the reservoir shortcut menu (Figure G.7). 
 
 2. The Reservoir Properties Editor will open (Figure G.8).  From the Description box 

you can edit or add a description. 
 

 
Figure G.8  Reservoir Properties Editor 

 
 3. If the selected reservoir is an existing project, select the Existing Project check box 

(Figure G.8). 
 
 4. If the reservoir is a Corps project, select the Corps Project check box. 
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 5. Enter the year the reservoir came on-line in the Year in Service box (Figure G.8).  For 

Version 1.0 this is just informational and is not used in any computation. 
 
Rename a Reservoir 
 
To rename a reservoir: 
 
 1. Right-click on the reservoir that needs to be renamed, and click Rename Reservoir from 

the reservoir shortcut menu (Figure G.7). 
 
 2. The Rename Reservoir dialog box will open (Figure G.9).  Enter the new Name 

(required) and Description (optional, but recommended) for the reservoir. 
 

 
Figure G.9 Rename Reservoir Dialog Box 

 
 3. Click OK, a Confirm Rename warning message will open asking the user for 

confirmation.  Click Yes, the warning message and the Rename Reservoir dialog box 
will close, and the reservoir will display the new name. 

 
Remove a Reservoir from a Schematic 
 
HEC-WAT allows the user to remove reservoirs from existing schematics.  The reservoir will be 
removed from the schematic, but not from the study. 
 
To remove a reservoir from a schematic: 
 
 1. Right-click on the reservoir to be removed from the active schematic, and click Remove 

ReservoirName from SchematicName from the reservoir shortcut menu (Figure G.7). 
 
 2. A warning message will open asking the user confirmation about removing the selected 

reservoir from the current schematic.  Click Yes, the warning message will close, and the 
reservoir will disappear from the schematic. 

 
Delete a Reservoir 
 
To delete a reservoir: 
 
 1. Right-click on the reservoir to be deleted, and click Delete ReservoirName from Study 

from the reservoir shortcut menu (Figure G.7). 
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 2. A Confirm Delete warning message will open asking for user confirmation to delete the 
selected reservoir.  Click Yes, another warning message will open asking the user if you 
wish to delete the computation points associated with the reservoir.  Click Yes, the 
warning message will close.  The reservoir and computation points will no longer appear 
in the schematic and will have been removed from the study. 

 
Add Schematic Notes for a Reservoir 
 
Schematic notes allow you to add information about a reservoir specific to a schematic.  
Schematic notes are helpful when multiple schematics have been defined. 
 
To add schematic notes for a reservoir: 
 
 1. Right-click on the reservoir that you want to add schematic notes to, and click 

Configuration Notes from the reservoir shortcut menu (Figure G.7). 
 
 2. The Notes: dialog box (Figure G.10) will open.  Enter information in the Configuration 

Notes box that describes the selected reservoir for the current schematic. 
 

 
Figure G.10  Notes: Dialog Box - Reservoir 

 
Graphically Edit a Reservoir 
 
After creating a reservoir, the reservoir can be edited graphically.  By using the Reservoir Tool      
, the CTRL key, and the SHIFT key, the user can edit a reservoir by adding, moving, and 
deleting vertex points.  This edit is performed graphically on the schematic in the active map 
window. 
 
Add Vertices to a Reservoir 
 
To add vertex points to an existing reservoir: 
 
 1. Double-click on the reservoir that you want to add a vertex point to, and the polygon will 

turn green. 
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 2. Place the pointer on the selected reservoir where a vertex point needs to be added.  Hold 
down the CTRL key and click.  A blue point will now appear on the selected reservoir, 
which represents a new vertex point. 

 
Move the Vertices of a Reservoir 
 
To move vertex points on an existing reservoir: 
 
 1. Double-click on the reservoir where the user wants to move a vertex point.  The selected 

reservoir will turn green, and the individual vertex points will turn blue. 
 
 2. Click on the vertex point that needs to be moved, and drag the vertex point to a new 

location. 
 
Delete Vertices from a Reservoir 
 
To delete vertex points from an existing reservoir: 
 
 1. Double-click on the reservoir where the user wants to delete a vertex point.  The selected 

reservoir will turn green, and the individual vertex points will turn blue. 
 
 2. Hold down the SHIFT+CTRL keys, and click on the vertex point that needs to be 

deleted.  The vertex point will disappear from the reservoir. 
 
G.2 Levees 
 
A levee/floodwall is a man-made barrier built along a stream to provide protection from 
flooding.  A levee/floodwall can reduce flood damage by preventing flood stages from reaching 
a potential damage area. 
 
G.2.1 Import Levees 
 
The user can either import levees from a shapefile or digitize levees by hand (Section G.2.2).  
The following are the steps for importing levees: 
 
 1. From the HEC-WAT main window (Figure G.1), from the Maps menu, point to Import, 

click Levees. 
 
 2. The Import Levees dialog box will open (Figure G.11).  The Shapefile Name box 

defaults to the first line shapefile it can find in the maps directory.  For example in Figure 
G.11, HEC-WAT selected the rr_Levee.shp shapefile, which is the correct file. 

 
 3. If the map layer that represents the levees does not display in the Shapefile Name box 

(Figure G.11), from the File men of the Import Levees dialog box (G.11), click Choose 
Shapefile.  A Choose Shapefile Selector will open (Figure G.12).  From the Available  
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Figure G.11  Import Levees Dialog Box 

 

 
Figure G.12  Choose Shapefile Selector 

 
  box, select the shapefile that represents the levees of the study area, click Add.  The 

selected shapefile name will now appear in the Selected box (G.12).  Click OK, the 
Choose Shapefile Selector will close (Figure G.12), and the name of the selected 
shapefile will display in the Shapefile Name box of the Import Levees dialog box 
(Figure G.11). 

 
 4. From the Database Field Name list (Figure G.11), the user needs to select the field name 

in the attribute file that contains the names of the levees – ID_Name.  Once a field name 
is selected, the table below will populate with the levees contained in the shapefile.  If 
there is an issue with any of the levee segments the checkbox in the Import column 
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(Figure G.11) will not be selected.  This means the levee is not continuous and will not be 
imported. 

 
 5. Click Import, the Import Levees dialog box will close (Figure G.11).  Once the import 

of the levees is completed, a message window will appear letting the user know that the 
levees have been imported successfully.  In the active Map Window the levees appear 
(black lines along the stream alignment). 

 
G.2.2 Create a Levee 
 
To create levees, the study must have a valid stream alignment (Appendix F), once the stream 
alignment has been created, the following steps for adding levees to the study: 
 
 1. From the HEC-WAT main window (Figure G.1), from the Study Pane, from the Study 

Tree, under the Simulations folder, double click on the schematic that requires the 
addition of reservoirs (e.g., Schematic:WithoutProjectCondtions).  A Schematic Map 
Window will open in the Desktop Pane that displays a stream alignment. 

 
 2. To assist the user in the location of a levee(s), a map layer that displays levee locations 

for the study area should be added to the study (Chapter 5). 
 
 3. From the map window toolbar, press the Zoom Tool      , zoom into an area on the map 

window where a levee is located. On the map window toolbar, press the Levee Tool      . 
 
 4. Hold down the CTRL key and click on the stream alignment to place the upstream end of 

the levee.  Release the CTRL key, drag the mouse to the downstream end of the levee 
and click. 

 
 5. The Name New Levee dialog box opens (Figure G.13).  Enter the new Name (required) 

and Description (optional, but recommended).  Click OK, the Name New Levee dialog 
box will close. 

 

 
Figure G.13  Name New Levee Dialog Box 



HEC-WAT User's Manual Appendix G - Measures 

 G-11 

 
 6. The levee will now appear on the schematic as a black line, as shown in Figure G.14. 
 

 
Figure G.14  A Levee Added to the Schematic 

 
G.2.3 Existing Levees 
 
After adding a levee to the schematic, the user can edit the levee; the user can rename an 
individual levee; remove a levee from the active schematic, delete individual levees from the 
study; and, create configuration notes for individual levees.  All of these tasks are accomplished 
through the levee shortcut menu (Figure G.15).  To access the levee shortcut menu, from a 
schematic, and with the Levee Tool (on the map toolbar, press the Levee Tool      ) selected, 
right-click on a levee. 
 

 
Figure G.15  Levee Shortcut Menu 
 
Edit a Levee 
 
The user can now edit the properties of an existing levee.  Properties that can be changed are: the 
description of the levee; whether the levee is an existing project; whether the levee is a Corps 
project; the year the levee came on-line; what stream the levee is located on; the start and end 
stations of the levee; adjust the distance (offset) from the stream the levee is placed; and, what 
stream bank the levee is located on. 
 
To edit levee properties: 
 
 1. Right-click on a levee, and click Edit Levee from the levee shortcut menu (Figure G.15). 
 
 2. The Levee Properties Editor will open (Figure G.16). 
 
 3. From the Description box (Figure G.16) the user can edit or add a description. 
 
 4. If the selected levee is an existing project, click Existing Project. 
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Figure G.16  Levee Properties Editor 

 
 5. If the levee is a Corps project, select Corps Project (Figure G.16). 
 
 6. The table (Figure G.16) displays what stream the levee is on and the stream stationing for 

the starting and ending stations of the levee.  If the user wants to change the starting and 
ending stations of the levee, edit the cells under the Start Station and End Station 
columns in the table. 

 
 7. HEC-WAT automatically determines the stream bank location of the levee.  If the user 

wants to change the stream bank location, from the Bank list (Figure G.16) select the 
appropriate stream bank. 

 
 8. If the user knows what year the levee came on-line, enter a year in the Year in Service 

box.  For HEC-WAT Version 1.0 this is just informational and is not used in any 
computation. 

 
 9. When a levee is created, a default-offset distance from the stream alignment is set.  The 

default offset is shown in the Average Offset box (Figure G.16) and is 50.  To change 
the offset, in the Average Offset box change the value, click Apply.  The levee on the 
schematic will move according to the new offset value. 

 
 10. Click OK, the Levee Properties Editor (Figure G.16) will close. 
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 Rename a Levee 
 
To rename a levee: 
 
 1. Right-click on the levee that needs to be renamed, and click Rename Levee from the 

levee shortcut menu (Figure G.15). 
 
 2. The Rename Levee dialog box will open (Figure G.17).  Enter the new Name (required) 

and Description (optional, but recommended) for the levee. 
 

 
Figure G.17  Rename Levee Dialog Box 

 
 3. Click OK, a Confirm Rename warning message will open asking the user if you really 

want to rename the selected levee.  Click Yes, the warning message and the Rename 
dialog boxes will close, and the levee will display the new name. 

 
Remove a Levee from a Schematic 
 
HEC-WAT allows the user to remove levees from existing schematics.  The levee will be 
removed from the schematic, but not from the study.  To remove a levee from a schematic, right-
click on the levee that is to be removed from the active schematic, and click Remove 
LeveeName from SchematicName from the levee shortcut menu (Figure G.15).  The levee no 
longer appears on the schematic. 
 
Delete a Levee 
 
To delete a levee: 
 
 1. Right-click on the levee that is to be deleted, and click Delete LeveeName from Study 

from the levee shortcut menu (Figure G.15). 
 
 2. A Confirm Delete warning message will open asking the user for confirmation to delete 

the selected levee.  Click Yes, the warning message will close, the levee will no longer 
appear in the schematic and has been removed from the study. 

 
Add Schematic Notes for a Levee 
 
Schematic notes allow the user to add information about a levee specific to a schematic.  
Schematic notes are helpful when multiple schematics have been defined. 
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To add schematic notes for a levee: 
 
 1. Right-click on the levee that the user wants to add schematic notes to, and click 

Configuration Notes from the levee shortcut menu (Figure G.15). 
 
 2. The Notes: dialog box will open (Figure G.18).  Enter information in the Configuration 

Notes box that describes the selected levee for the current schematic. 
 

 
Figure G.18  Notes: Dialog Box - Levee 

 
G.2.4 Save Measure Data 
 
To save data for measures, on the File menu, click Save Study.  This will save all of the data for 
measures to the appropriate files created and used by HEC-WAT for measures. 
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Appendix H 
 

Common Computation Points (CCPs) 
 
Common computation points (CCPs) are locations where one model transfers data to another 
model, where results are needed for model development or alternative analysis, and, where input 
boundary conditions are to be defined.  The CCPs need to be consistent for all models and should 
be placed on the stream alignment based on knowledge of possible study alternatives.  The entire 
study team should be involved in the definition of the CCPs.   
 
H.1 Import Common Computation Points 
 
To import CCPs, an active map layer (Chapter 5) that is a shapefile that represents the CCPs for 
the study area must be present.  This shapefile must have an attribute that is the name of each 
CCP, and each CCP must be a point. 
 
To import CCPs from a shapefile: 
 
 1. From the HEC-WAT main window (Figure H.1), from the Maps menu, point to Import, 

click Computation Points.  The Import Computation Points dialog box will open 
(Figure H.2).  The Shapefile Name box figures looks for available point shapefiles in the 
maps directory of the HEC-WAT study; from the box the shapefile that represents the 
CCPS for the study is displayed (e.g., RR_CommonComputationPoints.shp). 

 

 
Figure H.1  HEC-WAT Main Window 
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Figure H.2  Import Computation Points Dialog Box 

 
 2. If the shapefile is not in the maps directory of the HEC-WAT study, from the Import 

Computation Points dialog box (Figure H.2), from the File menu, click Choose 
Shapefile.  The Choose Shapefile Browser (Figure H.3) will open and the user can 
browse to the location of the shapefile. Double-click on the filename and the name will 
appear in the File name box.  Click Open, the Choose Shapefile Browser will close and 
the name of the shapefile will display on the Import Computation Points dialog box in 
the Shapefile Name list (Figure H.3). 

 

 
Figure H.3  Choose Shapefile Browser 
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 3. From the Database Field Name list (Figure H.2), the user needs to select the field name 
in the attribute file that contains the names of the CCPs - ID_Name.  Once a field name is 
selected, the table below will populate with the CCPs contained in the shapefile.  If there 
is an issue with any of the CCPs the checkbox in the Import column will not be selected. 

 
 4. Click Import, the Import Computation Points dialog box will close (Figure H.2).  

Once the import of the CCPs is completed, a message window will appear letting the user 
know that the CCPs have been imported successfully.  In the active Map Window the 
CCPs appear as black circles. 

 
H.2 Create a Common Computation Point 
 
To add a common computation point: 
 
 1. From the HEC-WAT main window (Figure H.1), from the Schematic Tab, on the 

Schematics folder, right-click on the schematic that requires a CCP be added.  From the 
shortcut menu, click Display in Map Window; a schematic map window will open. 

 
 2. On the map toolbar, press the Computation Point Tool     . 
 
 3. Hold down the CTRL key and click on the stream alignment to place the CCP. 
 
 4. The Name New Computation Point dialog box will open (Figure H.4).  Enter the new 

Name (required) and Description (optional, but recommended).  Click OK, the Name 
New Computation Point dialog box will close. 

 
 5. The CCP will now appear in the map window as a black circle.  
 

 
Figure H.4  Name New Computation Point Dialog Box 

 
To add a CCP at a stream junction (Appendix F): 
 
 1. From the Schematic Tab, right-click on the schematic that requires a CCP to be added.  

From the shortcut menu, click Display in Map Window; a schematic map window will 
open. 
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 2. On the map toolbar, press the Computation Point Tool     . 
 
 3. Hold down the CTRL key, click on the stream junction to place a CCP 
 
 4. A slightly different Name New Computation Point dialog box will open (H.5).  Enter 

the new Name (required) and Description (optional, but recommended). 
 

 
Figure H.5  Name new Computation Point Dialog Box at a Stream Junction 

 
 5. From the Select the Placement of the Computation Point list (Figure H.5), determine 

exactly where the CCP will be placed.  The user must decide to have the CCP placed on 
the stream junction; along one of the streams that form the stream junction; or, none of 
the above.  For example, in Figure H.5, the CCP will be placed on the stream junction. 

 
 6. Click OK, the Name New Computation Point dialog box (Figure H.5) will close.  The 

CCP will now appear in the display area as a black circle. 
 
H.3 Existing Common Computation Points 
 
After drawing a CCP in the map window, the user can rename, delete, and edit individual CCP 
properties.  All of these tasks are accomplished through the CCP shortcut menu (Figure H.6).  To 
access the CCP shortcut menu, from a schematic map window, and with the Computation Point 
Tool (on the map toolbar, press the Computation Point Tool     ) selected, right-click on a CCP. 
 

 
Figure H.6  Common Computation Point Shortcut Menu 
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H.3.1 Edit a Common Computation Point 
 
The general properties of a CCP that the user can edit include: the description; the stream; the 
position of the label on the map window; the stream stationing; the easting and northing; whether 
the CCP was system generated; what projects generated that CCP; and the location of the CCP 
on the stream alignment. 
 
To edit CCP properties: 
 
 1. Right-click on the CCP whose properties need to be changed, click Edit Computation 

Point from the CCP shortcut menu (Figure H.6). 
 
 2. The Computation Point Properties Editor will open (Figure H.7). From the 

Description box the user can edit or add a description (recommended). 
 

 
Figure H.7  Computation Point Properties Editor 

 
 3 By default HEC-WAT automatically decides on the stream for the location of the CCP.  

The Stream Name box (Figure H.7) provides the user with this information and is not 
editable. 

 
 4. HEC-WAT automatically generates the stream station for the CCP.  If the user wants to 

change the stream station, then enter a new value in the Stream Station box (Figure H.7) 
enter a new value. 

 
 5. The Label Position list allows the user to place the CCP label on the map window. 
 
 6. The location of the CCP is displayed by the northing and easting coordinates.  These 

values are not editable. 
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 7. By default, a CCP is placed on a stream in the stream alignment.  If the user wishes to 

have a CCP that is not on a stream, clear the Snap to Steam Element check box (Figure 
H.7). 

 
 8. Once the Snap to Stream Element has been cleared, the user can edit the easting and 

northing coordinates of the CCP, and then the CCP can be moved off the stream 
alignment. 

 
H.3.2 Rename a Common Computation Point 
 
To rename a CCP: 
 
 1. Right-click on a CCP, click Rename Computation Point from the CCP shortcut menu 

(Figure H.6). 
 
 2. The Rename Computation Point dialog box opens (Figure H.8).  The new Name 

(required) and Description (optional, but recommended) are entered for the CCP. 
 

 
Figure H.8  Rename Computation Point Dialog Box 

 
 3. Click OK, a Confirm Rename warning message will open asking the user if you really 

want to rename the selected CCP.  Click Yes, the warning message and the Rename 
Computation Point dialog box will close, and the CCP will display the new name. 

 
H.3.3 Delete a Common Computation Point 
 
CCPs created with a project (i.e., reservoirs) or an impact area cannot be deleted.  These CCPs 
are deleted when the project or impact area is deleted. 
 
To delete a CCP: 
 
 1. Right-click a CCP, click Delete ComputationPointName from Study from the CCP 

shortcut menu (Figure H.6). 
 
 2. A Confirm Delete warning message will open for user confirmation to delete the 

selected CCP.  Click Yes, the warning message will close and the CCP will no longer 
appear in the map window. 
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H.3.4 Graphically Edit a Common Computation Point 
 
After creating a CCP, the user can graphically edit a CCP.  By using the Computation Point 
Tool     , the user can move CCP.  This edit is performed graphically on the schematic in the 
active map window. 
 
Move a Common Computation Point 
 
To move a CCP: 
 
 1. From the map toolbar, press the Computation Point Tool     .  Double click on a CCP 

(Figure H.9). 
 

 
Figure H.9  Move a Common Computation Point 

 
 2. The CCP now has four little black dots (handles) at each corner.  Click and drag the CCP 

to where the CCP should be positioned, and release.  The CCP will now appear on the 
map window in the new position. 

 
 3 The user will only be able to move the CCP along a stream.  By default, a CCP must be 

on a stream.  If the user does not want a CCP on the stream alignment, the user must 
change a setting in the editor (Section 1.2.2). 

 
H.4 Save Common Computation Point Data 
 
To save data for CCPs, on the File menu, click Save Study.  This will save all of the data for 
CCPs to the appropriate files created and used by HEC-WAT for CCPs. 
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Appendix I 
 

Impact Areas 
 
An impact area is any distinct portion of a study that is affected by rising or falling stage in a 
stream, river, lake, or reservoir.  The boundaries of an impact area are defined by a closed 
polygon, and can be characterized by the effects of rising or falling stage that can be described 
by the property, project, and/or population at risk in the area bounded by the polygon.  Impact 
areas are an optional element, and are only required when a user wants to compute impacts at 
damage area centers in the study area, and an HEC-FIA model is part of the HEC-WAT 
modeling effort. 
 
The user can use underlying map layers to aid in importing impact areas (Section I.1) into the 
schematic or placing impact areas at the proper location on the schematic (Section I.2).  Besides 
location, a map layer can also give the user a concept of the dimensions of an impact area.  
However, HEC-WAT Version 1.0 does not have any geo-referencing attached to the impact area 
polygon. 
 
I.1 Import Impact Areas 
 
To import impact areas, an active map layer (Chapter 5) that is a shapefile (Chapter 5) that 
represents the impact areas should be available.  This shapefile must have an attribute that is the 
name of each impact area, and each impact area must form a contiguous polygon. 
 
To import impact areas from a shapefile: 
 
 1. From the HEC-WAT main window (Figure I.1), from the Maps menu, point to Import, 

click Impact Areas.  The Import Impact Areas dialog box will open (Figure I.2).  The 
Shapefile Name box figures out whether there are any polygon shapefiles available in 
the maps directory; from the box the shapefile that represents the impact areas for the 
study display (e.g., RR_ImpactAreas.shp). 

 
 2. If the shapefile is not in the maps directory of the HEC-WAT study, from the Import 

Impact Areas dialog box (Figure I.2), from the File menu, click Choose Shapefile.  The 
Choose Shapefile Browser (Figure I.3) will open and the user can browse to the location 
of the shapefile. Double-click on the filename and the name will appear in the File name 
box.  Click Open, the Choose Shapefile Browser will close and the name of the 
shapefile will display on the Import Impact Areas dialog box in the Shapefile Name 
list (Figure I.2). 

 
 3. From the Database Field Name list (Figure I.2), the user needs to select the field name 

in the attribute file of the impact areas - ID_Name.  Once a field name is selected, the 
table below will populate with the impact areas contained in the shapefile.  If there is an 
issue with any of the impact areas the checkbox in the Import column will not be 
selected. 
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Figure I.1  HEC-WAT Main Window 

 
 

 
Figure I.2  Import Impact Areas Dialog Box 
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Figure I.3  Choose Shapefile Browser 

 
 4. With the correct database field name selected, the table will list the impact area names.  If 

each impact area is a contiguous polygon, then the check box in the Import column of 
the table (Figure I.2) will be set.  If there is something wrong with the polygon that 
represents an impact area, the check box will not be set, and HEC-WAT will not import 
that impact area. 

 
 5. Replace Existing Impact Areas (Figure I.2) allows the user to replace the existing 

impact areas with the impact areas the will be imported from the selected ArcView® 
shapefile. 

 
 6. Click Import, the Import Impact Areas dialog box will close (Figure I.2).  Once the 

import of the impact areas is completed, a message window will appear letting the user 
know that the impact areas have been imported successfully.  In the active Map Window 
the impact areas appear as green polygons. 

 
I.2 Create an Impact Area 
 
To creating an impact area on the schematic: 
 
 1. From the HEC-WAT main window (Figure I.1), from the Schematic Tab, from the 

Schematics folder, right-click on the schematic on the location where an impact area 
needs to be added.  From the shortcut menu, click Display in Map Window; a schematic 
map window will. 

 
 2. On the map toolbar, press the Impact Area Tool      . 
 
 3. Hold down the CTRL key while clicking the mouse button.  Each click creates a vertex 

point (Figure I.4), which is the boundary of the polygon.  When reaching the end point, 
release the CTRL key and click. 
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Figure I.4  Add an Impact Area to the Schematic 

 
 4. The Name New Impact Area dialog box will open (Figure I.5).  The user must enter a 

name, and if needed, enter a description.  Click OK, the Name New Impact Area dialog 
box will close. 

 

 
Figure I.5  Name New Impact Area Dialog Box 

 
 5. The impact area will now appear in the display area as a green polygon with a name.  

Repeat Steps 3 and 4 for each impact area in your watershed. 
 
I.3 Existing Impact Areas 
 
After drawing an impact area on the schematic, the user can edit properties, rename, delete, and 
create schematic notes for individual impact areas.  All of these tasks are accomplished through 
the impact area shortcut menu (Figure I.6).  To access the impact area shortcut menu, from a 
schematic, and with the Impact Area Tool (on the map toolbar, press the Impact Area Tool 
     ) selected, right-click on an impact area. 
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Figure I.6  Impact Area Shortcut Menu 
 
I.3.1 Edit an Impact Area 
 
In a schematic, the user can describe the general and aesthetic properties of an impact area.  The 
impact area properties that the user can edit in a schematic include:  the description;  
 
the stream; the bank of the stream the impact area is on; the color of the impact area polygon; the 
position of the impact area label on the display area; the geographical location of the index 
station; and, the geographical location of the beginning and ending stations of the impact area 
polygon. 
 
To edit impact area properties: 
 
 1. Right-click an impact area and click Edit Impact Area from the available shortcut menu 

(Figure I.6).  The Impact Area Properties Editor will open (Figure I.7).  From the 
Description box (Figure I.7) the user can edit or add a description. 

 

 
Figure I.7  Impact Area Properties Editor 
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 2. If the Auto check box is selected for an item, the value for this data item is automatically 

updated as the polygon or index location is moved in the display area.  By default, when 
a polygon is drawn in the display area, these values are filled in automatically.  If the 
check box is cleared, data can be entered manually into these fields, and the value will 
not be automatically updated if changes are made to the polygon.  However, reselecting 
the check box allows the values to be automatically determined when edits are made in 
the display area. 

 
 3. If the default stream name selected by HEC- WAT is incorrect, clear the Auto check box, 

and from the Stream Name list select the appropriate stream name. 
 
 4. If the default bank selected by HEC-WAT is incorrect, clear the Auto check box (Figure 

I.7), and select the appropriate stream bank from the Bank box. 
 
 5. By default, the color of an impact area polygon is green.  The user can change the color 

by selecting a different color from the Color list. 
 
 6. The Label Position list (Figure I.7) allows the user to place the impact area label on the 

display area. 
 
 7. For each impact area, HEC-WAT generates an index station; this index station is a 

location.  If the user wants to place the index station manually, clear the Auto check box 
next to the Index box (Figure I.7), and then enter the new stream stationing in the Index 
box. 

 
 8. HEC-WAT automatically computes a beginning and ending station for each impact area.  

If the user wants to change the stream stationing the program has generated, clear the 
Auto check box next to the Upstream and Downstream boxes, and enter the new stream 
stationing in the Upstream box and the Downstream box.  Click OK, the Impact Area 
Properties Editor (Figure I.7) will close. 

 
Rename an Impact Area 
 
To rename an impact area: 
 
 1. Right-click an impact area and click Rename Impact Area from the impact area shortcut 

menu (Figure I.6). 
 
 2. The Rename Impact Area dialog box will open (Figure I.8).  Enter the new Name 

(required) and Description (optional, but recommended impact areas). 
 
 3. Click OK, a Confirm Rename warning message will open asking the user if you really 

want to rename the selected impact area.  Click Yes, the warning message and the 
Rename Impact Area dialog boxes will close, and the impact area will display the new 
name. 
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Figure I.8  Rename Impact Area Dialog Box 

 
Delete an Impact Area 
 
To delete an impact area: 
 
 1. Right-click an impact area and click Delete ImpactAreaName from Study from the 

impact area shortcut menu (Figure I.6). 
 
 2. A Confirm Delete warning message will open asking the user if you really want to delete 

the selected impact area.  Click Yes, the warning message will close, and the impact area 
will no longer appear in the display area. 

 
Add Schematic Notes for an Impact Area 
 
Schematic notes allow specific information about an impact area to be added to a schematic.  
This information is useful for describing impact areas that belong to schematics that include non-
structural measures.  If there are non-structural attributes for an impact area, the user can have a 
symbol appear in the schematic for the selected impact area.  Schematic notes are only added 
when other schematics have been defined. 
 
To add schematic notes for an impact area: 
 
 1. Right-click an impact area and click Configuration Notes from the impact area shortcut 

menu (Figure I.6). 
 
 2. The Configuration Notes Editor will open (Figure I.9).  The Configuration box 

displays the current schematic.  Enter information about this impact area for the current 
schematic in the Configuration Notes box. 

 
 3. If the notes are in regards to non-structural attributes, select Display Non-Structural 

Symbol.  This will cause a symbol to appear in the selected impact area on the schematic. 
 
I.3.2 Graphically Edit an Impact Area 
 
The user can create and graphically edit the impact area.  By using the Impact Area Tool, the 
CTRL key, and the SHIFT key, the user can edit an impact area by adding, moving, and 
deleting vertex points.  This edit is performed graphically on the schematic in the active map 
window. 
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Figure I.9  Configuration Notes Editor 
 
Add Vertices to an Impact Area 
 
To add vertex points to an existing impact area: 
 
 1. Double-click an impact area, the impact area will turn yellow. 
 
 2. Place the pointer on the selected impact area where the user wants to add a vertex point.  

Hold down the CTRL key and click.  A red point will now appear on the selected impact 
area, which represents a new vertex point. 

 
Move the Vertices of an Impact Area 
 
To move vertex points on an existing impact area: 
 
 1. Double-click an impact area, the impact area will turn yellow, and the individual vertex 

points will turn red. 
 
 2. Click on the vertex point that needs to be moved, and drag the vertex point to a new 

location. 
 
Delete Vertices from an Impact Area 
 
To delete vertex points from an existing impact area: 
 
 1. Double-click an impact area, the impact area will turn yellow, and the individual vertex 

points will turn red. 
 
 2. Hold down the SHIFT+CTRL keys and click on the vertex point that needs to be 

deleted.  The vertex point will disappear from the impact area. 
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I.3.3 Export Impact Areas 
 
If the impact areas have been digitized, the user can save the impact areas as an ArcView® 
shapefile.  To export impact areas the user must have impact areas in the schematic. 
 
To export impact areas: 
 
 1. From the HEC-WAT main window (Figure I.1), from the Maps menu, point to Export, 

and then click Impact Areas. 
 
 2. A Save browser will open (Figure I.10).  Enter a name in the File name box.  Click OK, 

the Save browser will close, and the user will have an ArcView® shapefile of the 
displayed impact areas. 

 

 
Figure I.10  Save Browser 

 
I.3.4 Save Impact Area Data 
 
To save data for impact areas, from the File menu, click Save Study.  This will save all of the 
data for impact areas to the appropriate files created and used by HEC-WAT for impact areas. 
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Appendix J 
 
 

Using HEC-DSSVue 
 
 
HEC-DSSVue (Hydrologic Engineering Center (HEC), Data Storage System Visual Utility 
Engine) is a graphical user interface program for viewing, editing, and manipulating data in 
HEC-DSS database files.  With DSSVue, data may be plotted, tabulated, edited, and manipulated 
with over fifty mathematical functions.  Along with these functions, DSSVue provides several 
utility functions, such as entering data sets into a database, renaming data set names, copying 
data sets to other DSS (HEC's Data Storage System) database files, and deleting data sets. 
 
For HEC-WAT, the user will use HEC-DSSVue mainly as a viewing tool for DSS data.  This 
appendix will review some of the general functions in HEC-DSSVue.  For further detail, see the 
HEC-DSSVue User's Manual. 
 
J.1 HEC Data Storage System Concepts 
 
HEC-DSS is a database system that was designed to efficiently store and retrieve scientific data 
that is typically sequential.  Such data types include, but are not limited to, time series data, 
curve data, spatial-oriented gridded data, textual data (such as this manual), and others.  The 
system was designed to make it easy for users and application programs to retrieve and store 
data. 
 
The data are arranged into blocks.  For example, one year of daily-interval data is stored in a 
single record in a DSS file.  Each record is given a unique name called a pathname.  The 
pathname is formulated in a way that makes it easy to group related data together.  HEC software 
has the ability to read from and write to DSS files.  This capability facilitates data exchange 
among applications.  For example, a user could use HEC-ResSim to generate the time series 
input for HEC-FIA. 
 
J.2 Overview of HEC-DSSVue in the WAT 
 
To access HEC-DSSVue, from the HEC-WAT main window, from the Tools toolbar (Chapter 3, 
Section 3.4), click      .  Alternatively, from the HEC-WAT main window, from the Tools menu, 
click HEC-DSSVue.  Either way, the HEC-DSSVue main window opens.  The main window 
and its different components are illustrated in Figure J.1. 
 
The Menu Bar contains the menus for the main window of HEC-DSSVue.  The following list is 
a description of the available menus. 
 
 File This menu is used for DSS file management and contains the following 

command:  New Ver 6, New Ver 7, Open, Close DSS File, Print Catalog 
Preview, Print Catalog, and Close. 
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Figure J.1  HEC-DSSVue Main Window 
 
 Edit This menu provides editing functions and contains the following commands:  

Tabular Edit, Graphical Edit, Select All, Rename Records, Delete 
Records, Undelete, Duplicate, Copy To, and Merge Copy. 

 
 View This menu provides options for viewing DSS pathnames.  Available commands 

are: Pathname List, Pathname Parts, Condensed Catalog, Condensed – 
Group Collections, No Pathnames, Unsorted List, Search pathnames by 
string, Search pathnames by parts, Catalog using wild characters, Refresh 
Catalog, Unit System, and Time Zone. 

 
 Display After a user has selected a pathname, this menu allows the user the ability to 

display the data for that pathname.  Available commands are:  Plot, Plot 
Individual Data Sets, Tabulate, Display Data Options, Supplemental 
Information, and Time Window. 

 
 Groups This menu provides the capability to save selected pathnames as groups, open a 

group, plot and/or tabulate a group, and perform math functions on a group.  
Available commands are:  Save Selected, Get, Get (add to list), Plot, Plot 
Individual Sets, Tabulate, Math, and Manage. 

 
 Data Entry This menu provides the user with the ability to either manually enter data or 

import data from other sources into the selected DSS file.  Also, allows the 
user to export DSS data into other formats.  Available commands are:  Manual 
Time Series, Manual Paired Data, Manual Text, Import, and Export. 
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 Tools This menu provides a user with tools that will manipulate the data stored in 

DSS pathnames.  Available commands are:  Math Functions, Compare, 
Search for Value, Check File Integrity, Squeeze, Convert to DSS 7, Script 
Editor, and Script Selector. 

 
 Advanced This menu provides options for saving the DSS catalog to a file, output, debug 

issues, and setting program options.  Available commands are:  Catalog to 
File, Output, Debug, and Program Options. 

 
 Help Displays current version information about DSSVue. 
 
The Toolbar (Figure J.1) contains buttons that provide a user with the capability to open a DSS 
file, plot the data, and tabulate the data.  These buttons provide a shortcut to the respective 
commands in the Display menu. 
 
 Open File Button – opens an Open File Browser, which allows a user to select a DSS 

file. 
 
 Plot Button – plots the data of the selected pathname(s). 
 
 Tabulate Button – displays the data of the selected pathname(s) in a tabular form. 
 
 Graphical Editor Button – opens the Graphical Editor (see HEC-DSSVue User's 

Manual, Chapter 4, Section 4.5). 
 
 Math Functions Button – opens the Math Functions dialog box (see HEC-DSSVue 

User's Manual, Chapter 6) which allows you to perform mathematical functions on the 
selected pathname(s). 

 
The DSS File Information (Figure G.1) box displays the filename of the DSS file, and statistics 
about the pathnames in the DSS file and the size of the DSS file. 
 
The Filter Lists (Figure J.1) are used to sort DSS pathnames by parts.  There is a filter list for 
each individual part, A through F.  The Pathname Table displays the filtered pathnames 
contained in the DSS file.  The pathnames are displayed by the individual parts.  The Selected 
Pathname List displays the pathnames that you have selected from the Pathname Table. 
 
The Select Commands (Figure J.1) are available after you have selected the pathnames you 
wish to view or manipulate.  Available commands are Select, De-Select, Clear Selections, 
Restore Selections, and Set Time Window.  These commands will be detailed later in this 
appendix. 
 
When a user has entered time window information, the Status Bar (Figure J.1) will display the 
time window information.  A time window is where a user provides a specific timeframe for 
viewing or manipulating DSS data. 
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J.3 Open a DSS File 
 
There are several ways to open a DSS file from HEC-DSSVue.  One way is to enter the path and 
filename of a DSS file in the File Name box of the HEC-DSSVue main window (Figure J.1).  
After the correct information has been entered, press ENTER, the Pathname Table will display 
the pathnames from the selected DSS file, and the DSS File Information (Figure J.1) box will 
display statistics about the DSS file. 
 
Another way to open a DSS file is from the File menu, click Open; or, click        from the 
Toolbar.  Either method opens an Open HEC-DSS File browser (Figure J.2).  The browser 
defaults to My Documents if a simulation map window is not displayed.  However, if a 
simulation map window is open, the browser will default to the HEC-WAT runs directory. A 
folder will be created that is based on an HEC-WAT alternative (associated with the simulation), 
and an analysis period.  Click on the DSS file, the name should appear in the File name box 
(Figure J.2), click Open.  The Open HEC-DSS File browser (Figure J.2) will close, and the 
HEC-DSSVue main window will display the name of the DSS file and all of the pathnames 
associated with that DSS file will appear in the Pathname Table (Figure J.1). 
 

 
Figure J.2  Open HEC-DSS File Browser 
 
J.4 Set Time Window 
 
To view the data for a certain block of time, you can set a time window: 
 
 1. From the Display menu, click Time Window, the Set Time Window dialog box (Figure 

J.3) will open. 
 
 2. To enter a start date and time, click Specific Time Window.  In the Start Date box type 

a date in the format ddmmmyyyy (e.g., 12Feb1986), and in the Start Time box type a 
time in the format hhmm (e.g., 1600). 
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Figure J.3  Set Time Window Dialog Box 

 
 3. To enter an ending date and time, in the End Date box type a date in the format 

ddmmmyyyy (e.g., 23Feb1986), and in the End Time box type a time in the format 
hhmm (e.g., 1600).  To clear the time window boxes, click Clear (Figure J.3). 

 
 4. If the user wants to use the current date and time, click Set Current Time (Figure J.3).  

All time window boxes will be filled, the user will probably need to edit the ending date 
and time. 

 
 5. Click OK, the Set Time Window dialog box (Figure J.3) will close, the time window 

will be set, and the time window will be displayed in the Status Bar of the HEC-
DSSVue main window (Figure J.1). 

 
J.5 DSS Pathnames 
 
Data is stored in blocks, or records, within a file, and each record is identified by a unique name 
called a pathname.  Each time that data is stored or retrieved from the file, its pathname must be 
given.  The pathname is the key to the data’s location in the database. A pathname is analyzed by 
DSS to determine an index number. This index determines where the dataset is stored within the 
database. The design ensures that very few disk accesses are made to retrieve or store datasets. 
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One dataset is not directly related to another, so there is no need to update other areas of the 
database when a new dataset is stored. 
 
DSS references records (data sets) by a pathname.  The pathname of a DSS record can be three 
hundred and ninety-one (391) characters or less, and is, by convention, separated into six parts.  
The parts can be sixty-four (64) characters or less and are delimited by slashes in the pathname.  
The pathname parts are designated A through F.  Table J.1 provides an example naming 
convention for regular-interval time series: 
 
Table J.1  DSS Pathname Parts 

A project, river, or basin name 
B location identifier 
C data parameter (e.g., FLOW, PRECIP) 
D starting block data; format ddmmyyyy 
E time interval 
F additional user-defined descriptive information 

 
J.5.1 View DSS Pathnames 
 
The display of pathnames in the Pathname Table shows all of the pathnames by the different 
parts (Figure J.1).  The user can change this display from the View menu; available commands 
are Pathname List, Pathname Parts, Condensed Catalog, and No Pathnames. 
 
The Pathname List command (Figure J.4) displays the pathnames in the Pathname Table, 
while No Pathnames displays nothing.  The Pathname Parts command is the same as the 
Condensed Catalog command, except for the D part.  On the Condensed Catalog, the D part 
displays the date span for each pathname. 
 

 
Figure J.4  Pathname List Display 
 
J.5.2 Sort DSS Pathnames by Parts 
 
Another way to affect the display of the pathnames is through sorting by pathname parts.  
Sorting the DSS pathnames by parts is the command Search pathnames by parts (default).  
However, another way to sort the pathnames is available from the View menu, choose Search 
pathnames by string.  The details for this method are described in the HEC-DSSVue User's 
Manual. 
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To sort by pathname parts, from the Filter Lists (Figure J.5) decide which pathname parts will 
be used to sort the pathname list.  There is a Filter List for each individual pathname part.  An 
example is shown in Figure J.5 where filters are used to see all of the FLOW records that are 
observed data.  In Figure J.5, FLOW has been selected for Filter C and RESSIM-CALIBRATE has 
been selected for Filter F.  The Pathname Table will now display only the pathnames that fit the 
criteria are stated in the Filter Lists. 
 

 
Figure J.5  Sorting Pathnames 
 
J.5.3 Select Pathnames 
 
Once an appropriate list of pathnames is displayed in the Pathname Table, the user can select 
which pathnames to view or manipulate.  To select a pathname, double-click on a pathname in 
the Pathname Table and the selected pathname will appear in the Selected Pathname List 
(Figure J.1).  The user can also click on a pathname in the Pathname Table, and then click 
Select from the Select Commands (Figure J.1). 
 
To select multiple pathnames, in the Pathname Table, click on a pathname the pathname will be 
highlighted.  Find the next pathname that needs to be included in a group, hold down the SHIFT 
key and click.  The block of pathnames will be highlighted, click Select, and all the pathnames 
within that block will be added to the Selected Pathname List. 
 
Another way to select multiple pathnames is from the Pathname Table, click and drag across 
the pathnames wanted, release the mouse button and the block of pathnames will be highlighted.  
Click Select, and all of the pathnames within that block will be added to the Selected Pathname 
List. 
 
The user can select individual pathnames to be in a group for selection.  From the Pathname 
Table, select a pathname which will be highlighted; to select another not in a contiguous group, 
hold down the CTRL key and select the next pathname which will be highlighted.  Continue to 
do this until all desired pathnames have been selected, release the CTRL key and click Select.  
All the pathnames you have selected will be added to the Selected Pathname List. 
 
The user can select all of the pathnames displayed in the Pathname Table.  From the Edit 
menu, choose Select All.  All of the pathnames will now appear in the Selected Pathname List. 
 



Appendix J – Using HEC-DSSVue HEC-WAT User's Manual 

J-8 
 

J.5.4 Clear Selected Pathnames 
 
To clear a pathname from the Selected Pathname List (Figure J.1), select a pathname and click 
De-Select from the Select Commands (Figure J.1).  The pathname will be cleared from the 
Selected Pathname List.  To clear all pathnames from the Selected Pathname List, click Clear 
Selections, and the Selected Pathname Box will be empty. 
 
The user can also clear groups of pathnames by using the same concepts described in selecting 
pathnames (Section J.5.3) by using the SHIFT and CTRL keys.  Once pathnames have been 
cleared from the Selected Pathname Box, the pathnames can be restored to the Selected 
Pathname Box by clicking Restore Selections from the Select Commands (Figure J.1). 
 
J.6 Visualize Data 
 
After selecting a pathname or multiple pathnames, the user can visualize the data associated with 
the pathname.  This can be done graphically with plots, or in a tabular format (table).  The 
examples described in this section are all for time-series data.  Similar features exist for other 
types of datasets, such as paired data.  Further details on plots and tables are discussed in the 
HEC-DSSVue User's Manual. 
 
J.6.1 Plots 
 
To view a plot of the pathnames in the Selected Pathname List (Figure J.1), a user can either 
click       the Toolbar, or from the Display menu, choose Plot.  Either way will open the Plot 
Window (Figure J.6). 
 

 
Figure J.6  Plot Window 
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The datasets for the plots are labeled and color-coded, date ranges are specified along one axis (if 
plotting time-series data), and the units of measure are specified along the other axis.  A user can 
resize the Plot Window by grabbing the corner of the window and dragging it to the desired size. 
 
The user can also zoom in on areas of the plot.  Click the Zoom Tool,       find the area on the 
plot, zoom-in, click and drag over the area.  The plot will refresh, the area within the zoom 
rectangle will fill the plot window.  To zoom out, with the Zoom Tool selected, right-click 
anywhere on the plot area. 
 
J.6.2 Tables 
 
To view a table of the pathnames in the Selected Pathname List (Figure J.1), a user can either 
click       from the Toolbar, or from the View menu, click Tabulate.  Either way the Tabulate 
Window will open (Figure J.7). 
 

 
Figure J.7  Tabulate Window 
 
The Tabulate Window displays the ordinate (starting from the start date/time), the date and time 
stamp, and the values for the selected data sets.  From the Tabulate Window, the user has 
several options for displaying tabular data (e.g., displaying commas in the number formatting, 
setting the precision of decimal places for data). 
 
J.7 DSS Records 
 
HEC-DSS uses a block of sequential data as the basic unit of storage.  Each block contains a 
series of values of a single variable over a time span appropriate for most applications.  The basic 
concept underlying DSS is the organization of data into records of continuous, applications-
related elements, as opposed to individually addressable data items.  This approach is more 
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efficient for scientific applications than that of a conventional database system because it avoids 
the processing and storage overhead required for assembling an equivalent record from a 
conventional system.  Data is stored in blocks, or records, within a file, and each record is 
identified by a pathname. 
 
J.7.1 Rename Records 
 
To change the pathname parts of a pathname: 
 
 1. The user must have selected one or more pathnames (Section J.5.3) for this command to 

be available. 
 
 2. From the Edit menu, click Rename Records.  The Rename Records to: dialog box 

(Figure J.8) will open. 
 

 
Figure J.8  Rename Records to: Dialog Box 

 
 3. Each of the boxes (A - F) represents the different pathname parts.  The D and E parts are 

not editable.  The user can change the parts A, B, C, and F by entering new information 
in the appropriate box. 

 
 4. Click OK, the Rename Records to: dialog box will close, a message will appear 

informing the user of the number of records renamed.  The selected pathname will no 
longer be displayed in the Selected Pathname Box (Figure J.1) and the pathname will 
display in the Pathname Table (Figure J.1) with the new pathname parts. 

 
J.7.2 Duplicate Records 
 
Duplicating a record allows a user to make a copy of a record, but with a pathname part that has 
been changed.  To duplicate records: 
 
 1. The user must have selected one or more pathnames (Section J.5.3) for this command to 

be available. 
 
 2. From the Edit menu, click Duplicate.  The New pathname parts for duplicate records: 

dialog box (similar to Figure J.8) will open. 
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 3. Each of the boxes (A - F) represents the different pathname parts.  The D and E parts are 

not editable.  The user can change the parts A, B, C, and F by entering the new 
information in the appropriate box. 

 
 4. Click OK, the New pathname parts for duplicate records: dialog box will close. A 

message will appear informing the user of the number of records that were duplicated.  A 
new pathname will be displayed in the Pathname Table (Figure J.1). 

 
J.7.3 Delete Records 
 
To delete records: 
 
 1. The user must have selected one or more pathnames (Section J.5.3) for this command to 

be available. 
 
 2. From the Edit menu, click Delete Records, a warning message dialog box appears 

asking the user if you really want to delete the listed pathnames.  These should be the 
same pathnames displayed in the Selected Pathname List (Figure J.1) 

. 
 3. Click Yes, the warning message dialog box will close.  A message will appear informing 

the user of the number of records deleted. 
 
 4. The deleted records no longer appear in the Pathname Table (Figure J.1). 
 
J.7.4 Edit Data Associated with Records 
 
The user can edit the data associated with a pathname, if the user has the appropriate 
permissions, on the Edit menu, click Tabular Edit or Graphical Edit.  The user can edit data 
directly, enter new time-series data or paired data, or use math functions to manipulate the data.  
All of these features are detailed in the HEC-DSSVue User's Manual. 
 
 
  



Appendix J – Using HEC-DSSVue HEC-WAT User's Manual 

J-12 
 

 
 

   
  

  
  

 
 

 



HEC-WAT User's Manual Appendix K – Model Integration Tools 

 K-1 

Appendix K 
 

Model Integration Tools 
 
For the HEC-WAT schematics to be truly interactive, all of the graphical elements from all of 
the software applications must display correctly and in the correct alignment.  The projection of 
the HEC-WAT study and the model alternatives must be the same.  The HEC-ResSim software 
is very close to the HEC-WAT framework, as long as the projections are the same, the user will 
not need to make any adjustments to the HEC-ResSim graphical elements.  However, for HEC-
HMS, HEC-RAS, and HEC-FIA, there are HEC-WAT tools that will aid integrating graphical 
elements from these software applications to display nicely in the HEC-WAT schematic. 
 
K.1 Stream Reach Alias 
 
The stream alignment is based on stream segment names, and those names must be exact among 
the model alternatives of an HEC-WAT simulation. When the stream names are not the same, 
instead of changing the HEC-WAT stream alignment or changing the stream naming in a model 
alternative, HEC-WAT has a tool that resolves naming inconsistencies through the use of aliases. 
 
From the HEC-WAT main window (Figure K.1), with a study open, from the Edit menu, click 
Stream Reach Alias Editor.  The Stream Reach Alias Editor will open (Figure K.2).  The tree 
contains all of the stream names in the stream alignment that has been selected.  When a stream 
name with a folder is selected, an alias for the selected stream name can be entered.   
 

 
Figure K.1  HEC-WAT Main Window 
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Figure K.2  Stream Reach Alias Editor 
 
For example, in Figure K.2, Dry Ck is an HEC-WAT stream name, however in HEC-RAS the 
stream name (reach name) is DryCreek.  For HEC-RAS graphical elements to display correctly 
on the HEC-WAT schematic, the user needs to let HEC-WAT know that both names for that 
stream are correct.  From the tree on the Stream Reach Alias Editor (Figure K.2), select Dry 
Ck, click Add Alias, the Enter Alias Name dialog box will open (Figure K.3).  
 

 
Figure K.3  Enter Alias Dialog Box 
 
In the Enter New Alias Name for Stream Reach Dry Ck (Figure K.3) – DryCreek.  Click OK, 
the Enter Alias Name dialog box will close (Figure K.3), and a node under the selected stream 
name will be added.  This needs to be done for all of the streams that do not match. 
 
To remove an alias, from the Stream Reach Alias Editor (Figure K.2), from the tree, select an 
alias, click Remove Alias.  A Confirm Deletion window will open (Figure K.4), asking the user 
are you sure you want to delete the selected alias, click Yes.  The Confirm Deletion window 
will close (Figure K.4), and the alias will no longer display on the tree. 
 

 
Figure K.4  Confirm Deletion Window 
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K.2 Junction Location Mapping 
 
The HEC-HMS graphical elements that HEC-WAT recognizes do not have coordinates 
(geographic location information), and therefore the HEC-HMS graphical elements do not 
display on the HEC-WAT schematic correctly.  For HEC-HMS reach and junction graphical 
elements, HEC-WAT provides tools that the user can use to make the HEC-HMS graphical 
elements display correctly on the HEC-WAT schematic.  The first of these tools is for HEC-
HMS junctions – Junction to Stream Mapper. 
 
To edit the geographic location of HEC-HMS junction graphical elements: 
 
 1. From the HEC-WAT main window (Figure K.1), from the Edit menu, point to HMS, 

click Junction Location Mapper. 
 
 2. The HMS Junction to Stream Mapper dialog box will open (Figure K.5).  This dialog 

box is not from HEC-HMS, but from HEC-WAT.  Since the current version of HEC-
HMS does not recognize the coordinate system that HEC-WAT has for a study, this 
dialog box allows the user to enter information that will give the HEC-HMS junction 
graphical element the correct geographic location on the schematic. 

 

 
Figure K.5  HMS Junction to Stream Mapper Dialog Box 

 
 3. From the Model Alternative list (Figure K.5), select an HMS model alternative (i.e., 

(RUN)Feb_1986).  This should be the HMS model alternative associated with the active 
HEC-WAT simulation displayed in the Map Window (Figure K.1). 

 
 4. From the Study Tree (Figure K.6), expand the Models node. Select HMS, from the 

Content Pane (Figure K.6), double-click on the HMS model alternative (i.e., 
HMS:(RUN)Feb_1986) that has been selected in the HMS Junction to Stream Mapper 
dialog box (Figure K.5).  A map window will open (Figure K.7) that displays the selected 
HMS model alternative. 
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Figure K.6  Study Tree – Models Node - HMS 

 

 
Figure K.7  HMS Model Alternative Map Window 

 
 5. Turning off some of the map layers in the map window (Figure K.7) will help in locating 

the stationing for the HMS junction graphic elements.  From the Maps tab (Figure K.8) 
of the HEC-WAT main window (Figure K.1), turn off all of the map layers that are not 
need for locating the HMS junction graphic elements.  When this is done, the Map 
Window (Figure K.7) displays the HMS model alternative. 
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Figure K.8  Maps Tab – Turning Map Layers Off 

 
 6. In Figure K.5, for example, the first junction (i.e., Ukiah Confluence), is it on the correct 

stream?  After reviewing the map window (Figure K.7), the selected stream (i.e., EF RR) 
is not correct.  To review the first junction on the map window (Figure K.7), zoom in to 
the first junction location (Figure K.9), which is the first red circle located in the 
upstream end of the study area.  Select      (Stream Node Tool), right-click on the red 
circle, from the shortcut menu click Edit Junction, the Stream Junction Editor will 
open (Figure K.9).  The HMS junction happens to be at a confluence of three streams, 
and an HEC-WAT stream junction is at that same location 

 

 
Figure K.9  Stream Junction Editor – Junction Stream Stationing 

 
 7. From the Stream Junction Editor (Figure K.9), the user can determine the stream 

location and the stationing for the first HMS junction.  For example, in Figure K.9, the 
first HMS junction (i.e., Ukiah Confluence) should be located on stream RR and the 
junction's stationing is 353.537.8.   

 
 8. From the HMS Junction to Stream Mapper dialog box (Figure K.5), from the Stream 

column, for the first HMS junction (i.e., Ukiah Confluence), from the list select RR.  
From the Station column (Figure K.5), for the first HMS junction, enter 353,537.8.   
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 9. For the rest of the HMS junctions, the user may have to repeat Steps 6 through 8, if the 
stream or the stationing is not correct for an HMS junction.  What happens there is no 
stream node or junction for a location?  The user will need to add a stream node/junction 
at that location (Appendix F, Section F.3.2).  Once the stream station has been entered 
into the HMS Junction to Stream Mapper dialog box (Figure K.5), the user will need 
to remove the stream node/junction from the schematic.  This has to be done, because any 
changes to the stream stationing will affect an HEC-ResSim model alternative. 

 
 10. When the HMS Junction to Stream Mapper dialog box (Figure K.10) is completed, 

click Apply.  The junction names that display in green, means that the user has entered 
the stationing for that junction. Click OK, the HMS Junction to Stream Mapper dialog 
box (Figure K.10) will close. 

 

 
Figure K.10  HMS Junction to Stream Mapper Dialog Box - Completed 

 
K.3 Reach to Stream Mapping 
 
The HEC-HMS reach and junction graphical elements do not have coordinates (geographic 
location information), and do not display on the HEC-WAT schematic correctly.  For HEC-HMS 
reach and junction graphical elements, HEC-WAT provides tools that correct the reach and 
junction graphical elements display in the HEC-WAT schematic. 
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K.3.1 By Junctions 
 
To correct the display of HMS junctions: 
 
 1. From the HEC-WAT main window (Figure K.1), from the Edit menu, point to HMS, 

click Reach to Stream Mapping. 
 
 2. The HMS Reach to Stream Editor will open (Figure K.11).  This editor is not from 

HEC-HMS, but from HEC-WAT.  Since the current version of HEC-HMS does not 
recognize the coordinate system that HEC-WAT has for a study, this editor allows the 
user to enter information that will give the HEC-HMS reach graphical element the correct 
geographic location on the schematic. 

 

 
Figure K.11  HMS Reach to Stream Editor – By Junctions Tab 

 
 3. An HEC-WAT simulation must be displayed in a map window on the HEC-WAT main 

window (Figure K.1).  The active simulation name is displayed in the Simulation box 
(Figure K.11). For example, in Figure K.11, the HEC-WAT simulation is Without Project 
Conditions-RR_Feb1986. 

 
 4. The HMS model alternative associated with the active HEC-WAT simulation is 

displayed in the Run list (Figure K.11).  For example, in Figure K.11, the HMS model 
alternative is (RUN)Feb_1986. 

 
 5. If the user has defined information about the HMS junctions from the HMS Junction to 

Stream Mapper dialog box (Figure K.10), click the By Junctions tab and proceed to 
Step 6. If the user has not entered HMS junction information, proceed to Section K.3.2. 

 
 6. Click Automatically Match (Figure K.11), a Validate Changes window (Figure K.12) 

will open.  This window is letting the user know that the information that will display in 
the table (Figure K.13) should be reviewed for accuracy.  Click OK, the Validate 
Changes window will close, and the table on HMS Reach to Stream Editor – By 
Junctions tab will display with junction information for each HMS reach (Figure K.13).  
The reach names display in blue, because items have been modified. 
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Figure K.12  Validate Changes Window 

 

 
Figure K.13  HMS Reach to Stream Editor – By Junctions Tab – Automatically Match 

 
 7. From the Study Tree (Figure K.6), expand the Models node. Select HMS, from the 

Content Pane (Figure K.6), double-click on the HMS model alternative (i.e., 
HMS:(RUN)Feb_1986) that has been selected in the HMS Junction to Stream Mapper 
dialog box (Figure K.5).  A map window will open (Figure K.7) that displays the selected 
HMS model alternative. 

 
 8. Turning off some of the maps layers in the map window (Figure K.7) will help in 

locating the stationing for the HMS junction graphic elements.  From the Maps tab 
(Figure K.8) of the HEC-WAT main window (Figure K.1), turn off all of the map layers 
that are not need for locating the HMS junction graphic elements.  When this is done, the 
Map Window (Figure K.7) displays the HMS model alternative. 

 9. So, is the automatic match correct (Figure K.13), no, the user will need to make some 
changes. Why is HEC-WAT having a hard time getting the correct matches? The HMS 
junction names and reach names are not exactly identical.  For example, in Figure K.13, 
for the first reach – Ukiah-Talmage, the selected upstream junction is not correct, because 
the upstream junction name Ukiah is not what that junction is named.  From reviewing 
the HMS basin model (Figure K.14), the user knows that the upstream junction for the 
reach in question should be Ukiah Confluence.  In the row associated with the reach, 
from the Upstream Junction column (Figure K.15), from the list, select Ukiah-
Confluence.  Repeat these steps for all of the rows in the table (Figure K.15). 
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Figure K.14  HMS Reach – Upstream and Downstream Junctions 

 

 
Figure K.15  HMS Reach to Stream Editor – By Junctions Tab – Modifying 

 
 10. What if the user encounters a reach that has a junction that is not defined in the selected 

HMS model alternative?  For example, in Figure K.15, the AG Resort-Big Sulphur reach, 
in the HMS model alternative there is not a defined downstream junction.  Do not make 
any changes to the reach in the HMS Reach to Stream Editor (Figure K.15) on the By 
Junctions tab, the change will need to be made in the By Streams tab (Section K.3.2). 

 
 11. Once all of the modifications have been made click Apply (Figure K.15), if there are 

issues with the mapping, an Invalid Junction Assignments windows will open.  An 
issue might be that the user has selected the same junction for the upstream and 
downstream junctions for a reach.  Click OK, the Invalid Junction Assignments 
windows will open, and the user should correct the issues. 
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 12. Now that identifying reaches by upstream and downstream junctions has been completed 
(Figure K.16).  Any further adjustments that need to be made for HMS reaches will be 
done by streams, which is detailed in the following Section K.3.2. 

 

 
Figure K.16  HMS Reach to Stream Editor – By Junctions Tab – Completed 

 
K.3.2 By Streams 
 
To edit the geographic location of HEC-HMS reach elements by stream: 
 
 1. From the HEC-WAT main window (Figure K.1), from the Edit menu, point to HMS, 

click Reach To Stream Mapping. 
 
 2. The HMS Reach to Stream Editor will open (Figure K.17).  This editor is not from 

HEC-HMS, but from HEC-WAT.  Since the current version of HEC-HMS does not 
recognize the coordinate system that HEC-WAT has for a study, this editor allows the 
user to enter information that will give the HEC-HMS reach element the correct 
geographic location on the schematic. 
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Figure K.17  HMS Reach to Stream Editor – By Streams Tab 

 
 3. An HEC-WAT simulation must be displayed in a map window on the HEC-WAT main 

window (Figure K.18).  The active simulation name is displayed in the Simulation box 
(Figure K.17). For example, in Figure K.17, the HEC-WAT simulation is Without Project 
Conditions-RR_Feb1986.  From the Maps tab (similar to Figure K.8), turn off all of the 
appropriate map layers for the simulation map window.  When this is done, the map 
windows displays (Figure K.18) the HMS graphical elements for the HMS model 
alternative and the HEC-WAT simulation.  The user should review the map windows to 
see if any HMS reaches are not displaying or are in the wrong location. 

 

 
Figure K.18  HEC-WAT Main Window – Simulation Map Window 

 



Appendix K – Model Integration Tools HEC-WAT User's Manual 

K-12 
 

 4. To assist in verifying the upstream and downstream junctions for a reach, from the HEC-
WAT main window (Figure K.18), from the Programs Toolbar, click     , the HEC-HMS 
main window will open (Figure K.19).  From study tree, from the Basin Models folder 
(Figure K.19), double click on the correct HMS basin model (i.e., Russian River 86).  A 
map window will display the HMS graphical elements of the selected HMS basin model 
(Figure K.19).  The user should take some time and familiarize themselves with the HMS 
model alternative and reach and junction locations. 

 

 
Figure K.19  HEC-HMS Main Window  

 
 5. Both the HEC-WAT and HEC-HMS map windows should be zoomed-in to the same 

location.  For the example given here, Figure K.18, the user has already provided 
stationing for the HMS junctions and has mapped upstream and downstream junctions to 
most of the HMS reaches.  There are five HMS reaches that still need to be modified so 
that the HMS reaches will display correctly on the HEC-WAT schematic. 

 
 
 6. After reviewing the map windows (Figures K.18 and K.19), from the HMS Reach to 

Stream Editor (Figure K.17), from the table for a Reach (e.g., AG Resort-Big Sulpher), 
from the Stream list (Figure K.17), select the correct stream (e.g., Big Sulfur Creek).  By 
viewing the HEC-WAT Map Window (Figure K.18), the user can determine the stream 
name. 

 
 7. To determine the upstream station, compare the two map windows, the user should be 

able to locate the upstream station.  For example, in Figure K.20, the upstream station is 
located at the end point of Big Sulfur Creek.  From the HEC-WAT map window, select      
(Stream Node Tool), right-click on the green circle, from the shortcut menu click Edit 
Node, the Stream Node Editor will open (Figure K.21). 
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Figure K.20  Stream Junction Editor – Upstream and Downstream Stations 

 

 
Figure K.21  Stream Node Editor 

 
 8. In the Station box (Figure K.21), the stream station for the selected upstream station is 

displayed (i.e., 80625.84).  From the HMS Reach to Stream Editor (Figure K.17), from 
the UpstreamStation cell for the selected HMS reach, enter the stream station. 

 
 9. To determine the downstream station, the user should be able to compare the two map 

windows.  For example, in Figure K.20 (upper left corner), the downstream station is just 
above the confluence of two streams.  The user will need to create at stream node at that 
location (Appendix F, Section F.3.2).  Right-click on the green circle (Figure K.20, upper 
left corner), from the shortcut menu click Edit Node, the Stream Node Editor will open 
(Figure K.21). 

 
 10. From the Station box (Figure K.21), the stream station for the selected downstream 

station is displayed (i.e., 2794.292).  From the HMS Reach to Stream Editor (Figure 
K.17), from the DownstreamStation cell for the selected HMS reach, enter the stream 
station. 
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 11. Once the stream station has been entered into the HMS Reach to Stream Editor (Figure 
K.22), the user will need to remove the stream node/junction from the schematic.  This 
has to be done, because any changes to the stream station will affect an HEC-ResSim 
model alternative. 

 

 
Figure K.22  HMS Reach to Stream Editor - Completed 

 
 12. For this particular example, the user will need to perform Steps 6 through 10 for four 

more reaches.  Once all reaches have been provided the correct stationing, click Apply 
(Figure K.21).  When the HMS Reach to Stream Editor (Figure K.10) is complete, 
click OK, the HMS Reach to Stream Editor (Figure K.10) will close. 

 
K.4 Coordinate Information 
 
HEC-HMS graphic elements could have problems displaying correctly if the HEC-HMS model 
alternative is in a different coordinate system.  To correct this issue, from the Edit menu, point to 
HMS, click Coordinate Information, the Select HMS Projection dialog box will open (Figure 
K. 23). 
 

 
Figure K.23  Select HMS Projection Dialog Box 
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 1. From the Select HMS Projection Dialog Box (Figure K.23), click Load from file (lower 
left corner); an Open browser (Figure K.24) will open.  Browse to where the map layer 
containing the correct projection is stored. Click Open, the Select HMS Projection 
dialog box will open (FigureK.25).  The Select HMS Projection dialog box contains 
information about the projected coordinate system (Figure K.25).  Click OK, the Select 
HMS Projection dialog box will close (Figure K.25). 

 

 
Figure K.24  Open Browser 

 

 
Figure K.25  Select HMS Projection Dialog Box 

 
 2. The projection of the HMS model alternative is now set to the correct coordinate system. 
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Appendix L 
 

Editing Model Data 
 
 
L.1 Overview 
 
HEC-WAT provides a framework that streamlines and integrates a study using software 
applications commonly used within USACE.  The software applications are directly accessible 
from within HEC-WAT, which allows the user to edit individual model alternative data directly 
from the individual software applications.  This flexibility is accomplished through the use of a 
"plug-in" (HEC-WAT Technical Reference Manual; not available for Version 1.0 release) that 
has been built for each piece of software.  The plug-in allows HEC-WAT and the individual 
software applications to communicate with minimal specific code being needed by HEC-WAT 
or the individual software application. 
 
From HEC-WAT the user has several options on editing model data.  The user can open the user 
interface of the individual software applications that edit the model data by clicking the 
appropriate software button from the Programs Toolbar (Chapter 3, Section 3.2.1) of the HEC-
WAT main window (Figure L.1).  Also from the HEC-WAT main window, from the Study 
Tree, on the Study Pane (Chapter 3, Section 3.2.2), right-click on a simulation, from the 
shortcut menu, point to Edit Model, and then click on the model alternative to edit. 
 

 
Figure L.1  HEC-WAT Main Window 
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From the Study Tree, from the Simulations folder, select a simulation, in the Content Pane 
(Figure L.1), under Models, the model alternatives for the selected simulation will display.  
Right-click on a model alternative, from the shortcut menu, click Edit Model, the user can then 
edit the select model alternative. Finally, from the HEC-WAT main window (Figure L.1) from 
the Edit menu, from the software application item, the user can access the main window of the 
selected software applications or individual editors from the software application.  For example, 
from the Edit menu, point to RAS, click Open RAS, and the HEC-RAS main window will open. 
 
This appendix will focus on accessing specific editors from the available software applications, 
from within HEC-WAT.  These editors can be accessed interactively from the schematic 
(Section L.2) or from the HEC-WAT main window (Section L.3). 
 
L.2 Schematic 
 
From the active simulation map window you can access software application specific editors 
from the model elements that are available on a map window. When hovering over a model 
element, a tooltip will appear (Figure L.2) which lists what model information is available for 
that particular model element.  For example, in Figure L.2 at the junction there is possible 
information from ResSim, also, there is a cross section and a reach element in the area that is 
recognized by ResSim, HMS, and RAS.  Also, there is structures and an impact area near the 
junction that are recognized by FIA. 
 

 
Figure L.2  ToolTip Information from Schematic (Simulation Map Window) 
 
To access model specific editors, right-click on a model element, a shortcut menu (Figure L.3) 
will appear which provides access to the available software application editors.  HEC-WAT 
searches for all available model elements in the area that the user has right-clicked on, so the 
shortcut menu will usually display all the model elements that were found in that area.  For 
example, in Figure L.3, right-clicking at a cross section, HEC-WAT has found four model 
elements in the area of that cross section.  To access the editor specific for the cross section, from 
the shortcut menu, point to Cross Section, click Edit Properties, the Cross Section Data 
Editor from RAS will open. 
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Figure L.3  Model Element Shortcut Menus 
 
The following sections will cover the available models editors for the default HEC-WAT 
software applications. 
 
L.2.1 HMS 
 
Whether right-clicking on a subbasin element, junction element, reach element, reservoir 
element, or sink element, from the schematic there are various HMS model editors that can be 
accessed.  The following section describes those editors. 
 
Subbasin Element 
 
To edit HMS model data at a subbasin: 
 
 1. From the simulation map window, right-click on an HMS subbasin model element (    ) 
  on the schematic, a shortcut menu will display (Figure L.4).  From the shortcut menu, 

point to Subbasin, click Edit Properties. 
 

 
Figure L.4  Subbasin Element Shortcut Menu 

 
 2. The HMS editor for subbasins will open (Figure L.5).  This editor allows the user to 

change parameters that are specific to an HMS subbasin.  For further detail on this editor, 
reference the HEC-HMS User's Manual. 

 
 3. To close the HMS editor for subbasins (Figure L.5) click      . 
 
Routing Reach Element 
 
 1. From the simulation map window, right-click on an HMS routing reach model element 

(blue line) on the schematic, a shortcut menu will display (Figure L.6).  From the shortcut 
menu, point to Reach, since there is more than reach element available (i.e., HMS, 
ResSim, RAS), point to Edit Properties, click on the available HMS model alternative 
(e.g., (RUN)Feb_1986-Chalk Hill-Digger Bend). 
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Figure L.5  HEC-HMS Editor - Subbasin 

 

 
Figure L.6  Routing Reach Element Shortcut Menu 

 
 2. The HMS editor for a routing reach will open (Figure L.7).  This editor allows the user to 

change parameters that are specific to an HMS routing reach.  For further detail on this 
editor, reference the HEC-HMS User's Manual. 

 
 3. To close the HMS editor for routing reaches (Figure L.7) click      . 
 
Junction Element 
 
 1. From the simulation map window, right-click on an HMS junction model element on the 

schematic (red circle), a shortcut menu will appear (Figure L.8).  From the shortcut menu 
click Edit Properties. 
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Figure L.7  HEC-HMS Editor – Routing Reach 

 

 
Figure L.8  Junction Element Shortcut Menu 

 
 2. The HMS editor for a junction will open (Figure L.9).  This editor allows the user to 

change parameters that are specific to an HMS junction.  For further detail on this editor, 
reference the HEC-HMS User's Manual. 

 

 
Figure L.9  HEC-HMS Editor - Junction 

 
 4. To close the HMS editor for junctions (Figure L.9) click      . 
 
Reservoir Element 
 
 1. From the simulation map window, right-click on an HMS reservoir model element on the 

schematic (     ), a shortcut menu will appear (Figure L.10).  From the shortcut menu click 
Edit Properties. 
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Figure L.10  Reservoir Element Shortcut Menu 

 
 2. The HMS editor for a junction will open (Figure L.11).  This editor allows the user to 

change parameters that are specific to an HMS reservoir.  For further detail on this editor, 
reference the HEC-HMS User's Manual. 

 
 3. To close the HMS editor for reservoirs (Figure L.11) click      . 
 

 
Figure L.11  HEC-HMS Editor - Reservoir 

 
L.2.2 ResSim 
 
Whether right-clicking on a reservoir element, junction element, or reach element, from the 
schematic there are various HEC-ResSim model editors that are accessible.  The following 
section describes those editors. 
 
Reservoir Element 
 
To edit ResSim model data at a reservoir: 
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 1. From the simulation map window, right-click on a reservoir model element (cyan 
triangle) on the schematic, a shortcut menu will appear (Figure L.12).  From the shortcut 
menu, point to Reservoir, click Edit Properties. 

 

 
Figure L.12  Reservoir Element Shortcut Menu 

 
 2. The ResSim Reservoir Editor will open (Figure L.13).  This editor allows the user to 

change physical data requirements for the reservoir, change the operation sets for a 
reservoir, and specify observed data if needed.  For further detail on this editor, reference 
the ResSim User's Manual. 

 

 
Figure L.13  HEC-ResSim – Reservoir Editor 

 
 3. Click OK, the ResSim Reservoir Editor (Figure L.13) will close. 
 
Junction Element 
 
To edit ResSim model data at a junction: 
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 1. From the simulation map window, right-click on a junction model element (red circle) on 
the schematic, a shortcut menu will appear (Figure L.14).  From the shortcut menu, point 
to Junction, click Edit Properties. 

 

 
Figure L.14  Junction Element Shortcut Menu 

 
 2. The ResSim Junction Editor will open (Figure L.15).  This editor allows the user to 

change information about a ResSim junction, add local flow and a rating curve, and if 
needed add information about observed data.  For further detail on this editor, reference 
the HEC-ResSim User's Manual. 

 

 
Figure L.15  HEC-ResSim – Junction Editor 

 
 3. Click OK, the ResSim Junction Editor (Figure L.15) will close. 
 
Routing Reach Element 
 
To edit ResSim model data at a routing reach: 
 
 1. From the simulation map window, right-click on a routing reach model element (blue 

line) on the schematic, a shortcut menu will appear (Figure L.16).  From the shortcut 
menu, point to Reach, click Edit Properties. 

 
 2. The ResSim Reach Editor will open (Figure L.17).  This editor allows the user to change 

information about a ResSim reach, add/change routing information, edit information 
about losses for the reach, and if needed add information about observed data.  For 
further detail on this editor, reference the HEC-ResSim User's Manual. 



HEC-WAT User's Manual Appendix L – Editing Model Data 

 L-9 

 

 
Figure L.16  Reach Element Shortcut Menu 

 

 
Figure L.17  HEC-ResSim – Reach Editor 

 
 3. Click OK, the ResSim Reach Editor (Figure L.17) will close. 
 
L.2.3 HEC-RAS – Cross Section 
 
To edit RAS model data at a cross section: 
 
 1. From the simulation map window, right-click on a cross section model element (green 

line) on the schematic, a shortcut menu will appear (Figure L.18).  From the shortcut 
menu, point to Cross Section, click Edit Properties. 

 

 
Figure L.18  Cross Section Element Shortcut Menu 

 
 2. The RAS Cross Section Data Editor will open (Figure L.19).  This editor allows the 

user to change information about a RAS cross section, add/change Manning's n values, 
edit cross section coordinates, and edit other information regarding a cross section.  For 
further detail on this editor, reference the HEC-RAS User's Manual. 
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 3. From the Exit menu, click Exit Cross Section Editor, the Cross Section Data Editor 
(Figure L.19) will close. 

 

 
Figure L.19  HEC-RAS – Cross Section Editor 

 
L.2.4 FIA 
 
Whether right-clicking on a reservoir element or a structure element, from the schematic there 
are various HEC-FIA model editors that are accessible.  The following section describes those 
editors. 
 
Impact Area 
 
To edit FIA model data at an impact area: 
 
 1. From the simulation map window, right-click on an impact area model element (green 

polygon) on the schematic, a shortcut menu will appear (Figure L.20).  From the shortcut 
menu click Edit Properties. 

 

 
Figure L.20  Impact Area Element Shortcut Menu 

 
 2. The FIA Impact Area Editor will open (Figure L.21).  This editor allows the user to 

change information about impact area description, life loss parameters, population 
adjustment, and the adjusted price index.  For further detail on this editor, reference the 
HEC-FIA User's Manual. 

 
 3. Click OK, the HEC-FIA Impact Area Editor (Figure L.21) will close. 
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Structure 
 
To edit FIA model data at a structure: 
 

 
Figure L.21  HEC-FIA – Impact Area Editor 

 
 1. From the simulation map window, right-click on a structure model element (blue square) 

on the schematic, a shortcut menu will appear (Figure L.22).  From the shortcut menu 
click Edit Properties. 

 

 
Figure L.22  Structure Element Shortcut Menu 

 
 2. The FIA Structure Editor will open (Figure L.23).  This editor allows the user to change 

information about a structure's location, occupancy type data, structure value, content 
value, first floor elevation, foundation height, ground elevation, and lethality zone 
parameter data.  For further detail on this editor, reference the HEC-FIA User's Manual. 

 
 3. Click OK, the HEC-FIA Structure Editor (Figure L.23) will close. 
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Figure L.23  HEC-FIA – Structure Editor 
 
L.3 Edit Menu 
 
From the menu bar of the main HEC-WAT window, click Edit (Figure L.24), from this menu 
the user can access various editors or parts of a software application's interface that are specific 
to the software applications included in the program order for a study.  For example, in Figure 
L.24, point to HMS, the available commands allow the user to interact with the HEC-HMS 
software application and access parts of the HEC-HMS interface like the Basin Model tab.  The 
following sections provide an overview of the available editors.  For more detail you will need to 
visit the user's manuals associated with each piece of software. 
 

 
Figure L.24  Edit Menu – HMS 
 



HEC-WAT User's Manual Appendix L – Editing Model Data 

 L-13 

L.3.1 HEC-HMS 
 
From the HEC-WAT main window (Figure L.1), from the Edit menu, point to HMS (Figure 
L.24), click Open HMS.  The HEC-HMS software application will open and the HEC-HMS 
main window will display (Figure L.25).  The user can modify existing HEC-HMS models or 
create new HEC-HMS model components, once the user is finished and the model has been 
saved, the HEC-HMS model information is stored in the HEC-WAT study directory, under the 
hms folder.  The rest of this section provides an overview of the HEC-HMS interface that is 
directly available from the HEC-WAT framework. 
 

 
Figure L.25  HEC-HMS Main Window – Basin Model Tab 
 
Basin Model 
 
To edit HMS model data for a basin: 
 
 1. From the WAT main window, from the Edit menu (Figure L.24), point to HMS, click 

Basin Model. 
 
 2. The HEC-HMS main window will open with the Basin Model tab displayed (Figure 

L.25).  This tab allows the user to change parameters that are specific to an HMS basin.  
For further detail on this editor, reference the HEC-HMS User's Manual. 

 
 3. From the File menu, click Exit, the HEC-HMS main window will close (Figure L.25). 
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Meteorologic Model 
 
To edit the HMS meteorologic model for a study: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.25), point to HMS, 

click Meteorologic Model. 
 
 2. The HEC-HMS main window will open with the Meteorology Model tab displayed 

(Figure L.26).  This tab allows the user to edit parameters that have been defined for the 
meteorologic model.  For further detail on this editor, reference the HEC-HMS User's 
Manual. 

 

 
Figure L.26  HEC-HMS Main Window – Meteorology Model Tab 

 
 3. From the File menu, click Exit, the HEC-HMS main window will close (Figure L.26). 
 
Simulation Run 
 
To edit the defined parameters for an HMS simulation: 
 
 1. From the WAT main window, from the Edit menu (Figure L.24), point to HMS, click 

Simulation Run. 
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 2. The HEC-HMS main window will open with the Compute tab displayed (Figure L.27).  
This tab allows the user to edit parameters that have been defined for an HMS simulation 
run.  For further detail on this editor, reference the HEC-HMS User's Manual. 

 

 
Figure L.27  HEC-HMS Main Window – Basin Model Tab – Simulation Runs 

 
 3. From the File menu, click Exit, the HEC-HMS main window will close (Figure L.26). 
 
L.3.2 HEC-ResSim 
 
From the HEC-WAT main window (Figure L.1), from the Edit menu, point to ResSim (Figure 
L.28), click Open ResSim.  The HEC-ResSim software application will execute and the HEC-
ResSim main window will display (Figure L.29).  The user can modify existing HEC-ResSim 
model components or create new HEC-ResSim model components, once the user is finished and 
data has been saved, the HEC-ResSim model information is stored in the HEC-WAT study 
directory, under the rss folder.  The rest of this section provides an overview of the HEC-ResSim 
editors that are directly available from the HEC-WAT framework. 
 

 
Figure L.28  Edit Menu – ResSim 
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Figure L.29  HEC-ResSim Main Window 
 
Edit Reservoirs 
 
To edit HEC-ResSim model data at a reservoir: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.28), point to ResSim, 

click Edit Reservoirs. 
 
 2. The HEC-ResSim Reservoir Editor will open (Figure L.13).  This editor allows the user 

to change physical data requirements for the reservoir, change the operation sets for a 
reservoir, and specify observed data if needed.  For further detail on this editor, reference 
the HEC-ResSim User's Manual. 

 
 3. Click OK, the HEC-ResSim Reservoir Editor (Figure L.13) will close. 
 
Edit Reaches 
 
To edit HEC-ResSim model data at a reach: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.28), point to ResSim, 

click Edit Reaches. 
 
 2. The HEC-ResSim Reach Editor will open (Figure L.17).  This editor allows the user to 

change information about a ResSim reach, add/change routing information, edit 
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information about losses for the reach, and if needed add information about observed 
data.  For further detail on this editor, reference the HEC-ResSim User's Manual. 

 
 3. Click OK, the Reach Editor (Figure L.17) will close. 
 
Edit Junctions 
 
To edit HEC-ResSim model data at a junction: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.28), point to ResSim, 

click Edit Junctions. 
 
 2. The HEC-ResSim Junction Editor will open (Figure L.15).  This editor allows the user 

to change information about a ResSim junction, add local flow and a rating curve, and if 
needed add information about observed data.  For further detail on this editor, reference 
the HEC-ResSim User's Manual. 

 
 3. Click OK, the Diversion Editor (Figure L.15) will close. 
 
Edit Diversions 
 
To edit HEC-ResSim model data at a diversion: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.28), point to ResSim, 

click Edit Diversions. 
 
 2. The HEC-ResSim Diversion Editor will open (Figure L.30).  This editor allows the user 

to change information about a ResSim diversion, for further details on this editor, 
reference the HEC-ResSim User's Manual. 

 

 
Figure L.30  HEC-ResSim – Diversion Editor 

 
 3. Click OK, the Diversion Editor (Figure L.30) will close. 
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Edit State Variables 
 
To edit HEC-ResSim state variables: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.28), point to ResSim, 

click Edit State Variables. 
 
 2. The HEC-ResSim State Variable Editor will open (Figure L.31).  This editor allows the 

user to modify information about a state variable that has been created for the HEC-
ResSim model.  For further detail on this editor, reference the HEC-ResSim User's 
Manual. 

 

 
Figure L.31  HEC-ResSim – State Variable Editor 

 
 3. Click OK, the State Variable Editor (Figure L.31) will close. 
 



HEC-WAT User's Manual Appendix L – Editing Model Data 

 L-19 

Edit Alternatives 
 
To edit HEC-ResSim alternatives: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.28), point to ResSim, 

click Edit Alternatives. 
 
 2. The ResSim Alternative Editor will open (Figure L.32).  This editor allows the user to 

modify the run control information for the selected HEC-ResSim model alternative; 
adjust data for operations, lookback, time-series, and observed data; and, various other 
alternative based options.  For further detail on this editor, reference the HEC-ResSim 
User's Manual. 

 

 
Figure L.32  HEC-ResSim – Alternative Editor 

 
 3. From the Alternative menu, click Close, the ResSim Alternative Editor (Figure L.32) 

will close. 
 
Edit Run 
 
From the HEC-WAT main window, from the Edit menu (Figure L.28), point to ResSim, click 
Edit Run.  The ResSim Editor will open (Figure L.33).  This editor provides the user with a 
convenient way to access all HEC-ResSim editors for an HEC-ResSim model alternative.  For 
further detail on this editor, reference the HEC-ResSim User's Manual.  Click OK, the ResSim 
Editor (Figure L.33) will close. 
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Figure L.33  HEC-ResSim - ResSim Editor 
 
ResSim Editor - Reservoir Systems 
 
From the Reservoir System dialog box (Figure L.34), HEC-ResSim allows the user to define the 
reservoirs in a study area as a system of how the reservoirs work and operate together.  Further 
details of this capability are available in the HEC-ResSim User's manual. 
 

 
Figure L.34  HEC-ResSim – Reservoir System Dialog Box 
 
ResSim Editor - Overrides 
 
The HEC-ResSim Overrides interface (Figure L.33) is not available in HEC-WAT Version 1.0.  
This capability will be available in the next HEC-WAT version.  For further details on this 
capability, refer to the HEC-ResSim User's manual. 
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L.3.3 HEC-RAS 
 
From the HEC-WAT main window (Figure L.1), from the Edit menu, point to RAS (Figure 
L.35), click Open RAS.  The HEC-RAS software application will open and the HEC-RAS main 
window will display (Figure L.36).  The user can modify existing HEC-RAS model components 
or create new HEC-RAS model components, once the user is finished and data has been saved, 
the HEC-RAS model information is stored in the HEC-WAT study directory, under the ras 
folder.  The rest of this section provides an overview of the HEC-RAS editors that are directly 
available from the HEC-WAT framework. 
 
 

 
Figure L.35  Edit Menu – RAS 
 

 
Figure L.36  HEC-RAS Main Window 
 
Geometric Data 
 
To edit geometric data associated with a RAS model alternative: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.35), point to RAS, 

click Geometric Data. 
 
 2. The RAS Geometric Data Editor will open (Figure L.37).  This editor allows the user to 

edit parameters that have been defined for the geometric data for a RAS model 
alternative.  For further detail on this editor, reference the HEC-RAS User's Manual. 

 
 3. From the File menu, click Exit Geometry Data Editor, the RAS Geometric Data 

Editor (Figure L.37) will close. 
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Steady Flow Data 
 
To edit steady flow data associated with a RAS steady flow model alternative: 
 
 1. From the WAT main window, from the Edit menu (Figure L.35), point to RAS, click 

Steady Flow Data. 
 

 
Figure L.37  HEC-RAS – Geometric Data Editor 

 
 2. The RAS Steady Flow Data Editor will open (Figure L.38).  This editor allows the user 

to edit boundary conditions that have been defined for the steady flow data for a RAS 
model alternative.  For further detail on this editor, reference the HEC-RAS User's 
Manual. 

 

 
Figure L.38  HEC-RAS –Steady Flow Data Editor 
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 3. From the File menu, click Exit Flow Data Editor, the RAS Steady Flow Data Editor 
(Figure L.38) will close. 

 
Quasi-Unsteady Flow Data 
 
To edit quasi-unsteady flow data associated with a RAS unsteady flow model alternative: 
 
 1. From the WAT main window, from the Edit menu (Figure L.35), point to RAS, click 

Quasi-Unsteady Flow Data. 
 
 2. The RAS Quasi Unsteady Flow Editor will open (Figure L.39).  This editor allows the 

user to edit boundary conditions that have been defined for the quasi-unsteady flow data 
for a RAS unsteady flow model alternative.  For further detail on this editor, reference the 
HEC-RAS User's Manual. 

 

 
Figure L.39  HEC-RAS – Quasi Unsteady Flow Editor 

 
 3. To close the RAS Quasi Unsteady Flow Editor (Figure L.39) click      . 
 
Unsteady Flow Data 
 
To edit unsteady flow data associated with a RAS unsteady flow model alternative: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.35), point to RAS, 

click Unsteady Flow Data. 
 
 2. The RAS Unsteady Flow Editor will open (Figure L.40).  This editor allows the user to 

edit boundary and initial conditions that have been defined for the unsteady flow data for 
a RAS unsteady flow model alternative.  For further detail on this editor, reference the 
HEC-RAS User's Manual. 
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Figure L.40  HEC-RAS –Unsteady Flow Data Editor 

 
 3. From the File menu, click Exit, the RAS Unsteady Flow Editor (Figure L.40) will close. 
 
Sediment Data 
 
To edit sediment data associated with a RAS model alternative: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.35), point to RAS, 

click Sediment Data. 
 
 2. The HEC-RAS Sediment Data Editor will open (see Figure L.41).  This editor allows 

you to edit parameters and boundary conditions that have been defined for the sediment 
data for a RAS model alternative.  For further detail on this editor, reference the HEC-
RAS User's Manual. 

 

 
Figure L.41  HEC-RAS –Sediment Data Editor 
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 3. From the File menu, click Exit, the RAS Sediment Data Editor (Figure L.41) will close. 
 
Water Quality Data 
 
To edit water quality data associated with a RAS model alternative: 
 
 1. From the WAT main window, from the Edit menu (Figure L.35), point to RAS, click 

Water Quality Data. 
 
 2. The RAS Water Quality Data Editor will open (Figure L.42).  This editor allows you to 

edit parameters that have been defined for the water quality data for a RAS model 
alternative.  For further detail on this editor, reference the HEC-RAS User's Manual. 

 
 3. From the File menu, click Exit, the RAS Water Quality Data Editor (Figure L.42) will 

close. 

 
Figure L.42  HEC-RAS – Water Quality Data Editor 

 
Plan Data 
 
To edit plan data associated with a RAS model alternative: 
 
 1. From the WAT main window, from the Edit menu (Figure L.35), point to RAS, click 

Plan Data. 
 
 2. The RAS Unsteady Flow Analysis Editor will open (Figure L.43).  This editor allows 

the user to edit information that has been defined for the plan data for a RAS model 
alternative.  For further detail on this editor, reference the HEC-RAS User's Manual. 
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Figure L.43  HEC-RAS – Unsteady Flow Analysis Editor 

 
 3. From the File menu, click Exit, the RAS Unsteady Flow Editor (Figure L.43) will close. 
 
RAS Mapper 
 
HEC-RAS has the capability to perform inundation mapping of water surface profile results 
directly from HEC-RAS. RAS Mapper is a tool within the HEC-RAS that creates inundation 
mapping by using the HEC-RAS geometry data and computed water surface profiles from an 
HEC-RAS compute.  To access RAS Mapper: 
 
 1. From the WAT main window, from the Edit menu (Figure L.35), point to RAS, click 

RAS Mapper. 
 
 2. The RAS Mapper dialog box will open (Figure L.44).  From this dialog box the user can 

setup the necessary information in RAS Mapper to create inundation maps, velocity 
maps, and depth grids.  For further detail on this editor, reference the HEC-RAS User's 
Manual. 

 
 3. From the File menu, click Exit, the RAS Mapper dialog box will close (Figure L.44). 
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Figure L.44  HEC-RAS – RAS Mapper Dialog Box 

 
L.3.4 FIA 
 
From the HEC-WAT main window (Figure L.1), from the Edit menu, point to FIA (Figure 
L.45), click Open FIA.  The HEC-FIA software application will execute and the HEC-FIA main 
window will display (Figure L.46).  The user can modify existing HEC-FIA components model 
or create new HEC-FIA model components, once the user is finished and data has been saved, 
the HEC-FIA model information is stored in the HEC-WAT study directory, under the fia folder.  
The rest of this section provides an overview of the HEC-FIA editors that are directly available 
from the HEC-WAT framework. 
 

 
Figure L.45  Edit Menu – FIA 
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Figure L.46  HEC-FIA Main Window 
 
Global Data Editor 
 
To edit the global data associated with an HEC-FIA model alternative: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.45), point to FIA, 

click Global Data. 
 
 2. The HEC-FIA Global Data Editor will open (Figure L.47).  This editor allows the user 

to edit the global data that has been defined for an FIA model alternative.  For further 
detail on this editor, reference the HEC-FIA User's Manual. 

 

 
Figure L.47  HEC-FIA – Global Data Editor 

 
 3. Click OK, the HEC-FIA Global Data Editor (Figure L.46) will close. 
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Impact Area Editor 
 
To edit impact area data associated with an HEC-FIA model alternative: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.45), point to FIA, 

click Impact Areas. 
 
 2. The HEC-FIA Impact Area Editor will open (Figure L.21).  This editor allows the user 

to change information about impact area description, life loss parameters, population 
adjustment, and the adjusted price index.  For further detail on this editor, reference the 
HEC-FIA User's Manual. 

 
 3. Click OK, the HEC-FIA Impact Area Editor (Figure L.21) will close. 
 
Structure Editor 
 
To edit data associated with a structure: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.45), point to FIA, 

click Structure Form Editor. 
 
 2. The HEC-FIA Structure Form Editor will open (Figure L.48).  This editor allows the 

user to edit individual structures that are part of the FIA model alternative.  For further 
detail on this editor, reference the HEC-FIA User's Manual. 

 

 
Figure L.48  HEC-FIA – Structure Form Editor 

 
 3. Click OK, the HEC-FIA Structure Form Editor will close (Figure L.48). 
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Critical Infrastructure 
 
To edit data associated with the HEC-FIA critical infrastructure option: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.45), point to FIA, 

click Critical Infrastructure. 
 
 2. The HEC-FIA Critical Infrastructure dialog box (Figure L.49).  This editor allows the 

user to edit information related to the critical infrastructure option of HEC-FIA.  For 
further detail on this editor, reference the HEC-FIA User's Manual. 

 
 3. Click OK, the HEC-FIA Critical Infrastructure dialog box will close (Figure L.49). 
 

 
Figure L.49  HEC-FIA – Critical Infrastructure Dialog Box 

 
Warning Issuance Scenarios 
 
To edit data associated with the HEC-FIA warning issuance scenario option: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.45), point to FIA, 

click Warning Issuance Scenarios. 
 
 2. The HEC-FIA Warning Issuance Scenarios dialog box (Figure L.50).  This editor 

allows the user to edit information related to the warning issuance scenario option of 
HEC-FIA.  For further detail on this editor, reference the HEC-FIA User's Manual. 

 
 3. Click OK, the HEC-FIA Warning Issuance Scenarios dialog box will close (Figure 

L.50). 
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Figure L.50  HEC-FIA – Warning Issuance Scenarios Dialog Box 

 
Alternative Editor 
 
To edit the setup options associated with an HEC-FIA alternative: 
 
 1. From the HEC-WAT main window, from the Edit menu (Figure L.45), point to FIA, 

click Alternative. 
 
 2. The HEC-FIA Alternative Editor (Figure L.51).  This editor allows the user to edit the 

setup options associated with an HEC-FIA alternative.  For further detail on this editor, 
reference the HEC-FIA User's Manual. 
 

 
Figure L.51  HEC-FIA – Alternative Editor 

 
 3. Click OK, the HEC-FIA Alternative Editor will close (Figure L.51). 
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L.4 Study Tree and Content Pane 
 
From either the Study Tree or Content Pane of the HEC-WAT main window (Figure L.1), with 
an HEC-WAT simulation selected, the user can also edit model alternatives.  From the Study 
Tree, from the Simulations folder, right-click on a simulation, from the shortcut menu (Figure 
L.52), point to Edit Model, click on a model alternative. 
 

 
Figure L.52  Study Tree - Simulation Shortcut Menu – Edit Model 
 
When selecting an HEC-HMS or an HEC-RAS model alternative, the user will get the respective 
software application's main window (Figures L.25 and L.36).  However, when selecting an HEC-
ResSim model alternative, the ResSim Editor will open (Figure L.33), and when selecting an 
HEC-FIA model alternative, the Alternative Editor will open (Figure L.51). 
 
From the Content Pane, under the models folder, right click on a model alternative.  From the 
shortcut menu, click Edit Model.  When selecting an HEC-HMS or an HEC-RAS model 
alternative, the user will get the respective software application's main window (Figures L.25 and 
L.36).  However, when selecting an HEC-ResSim model alternative, the ResSim Editor will 
open (Figure L.33), and when selecting an HEC-FIA model alternative, the Alternative Editor 
will open (Figure L.51). 
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Appendix M 
 
 

Plots 
 
Plots offer an array of information that will assist a user when reviewing results in HEC-WAT.  
Other software applications (i.e., HEC-HMS) have their own plotting capabilities, which were 
presented in Appendix L.  HEC-WAT does have data displayed graphically, and the plotting 
capabilities are based on the plotting capability available in HEC-DSSVue.  This appendix 
covers some of the capabilities of plots within HEC-WAT. For further details, review the HEC-
DSSVue User's Manual. 
 
M.1 Plot Window 
 
The Plot window provides tools that facilitate the viewing of results.  The main window and the 
different components for the Plot window are illustrated in Figure M.1.  The Title Bar contains 
the name of the plot type (i.e., Frequency Viewer, Hydrographs, etc.). 
 

 
Figure M.1  Plot Window 
 
M.2 Menu Bar 
 
Following is an overview of the Menu Bar (Figure M.1) for the Plot window.  The commands 
available from the menus will facilitate the viewing and customizing of plots. 
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 File From this menu the user can view the plotted data in a tabular format; save the plot 

as a graphics file; save a template; use a template; save user selected specifications; 
copy the plot to the clipboard, and print the plot.  Available commands are:  
Tabulate, Save As, Save Template, Apply Template, Save Specifications, Print, 
Page Setup, Print Preview, Print Multiple, and Close. 

 
 Edit From this menu the user can customize the plot.  Available commands are:  Plot 

Properties, Configure Plot Layout, Default Line Styles, and Default Plot 
Properties. 

 
 View From this menu the user can have the plot window always on top of the desktop; 

choose to use line styles; zoom out; placement of the legend; and, hide the legend.  
Available commands are:  Always On Top, Use Line Styles, Zoom to all, Legend 
Placement, and Hide Legend. 

 
M.3 Tools 
 
The Tools appear in a toolbar on the left side of the Plot window (Figure M.1).  The tools 
change the appearance of the mouse, as well as the functionality of the mouse: 
 
 Pointer/Selector Tool 
 
With the Pointer/Selector Tool, the user can access shortcut menus that allow customization of 
plots using the plot editing tools. 
 
 Zoom Tool 
 
The Zoom Tool allows the user to view data closely at a specific time.  To zoom in, hold the 
mouse button down and outline the area the user wants to enlarge.  To zoom out, click the right 
mouse button (right-click).  The zoom out is done by a factor of two and positions the clicked 
location at the center of the display area. 
 
M.4 Customizing Plots – Plot Window 
 
From a Plot window there are several areas (Figure M.1) that allow the user to configure default 
properties for all plots as well as customize individual plots.  Figure M.1 shows the plot areas 
that can be configured.  Some configuration items being discussed in this section are available 
from the Edit menu, which will be discussed in Section M.5. 
 
 Title Area Modify/create the title to individual plots. 
 
 Marker Add markers on the X- and Y-axes and customize the appearance of these markers. 
 
 Curve Customize the appearance of curves (line or point), add labels, specify symbols to 

indicate quality or missing values; hide or remove a curve, and create, hide or 
remove callouts. 
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 Spacer Specify the distance between viewports, between a viewport and the legend, and the 

width of side margins. 
 
 Viewport Customize the border around the viewport, the background color and pattern, and 

the appearance of gridlines.  The user can also specify the number, size, and 
content of viewports. 

 
 Axis Specify either a linear or log axis type; specify the axis scale; customize tic marks; 

and, customize the axis labels. 
 
 Legend Customize the legend by adding a title and specifying whether the legend appears 

below or to the right of the plot. 
 
M.4.1 Shortcut Menus 
 
Using the Pointer/Selector tool (Section M.3), right-click on an element or on an area of a plot 
window (Figure M.1) where enhancing/modify the plot might need to occur.  A shortcut menu 
will appear (Figure M.2), with the possible commands: 
 

 
Figure M.2  Plot Window – Element/Area Shortcut Menu Example 
 
 Title, Axis Label, etc. informational; name of element/area of a plot window 
 
 Edit Properties Displays the property editor for the select element/area of a plot window. 
 
M.4.2 Plot - Title 
 
To create/modify a title for a plot: 
 
 1. Right-click on a plot window where the title is displayed or would be displayed (Figure 

M.2).  From the shortcut menu, click Edit Properties. 
 
 2. The Edit Title Properties dialog box will open (Figure M.3). 
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Figure M.3  Edit Title Properties Dialog Box 

 
 3. To have the title of the plot display in the plot window, select Show Plot Title (Figure 

M3.), click Apply.  The title from the Text box (Figure M.3) will display. 
 
 4. From the Text box (Figure M.3), enter the title for the plot, click Apply.  The title from 

the Text box (Figure M.3) will display. 
 
 5. From the Font box (Figure M.4), from the Font list, the user can select a font type for the 

plot.  The user can choose to have the text, displayed bolded or italicized by select either 
Bold or Italic (Figure M.4) from the Font box.  From the Color list (Figure M.4) the user 
can have the title display in a selected color.  From the Size list (Figure M.4), the user can 
set the size of font for the plot.  The Use Font Scaling option (Figure M.4) allows for the 
font size to adjust when the plot window is being resized.  The scaling of the font is set in 
the Min Size list and the Max Size list. 

 

 
Figure M.4  Edit Title Properties Dialog Box – Font Box 

 
 6. From the Alignment list (Figure M.3) the user can center; right justify; or, left justify the 

title on the plot window. 
 
 7. The Sample box (Figure M.3) provides a preview of the plot title. 



HEC-WAT User's Manual Appendix M – Plots 

 M-5 

 
 8. From the Border box (Figure M.5), the user has the option to draw a border around the 

title.  Click Draw Border (Figure M.5), the user can select the color, style, and weight of 
the border, click Apply.  A border as defined will display around the title. 

 

 
Figure M.5  Edit Title Properties Dialog Box – Border Box 

 
 9. From the Background box (Figure M.6), the user has the option to incorporate a 

background as part of the title.  Click Draw Background (Figure M.6), the user can 
select the color, pattern, and set the transparency of the background, click Apply.  The 
title area of the plot will display with a background as defined. 

 

 
Figure M.6  Edit Title Properties Dialog Box – Background Box 

 
M.4.3 Plot - Markers 
 
Create a Marker 
 
To create a marker line for a plot: 
 
 1. Right-click on a plot window where a marker needs to be added (Figure M.7).  From the 

shortcut menu, point to Add Marker (Figure M.7), click on which axis the marker line 
should be placed – On X-Axis or On Y-Axis. 

 
 2. An Input message window will open (Figure M.8), asking the user if the value is correct.  

This value defaults to the location that the user pointed to on the plot area, for either the 
X-axis or Y-axis.  The user can change the value, but that means the maker line will be 
drawn somewhere else.  Click OK, the Input message window will close (Figure M.8) 
and the marker line will display on the plot. 

 
To create a marker point for a plot: 
 
 1. Right-click on a plot window where a marker needs to be added (Figure M.7).  From the 

shortcut menu, click to Add Marker Point (Figure M.7). 
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Figure M.7  Plot – Viewport Shortcut Menu 

 

 
Figure M.8  Input Message Window 

 
 2. A Point Location dialog box will open (Figure M.9), displaying the X-axis value and the 

Y-axis value of where the user pointed to on the plot.  The user can changes the values, 
but that means the marker point will be drawn somewhere else.  Click OK, the Point 
Location dialog box will close (Figure M.9) and the marker point will display on the 
plot. 

 

 
Figure M.9  Point Location Dialog Box 

 
 3. Click Apply, either the marker line or point will display on the plot. 
 
Edit a Marker 
 
Edit a marker line: 
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 1. Right-click on a marker line from a plot window (Figure M.10).  From the shortcut menu, 
click Edit Properties (Figure M.10), the Edit Marker Line Properties dialog box will 
open (Figure M.11). 

 

 
Figure M.10  Plot – Marker Line Shortcut Menu 
 

 
Figure M.11  Edit Marker Line Plot Dialog Box 

 
 2. The Marker Value (Figure M.11) of the marker line is displayed. 
 
 3. From the Line box (Figure M.11), Draw Line should be selected so that the marker line 

will be displayed on the plot (Figure M.10).  The user can select the color, style, and 
weight of the marker line from the Line box (Figure M.11).  Also, the marker line can 
have a fill associated with it.  The user can choose to have the fill Below (to left of the 
marker line) or Above (to the right of the marker line).  The Sample box (Figure M.11) 
will give the user a preview of the modifications to the marker line. 



Appendix M – Plots HEC-WAT User's Manual 

M-8 

 4. From the Label box (Figure M.11), the user can choose to display a label for the marker 
by selecting Draw Label (Figure M.11).  The user can provide a label for the marker, by 
entering information in the Text box (Figure M.11).  From the Font box (Figure M.4), 
from the Font list, the user can select a font type for the plot.  From the Color list (Figure 
M.4) the user can have the label for the marker display in a selected color.  The user can 
choose to have the text, displayed bolded or italicized by select either Bold or Italic 
(Figure M.4) from the Font box.  From the Size list (Figure M.4), the user can set the size 
of font for the plot.  The Use Font Scaling option (Figure M.4) allows for the font size to 
adjust when the plot window is being resized.  The scaling of the font is set in the Min 
Size list and the Max Size list. 

 
 5. From the Alignment list (Figure M.11) the user can center; right justify; or, left justify 

the marker label on the plot window. 
 
 6. From the Position list (Figure M.11) the user can position the label Above, Below or 

Center on the marker. 
 
Edit a marker point: 
 
 1. Right-click on a marker point from a plot window (Figure M.12).  From the shortcut 

menu, click Edit Properties (Figure M.10), the Edit Marker Line Properties dialog 
box will open (Figure M.13). 

 

 
Figure M.12  Plot – Marker Point Shortcut Menu 

 
 2. The Location box (Figure M.13) displays the X- and Y-values of the marker point. 
 
 3. From the Point box (Figure M.13), the user can select the style, line color, fill color, and 

the size of the marker point. 
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 4. The Label box, Alignment list, and the Position list (Figure M.13) are same as Items 4 
through 6 for a marker line. 

 

 
Figure M.13  Edit Marker Line Plot Dialog Box – Marker Point 

 
Delete a Marker 
 
To delete a marker line or point, right-click on a marker line (Figure M.10) or point (Figure 
M.12) from the plot window.  From either shortcut menu, click Delete, the selected marker line 
or point will be deleted from the plot window. 
 
M.4.4 Plot – Curve 
 
Customize Curves 
 
To customize curves on a plot: 
 
 1. Right-click on a curve in a plot window (Figure M.14), from the shortcut menu, click 

Edit Properties (Figure M.14), the curve name Properties dialog box will open (Figure 
M.15).  In Figure M.14, there are three curves displayed, and each of those curves has a 
shortcut menu, which displays the label (label is generated from the DSS record 
associated with the curve) associated with the curve. 

 
 2. For the selected curve to display on the plot window, click Draw Curve (Figure M.15); 

and for the selected curve to appear in the legend of the plot window, click Show in 
Legend (Figure M.15).  Click Remove Curve (Figure M.15), if the user wishes to have 
the selected curve no longer display in the plot window (option not functional in HEC-
WAT Version 1.0). 
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Figure M.14  Plot – Curve Shortcut Menu 

 
 

 
Figure M.15  curve name Properties Dialog Box 

 
 3. The curve name Properties dialog box (Figure M.15) allows the user to customize the 

style, label, and the legend item associated with the selected curve.  The user can also add 
quality symbols to the selected curve.  The following section discuss each of the tabs 
associated with the curve name Properties dialog box (Figure M.15). 

 
 Style Tab 
 
 a. From the Line box (Figure M.15), if the user wishes to the curve to be a line, select 

Draw Line (Figure M.15), the curve will be displayed on the plot as a line.  The user 
can select the color, style, and weight of the line from the Line box (Figure M.15).  
Also, the line can have a fill, the user can choose to have the fill Below or Above the 
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line (Figure M.15).  The Type of the line can be Stepped or Linear (Figure M.15) 
will give the user a preview of the modifications to the marker line.  If there are 
missing values, to create a "smoother curve", click Interpolate for Missing Values 
(Figure M.15).  Click Apply, the line displayed is now a smoother curve. 

 
 b. From the Point box (Figure M.16), if the user wishes to the curve to be a series of 

points, select Draw Point (Figure M.16), the curve will be displayed on the plot as a 
series of points.  The user can select the style of the point, line color of the point, fill 
color of the point, and the size of the point from the Point box (Figure M.16). By 
default a point is drawn for each data point on the curve (Draw Symbols on Data 
Points), the user can Skip data points or set an Offset for the data points (Figure 
M.16).  If the user wants to display a "smoother curve of points" select Automatic 
Symbol Drawing (Figure M.16).  The Sample box (Figure M.16) provides the user 
with a preview of the defined point. 

 

 
Figure M.16  curve name Properties Dialog Box – Style Tab – Point Box 

 
 c. The Missing Value Symbols box (Figure M.17) allows the user to display any 

missing values for the curve.  Click Draw Missing Value Symbols (Figure M.17), if 
there is any data related to the selected curve that is marked missing, the defined 
symbol will display on the plot.  The user can select the style, line color, fill color, and 
the size of the missing value symbol from the Missing Value Symbols box (Figure 
M.17). 

 

 
Figure M.17 curve name Properties Dialog Box – Style Tab – Missing Value Symbols Box 
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 Label Tab 
 

From the Label tab (Figure M.15), if the user wishes to a label for the curve to display 
on the plot, click Show Label (Figure M.18).  In the Label Text box (Figure M.18) is 
the default label that is created from the DSS record that represents the selected curve.  
The user can edit the label in the Label Text box (Figure M.18).  From the Alignment 
list (Figure M.18), the label can be centered, right or left justified on the selected curve.  
From the Position list (Figure M.18), the label can be positioned above, below, or 
centered on the selected curve. 

 

 
Figure M.18  curve name Properties Dialog Box – Label Tab 

 
 Legend Item Tab 
 
 a. From the Legend Item tab (Figure M.15), if the user wishes to modify the selected 

curve's legend label, enter new information in the Text box (Figure M.19). 
 

 
Figure M.19  curve name Properties Dialog Box – Legend Item Tab – Text Box 

 
 b. From the Border box (Figure M.5), the user has the option to draw a border around 

the selected curve's legend item.  Click Draw Border (Figure M.5), the user can select 
the color, style, and weight of the border, click Apply.  A border as defined will 
display around the selected curve's legend item. 

 
 c. From the Background box (Figure M.6), the user has the option to incorporate a 

background as part of the selected curve's legend item.  Click Draw Background 
(Figure M.6), the user can select the color, pattern, and set the transparency of the 
background, click Apply.  The selected curve's legend item of the plot will display 
with a background as defined. 

 
 Quality Symbols Tab 
 

From the Quality Symbols tab (Figure M.15), if the user wants to display information 
about data quality symbols related to the selected curve, select Draw Quality Symbols 
(Figure M.20). Click Apply, the defined data quality symbols will display on the  
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Figure M.20  curve name Properties Dialog Box – Quality Symbols Tab 
 
selected curve on the plot.  There are four data quality types available – Valid, 
Questionable, Rejected, and Missing (Figure M.20). For each of the data quality types 
the user can set the style, line color, fill color, and the size of the symbol that will 
represent the different data quality types. 

 
Hide/Show a Curve 
 
The user can select a curve that for reporting purposes might not need to be displayed.  From a 
plot window (Figure M.14), right-click on a curve, from the shortcut menu, click Hide Curve 
(Figure M.14), the selected curve will no longer be displayed in the plot.  To display the curve 
again, right-click on the area where the curve originally displayed, from the shortcut menu click 
Show Curve.  The selected curve now displays on the plot. 
 
Add a Callout to a Curve 
 
A callout is an annotation or additional information about the curves or points on a curve that are 
display in a plot.  Right-click on a curve, from the shortcut menu (Figure M.14), a user can add a 
callout by clicking Add Callout (Figure M.14).  The Add Callout message window will open 
(Figure M.21), in the Callout Text box, the user can enter the required information.  Click OK, 
the Add Callout message window will close (Figure M.21), and the callout will display on the 
plot along the selected curve. 
 

 
Figure M.21  Add Callout Message Window 
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Hide/Show Callouts 
 
For reporting purposes, callouts for a selected curve might not need to be displayed.  From a plot 
window (Figure M.14), right-click on a curve, from the shortcut menu, click Hide Callouts, 
from the selected curve, callouts will no longer display in the plot.  To display callouts again, 
right-click on the curve where the callouts originally displayed, from the shortcut menu click 
Show Callouts.  From the selected curve the callouts now display on the plot. 
 
Clear Callouts 
 
Callouts for a selected curve can be deleted, from a plot window (Figure M.14), right-click on a 
curve, from the shortcut menu, click Clear Callouts, from the selected curve, all callouts have 
been deleted. 
 
M.4.5 Plot - Spacers 
 
Spacers specify the distance between viewports, between a viewport and the legend, and the 
width of side margins.  From a plot window, right-click on the space between the title and the 
plot (viewport), from the shortcut menu (Figure M.22), click Edit Properties.  The Edit Space 
Properties dialog box will open (Figure M.23), from the Size in Pixels box, enter a number that 
will increase/decrease the distance between the title and the plot.  Click OK, the Edit Space 
Properties dialog box will close (Figure M.23), and the modification to the spacer will have 
been adjusted. 
 

 
Figure M.22  Plot – Spacer Shortcut Menu 
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Figure M.23  Edit Space Properties Dialog Box 
 
M.4.6 Plot - Viewport 
 
Viewport is the polygon viewing region of a plot where the grid containing the curves are 
displayed.  From the plot window, right-click in the grid area of the plot, from the shortcut menu 
(Figure M.24), right click Edit Properties, the Viewport Properties dialog box will open 
(Figure M.25). 
 

 
Figure M.24  Plot – Viewport Shortcut Menu 
 

 
Figure M.25  Viewport Properties Dialog Box 
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From the Viewport Properties dialog box (Figure M.25), there are four boxes that are 
concerned with the gird – Major X Grid, Minor X Grid, Major Y Grid, and Minor Y Grid 
(Figure M.26).  The user can set the color, style, and weight for each of the grid settings.  By 
default, the Major X- and Y-grids are set to display, if the user wants to have the minor X- and 
Y- grids display, the user would select Draw Minor X Grid and Draw Minor Y Grid (Figure 
M.26). Click Apply, and the minor gridlines will display in the plot. 
 

 
Figure M.26  Viewport Properties Dialog Box - Gridlines 
 
From the Border box (Figure M.5), by default a border around the viewport area is drawn.  The 
user can choose to not to have a border around the plot; select the color, style, and weight of the 
border. 
 
From the Background box (Figure M.6), the user has the option to incorporate a background as 
part of the plot.  Click Draw Background (Figure M.6), the user can select the color, pattern, 
and set the transparency of the background, click Apply.  The plot will display with a 
background as defined. 
 
M.4.7 Plot – X- and Y-Axis 
 
For the X- and Y-axes, the user can create/modify the individual axis label; change the font 
attributes; add a border; add a background color; adjust the scalability of the label; reverse the 
axes; switch the axes (does not work in Version 1.0 of HEC-WAT); display major and/or minor 
tic marks; and, set the axis type. 
 
Axis Label 
 
From the plot window, right-click on the axis label of a plot (X or Y), from the shortcut menu 
(Figure M.27), right click Edit Properties, the Viewport – Axis Label Properties dialog box 
will open (Figure M.28). 
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Figure M.27  Axis Label and Tics Shortcut Menus 
 

 
Figure M.28  Viewport – Axis Label Properties Dialog Box 
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 Axis Label Tab 
 
 a. From the default tab – Axis Label (Figure M.28), Show Axis Label displays an axis 

title (Figure M.28). The user can define the title by entering information in the Text 
box (Figure M.28).  Click Apply, the title of an axis will display. 

 
 b. From the Font box (Figure M.4), from the Font list, the user can select a font type for 

the selected axis label.  The user can choose to have the selected axis label, displayed 
bolded or italicized by select either Bold or Italic (Figure M.4) from the Font box.  
From the Color list (Figure M.4) the user can have the selected axis label display in a 
selected color.  From the Size list (Figure M.4), the user can set the size of font for the 
selected axis label.  The Use Font Scaling option (Figure M.4) allows for the font size 
to adjust when the plot window is being resized.  The scaling of the font is set in the 
Min Size list and the Max Size list. 

 
 c. From the Border box (Figure M.5), the user has the option to draw a border around 

the selected axis label.  Click Draw Border (Figure M.5), the user can select the color, 
style, and weight of the border, click Apply.  A border as defined will display around 
the selected axis label. 

 
 d. From the Background box (Figure M.6), the user has the option to incorporate a 

background as part of the selected axis label.  Click Draw Background (Figure M.6), 
the user can select the color, pattern, and set the transparency of the background, click 
Apply.  The selected axis label will display with a background as defined. 

 
 Scale Tab 
 

From the Scale tab (Figure M.29), by default scaling of the axes and the axes tic marks 
is set to Auto, all scaling items have a check mark by the description.  If the user wishes 
to set scaling, click an item (check mark no longer displays), and enter a new scaling 
factor for the item.  Click Apply, and the new scaling for the axes and the axes tic marks 
is available.  By selecting Reverse (invert) Axis (Figure M.29) the user can invert the 
axes in the plot.  The Switch X and Y Axis (Figure M.29) is not functional in HEC-
WAT Version 1.0. 

 

 
Figure M.29  Viewport – Axis Label Properties Dialog Box – Scale Tab 
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 Tics Tab 
 

From the Tic tab (Figure M.30), by default major tick marks are set – Use major tick 
marks.  If the user wants the minor tick marks to display, click Use minor tick marks 
(figure M.30).  In either sub tab – Major Tics or Minor Tics the user can display the 
tick labels by selecting Show Tic Labels (Figure M.30).  From the Font box (Figure 
M.4), from the Font list, the user can select a font type for the tick labels.  The user can 
choose to have the tick labels displayed bolded or italicized by selecting either Bold or 
Italic (Figure M.4) from the Font box.  From the Color list (Figure M.4) the user can 
have the tick labels display in a selected color.  From the Size list (Figure M.4), the user 
can set the size of font for the tick labels.  The Use Font Scaling option (Figure M.4) 
allows for the font size to adjust when the plot window is being resized.  The scaling of 
the font is set in the Min Size list and the Max Size list. 

 

 
Figure M.30  Viewport – Axis Label Properties Dialog Box – Tics Tab 

 
Axis Tics 
 
From the plot window, right-click on an axis tic label, from the shortcut menu (Figure M.27), 
right click Edit Properties, the Viewport – Axis Label Properties dialog box will open (Figure 
M.28).  The user can change the axis type, from the shortcut menu (Figure M.27), point to Set 
Axis Type, click Linear Axis (in Figure M.27 the axis type is Log Axis).  The plot will now 
display as a linear plot.  To change the plot to a log plot, from the shortcut menu (Figure M.27), 
point to Set Axis Type, click Log Axis 
 
M.4.8 Plot – Legend 
 
The legend provides the user with information about the items displayed in the plot.  The user 
can modify the legend panel and the customize curves that displayed in the legend. 
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Legend Panel 
 
The Legend Panel on (Figure M.31) contains information about the items displayed in the plot.  
From the plot window, right-click in the legend panel, from the shortcut menu (Figure M.31), 
right click Edit Properties, the Edit Legend Properties dialog box will open (Figure M.32).  
By default the legend panel displays, click Show Legend (check mark no longer displays) and 
the legend panel will no longer display.  The user can also position the legend panel from the 
Legend Position list. 
 

 
Figure M.31  Legend Panel and Legend Items Shortcut Menus 
 
 Legend Title Tab 
 
 a. From the default tab – Legend Title (Figure M.32), the user can add a title to the 

legend panel.  Click Draw Legend Title (Figure M.32), in the Text box the user can 
enter the information for the legend panel title.  Click Apply, the title will display in 
the legend panel 

 
 b. From the Font box (Figure M.4), from the Font list, the user can select a font type for 

the legend title.  The user can choose to have the legend title displayed bolded or 
italicized by select either Bold or Italic (Figure M.4) from the Font box.  From the 
Color list (Figure M.4) the user can have the legend title display in a selected color.  
From the Size list (Figure M.4), the user can set the size of font for the legend title.  
The Use Font Scaling option (Figure M.4) allows for the font size to adjust when the 
plot window is being resized.  The scaling of the font is set in the Min Size list and the 
Max Size list. 
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Figure M.32  Edit Legend Properties Dialog Box 

 
 c. From the Border box (Figure M.5), the user has the option to draw a border around 

the selected legend title.  Click Draw Border (Figure M.5), the user can select the 
color, style, and weight of the border, click Apply.  A border as defined will display 
around the legend title. 

 
 d. From the Background box (Figure M.6), the user has the option to incorporate a 

background as part of the legend title.  Click Draw Background (Figure M.6), the 
user can select the color, pattern, and set the transparency of the background, click 
Apply.  The legend title will display with a background as defined. 

 
 Left/Right Block Tabs 
 
 a. From the Left Block or Right Block tabs (Figure M.33), the user can add a block to 

the left or right of the legend panel.  To display the blocks the user clicks Draw Left 
Legend Block/Draw Right Legend Block (Figure M.33), click Apply.  On the 
left/right side of the legend panel a block will be displayed.  The user can add text to 
the block, by entering information into the Text box (Figure M.33) 

 
 b. From the Font box (Figure M.4), from the Font list, the user can select a font type for 

the legend panel block text.  The user can choose to have the legend panel block text 
displayed bolded or italicized by select either Bold or Italic (Figure M.4) from the 
Font box.  From the Color list (Figure M.4) the user can have the legend panel block 
text display in a selected color.  From the Size list (Figure M.4), the user can set the 
size of font for the legend panel block text.  The Use Font Scaling option (Figure 
M.4) allows for the font size to adjust when the plot window is being resized.  The 
scaling of the font is set in the Min Size list and the Max Size list. 
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Figure M.33  Edit Legend Properties Dialog Box – Left/Right Block Tabs 

 
 c. From the Icon box (Figure M.33), the user add a graphics file to a legend panel block.  

Next to the File box (Figure M.22), click         , an Open Browser will open (Figure 
M.34).  Browse to the location of a graphics file, select the file, click Open, the Open 
Browser will close (Figure M.34).  In the File box (Figure M.33), the location and 
name of the selected file will be displayed.  Click Apply, the selected graphic will 
display in the legend panel block.  Be sure to size the graphic before adding it to the 
legend panel block. 

 

 
Figure M.34  Open Browser 

 
 d. From the Border box (Figure M.5), the user has the option to draw a border around 

the legend panel block.  Click Draw Border (Figure M.5), the user can select the 
color, style, and weight of the border, click Apply.  A border as defined will display 
around the legend panel block. 
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 e. From the Background box (Figure M.6), the user has the option to incorporate a 
background as part of the legend panel block.  Click Draw Background (Figure M.6), 
the user can select the color, pattern, and set the transparency of the background, click 
Apply.  The legend panel block will display with a background as defined. 

 
Legend Panel – Customizing Curves 
 
From the Legend Panel (Figure M.31), right-click on a curve label, from the shortcut menu 
(Figure M.31), right click Edit Properties, the Curve Properties dialog box will open (Figure 
M.15).  Section M.4.4, Custom Curves, describes the various option available to a user for 
customizing curves. 
 
M.5 Customizing Plots – Edit Menu 
 
If the user does not want to customize plots from the plot, from a plot window, from the Edit 
menu, click Plot Properties.  The Plot Properties dialog box will open (Figure M.35), from 
seven tabs allows the user to configure multiple display properties of an individual plot.  The 
properties and options available from the Plot Properties dialog box (Figure M.35) are detailed 
in Section M.4.  The Layout tab (Figure M.35) is available for the user to set the plot window 
size, add a background color to the panel around the plot, and set the space size in pixels.  Before 
adjusting any of the options, please review the HEC-DSSVue User's Manual. 
 

 
Figure M.35  Frequency Viewer Properties Dialog Box – Layout Tab 
 
M.6 Configure Plot Layout 
 
The user can customize the layout of an individual plot, available options are: adding and 
removing axes, arrange the order of viewports, add and remove viewports, and set the weight of 
viewports.  The plot components are displayed in a tree structure. 
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To add a viewport to an individual plot: 
 
 1. From the plot window, from the Edit menu, click Configure Plot Layout.  The 

Configure Plot dialog box will open (Figure M.36). 
 

 
Figure M.36  Configure Plot Dialog Box 

 
 2. From Edit menu, click Add Viewport.  A new viewport will be added to the bottom of 

the tree on the Configure Plot dialog box (Figure M.37). 
 
 3. The user can now add data from one of the other viewports to the new viewport.  If data 

is not added, the new viewport will not be saved.  Select a curve from one of the existing 
viewports, using the down move arrow, move the curve to the new viewport. 

 
 4. Click Apply, the plot will now have an additional viewport that displays the curve that 

was moved. 
 
 5. Click OK, the Configure Plot Editor (Figure M.36) will close, and the plot will display 

the changes that were made. 
 
M.7 All Plots 
 
The user can customize all the plots for an entire HEC-WAT study.  From the Plot window 
(Figure M.1), from the Edit menu, there are two commands - Default Line Styles and Default 
Plot Properties.  These commands allow a user to customize all new plot windows that will be 
accessed in a study. 
 
M.7.1 Default Line Style Options 
 
The Default Line Style Options dialog box (Figure M.37) is specifically for adjusting the 
curves (lines) in all of the plots for a study.  From this dialog box, the user can add curve (line)  



HEC-WAT User's Manual Appendix M – Plots 

 M-25 

 
Figure M.37  Default Line Style Options Dialog Box 
 
types; change the color and fill of the curves (lines); and, add labels for the curves (lines) for all 
plots in a study.  For more detailed information on Default Line Style Options dialog box, refer 
to the HEC-DSSVue User's Manual (Chapter 5). 
 
From the Line tab (Figure M.37) the user can set the color, style, and weight for curves (lines) in 
all plots.  If the curves have points, the user can adjust the style, color, and fill color for the 
points on curves in all plots. 
 
From the Default Line Style Options dialog box (Figure M.37) labels can be added to the 
curves and adjust the position of the label (Label tab) for all plots.  The user can manually adjust 
the maximum and minimum values for the X-axis, set viewport weight, and reverse the X-axis 
(Defaults tab) for certain curve types such as Precip. 
 
M.7.2 Default Plot Properties 
 
The Default Plot Properties dialog box (Figure M.38) allows the configuration of all of plot 
properties related to the active study.  The worksheets for this dialog box allow a user to make 
adjustment to the viewport; modify/create a title for all plots; adjust grids; modify/add axis 
labels; marker lines; change the color of the plot background; change the layout of the legend, 
and adjust the layout of the plots.  The properties and options available from the Default Plot 
Properties dialog box (Figure M.38) are detailed in Section M.4.   
 
M.8 HEC-DSSVue User's Manual 
 
There are many more options available from the HEC-WAT plot windows.  Please review the 
HEC-DSSVue User's Manual for further details on the available options. 
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Figure M.38  Default Plot Properties Dialog Box 
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Appendix N 
 
 

Printing and Copying Data 
 
 
Plots and tables in HEC-WAT offer detailed views of data and model results that the user can 
print or copy and paste into other applications.  In addition, the user can print reports generated 
by the individual models.  The following sections provide information by the individual models 
available from HEC-WAT on printing and copying data. 
 
N.1 HEC-HMS 
 
From an HEC-HMS plot the user is able to print the plot.  For example, from an HEC-HMS plot 
result (Figure N.1), click Print      .  A Print dialog box will open (Figure N.2).  The user can 
select the printer; set properties for the print job; print to a file; setup the pages; and adjust 
appearance settings.  When everything is setup, click Print, the Print dialog box (Figure N.2) 
will close, and the HEC-HMS plot is printed. 
 

 
Figure N.1  HEC-HMS Plot Results 
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Figure N.2  HEC-HMS - Print Dialog Box 
 
N.2 HEC-RAS 
 
N.2.1 Printing 
 
Plots 
 
To print an HEC-RAS plot, for example, from a Cross Section Plot dialog box (Figure N.3), 
from the File menu, click Print.  The Print Options dialog box will open (Figure N.4).  From 
this dialog box the user can select a printer, select orientation, set margins, set printer scaling, 
and other additional options.  There are other options, for further information see the HEC-RAS 
User's Manual. 
 

 
Figure N.3  HEC-RAS - Cross Section Plot Dialog Box 
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Figure N.4  Print Options Dialog Box – HEC-RAS Plot 
 
Click Print, the Print Options dialog box (Figure N.4) will close.  A copy of the plot will be 
sent to the selected printer. 
 
Tables 
 
To print a RAS table, for example from a Profile Output Table – Standard Table 1 dialog box 
(Figure N.5), from the File menu, click Print.  A Print Options dialog box will open (Figure 
N.4) which is very similar to the Print Options dialog box for RAS plots.  The user can select a 
printer, select orientation, set margins, set options for the table, and additional options.  There are 
other options for further information see the HEC-RAS User's Manual. 
 

 
Figure N.5  HEC-RAS - Profile Output Table – Standard Table 1 Dialog Box 
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Click Print, the Print Options dialog box (Figure N.4) will close.  A copy of a RAS table will 
be sent to the selected printer. 
 
N.2.2 Copying 
 
Plots 
 
In HEC-RAS there are several copying processes associated with a plot.  The first is copying the 
plot to the clipboard for use in other programs as a graphic.  The graphic is a picture, which is 
easily copied into most programs.  For example, from a Profile Plot dialog box (Figure N.6), 
from the File menu, click Copy Plot to Clipboard.  The contents for the display area on the 
Profile Plot dialog box (Figure N.6) will be copied to the clipboard and is available for pasting 
into other programs. 
 

 
Figure N.6  HEC-RAS - Profile Plot Dialog Box 
 
Another way is to copy the data of a plot to the clipboard.  The data is copied to the clipboard in 
a tab delimited format, which is easily pasted into an Excel® spreadsheet for example.  For 
example, from a Profile Plot dialog box (Figure N.6), from the File menu, click Copy Values to 
Clipboard.  The data values that represent the plot on the Profile Plot dialog box (Figure N.6) 
will be copied to the clipboard and is available for pasting into other programs. 
 
The last way to copy RAS plot data, is to create an AutoCAD file – DXF.  The DXF format is a 
vector-based graphic and is commonly used for data export from other Computer-Aided Design 
(CAD) and GIS program (Chapter 5, Section 5.2.1).  For example, from a Profile Plot dialog 
box (Figure N.6), from the File menu, click Write DXF File.  An Enter the DXF Filename 
Browser will open (Figure N.7).  The user should search for a location to save the file and 
provide a name in the File name box.  Click Save, the Enter the DXF Filename Browser will 
close (Figure N.7) and the DXF Export dialog box will open (Figure N.8).  The user will need to  
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Figure N.7  HEC-RAS - Enter the DXF Filename Browser 
 

 
Figure N.8  HEC-RAS - DXF Export Dialog Box 
 
enter a filename (default name for a cross section plot is riverstation.dxf), and adjust some other 
settings (see HEC-RAS User's Manual for further details) if needed.  Click OK, the DXF Export 
dialog box (Figure N.7) will close, and a message window will appear informing the user that the 
DXF file has been created.  Click OK, the message box will close and the DXF will have been 
created. 
 
Cross Section Table 
 
From an HEC-RAS cross section table the user can copy the data and headings to the clipboard 
in a tab delimited format, which can be easily pasted in to an Excel® spreadsheet for example.  
For example, from a Cross Section Output dialog box (Figure N.9), from the File menu, click  
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Figure N.9  HEC-RAS - Cross Section Output Dialog Box 
 
Copy to Clipboard (Data and Headings).  The data values and headings from the table on the 
Cross Section Output dialog box (Figure N.9) will be copied to the clipboard and is available 
for pasting into other programs. 
 
Profile Table 
 
From an HEC-RAS profile table the user can copy the data and headings to the clipboard, data 
only to the clipboard, or create a text file.  To copy items to the clipboard, for example, from a 
Profile Output Table –Standard Table 1 dialog box (Figure N.5), from the File menu, click 
Copy to Clipboard (Data and Headings) or Copy to Clipboard (Data Only).  Either way the 
data values and/or headings from the table are copied to the clipboard in a tab delimited format 
which can be easily pasted into an Excel® spreadsheet. 
 
To create a text file of an HEC-RAS profile table, for example from a Profile Output Table – 
Standard Table 1 (Figure N.5), from the File menu, click Write to Text File.  An Enter 
Filename browser will open (Figure N.10).  Select where you want the file copied to and enter a 
filename.  Click Save, the Enter Filename browser (Figure N.10) will close and the file will be 
created. 
 



HEC-WAT User's Manual Appendix N – Printing and Copying Data 

 N-7 

 
Figure N.10  HEC-RAS – Enter Filename Browser 
 
N.3 HEC-ResSim 
 
N.3.1 Plots 
 
Plots provide a graphical representation of your data.  From the Plot Window (Figure N.11) the 
user can view the plot, as well as print, save as a graphics file, copy the contents of the Plot 
Window to the clipboard, and save the properties of the plot to a template to be used by other 
plots.  Following is an overview of the menu bar of the Plot Window.  The commands available 
from the menus are: 
 

 
Figure N.11  HEC-ResSim Plot Window 
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 File From this menu you can view the plotted data in a tabular format, save the plot as a 

graphics file, save a template, use a template, copy the plot to the clipboard, and 
print the plot.  Available commands are:  Tabulate, Save As, Save Template, 
Apply Template, Save Specification, Print, Page Setup, Print Preview, Print 
Multiple, and Close. 

 
 Edit From this menu you can customize the plot.  Available commands are:  Plot 

Properties, Default Line Styles, and Default Plot Properties. 
 
 Plot From this menu you can customize the layout of an individual plot, and save a plot 

type.  Available commands are:  Select Variables, Open Plot Type and Save Plot 
Type. 

 
 View From this menu you can have the plot window always on top of your desktop, and 

you can choose to use line styles.  Available commands are:  Always On Top, Use 
Line Styles, and Zoom to all. 

 
The Tools appear in a toolbar on the left side of the Plot window (Figure N.1).  The tools change 
the appearance of the mouse, as well as the functionality of the mouse: 
 
 Pointer/Selector Tool 
 
With the Pointer/Selector Tool, the user can access shortcut menus that allow customization of 
plots using the plot editing tools. 
 
 Zoom Tool 
 
The Zoom Tool allows the user to view data closely at a specific time.  To zoom in, hold the 
mouse button down and outline the area the user wants to enlarge.  To zoom out, click the right 
mouse button (right-click).  The zoom out is done by a factor of two and positions the clicked 
location at the center of the display area. 
 
Save As 
 
The Save As command allows the user to save the active plot to a graphics file.  HEC-ResSim 
has four possible formats:  Windows Metafile (*.wmf), Postscript (*.ps), JPEG (*.jpg, *.jpeg), 
and Portable Network Graphics (*.png). 
 
To create a graphics file: 
 
 1. On the File menu, click Save As, the Save browser will open (Figure N.12). 
 
 2. Find the location where to save the graphics file. 
 
 3. Enter a name for the file in the File name box. 
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Figure N.12  Save Browser 
 

 4. From the Files of type list, select the type of graphics file you wish to create. 
 
 5. Click Save, a file with the appropriate extension will be created in the selected location.  

The file will contain the contents of the Plot Window (Figure N.11). 
 
Copy to Clipboard 
 
The Copy to Clipboard command will copy the contents of the Plot Window to the clipboard.  
Once the copy is complete, the user can paste the plot as an image into other applications. 
 
Print Commands 
 
The Plot Window (Figure N.11) provides the user with several different commands to setup the 
printing process and to print. 
 
Print 
 
The Print command opens a standard system Print dialog box (Figure N.13).  From the dialog 
box the user can select the printer, choose to print to a file, and the number of copies to print.  
Click OK, the Print dialog box will close and the plot will print to the selected printer. 
 
Page Setup 
 
The Page Setup command opens the Page Setup dialog box (Figure N.14).  When using this 
dialog box, the user can setup the format of the printed page.  Following is a list of the available 
options: 
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Figure N.13  HEC-ResSim - Print Dialog Box 
 

 
Figure N.14  HEC- ResSim - Page Setup Dialog Box 
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 Orientation 
  By default, the page will be printed in Portrait.  In addition, you can choose to print in 

Landscape or Reversed (does not work in HEC-WAT Version 1.0). 
 
 Margins 
  The default margin settings are displayed in the Margins area of the Page Setup dialog 

box.  If you want to set the margins, click Set Margins, the Printer Margins dialog box 
(Figure N.15) will open.  From this dialog box, you can adjust the top, left, bottom, and 
right margins. 

 

 
Figure N.15  HEC- ResSim – Printer Margins Dialog Box 

 
 Additional Options 
  If you would like page numbers included on your printed page, select the Page Numbers 

check box (Figure N.14).  The Frame around plot option is not available in HEC-WAT 
Version 1.0. 

 
 Printer Scale 
  The default option is Maximum Plotting Area, and in Version 1.0 of HEC-WAT, is the 

only available option. 
 
Print Preview 
 
The Print Preview command opens the Preview dialog box (Figure N.16).  From this dialog 
box, the user can view the plot, adjust the scaling of the plot, and print the plot.  The Print 
command automatically prints the plot to the default system printer. 
 
Print Multiple 
 
The Print Multiple command opens the Print Multiple dialog box (Figure N.17).  To be able to 
print multiple plots the user must have opened multiple individual plot windows.  The open plots 
are listed in the Available Plots list of the Print Multiple dialog box.  To select plots to be 
printed on one page, double-click on a plot name in the Available Plots list.  The plot name will 
move to the Selected Plots list.  The user can adjust the way the plots are arranged on a page, 
horizontally or vertically.  Use the Number Across or Number Down sliders.  The grid to the 
right of the sliders reflects your choices.  From the File menu, the Page Setup and Print 
Preview commands are available. 
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Figure N.16  HEC-ResSim - Preview Dialog Box - Plot 
 

 
Figure N.17  HEC-ResSim - Print Multiple Dialog Box 
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N.3.2 Tables 
 
Tables provide a tabular format of data.  From the Tabulate Window (Figure N.18) the user can 
view the data, as well as print the table, copy the selected contents of the Tabulate Window to 
the clipboard, adjust the display of the data, and save the data to an ASCII file.  Following is an 
overview of the menu bar of the Tabulate Window.  The commands available from the menus 
are: 
 

 
Figure N.18  HEC-ResSim - Tabulate Window 
 
 File From this menu, the user can print the data in a tabular format and view a plot of the 

data.  Available commands are:  Print, Print Preview, Export, Plot, and Close. 
 
 Edit From this menu, select data to be copied to the clipboard.  Available commands are:  

Copy, Select All, Find, and Compare data sets. 
 
 View From this menu, the user can control the appearance of the data displayed in the 

Tabulate Window.  Available commands are:  Commas, Date and Time 
Separately, Date with 4 Digit Years, Show Decimal Places (auto, 1 - 6), and Show 
Missing As (blank, -901.00, M, -M-). 

 
Copy to Clipboard 
 
To copy data from the Tabulate Window (Figure N.18) to the clipboard, there are several ways.  
To use the Copy command from the Edit menu, the user must first select the cells in the table 
that will be copied to the clipboard.  If the user wants the whole table, from the Edit menu 
choose Select All.  If there is, only a certain area the user wishes to copy to the clipboard, from 
the table click and drag over the cells to be copied, the selection will be highlighted.  With either 
method, then from the Edit menu choose Copy.  The contents will then be copied to the 
clipboard where the user can paste the data into other applications.  In addition, if the user right-
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clicks on the table, a shortcut menu will appear which will also allow you to copy data to the 
clipboard. 
 
Display Data 
 
By default, data is displayed with commas and two decimal places.  If the user wants to change 
the way the data is displayed, from the View menu there are several options.  If user does not 
want commas displayed, from the View menu, click Commas. 
 
For time series data the date and time are displayed in the following default format:  ddmmmyy 
hhmm.  The user can change the way the date and time are displayed.  From the View menu, 
click Date and Time Separately; the date and time are now displayed in two separate columns 
in the table.  Another way is from the View menu, click Date with 4 Digit Years; the date and 
time now displays a four-digit year instead of a two-digit year. 
 
Numbers by default are displayed with two decimal places.  If the user wants to see more or less 
number of decimal places, from the View menu, point to Decimal Places, and click on the 
number (zero through 6) of decimal places you would like displayed. 
 
ASCII File 
 
The user can save the table of data to an ASCII file, right-click on the table.  From the shortcut 
menu, click Export; the Table Export Options dialog box will open (Figure N.19).  From this 
dialog box, the user can set certain options for the ASCII file. 
 

 
Figure N.19  HEC-ResSim - Table Export Options Dialog Box 
 
The user can set the delimiter for the file from the Field Delimiter list.  The hardwired choices 
are TAB (default), SPACE, COMMA, and COLON.  The user can also make choices on 
whether the file contains fixed width columns, strings are set in quotes, whether to include 
column headers in the file, include gridlines in the file, and whether to include the a title in the 
file. 
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When all of the options are set, click OK.  A Save browser will open.  Find the location where 
the file will be saved, and provide a filename.  Click Save, the file will be created without an 
extension, since this is an ASCII file, you might want to give the file an extension of .txt. 
 
Print 
 
The Print command opens the Properties dialog box will open (Figure N.21).  From this dialog 
box, the user can set up the format of the table for output. 
 

 
Figure N.20  HEC-ResSim Properties Dialog Box 
 
From the Page Tab (Figure N.20), the user can set the orientation; fit the table to a page, and 
choose whether to include the entire table or only a selection.  In addition, the user can also 
choose to print the table in ASCII, add headers, add background color to headers (non-ASCII 
option), and add gridlines. 
 
If the user wants to add header or foot information to the table report, click the Header/Footer 
tab (Figure N.20).  From the Header/Footer Worksheet enter header or footer information. 
 
The title of the table report defaults to the pathname tag associated with the data.  If the user 
wants to change this title, click the Table Title Tab.  From the Table Title Worksheet enter or 
change the title, and decide if the title needs to be printed on each page of the report.  When 
everything is set, click Print, a standard system Print (Figure N.13) dialog box will open. 
 
To preview the table report, right-click on the table, from the shortcut menu click Print Preview.  
A dialog box similar to the Properties dialog box (Figure N.20) will open.  Setup options for the 
table report; click Preview, and the Print Preview dialog box (Figure N.21) will open.  From 
this dialog box, the user can view the table report, adjust the scaling of the report, and print the 
report.  The Print command automatically prints the report to the default system printer. 
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Figure N.21  HEC-ResSim - Preview Dialog Box - Tables 
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Appendix O 
 

Glossary 
 
This glossary is a collection of definitions from throughout this user's manual, plus definitions of 
other pertinent terms. 
 
Acre: A unit of area in English units used in calculation of agricultural crop damage. 
 
Activity: Linked with features and may involve changes to operations or institutional actions. 
 
Alternative: A system of structural and/or nonstructural measures, strategies, or programs 

formulated to alleviate problems or take advantage of specific opportunities 
associated with water and related land resources in the planning area.  An 
alternative in HEC-WAT is a way to group a schematic with different operations 
and model parameters.  The HEC-WAT creates a base alternative (Without Project 
Conditions) by default. 

 
Analysis Period: Defines the time window and events that could be associated with an 

alternative.  Analysis periods are for determining damage and project 
performance information for specific time periods, such as the base year or 
the most likely future year.  The analysis year results for a plan are also used 
to perform equivalent annual damage computations.  The analysis years are 
used for all study evaluations.  An analysis year represents a static time 
period or year that the hydrology, hydraulics, and economic data represent.  
Base year is the first year of the plan operation.  The "most likely future 
year" condition is a development projection for a specific future year; say 
twenty years out from the base year.  It usually is based on the projections of 
local future development plans. 

 
Arc Shapefile: This layer type is the native data structure for the ArcView® GIS program.  

Shapefiles store non-topological geometry and attribute information for the 
spatial features of a data set.  Usually there are three files:  *.dbf, *.shp, and 
*.shx.  The shp file contains the shapes (point, polylines, or polygons) that are 
displayed in the layer.  Each shape has a record in the dbf file containing 
descriptive data called "attributes".  The .shx file contains an index that links 
each shape to its record in the .dbf file. 

 
ArcInfo® DEM: This is an ASCII file format representation of a grid generated by ArcInfo®.  

The file consists of keywords followed by values defining the number of 
columns, number of rows, lower left corner, cell size, no data value, and each 
cell value. 

 
ASCII NetTin: This is an ASCII file format used to represent a triangulated irregular network 

(TIN).  The TIN data are stored in a simple format that defines the nodes, 
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edges, and triangles contain in the TIN.  This format is common for 
transferring TIN data between software. 

 
AutoCAD® DXF: A Drawing Interchange File (dxf) is created by a Computer-Aided Design 

(CAD) package, AutoCAD®.  This format is a tagged data representation 
of an AutoCad® drawing file.  Tagged data is where each data element is 
preceded by a group code.  A group code is an integer indicating the type 
of data element.  The file created is a vector-based graphic.  The DXF 
format is commonly used for data export from other CAD and GIS 
programs. 

 
CAP: Continuing Authorities Program; is a group of legislative authorities that give the Corps 

of Engineers the authority to plan, design, and construct certain types of water resource 
and ecosystem restoration projects without additional and specific congressional 
authorization.  The following are the most commonly used CAP authorities:  Small Flood 
control Projects (authorized by Section 205 of the 1948 Flood control Act); Emergency 
Streambank Protection Projects (authorized by Section 14 of the 1946 Flood control Act), 
Aquatic Ecosystem Restoration (authorized by Section 206 of the 1996 Water Resources 
Development Act); and, Project Modifications of the Improvement of the Environment 
(authorized by Section 1135 of the 1986 Water Resources Development Act). 

 
Channel Modification: Physical alternation of the channel through re-sizing, re-configuration, 

or re-vegetation, etc. 
 
Channel Modification  Tool to create, delete, rename, and edit channel 
Tool: modifications.  A channel modification has to be created on the stream 

alignment. 
 
Common Computation Locations where one model transfers data to  
Point: another model, a location where results are needed for model 

development or alternative analysis, or locations where input boundary 
conditions are to be defined. 

 
Common Computation Tool to create, delete, rename, and edit common computation points. 
Point Tool: See Appendix H for more detail on creating, deleting, renaming, and 

editing computation points. 
 
Compute: Capability within HEC-WAT that allows the user to perform the calculations made 

available through HEC-WAT.  These calculations could be for one or more of the 
models in an order chosen by the Project Delivery Team (PDT). 

 
 Also, a menu where the user can compute individual simulations; compute multiple 

simulations; compute by individual program; and, view the compute log for the 
active simulation. 

 
Content Pane: Area of the HEC-WAT framework that provides details on the selected HEC-

WAT component in the Study Pane. 
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Desktop Pane: Area of the HEC-WAT framework where the different map windows available 

from HEC-WAT will display. 
 
Diversion: Removal and redirection of water from its normal course for various reasons, water 

supply, flood control, or environmental, etc. 
 
Diversion Tool: Tool to create, delete, rename, and edit diversions.  A diversion has to be 

started on the stream alignment. 
 
DXF: See AutoCAD® DXF. 
 
Easting: The eastward measured distance in common map projections (X-coordinate). 
 
Ecosystem Restoration  Physical modifications or other actions that improve the value and  
Measure: function of an ecosystem (e.g., channel improvements, removal of 

drainage structures or levees). 
 
Edit: A menu where the program order can be set; manipulate alternatives and simulations; 

link individual model alternatives; and, access the individual program editors. 
 
Event: A rainfall and/or flow episode.  Normally the event is the time period over which the 

model will retrieve data and produce results.  An occurrence of precipitation/snowmelt 
that leads to some sort of hydrologic response normally associated with a specific time 
period.  The event can be historical or represent the upper limit of a precipitation runoff 
response. 

 
File: A menu used for study management, printing the active map, and, importing and 

exporting model alternatives. 
 
FIA: Flood Impact Analysis, see HEC-FIA. 
 
Feature: A physical element that generally requires site construction. 
 
Flood Damage Can be a physical modification (structural measures) designed to 
Reduction Measure : reduce the frequency of damaging levels of flood inundation (i.e., 

reservoirs, levees, channelization measures, walls, etc.); or, it can be an 
activity (non-structural measure) that reduces flood damage without 
significantly altering the nature or extent of flooding (e.g., flood 
proofing, relocation of structures, raising structures). 

 
Floodwall: A levee/floodwall is manmade barrier built along a stream to provide protection 

from flooding.  A levee/floodwall can reduce flood damage by preventing flood 
stages from reaching a potential damage area. 

 
GIS: Geographic Information System 
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Group Code: In a DXF file an integer indicating the type of data element, see AutoCAD® 
DXF. 

 
GUI: Graphical User Interface, designed to make the program easy and efficient to enter data, 

review output, and make comparisons. 
 
Hectare: A unit of area in SI units used in calculation of agricultural crop damage. 
 
HEC-DSS: The HEC database management system, HEC Data Storage System, stores data in 

a convenient manner for inventory, retrieval, and archiving for water resource 
applications. 

 
HEC-DSSVue: The HEC software package, HEC Data Storage System Visual Utility Engine, 

which provides a graphical user interface for viewing, editing, and 
manipulating data in HEC-DSS files. 

 
HEC-FIA: The HEC software package, HEC Flood Impact Analysis.  This software package 

provides the capability to estimate the impacts and damage associated with flood 
events and the benefits attributed to flood control projects. 

 
HEC-HMS: The HEC software package, HEC Hydrologic Modeling System.  This software 

package is designed to simulate the precipitation-runoff processes of dendritic 
watershed systems and provides the capability to simulate the hydrologic response 
in a watershed. 

 
HEC-RAS: The HEC software package, HEC River Analysis System.  This software package 

is designed to perform one-dimensional hydraulic calculations for a full network 
of natural and constructed channels, that allow the user the capability to perform 
one-dimensional steady and unsteady flow river hydraulics calculations, sediment 
transport-mobile be modeling, and water temperature analysis. 

 
HEC-ResSim: The HEC software package, HEC Reservoir System Simulation.  This software 

package provides the capability to simulate the operation of a reservoir or 
reservoir system for an observed, synthetic or predicted flow event using a 
defined operation scheme. 

 
HEC-SSP: The HEC software package, HEC Statistical Software Package.  This software 

package allows the user to perform statistical analyses of hydrologic data. 
 
HEC-WAT: The HEC software package, HEC Watershed Analysis Tools.  This software 

package will provide an interface that will streamline the analytical process using 
the tools commonly applied by multi-disciplinary teams at USACE offices. 

 
Help: A menu that provides access to HEC-WAT documentation and displays current 

information about HEC-WAT. 
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Impact Area: Is any distinct portion of a study area that is affected by rising or falling stage in 
a stream, river, lake, or reservoir.  The boundaries of an impact area are defined 
by a closed polygon, and the user characterize the effects of rising or falling 
stage by describing the property and population at risk in the area bounded by 
the polygon. 

 
Impact Area Tool: Tool is used to create, edit, delete, and rename, impact areas.  See 

Appendix I for more detail on creating, deleting, renaming, and editing 
impact areas. 

 
JRE: Java Runtime Environment (JRE) 
 
Layer: Layers are maps that can be placed as background images behind the workspace.  They 

are optional but do provide significant information.  Layers can be many types (*.dlg, 
*.shp (ARC/INFO® or Arc Shapefile), *.dxf (AutoCAD®), *.dem). 

 
Levee : A levee/floodwall is a manmade barrier built along a stream to provide protection from 

flooding.  A levee/floodwall can reduce flood damage by preventing flood stages from 
reaching a potential damage area. 

 
Levee Tool: Tool to create, delete, rename, and edit levees.  See Appendix G for more details 

on creating, deleting, renaming, and editing levees. 
 
Map Windows: A way to graphically display the major components of an HEC-WAT study 

(stream alignments, schematics, alternatives, simulations).  From these map 
windows the user can created, edit, delete, open model editors, or view results. 

 
Maps: A menu where the user can setup map layers and map windows.  The user can set spatial 

properties; zoom the active map window out to its full extents, add map layers, remove 
map layers, open a new map window, adjust the active map windows properties, save 
the contents of the active map window as a graphic file, import a stream alignment from 
an ArcView® shapefile, import impact areas from an ArcView® shapefile, export a 
stream alignment to an ArcView® shapefile, and, export impact areas to an ArcView® 
shapefile. 

 
Measure: Measures for HEC-WAT include structural/non-structural measures (flood damage 

reduction), and/or ecosystem measures.  Structural measures are physical 
modifications designed to reduce the frequency of damaging levels of flood 
inundation, and include dams with reservoirs, levees, channelization measures, 
walls, diversion channels, pumps, bridge modifications, and ice-control structures.  
Non-structural measures are activities that reduce flood damage without 
significantly altering the nature or extent of flooding (e.g., flood proofing, relocation 
of structures, raising structures).  Ecosystem restoration measures are physical 
modifications or other actions that improve the value and function of an ecosystem 
(e.g., channel improvements, removal of drainage structures or levees). 

 
Message Pane: Area of the HEC-WAT framework that contains messages that the HEC-WAT 

software provides for informational purposes.  The information in the Message 
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Pane is a record of HEC-WAT software activity, recording the opening of the 
study, opening map windows, accessing DSS, and many other HEC-WAT 
activities. 

 
NED: National Economic Development; usually referred to as the NED plan, which is the plan 

USACE is required to compute and report.  The NED plan provides the greatest 
economic benefits.  If a plan is recommended, most likely it is the NED plan. 

 
NexGen: Next Generation Software Development Project 
 
Northing: The northward measured distance in common ma projections (Y-coordinate). 
 
Panes: Viewing areas of the HEC-WAT main window that allow viewing of HEC-WAT study 

data. 
 
Pan Tool: Tool to move the display area while zoomed in. 
 
PDT: Project Delivery Team 
 
Plan: A set of one or more flood damage reduction or ecosystem restoration measures or 

actions designed to operate over a period of time (project life).  The plan is inclusive of 
the entire study area although it may have a flood damage reduction measure for a single 
damage reach. 

 
Plug-In: Provides the ability to access model parameters and view results of a model from 

HEC-WAT. 
 
PM: Project Manager 
 
Pointer/Selector Tool: Allows the user to select components for editing and viewing (plots) 

data or results. 
 
Project: A man-made structure for the purpose of reducing flood damage or for ecosystem 

restoration. 
 
R&U: Risk and Uncertainty 
 
Raster Image: Generally defined as a rectangular array of sampled values (pixels).  Each pixel 

has one or more number associated with it, generally specifying a color the 
pixel should be display in.  The raster image formats supported by HEC-WAT 
are JPEG format (*.jpg) and Graphics Interchange Format (*.gif).  For HEC-
WAT to access these file types an *.img (ASCII text) file must be created by 
the user outside of HEC-WAT.  The file needs to contain the following lines, 
which need to match the easting and northing parameters stated in the Map 
Default Properties for StudyName dialog box (Chapter 5, Section 5.2.5). 
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Rating Curve: A graphical relationship that yields the stage for a given discharge at a 
specific location on a stream or river. 

 
Reservoir: The impoundment created behind dams, or behind navigation locks and dams. For 

HEC-WAT a reservoir also includes the dam built on a stream to store water for 
uses such as navigation, tribal resources, flood damage reduction, fish and wildlife 
habitat considerations, hydroelectric power generation, recreation use, water 
quality, water supply, erosion and sedimentation control, and sustaining hydrologic 
function on lakes and rivers.  The releases from a reservoir can reduce flood 
damage by reducing flood stages. 

 
Reservoir Tool: Tool to create, delete, rename, and edit reservoirs.  See Appendix G for more 

detail on creating, deleting, renaming, and editing reservoirs. 
 
Results: A menu from which the user can select simulations for comparison; and, view results 

from HEC-WAT and the individual software applications from within HEC-WAT. 
 
Risk: The probability an area will be flooded, resulting in undesirable consequences. 
 
Risk Analysis: An approach to evaluation and decision making that explicitly, and to the 

extent practical, analytically, incorporates considerations of risk and 
uncertainty in a flood damage reduction study. 

 
Run: Capability within HEC-WAT that allows the PDT to select the models to execute for a 

given event or events. 
 
Schematic: In HEC-WAT, a physical representation of the study and it includes: common 

computation points, impact areas, stream alignment, and flood damage reduction 
and environmental measures that will be modeled. 

 
Simulation: A combination of an analysis period and event(s) associated with an alternative. 
 
Stage: The vertical distance in feet (meters) above or below a local or national datum 

(N.G.V.D. for elevations). 
 
Stage Hydrograph: A graphical relationship of stage as a function of time for a certain 

location. 
 
Status Bar: Displays the coordinates of the pointer on a map window.  Outside of a map 

window it reflects the status of the program. 
 
Stream Alignment: Represents the stream system in the watershed.  The alignment indicates 

where confluences and bifurcations occur and provides a sense of distance 
and scale.  In HEC-WAT, stream alignments are composed of a series of 
stream elements.  See Appendix F for more detail on creating, deleting, 
renaming, and editing stream alignments. 
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Stream Alignment Properties of a stream alignment that include: line width, color of line, 
Properties: font style, etc.  See Appendix F for more detail on creating, deleting, 

renaming, and editing stream alignments. 
 
Stream Alignment Tool is used to create, delete, and edit the stream  
Tool: elements that make up the stream alignments.  See Appendix F for more 

detail on creating, deleting, renaming, and editing stream alignment. 
 
Stream Element: Segment of the stream alignment that is composed of vertex points, with 

the beginning and ending vertex points being stream nodes.  Typically 
begins or ends at a confluence, bifurcation, or at the boundary of the river 
system.  See Appendix F for more detail on creating, deleting, renaming, 
and editing stream elements. 

 
Streamgage Records: Records of the stream elevation or stage taken at a streamgage location. 
 
Stream Node: The beginning and ending point for each stream element.  Stream nodes are also 

created where stream elements meet.  Also, a stream node can be used to 
establish stationing for a stream element.  See Appendix F for more detail on 
creating, deleting, renaming, and editing stream nodes. 

 
Stream Node Tool: Tool is used to create, delete, and edit stream nodes on the stream 

alignment.  See Appendix F for more detail on creating, deleting, 
renaming, and editing stream nodes. 

 
Stream Stationing: Watershed adopted stations along a stream normally denoted as miles 

(kilometers) above the mouth of a stream. 
 
Study: The basic component of HEC-WAT.  An HEC-WAT study defines the watershed or 

geographic are to be evaluated.  The study includes alternative analyses which is the 
investigation of with and without-project conditions involving hydrology, hydraulics, 
economics, plan formulation and evaluation.  In HEC-WAT, the study also includes all 
of the necessary information to complete an analysis of a specific geographical area. 

 
Study Pane: Area of the HEC-WAT framework that provides an overview of HEC-WAT 

alternatives, simulations, and analysis periods that have been defined for a study. 
 
System Units: This value is used as a label for data entry forms and output reports.  Choices 

are English or Metric, with the default being English. 
 
Tabs: Provides different views of the available data in an HEC-WAT study.  The user can 

perform certain operations for a study from the tabs. 
 
Toolbar: Provides quick access to the most frequently used options from the HEC-WAT menu 

bar. 
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Tools: A menu that provides access to DSS data (HEC-DSSVue); provides access to the 
Statistical Software Package (HEC-SSP); allows the user to view general information 
about the study; provides options for the HEC-WAT startup and system properties; view 
HEC-WAT program activity; and, monitor memory usage. 

 
Top of Levee: Stage at the top of the levee, floodwall or tidal barrier. 
 
Uncertainty: A measure of imprecision of knowledge of parameters and functions used to 

describe the hydraulic, hydrologic, geotechnical, and economic aspects of a 
project plan. 

 
USGS DEM: The U.Ss Geological Survey (USGS) publishes the file format USGS DEM 

(Digital Elevation Map).  A raster file format, DEM files usually contain terrain 
elevations, but the file format can be used for representing any surface.  The 
format, published by the USGS, allows internal documentation of coordinate 
system, date of publication, etc.  These values are referenced horizontally either 
to a Universal Transverse Mercator (UTM) projection or to a geographic 
coordinate system. 

 
USGS Digital USGS Digital Line Graphs (DLG) are created from two sources using manual 
Line Graph: and automated digitizing methods.  The two sources are aerial photographs or 

cartographic sources.  DLG files are vector representations of the data.  When 
the HEC-WAT interacts with a dlg file it automatically creates a dlgbin file for 
use. 

 
Vertex Point: A point with known coordinates on a stream element in the stream alignment. 
 
View: A menu that allows the user to setup the HEC-WAT main window; the user can select 

toolbars and panes; set display unit for plotting and tabulating; and manage layouts for 
the HEC-WAT main window. 

 
WAT: Watershed Analysis Tool, see HEC-WAT. 
 
Watershed: The total area of land that drains to a common stream system. 
 
Window: A menu where the user can control the appearance of the map windows in the 

Desktop Pane of the HEC-WAT main window. 
 
With Project The economic, performance, and other conditions associated with  
Conditions: implementing a flood damage reduction plan.  It is compared to the without-

project condition.  It includes the base-year and static future analysis year 
periods to determine the equivalent values. 

 
Without Project Base alternative in HEC-WAT for evaluating the benefits and performance of 
Conditions: potential flood damage reduction plans and represents the conditions of the 

study if no actions are taken.  The without project conditions includes the base 
year conditions and the most likely future year conditions. 
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Zoom Tool: Tool that allows zooming in and out of map windows.   
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Appendix P 
 
 
 

Terms and Conditions for Use 
 
Use of the program is governed by the terms and conditions for use.  They limit what can be 
done with the program software, waive warranty, limit liability, and indemnify the developers 
and the United States government.  The program cannot be used unless the terms and conditions 
for use are accepted; the full text is given below. 
 
 
Terms and Conditions for Use 
 
The United States Government, US Army Corps of Engineers, Hydrologic Engineering Center 
("HEC") grants to the user the rights to install Watershed Analysis Tool (HEC-WAT) "the 
Software" (either from a disk copy obtained from HEC, a distributor or another user or by 
downloading it from a network) and to use, copy and/or distribute copies of the Software to other 
users, subject to the following Terms and Conditions for Use: 
 
All copies of the Software received or reproduced by or for user pursuant to the authority of this 
Terms and Conditions for Use will be and remain the property of HEC. 
 
User may reproduce and distribute the Software provided that the recipient agrees to the Terms 
and Conditions for Use noted herein. 
 
HEC is solely responsible for the content of the Software.  The Software may not be modified, 
abridged, decompiled, disassembled, unobfuscated or reverse engineered.  The user is solely 
responsible for the content, interactions, and effects of any and all amendments, if present, 
whether they be extension modules, language resource bundles, scripts or any other amendment. 
 
The name "HEC-WAT" must not be used to endorse or promote products derived from the 
Software.  Products derived from the Software may not be called "HEC-WAT" nor may any part 
of the "HEC-WAT" name appear within the name of derived products. 
 
No part of this Terms and Conditions for Use may be modified, deleted or obliterated from the 
Software. 
 
No part of the Software may be exported or re-exported in contravention of U.S. export laws or 
regulations. 
 
Waiver of Warranty 
 
THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, 
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND  
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SUPPLIERS PROVIDE HEC-WAT \"AS IS,\" WITHOUT ANY WARRANTY OR 
CONDITION, EXPRESS, IMPLIED OR STATUTORY, AND SPECIFICALLY DISCLAIM 
ANY IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NON-INFRINGEMENT.  Depending on state law, the 
foregoing disclaimer may not apply to you, and you may also have other legal rights that vary 
from state to state. 
 
Limitation of Liability 
 
IN NO EVENT SHALL THE UNITED STATES GOVERNMENT AND ITS AGENCIES, 
OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS 
AND SUPPLIERS, BE LIABLE FOR LOST PROFITS OR ANY SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF OR IN CONNECTION WITH USE OF 
HEC-WAT REGARDLESS OF CAUSE, INCLUDING NEGLIGENCE. 
 
THE UNITED STATES GOVERNMENT’S LIABILITY, AND THE LIABILITY OF ITS 
AGENCIES, OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS 
CONTRACTORS AND SUPPLIERS, TO YOU OR ANY THIRD PARTIES IN ANY 
CIRCUMSTANCE IS LIMITED TO THE REPLACEMENT OF CERTIFIED COPIES OF 
HEC-WAT WITH IDENTIFIED ERRORS CORRECTED.  Depending on state law, the above 
limitation or exclusion may not apply to you. 
 
Indemnity 
 
As a voluntary user of HEC-WAT you agree to indemnify and hold the United States 
Government, and its agencies, officials, representatives, and employees, including its contractors 
and suppliers, harmless from any claim or demand, including reasonable attorneys' fees, made by 
any third party due to or arising out of your use of HEC-WAT or breach of this Agreement or 
your violation of any law or the rights of a third party. 
 
Assent 
 
By using this program you voluntarily accept these terms and conditions.  If you do not agree to 
these terms and conditions, uninstall the program and return any program materials to HEC (if 
you downloaded the program and do not have disk media, please delete all copies, and cease 
using the program.) 
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